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SYBEX

To Our Valued Readers:

Thank you for looking to Sybex for your MCDST exam prep needs. We at Sybex are proud of
our reputation for providing certification candidates with the practical knowledge and skills
needed to succeed in the highly competitive IT marketplace. Certification candidates have come
to rely on Sybex for accurate and accessible instruction on today’s crucial technologies and busi-
ness skills. For the second year in a row, readers such as yourself voted Sybex as winner of the
“Best Study Guides” category in the most recent CertCities Readers Choice Awards.

Just as Microsoft is committed to establishing measurable standards for certifying desktop
support technicians by means of the MCDST certification, Sybex is committed to providing
those individuals with the knowledge needed to meet those standards.

The author and editors have worked hard to ensure that the study guide you hold in your
hands is comprehensive, in-depth, and pedagogically sound. We’re confident that this book
will exceed the demanding standards of the certification marketplace and help you, the
MCDST certification candidate, succeed in your endeavors.

As always, your feedback is important to us. If you believe you’ve identified an error in the

book, please send a detailed e-mail to support@sybex.com. And if you have general comments
or suggestions, feel free to drop me a line directly at nedde@sybex.com. At Sybex we’re con-
tinually striving to meet the needs of individuals preparing for certification exams.

Good luck in pursuit of your MCDST certification!

Neil Edde
Associate Publisher—Certification
Sybex, Inc.




Software License Agreement: Terms and Conditions

The media and/or any online materials accompanying
this book that are available now or in the future contain
programs and/or text files (the “Software”) to be used in
connection with the book. SYBEX hereby grants to you
a license to use the Software, subject to the terms that
follow. Your purchase, acceptance, or use of the Soft-
ware will constitute your acceptance of such terms.
The Software compilation is the property of SYBEX
unless otherwise indicated and is protected by copyright
to SYBEX or other copyright owner(s) as indicated in
the media files (the “Owner(s)”). You are hereby
granted a single-user license to use the Software for your
personal, noncommercial use only. You may not repro-
duce, sell, distribute, publish, circulate, or commercially
exploit the Software, or any portion thereof, without the
written consent of SYBEX and the specific copyright
owner(s) of any component software included on this
media.

In the event that the Software or components include
specific license requirements or end-user agreements,
statements of condition, disclaimers, limitations or war-
ranties (“End-User License”), those End-User Licenses
supersede the terms and conditions herein as to that par-
ticular Software component. Your purchase, accep-
tance, or use of the Software will constitute your
acceptance of such End-User Licenses.

By purchase, use or acceptance of the Software you fur-
ther agree to comply with all export laws and regula-
tions of the United States as such laws and regulations
may exist from time to time.

Software Support

Components of the supplemental Software and any
offers associated with them may be supported by the
specific Owner(s) of that material, but they are not sup-
ported by SYBEX. Information regarding any available
support may be obtained from the Owner(s) using the
information provided in the appropriate read.me files or
listed elsewhere on the media.

Should the manufacturer(s) or other Owner(s) cease to
offer support or decline to honor any offer, SYBEX
bears no responsibility. This notice concerning support
for the Software is provided for your information only.
SYBEX is not the agent or principal of the Owner(s),
and SYBEX is in no way responsible for providing any
support for the Software, nor is it liable or responsible
for any support provided, or not provided, by the
Owner(s).

Warranty

SYBEX warrants the enclosed media to be free of phys-
ical defects for a period of ninety (90) days after pur-

chase. The Software is not available from SYBEX in any
other form or media than that enclosed herein or posted
to www.sybex.com. If you discover a defect in the media

during this warranty period, you may obtain a replace-
ment of identical format at no charge by sending the
defective media, postage prepaid, with proof of pur-
chase to:

SYBEX Inc.

Product Support Department
1151 Marina Village Parkway
Alameda, CA 94501

Web: http://www.sybex.com

After the 90-day period, you can obtain replacement
media of identical format by sending us the defective
disk, proof of purchase, and a check or money order for
$10, payable to SYBEX.

Disclaimer

SYBEX makes no warranty or representation, either
expressed or implied, with respect to the Software or its
contents, quality, performance, merchantability, or fit-
ness for a particular purpose. In no event will SYBEX,
its distributors, or dealers be liable to you or any other
party for direct, indirect, special, incidental, consequen-
tial, or other damages arising out of the use of or inabil-
ity to use the Software or its contents even if advised of
the possibility of such damage. In the event that the Soft-
ware includes an online update feature, SYBEX further
disclaims any obligation to provide this feature for any
specific duration other than the initial posting.

The exclusion of implied warranties is not permitted by
some states. Therefore, the above exclusion may not
apply to you. This warranty provides you with specific
legal rights; there may be other rights that you may have
that vary from state to state. The pricing of the book
with the Software by SYBEX reflects the allocation of
risk and limitations on liability contained in this agree-
ment of Terms and Conditions.

Shareware Distribution

This Software may contain various programs that are
distributed as shareware. Copyright laws apply to both
shareware and ordinary commercial software, and the
copyright Owner(s) retains all rights. If you try a share-
ware program and continue using it, you are expected to
register it. Individual programs differ on details of trial
periods, registration, and payment. Please observe the
requirements stated in appropriate files.

Copy Protection

The Software in whole or in part may or may not be
copy-protected or encrypted. However, in all cases,
reselling or redistributing these files without authoriza-
tion is expressly forbidden except as specifically pro-
vided for by the Owner(s) therein.
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Introduction

Microsoft’s new Microsoft Certified Desktop Support Technician (MCDST) certification is
designed to help get you started on your career by ensuring that you have the skills to trouble-
shoot desktop environments running on the Windows operating system.

This book has been developed to give you the critical skills and knowledge that you need to
prepare for the two exams that you are required to pass to become an MCDST. These exams
are MS 70-271 (Supporting Users and Troubleshooting a Microsoft Windows XP Operating
System) and MS 70-272 (Supporting Users and Troubleshooting Desktop Applications on a
Microsoft Windows XP Operating System). We have mapped the content of this book in direct
relation to Microsoft’s stated objectives for these exams. You can read the specific objectives of
these exams at www.microsoft.com/mcdst.

Why Become Certified as an MCDST?

As the computer network industry grows in both size and complexity, the need for proven abil-
ity is increasing. Companies rely on certifications to verify the skills of prospective employees
and contractors. Whether you are just getting started or are ready to move ahead in the com-
puter industry, the knowledge, skills, and credentials you have are your most valuable assets.

Microsoft has developed its Microsoft Certified Professional (MCDST) program to give you
credentials that verify your ability to troubleshoot the user’s desktop, including the operating
systems and the applications that he uses most. In addition, you will learn how to communicate
with users to assist them and ensure their continued productivity to the organization.

Over the next few years, thousands of companies around the world will be searching for
IT professionals who can help improve their user productivity by quickly troubleshooting and
repairing issues related to their desktop operating systems and the applications that they use
most often. They will turn to people who can prove that they have the ability to work with com-
puters and with the users in the network. Your certification will be proof that you understand
not only the technical aspects of troubleshooting the problem but also how to work with the end
user to ensure her continued productivity for her organization. The MCDST certification will
give you an advantage over your competition for the same job.

Is This Book for You?

If you want to acquire a solid foundation in troubleshooting the latest desktop operating sys-
tems and working with the end users of a network, this book is for you. You’ll find clear expla-
nations of the fundamental concepts you need to grasp.

If your goal is to prepare for the exam by learning how Microsoft wants you to communicate
with the users and troubleshoot their issues, this book is for you. It will help you to achieve the
high level of professional competency you need to succeed in this field.

If you want to become certified as an MCDST, this book is definitely for you. However, if
you just want to attempt to pass the exam without really understanding the role of an MCDST,



XX Introduction

this book is 7ot for you. This book is written for those who want to acquire hands-on skills and
in-depth knowledge of the Microsoft Certified Desktop Support Technician certification and its
role in an organization.

What Does This Book Cover?

Think of this book as your complete guide to troubleshooting Windows XP and the most
common operating systems utilized by users in a Microsoft Windows environment. It begins
by covering basic concepts, such as installing the Windows operating system and managing
access to resources. Each chapter teaches you how to perform important tasks, including
the following:

= Configuring and troubleshooting hardware devices and drivers
=  Configuring and troubleshooting desktop user environments

=  Troubleshooting network protocols and services

=  Configuring and troubleshooting connectivity for applications

Throughout the book, you will be provided with technical information and practical
experience for each exam objective. At the end of each chapter, you’ll find a summary of the
topics covered in the chapter. Each chapter will incorporate key terms indicated in italics.
The key terms represent not only the terminology that you should recognize but also the
underlying concepts that you should understand to pass the exam. All of the key terms are
defined in the glossary at the back of the study guide.

Finally, each chapter concludes with 10 review questions that test your knowledge of
the information covered and provides thorough explanations of the answers. Two Bonus
Exams, as well as multimedia demonstrations of the hands-on exercises, are included on the
CD that accompanies this book, as explained in the “What’s on the CD?” section later in
this Introduction.

4 The topics covered in this book map directly to Microsoft’s official exam objec-
TE tives. Each exam objective is covered completely.

How Do You Become an MCDST?

Attaining MCDST certification is a challenge. Prospective MCDSTs will need to complete a
course of study that provides not only detailed knowledge of a wide range of topics but true
skills derived from working with Windows XP and related software products. If you are willing
to dedicate time and effort with Windows XP and the desktop applications, you can prepare for
the exams by using the proper tools. If you work through this book, you should meet the exam
requirements successfully.
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This book is a part of a complete series of MCDST, MCSA, and MCSE Study Guides, pub-
lished by Sybex, that covers the core and elective requirements you need to obtain these
Microsoft certifications. Titles include the following:

= MCSA/MCSE: Windows Server 2003 Environment Management and Maintenance Study
Guide (70-290)

=  MCSA/MCSE: Windows Server 2003 Network Infrastructure Implementation, Manage-
ment, and Maintenance Study Guide (70-291)

= MCSE: Windows Server 2003 Network Infrastructure Planning and Maintenance Study
Guide (70-293)

=  MCSE: Windows Server 2003 Active Directory Planning, Implementation, and Mainte-
nance Study Guide (70-294)

=  MCSA/MCSE: Windows 2000 Professional Study Guide, Second Edition (70-210)
= MCSA/MCSE: Windows XP Professional Study Guide, Second Edition (70-270)
=  MCSA/MCSE: Windows Server 2003 Upgrade Study Guide (70-292 and 70-296)

Types of Exam Questions on the MCDST Exams

Microsoft has introduced some new exam elements on many of their certification exams. You
will not know in advance which type of format you will see on your exam. These innovations
make the exams more challenging, and they make it much more difficult for someone to pass
an exam after simply “cramming” for it.

) Microsoft will be accomplishing its goal of protecting the exams by regularly
TE adding and removing exam questions, limiting the number of questions that
any individual sees in a beta exam, and adding new exam elements.

Exam questions come in many forms in the new MCDST exams, so let’s examine these
forms now.

Active Screen

The active screen question, seen in Figure 1, tests your working knowledge of the product by pre-
senting you with a dialog box and requiring you to configure or change one or more options in
order to successfully answer the question. You may need to select or deselect options, use drop-
down menus, or drag text elements into text areas within the dialog box to meet the requirements
of the question. Note that not every element you see in the dialog box will be active for you to
interact with—use this to your advantage in weeding out actions that you do not need to perform.

Build List and Reorder

The build list and reorder question type, seen in Figure 2, has been used in MCP exams for quite
some time but has been refined a bit for the new exams. When presented with a build list and
reorder type of question, you will be required to create a list, in the correct order, that represents
the steps required to complete the stated problem.
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FIGURE 1 The active screen question format

You want to add page numbers to a Microsoft Word document, You want the page numbers to appear at the top
of the page and be centered, You want the page numbering to begin on page 2.

You open the Page Mumbers dialog box. What should you do?

To answer, use the dizlog box controls to configure the options correctly.

Page Mumbers

Entian:

|Botiom of page iFaater) B
Abanment:

IH.igm vi

W Shaw number on first page

Format...

Resat | jons | Calculator

FIGURE 2 The build list and reorder question format

You are a user in the human resources department. You need to set up a rule in Microsoft Outlock to move e-mail
messages that you raceive regarding job openings into a specific folder.

“You need to idenbify the achions that vou should perform to achieve this goal. Move the appropnate zchons from
the Possible Actions pane to the Necessary Actions pane, and arrange them in the appropnate order. {Use only
actions that apply.)

.
IOpen the Rules Wizard. I =

| Open the Options dizlog box. |

| Create a new folder within your Inbox.

Create a rule based on the Move new
messages from someone template.

N 2
e 1>

based on content template,

Specify that the message contain specific
words in the subject.

Create a rule based on the Move messages ‘

| Specify that the message is from specific | -

Resal | i Calcul
| | |

Create a Tree

When presented with a create a tree question, as seen in Figure 3, you are being asked to drag
source nodes into the answer tree area in their correct location in order to successfully answer
the question.
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Drag and Drop

One of the new question types, the drag and drop question, seen in Figure 4, requires you to
drag source objects into the correct target area in order to successfully answer the question.

FIGURE 3 The create atree question format

You are 3 user in the finance department. You are creating documents that will be usad in the company's annual
report, and you naad to datermine the best program to use to create the documents, You nead to identify the
program in which you should perform each task. Move the appropriate tasks to the corresponding program. {Use
only tasks that apply, Use tasks only onca.)

O Create a letter to sharaholders. ® Accaess

O Create a mission and vision statemant. ® Excel

O Create an organization chart. ® Dutlook

© Create the financial statements. ® PowerPoint
® Visio
® Word

Resat i Caleul
| | |

FIGURE 4 The drag and drop question format

Your desk contains four items. You must identify these items by name.
What are the names of the itams on your desk?

To answer, drag the namss to the corect itams. %

Hard Disk Drive T——

Laptop

a | >
Reset i Caleul
| | | 1
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Hot Area

The hot area question type, seen in Figure 5, asks you to select one or more areas of a graphic
to correctly answer the question. You will be able to easily see where selectable options exist
within the graphic.

FIGURE 5 The hotarea question format

You need to delete all files within the Demo folder that exceed 100 KB in size. You open the Demo folder and view
the details of the files.

Which file or files should you delete? (Choose all that apply.}

To answer, select the file or files that you should delets in the Dema window.

Ele Edt Wew Favores Ioos  Help
Qoo = () [T DOseacnr [ Favers &) |
Adbess | B0 C-\Damuments snd Settings|Deskton|Demo v B e
MName - S Tvpe Date ModFfied
Bl hils g K IPEE Image £/27/2001 5:00 A1
& music.ass 1K8  vndows Mada Audia/vidao shortout  §[25/2001 5:00 AM
|54 music bmp 19K Btmap Image ) £127]2001 5200 AM
Elmusicwma  3511KE Vindows Media Audia file Bj23/2001 5-00 A
£lzurset.ipg TOKE  IFEE Imaoe £/27]2001 5:00 A
& Tawnmid ZKE  MIDLS3equance £[27[2001 5:00 A1
Hwaterliies.jpg  B2KE JFEG Tmape BJ23j2001 5:00 A
F|Water llfes oy B2KE JPEG Image £/27/2001 5-00 A
ke, lpg 104KE  JPEE Imaoe £/27/2001 5:00 A
Resal I Instructions I Calculator

Multiple Choice

The multiple-choice question is the old standby when it comes to certification exams. Not much
has changed when it comes to this question type. You can expect questions that require one cor-
rect answer or multiple correct answers. In some instances you will be told specifically how
many choices to make; in others you will not. Microsoft has made this question more difficult,
however, by increasing the amount of information that you must sift through in order to suc-
cessfully answer the question correctly.

- The questions throughout this study guide and on the accompanying CD are
TE presented in the same multiple-choice format that you will see on the exam.

Exam Question Development

Microsoft follows an exam-development process consisting of eight mandatory phases. The
process takes an average of seven months and involves more than 150 specific steps. The MCP
exam development consists of the following phases:

Phase 1: Job Analysis Phase 1 is an analysis of all of the tasks that make up a specific job func-
tion, based on tasks performed by people who are currently performing that job function. This
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phase also identifies the knowledge, skills, and abilities that relate specifically to the perfor-
mance area to be certified.

Phase 2: Objective Domain Definition The results of the job analysis provide the framework
used to develop objectives. The development of objectives involves translating the job-function
tasks into a comprehensive set of more specific and measurable knowledge, skills, and abilities.
The resulting list of objectives—the objective domain—is the basis for the development of both
the certification exams and the training materials.

Phase 3: Blueprint Survey The final objective domain is transformed into a blueprint survey in
which contributors are asked to rate each objective. These contributors may be past MCP can-
didates, appropriately skilled exam development volunteers, or Microsoft employees. Based on
the contributors’ input, the objectives are prioritized and weighted. The actual exam items are
written according to the prioritized objectives. Contributors are queried about how they spend
their time on the job. If a contributor doesn’t spend an adequate amount of time actually per-
forming the specified job function, his data is eliminated from the analysis. The blueprint survey
phase helps determine which objectives to measure, as well as the appropriate number and types
of items to include on the exam.

Phase 4: Item Development A pool of items is developed to measure the blueprinted objective
domain. The number and types of items to be written are based on the results of the blueprint survey.

Phase 5: Alpha Review and Item Revision During this phase, a panel of technical and job-
function experts reviews each item for technical accuracy and then answers each item, reaching
a consensus on all technical issues. Once the items have been verified as technically accurate,
they are edited to ensure that they are expressed in the clearest language possible.

Phase 6: Beta Exam The reviewed and edited items are collected into beta exams. Based

on the responses of all beta participants, Microsoft performs a statistical analysis to verify the
validity of the exam items and to determine which items will be used in the certification exam.
Once the analysis has been completed, the items are distributed into multiple parallel forms, or
versions, of the final certification exam.

Phase 7: Item Selection and Cut-Score Setting The results of the beta exams are analyzed

to determine which items should be included in the certification exam based on many factors,
including item difficulty and relevance. During this phase, a panel of job-function experts deter-
mines the cut score (minimum passing score) for the exams. The cut score differs from exam to
exam because it is based on an item-by-item determination of the percentage of candidates who
answered the item correctly and who would be expected to answer the item correctly.

Phase 8: Live Exam As the final phase, the exams are given to candidates. MCP exams are
administered by Sylvan Prometric and Virtual University Enterprises (VUE).

)’ Microsoft will regularly add and remove questions from the exams. This is
A&TE called item seeding. It is part of the effort to make it more difficult for individ-
uals to merely memorize exam questions passed along by previous test-takers.
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Tips for Taking the MCDST Exams

Here are some general tips for taking the exam successfully:

= Arrive early at the exam center so you can relax and review your study materials. During
your final review, you can look over tables and lists of exam-related information.

*  Read the questions carefully. Don’t be tempted to jump to an early conclusion. Make sure
you know exactly what the question is asking.

= Answer all questions.

= Use a process of elimination to get rid of the obviously incorrect answers first on questions
that you’re not sure about. This method will improve your odds of selecting the correct
answer if you need to make an educated guess.

Exam Registration

You may take the exams at any of more than 1,000 Authorized Prometric Testing Centers
(APTCs) and VUE Testing Centers around the world. For the location of a testing center near you,
call Sylvan Prometric at 800-755-EXAM (755-3926), or call VUE at 888-837-8616. Outside the
United States and Canada, contact your local Sylvan Prometric or VUE registration center.

You should determine the number of the exam you want to take and then register with the
Sylvan Prometric or VUE registration center nearest to you. At this point, you will be asked for
advance payment for the exam. The exams are $125 each. Exams must be taken within one year
of payment. You can schedule exams up to six weeks in advance or as late as one working day
prior to the date of the exam. You can cancel or reschedule your exam if you contact the center
at least two working days prior to the exam. Same-day registration is available in some loca-
tions, subject to space availability. Where same-day registration is available, you must register
a minimum of two hours before test time.

% You may also register for your exams online at www.2test.com or www.vue.com.
P

When you schedule the exam, you will be provided with instructions regarding appointment
and cancellation procedures, ID requirements, and information about the testing center loca-
tion. In addition, you will receive a registration and payment confirmation letter from Sylvan
Prometric or VUE.

Microsoft requires certification candidates to accept the terms of a Non-Disclosure Agree-
ment before taking certification exams.

What’s on the CD?

With this new book in our best-selling MCDST, MCSA, and MCSE Study Guide series, we are
including quite an array of training resources. On the CD are numerous simulations, practice
exams, and flashcards to help you study for the exam. Also included are the entire contents of
the book. These resources are described in the following sections.
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The Sybex E-book for MCDST Exams

Many people like the convenience of being able to carry their whole study guide on a CD. They
also like being able to search the text to find specific information quickly and easily. For these
reasons, we have included the entire contents of this study guide on a CD, in PDF format. We’ve
also included Adobe Acrobat Reader, which provides the interface for the contents, as well as
the search capabilities.

The Sybex MCDST Test Engine

This is a collection of multiple-choice questions that will help you prepare for your exam. There
are three sets of questions:

*  Two bonus exams designed to simulate the actual live exam.

= All the questions from the Study Guide, presented in a test engine for your review. You can
review questions by objective or take a random test.

= The assessment test.

Here is a sample screen from the Sybex MCDST Test Engine:

=7 SybexTestEngine
File Assessmerk Test Chapter Tests Bonus Exams Help

Assessment Test
l [ mark Time Left: 1 hr 19 min(s) Question: 1 of 20
You are the desktop support technician for your organization. A user has an issue with e-mail spam. She is

receiving multiple messages from entities that she does not know and has never contacted. How should you
assist the user in fltering these messages?

O A, Use the Junk E-mail options to delete the senders from the Safe Senders list.
(O B. Usc E-mail rules to send all unrecognized messages to the Recycle Bin.
(® C. Usc the Junk E-mail options to add the senders to the Blocked Senders list.

(O D.  Enable the user's Internet Connection Firewall (ICF) and block all unwanted messages.

Answer: C

You should use the Junk E-mall options to add the senders to the Blocked Senders list. Since she does not know the
senders and has never contacted them, they would not be on the Safe Senders list. E-mail rules and the ICF do not
apply in this case. See Chapter & for more information.

Your Answer: C
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Sybex MICDST Flashcards for PCs and Palm Devices

The “flashcard” style of question offers an effective way to quickly and efficiently test your under-
standing of the fundamental concepts covered in the MCDST exams. The Sybex MCDST Flashcards
set consists of approximately 200 questions presented in a special engine developed specifically for
this Study Guide series. Here’s what the Sybex MCDST Flashcards interface looks like:

¥ Macromedia Flash Player 6
File Wiew Contral Help

MAIN MENU OPTIONS

M C DS T Microsoft Certified Desktop
Support Technician Study Guide
Flashcards
Vi N
e You should use a Macro Security setting only if another
© | thurd-party software is protecting the application and the docurments from
% | unsafe macros,
g
o
D 4
' Y
Low
g
W
c
<
b J/
C<<) C< 1 Aswer 1> ) =) D
SYBEX

Copyright © 2004

How Do You Use This Book?

This book can provide a solid foundation for the serious effort of preparing for the MCDST
exams. To best benefit from this book, you may wish to use the following study method:

1.
2.

Study each chapter carefully. Do your best to fully understand the information.

Complete all hands-on exercises in the chapter, referring back to the text as necessary so
that you understand each step you take.

Answer the review questions at the end of each chapter. If you would prefer to answer the
questions in a timed and graded format, install the Sybex Test Engine from the CD that
accompanies this book and answer the chapter questions there instead of in the book.

Note the questions you did not understand, and study the corresponding sections of the
book again.

Make sure you complete the entire book.

Before taking the exam, go through the training resources included on the CD that accom-
panies this book. Try the adaptive version that is included with the Sybex Test Engine.
Review and sharpen your knowledge with the MCDST Flashcards.
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) In order to complete the exercises in this book, you’ll need to have access to at
TE least one machine running Windows XP and preferably two such machines
networked together. You will also need access to Microsoft Office, of which you
can order a trial version through Microsoft. Some exercises may require you to
have administrative access or to be part of an Active Directory domain.

TE and with discipline. Try to set aside the same time every day to study, and
select a comfortable and quiet place in which to do it. If you work hard, you will
be surprised at how quickly you learn this material. Good luck!

% To learn all of the material covered in this book, you will need to study regularly

Contacts and Resources

To find out more about Microsoft Education and Certification materials and programs, to register
with Sylvan Prometric or VUE, or to get other useful information, check the following resources.

Microsoft Learning Home Page www.microsoft.com/learning

This website provides information about the MCDST program and exams. You can also get
information on related Microsoft products.

Prometric www.2test.com
(800) 755-EXAM

Contact Sylvan Prometric to register to take an MCDST exam at any of more than 800 Pro-
metric Testing Centers around the world.

Virtual University Enterprises (VUE) www.vue.com
(888) 837-8616

Contact the VUE registration center to register to take an MCDST exam at one of the VUE
Testing Centers.



XXX

Assessment Test

Assessment Test

You are the desktop support technician for your organization. A user has an issue with e-mail
spam. She is receiving multiple messages from entities that she does not know and has never con-
tacted. How should you assist the user in filtering these messages?

A. Use the Junk E-mail options to delete the senders from the Safe Senders list.

B. Use E-mail rules to send all unrecognized messages to the Recycle Bin.

C. Use the Junk E-mail options to add the senders to the Blocked Senders list.

D. Enable the user’s Internet Connection Firewall (ICF) and block all unwanted messages.
You are the desktop support technician for your organization. A group of Japanese users needs
to have the latest Windows XP operating system software with Japanese language in the menus

and Help menus. Your organization currently has only the English version of Windows XP.
Which of the following are valid options to assist the Japanese users? (Choose two.)

A. Install the Japanese language in the Regional and Language Options tools of the
Windows XP English version.

B. Purchase and install the MUI version of the Windows XP software; select the
Japanese language.
C. Purchase and install the Japanese version of the Windows XP software.

D. Add the Japanese fonts to the menus and Help menus of the English version of
Windows XP.

You are the desktop support technician for your organization. The user requests your assistance
in configuring the AutoComplete feature in his Internet Explorer application. Which tab in
Internet Options contains these settings?

A. General
B. Security
C. Privacy
D. Content

You are the desktop support technician for your organization. You are assisting in troubleshoot-
ing name resolution problems on a client computer. The application that the user is utilizing
requires hostname resolution. Which of the following services or files are directly related to host-
name resolution?

A. WINS

B. DNS

C. Lmbhosts file
D. Hosts file
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You are the desktop support technician for your organization. An Outlook Express user has
received an e-mail that has unique stationery. She asks you how she can save the stationery so she
can use it on future e-mail. To which menu of Outlook Express settings should you direct her?

A. Message

B. File

C. View

D. Tools

You are the desktop support technician for your organization. A user has some older computers

on which he wants to install Windows XP operating system software. Which of the following
would cause a Windows XP installation to fail?

A. Pentium III 350 MHz processor

B. 32 MB RAM

C. 16X CD-ROM drive

D. VGA resolution

You are the desktop support technician for your company. The user is having problems with
Microsoft Word 2003. You want to ensure that the user’s computer contains the latest security

updates for this application. Which of the following are valid methods to start the process of
obtaining these updates?

A. Choose Help and then choose Check For Updates.

B. Use the browser to connect to the Windows Update website.

C. Use the browser to connect to the Office Update website.

D. Choose File and then choose Check For Updates.

You are the desktop support technician for your organization. The user is experiencing general
connectivity issues on a client computer. You want to determine the IP address of the computer

as well as the IP addresses of all of the name resolution servers configured for the computer.
Which of the following should you type on a command prompt?

A. ipconfig

B. nbtstat -n

C. arp -a

D. ipconfig /all

You are the desktop support technician for your organization. You’re setting up NTFS permis-
sions on a local computer. You want a user to be able to read files in a folder and create new files

within the folder but not be able to delete the folder. Which NTES folder permissions should you
assign to the user?

A. Write, Read and Execute, List Folder Contents
B. Modify, Read and Execute, List Folder Contents
C. Read and Execute, List Folder Contents

D. Read and Execute, Modify
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10.

1.

12.

13.

You are the desktop support technician for your company. A user is experiencing problems with
an application that utilizes DirectX. You want to troubleshoot the problem and determine
whether DirectX is functioning properly on the computer. Which of the following is a valid
method of beginning to access the DirectX Diagnostic tool?

A. Type msinfo32 on the command prompt.

B. Choose System Information in the Control Panel.

C. Type msinfo32 on the Run line.

D. Choose System Information from System Tools in Accessories.

You are the desktop support technician for your organization. A user has been working on an
Excel spreadsheet on Excel 2003 for many hours. She saved the spreadsheet earlier in the day,
but she has not performed any subsequent save operations. Your organization experiences a

power failure and her computer suddenly loses all power. Which feature in Office 2003 might
assist her in preserving most, if not all, of her spreadsheet changes?

A. AutoComplete

B. Microsoft Application Recovery Tool

C. AutoCorrect

D. AutoRecover

You are the desktop support technician for your company. A user is experiencing a general con-
nectivity issue. She can connect to resources within her own subnet, but she cannot connect to

any resources outside her subnet. Which of the following elements of her IP configuration should
you examine first?

A. Default gateway

B. IP address of her computer

C. Subnet mask

D. IP address of the DNS server

You are the desktop support technician for your organization. One of your users makes many
presentations during the day using her laptop. She asks you if there is a way to store the presen-

tation already loaded on the laptop when she carries the laptop inside its carrying case between
locations. Which power option of Windows XP should the user utilize?

A. Standby
B. Power schemes
C. UPS
D

. Hibernation
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15.

16.

17.

Assessment Test xXxxiii

You are the desktop support technician for your organization. In an effort to tighten secu-
rity, management has decided to disallow password caching in Internet Explorer 6.0 on all
of the computers in your department. Your supervisor has asked you to check each of the
client computers and make sure that password caching is not allowed. Which tab in Internet
Options contains the correct settings?

A. General
B. Security
C. Content
D. Advanced

You are the desktop support technician for your company. A user is having general connectivity
problems with a client computer. You ask the user to type ipconfig on a command line and
then read the resulting IP address. The IP address that the user reads is 169.254.1.4. Which of
the following network services is most likely associated with this problem?

A. WINS

B. DNS
C. RAS
D. DHCP

You are the desktop support technician for your organization. A user is having problems with
his Windows XP software. You want to make sure that the user has the latest security updates.
You click on the Automatic Updates tab within System Properties, but you find that it is preset
and that the settings are grayed out so that you can’t change them. Which of the following
should you suspect first?

A. A virus

B. A macro

C. A corrupted file

D. A Group Policy

You are the desktop support technician for your company. A user asks you for assistance in set-

ting up print options within Internet Explorer. In particular, he wants to find the Page Setup
option. To which Internet Explorer menu should you direct him?

A. File
B. Edit
C. View
D. Tools
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18.

19.

20.

You are the desktop support technician for your organization. A user is experiencing security
issues with a computer that is a member of a domain. You want to determine which Group Pol-
icies are affecting the computer and the user. Which command-line tool should you use?

A. ipconfig

B. ipconfig /all

C. nbtstat -n

D. gpresult

You are the desktop support technician for your company. You control a hierarchy of files and
folders on a user’s computer. You have decided to move and copy some of these files and folders,
all of which have NTFS permissions applied to them. You are moving and copying them into

folders that are located on a different NTFS volume. Which of the following statements are true?
(Choose two.)

A. Allfiles that are copied will inherit the permissions of the folder into which they are copied.
B. All files that are moved will retain the permissions from which they were moved.

C. Allfiles that are moved will inherit the permissions of the folder to which they are moved.
D. All files that are copied will retain the permissions of the folder from which they

were copied.

You are the desktop support technician for your organization. You want to capture the config-
uration settings of a computer that is a member of a domain so that you can load the settings
onto other computers that are also members of a domain. Which tool will allow you to perform
this task?

A. Loadstate

B. File and Settings Transfer Wizard
C. Scanstate

D. Upgrade Advisor
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Answers to Assessment Test

1.

10.

C. You should use the Junk E-mail options to add the senders to the Blocked Senders list. Since
she does not know the senders and has never contacted them, they would not be on the Safe Send-
ers list. E-mail rules and the ICF do not apply in this case. See Chapter 8 for more information.

B, C. You should purchase and install either the Japanese version or the Multilanguage User
Interface (MUI) version of the Windows XP software. The Regional and Language options will
not change the menus and Help menus of the operating system software. You cannot just install
a new font in the English version of Windows XP. See Chapter 4 for more information.

D. The Content tab within Internet Options in the Tools menu contains the settings for Auto-
Complete. The other options are valid tabs, but they do not contain the settings required. See
Chapter 6 for more information.

B, D. The elements that might affect hostname resolution are Domain Name System (DNS) ser-
vices and the Hosts file. Windows Internet Name Services (WINS) and the Lmhosts file are not
directly related to hostname resolution; instead, they are related to NetBIOS name resolution.

See Chapter 9 for more information.

B. Youshould direct her to the File menu and then to Save As Stationery. The other options are
valid tabs in Outlook Express but they do not contain the required setting. See Chapter 7 for
more information.

B, D. Windows XP requires at least 64 MB of RAM and a Super VGA resolution video adapter.
It also requires only a Pentium 233 MHz processor and any CD-ROM; therefore, a Pentium 1T
350 MHz processor and a 16X CD-ROM drive would not cause the installation to fail. See
Chapter 1 for more information.

A, C. Either you should choose Help from the Word 2003 application and then choose Check
For Updates, or you should use the browser to connect to the Microsoft Office Update website.
The Windows Update website does not contain the latest security updates for Word 2003. The
File menu does not contain the Check For Updates option. See Chapter 10 for more information.

D. You should type ipconfig /all to obtain the IP address of the computer as well as the IP
addresses of all of the name resolution servers configured for the computer. The ipconfig com-
mand will display only the IP address of the computer. The arp -a command will display the
Address Resolution Protocol (ARP) cache. The nbtstat -n command will display the list of
NetBIOS names used by the computer. See Chapter 5 for more information.

A. Youshould assign Write, Read and Execute, and List Folder Contents to the folder. Assign-
ing Modify permissions would allow the user to delete the folder. Assigning only Read and Exe-
cute and List Folder Contents would not allow the user to add files and folders to the folder. See
Chapter 2 for more information.

C,D. Youshould either type msinfo32 on the Run line or choose System Information from the
System Tools menu in the Accessories menu. Typing msinfo32 on a command prompt is not a
valid option. System Information is not contained in the Control Panel by default. See Chapter 3
for more information.



xxxvi  Answers to Assessment Test

1.

12.

13.

14.

15.

16.

17.

18.

19.

20.

D. The AutoRecover feature of Office 2003 automatically saves a user’s document at regular
intervals. The user can select the recovered document in the case of a power failure. Auto-
Complete is a feature included with IE 6.0, not Office 2003. The Microsoft Application Recov-
ery Tool can be used to close hung applications without losing data. The AutoCorrect feature
is used to correct common spelling errors or substitute typed words with other words or phrases.
See Chapter 6 for more information about AutoRecover.

A. You should first examine the default gateway configured for her computer. An incorrectly
configured default gateway will cause this problem. Since she can connect to resources within
her own subnet, her IP address and subnet mask must be correct. Since she cannot connect to any
resources outside her own subnet, the problem is more than just an incorrectly configured

IP address for her DNS server. See Chapter 9 for more information.

D. The user should utilize hibernation, provided that she has enough hard drive space available on
her laptop to hold the amount of RAM installed in the laptop. Hibernation will ensure that the lap-
top is completely shut down when she places it into its carrying case. She can then resume her pre-
sentation at the next location. The other power options do not address the problem of completely
shutting down the laptop while holding the presentation. See Chapter 3 for more information.

C. Youshould use the Content tab in Internet Options to access AutoComplete within the Per-
sonal Information section. You can configure password caching, and even clear previous pass-
words, using the AutoComplete tool. The other options are all valid tabs in Internet Options,
but they do not contain the correct setting. See Chapter 8 for more information.

D. The Dynamic Host Configuration Protocol (DHCP) service is most likely associated with
this problem. The client is very likely configured to obtain an IP address automatically, and it
could not find a DHCP server when it was last started. The other options are valid network ser-
vices, but they are not likely associated with this problem. See Chapter 5 for more information.

D. You should first suspect that an administrator is controlling automatic updates using Group
Policy. The other options are also possible, but they are much less likely. See Chapter 10 for
more information.

A. Youshould direct him to the File menu to find Page Setup. The other options are all valid menus
in Internet Explorer, but they do not contain Page Setup. See Chapter 7 for more information.

D. You should use the gpresult tool to determine which Group Policies are affecting the com-
puter and the user. Ipconfig and ipconfig /all can be used to troubleshoot problems with
connectivity. Nbtstat -n displays a list of NetBIOS names for the computer. See Chapter 4 for
more information.

A, C. The key to this scenario is the fact that all of the files are being moved or copied to a dif-
ferent NTFS volume. For this reason, whether they are moved or copied, they will inherit the
permissions of their new folder. See Chapter 2 for more information.

C. You should use the Scanstate tool in the User State Migration Tool to capture the settings
on a computer that is part of a domain. You can then use the Loadstate tool to configure other
computers with those settings. You cannot use the File and Settings Transfer Wizard on com-
puters that are members of a domain. The Upgrade Advisor is not the appropriate tool for this
action. See Chapter 1 for more information.
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v" Perform and troubleshoot an attended installation of a
Windows XP operating system.

Answer end-user questions related to performing an
attended installation of a Windows XP operating system.

Troubleshoot and complete installations in which an
installation does not start. Tasks include configuring the
device boot order and ascertaining probable cause of
the failure to start.

Troubleshoot and complete installations in which an
installation fails to complete. Tasks include reviewing
setup log files and providing needed files.

Perform postinstallation configuration. Tasks include
customizing installations for individual users and
applying service packs.

v" Perform and troubleshoot an unattended installation of a
Windows desktop operating system.

Answer end-user questions related to performing an
unattended installation of a Windows XP operating
system. Tasks include starting an installation, answering
questions asked by an end user during an installation,
and performing postinstallation tasks.

Configure a PC to boot to a network device and start
installation of a Windows XP operating system. Tasks
include configuring PXE-compliant network cards.

Perform an installation by using unattended
installation files.




v" Upgrade from a previous version of Windows.

Answer end-user questions related to upgrading from
a previous version of Windows. Considerations include
available upgrade paths and methods for transferring
user state data.

Verify hardware compatibility for upgrade. Considerations
include minimum hardware and system resource
requirements.

Verify application compatibility for upgrade. Tasks
include ascertaining which applications can and cannot
run, and using the application compatibility tools.
Migrate user state data from an existing PC to a new PC.
Install a second instance of an operating system on a
computer.




A desktop support technician must have expert knowledge of
the hardware and software components involved in installing an
operating system and of how they work together at each stage of
the installation process. This is because understanding how an operating system is installed
is the first step toward understanding how to troubleshoot a failed installation. Your ability
to quickly troubleshoot and repair a failed installation will be a key to keeping your customer
(the end user) productive and happy.

In this chapter, we will discuss the major types of operating system installations, the com-
ponents involved in each of them, and how to quickly troubleshoot and repair a failed instal-
lation. There are four main types of operating system installations:

Attended An attended installation consists of a user or an administrator acquiring the oper-
ating system software from a CD/DVD or a shared network source and beginning the installa-
tion. In this case, the user or administrator monitors the entire installation, answering questions
and filling in information where appropriate. This is sometimes referred to as “baby-sitting” the
installation. This method takes a tremendous amount of time and may not be the best alterna-
tive when many installations must be performed.

Unattended One type of unattended installation makes use of special files called answer files
and uniqueness database files to automate the installation of the operating system. Although it
takes time and effort to create these files, it’s well worth it in the long run if you are installing
an operating system on many computers. This method not only saves time but can also increase
the consistency of the options and settings that are applied to the computers, since the answer
file provides the answers to each of the computers. The relationship of the answer files to the
uniqueness database files is a key element in this type of installation.

Another type of unattended installation uses a Remote Installation Services (RIS) server that is
installed and configured by the network administrator. With a properly configured RIS server,
you can install new client operating systems through the network with the push of a button.

Upgrade An upgrade installation is performed on a computer that currently has a Windows
operating system installed and functional. The purpose of the upgrade is generally to take
advantage of new features and functionality that the newer operating system offers by replacing
the older operating system with the newer one. A chief concern in an upgrade installation is the
compatibility of the current hardware and application software with the proposed new operat-
ing system. Users are also primarily concerned that their settings and documents will be left
intact. One disadvantage of an upgrade versus a new installation is that an upgrade might inad-
vertently bring in software bugs that would have been fixed completely with a new installation.
You should consider this issue when you are deciding whether to upgrade or perform a com-
plete new installation.
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Multiboot Like an upgrade, a multiboot installation is also performed on a computer that
currently has a Windows operating system installed and functional. The difference between a
multiboot and an upgrade is that the purpose of multiboot installation is to create other func-
tional Windows operating systems on the same computer. Once a multiboot installation is suc-
cessfully performed, a user will be able to choose which operating system to boot to at startup.
The keys to creating a successful multiboot installation are the order in which the operating sys-
tems are installed and the capability to install the second operating system without disturbing
the first operating system.

The rest of this chapter discusses the procedures and components involved with each major
type of installation and their relation to troubleshooting a failed installation.

Performing and Troubleshooting an
Attended Installation of Windows XP

A successful installation of Windows XP requires some upfront planning and preparation.
When you are responsible for troubleshooting a failed installation, it is essential that you know
what should have been done to prepare for the installation. By knowing what should have been
done, you can ask the right questions to determine the problem. You can then isolate what needs
to be done to provide a solution. The steps involved in a successful installation of Windows XP
are discussed in the following sections.

Verifying that Hardware Meets the
Minimum Requirements

Before you begin an installation of Windows XP, you should ensure that the computer on which
you are installing the operating system meets at least the minimum requirements for the instal-
lation. You should also be aware that the minimum requirements will ensure only that the oper-
ating system will function, not that it will function with acceptable speed. In addition, you
should realize that the minimum hard drive requirements are only for the operating system to
run efficiently and do not include the space to contain applications. The following list represents
the minimum hardware specifications from Microsoft’s website:

= 233-MHz processor from the Pentium/Celeron family or the AMD Ké6/Athlon/Duron family
= 64 MB of RAM

= 1.5 GB of available hard disk space

= Super VGA (800 x 600) resolution

= CD-ROM or DVD drive

= Keyboard and Microsoft mouse or compatible pointing device
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Checking Hardware and Software Compatibility

Just because a computer meets the minimum hardware requirements does not mean that all of the
hardware and software on the computer is compatible with the Windows XP operating system.
You should ensure that all of hardware is compatible prior to installing the operating system. You
can ensure that the hardware is compatible using the following methods.

Use the Windows XP CD to Check System Compatibility

You can verify a computer’s compatibility with Windows XP just prior to installing the oper-
ating system using the Windows XP operating system installation CD. It is not necessary to have
any operating system installed on the computer to check the system compatibility. You should
have a hard drive installed and formatted with at least one partition. Exercise 1.1 outlines the
steps that you can use to check a computer’s compatibility with the Windows XP operating sys-
tem before continuing to install the operating system. Later in this chapter, we will discuss the
preparation steps that you might take prior to installing the operating system and what you
might do with a failed installation. For this exercise, we are just letting the operating system
examine the computer prior to installing the software normally. You can use a Windows XP
Home Edition or Windows XP Professional CD for this exercise. If you encounter any errors
during the installation, then read further into this chapter to get clues about troubleshooting
your own system.

Using the Windows XP CD to Check System Compatibility

1. Setthe boot order in the computer’s BIOS settings to recognize the CD-ROM drive before
the hard drives.

Insert the Windows XP CD into the CD-ROM drive.
Restart the computer.

When the screen says “Press any key to boot to the CD,” press a key.

g &~ W N

The computer will then copy files from the CD-ROM to the hard drive and examine the con-
figuration of the computer. At this point, you will be informed if any hardware fails the
compatibility test.

6. Ifall of your hardware is compatible, then you can then proceed with the installation of the
operating system.

Check the Windows Catalog on the Web

You can use the Windows Catalog located on the Web atwww.microsoft.com/windows/catalog
to find hardware and software that is designed to work with the Windows XP operating system. The
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Windows Catalog is shown in Figures 1.1 and 1.2. It contains hardware and software in two main
categories as follows:

= Designed for Windows XP
= Compatible with Windows XP

FIGURE 1.1 The Windows Catalog Home Page
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Hardware and software that carries the Designed for Windows XP logo is specifically
designed for use with Windows XP. The use of this hardware and software will reduce the num-
ber of problems and frustrations associated with using the Windows XP product. If your hard-
ware or software is listed as Compatible with Windows XP, then it has not met all of the
requirements of the Windows Logo Program but it has been deemed compatible by Microsoft
and/or the manufacturer of the software.

) If your hardware or software is not listed, this does not always mean that it will
TE not work with Windows XP. In this case, you should check with the manufac-
turer of the hardware or software to determine compatibility.

Preparing the BIOS

The basic input/output system (BIOS) of a computer is the most basic intelligence of a com-
puter. The BIOS is a set of software that tests hardware at startup, starts the operating system,
and supports the transfer of data among hardware devices, including date and time. If a BIOS
is out of date for the software and hardware installed on the computer, it can cause problems
with power management, peripheral configuration, disk partitioning, and other crucial func-
tions. You should check with the computer or motherboard manufacturer to determine whether
a BIOS update is available. You can often download a BIOS update and perform an electronic
flash to update the BIOS of a computer. You should carefully follow the instructions provided
by the manufacturer when updating a computer’s BIOS.

Obtaining Driver Updates

Drivers are software the allow hardware to communicate with the operating system. Because of
this, drivers are usually very specific to an operating system. You should therefore make sure
that you have obtained the necessary drivers for the hardware that is installed on your computer
prior to installing the operating system. If your computer is equipped with Plug and Play (which
most new computers are), then it will ask for the drivers at the end portion of the setup. The

Windows XP CD contains a cache of drivers that includes many of the most common drivers
for network interface cards, video cards, sound cards, and other computer hardware. You can
also obtain drivers from the website of the manufacturer of the hardware.

Preparing the Hard Disk for Installation

Since the operating system will be installed on a hard disk, its important to understand the orga-
nization of a hard disk in a computer and the file systems from which you can choose. You
should also be familiar with the tools that you can use to prepare the hard disk for installation
and begin to install the system. In this section, we will discuss the key terms relating to hard
disks, the tools used to prepare the installation, and the order of their use.
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Partitions

When you purchase a new hard disk or buy a computer without an operating system installed,
the only formatting on the hard disk is a low-level format from the factory. This low-level for-
mat is the basis on which you can begin to build a working hard disk and install an operating
system. The first step that you should take to begin to prepare a hard disk is to partition the hard
disk. Partitioning the disk is logically setting aside a portion of the disk. A partition is sometimes
referred to as a volume, but a partition is one area limited to one physical hard disk, whereas
a volume can contain multiple partitions on the same disk or even on multiple disks.

There are three critical partition types of which you should be aware as a desktop support
technician.

Active Partition

The active partition on a disk is the partition from which an x86-based computer boots. It is the par-
tition that contains the files required to boot the operating system that is designated as the default

operating system in the computer. The active partition must always be on the first hard disk attached
to the computer. This disk is referred to as Disk 0.

System Partition

The system partition is the partition that contains the bootstrap files that are required to display
the boot menu and start the operating system. On most client computers this is the first primary
partition on Disk 0. The bootstrap files that must be on the system partition on a computer run-
ning the Windows XP operating system include the following:

= Ntldr: This is a hidden file.

= Ntdetect.com: This is hidden file.

= Boot.ini: This is a hidden file.

= Bootsect.dos: This file is for dual configurations only.

= Ntbootdd.sys: This file is for system partitions located on Small Computer System Inter-
face (SCSI) drives only.

Boot Partition

The boot partition is the partition that contains the Windows system files. The folder in which
the files are located is referred to as the systemroot folder. The files are by default located in
a folder within the systemroot folder named the systemroot/system32 folder. On most client
computers this partition is the same as the system partition. Typically this is the C: drive. On
client computers with multiboot configuration the boot partition may be assigned a different
drive letter.

sl Logically speaking, the names of the system and boot partitions seem back-

ING wards based on what they contain and what they do. This naming was estab-
lished long ago with the first PCs. The best way to remember this is that they
are backwards!
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Formatting and File Systems

1

After you have created a partition on a disk, you must format the partition to prepare it to hold
data or, as in this case, an operating system. Formatting the partition places a file system on
which files can be stored and managed. File systems have evolved over time, and some file sys-
tems offer significant advantages over others. Table 1.1 illustrates the features of file systems
and the Microsoft clients that can use each type of file system.

TABLE 1.1 File System Features

Feature FAT

FAT32

NTFS

Windows 95 OSR1,
Windows 95 OSR2,
Windows 98, Windows
Me, Windows NT
Workstation, Windows

Microsoft clients
that support

Windows 98, Windows
Me, Windows 2000 Pro-
fessional, Windows XP
Home Edition, Win-
dows XP Professional

Windows NT Worksta-
tion, Windows 2000
Professional, Windows
XP Home Edition, Win-
dows XP Professional

2000 Professional,
Windows XP Home
Edition, Windows XP
Professional

Maximum partition 4 GB 32GB 2 terabytes
size
Sector size 16 KB to 64 KB As low as 4 KB As low as 4 KB
File attributes File attributes File, folder, and encryp-
Security tion attributes

None None Files

Compression

You should use the NTFS file system for all partitions on a computer with the
Windows XP operating system installed. This takes advantage of the additional
security and stability of the file system. The only exception is when you are
multibooting the computer with an operating system that does not support
NTFS, such as Windows 95, Windows 98, or Windows Me.

oPe

TE

Tools for Hard Disk Preparation

There are many tools that you can use to prepare a hard disk. In this section, we will focus on
the tools that are inherent to Microsoft clients. These tools can be used to partition the disk and
then format the partitions with the various file systems. They have evolved over time and have
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become easier to use with the latest operating systems, such as Windows XP. The tools that you
can use create partitions and format them include the following:

Fdisk

The fdisk tool is an MS-DOS-based tool that you can use to partition a hard disk. You can use
the fdisk tool to create, change, delete, or display the current partitions on a hard disk. You can
create primary partitions and extended partitions. You can then create logical drives on the
extended partitions.

Format

After you create partitions with the fdisk tool, you can then format those partitions with the
format tool. As mentioned before, the format tool places a file system on the disk on which
data can be stored and managed. You can use the format tool to apply FAT, FAT32, and
NTES file systems.

The Windows XP CD

Another method of creating partitions is to use the Windows XP CD itself. You can create
and format partitions just prior to installing Windows XP using only the Windows XP CD.
Exercise 1.2 outlines the steps involved in this process.

Creating and Formatting Partitions with the Windows XP CD

1. Setthe boot order in the computer’s BIOS settings to recognize the CD-ROM drive before
the hard drives.

2. Insert the Windows XP CD into the CD-ROM drive.

3. Restart the computer.

4. When the screen says “Press any key to boot to the CD,” press a key.

5. The computer will then copy files from the CD-ROM to the hard drive and examine the con-
figuration of the computer.

6. Atthe Welcome to Setup page, press the Enter key to continue.

7. Press F8to accept the Windows XP Licensing Agreement.

8. If another Windows XP installation is detected, you will be prompted to repair it. Press Esc.
Do not repair.

9. All existing partitions and unallocated space on the hard disk will now be listed. Use the
arrow keys to select a partition or unallocated space where you want to create a partition.

10. Press D to delete an existing partition or C to create a new partition using unallocated
space. If you press D, then you must press L to confirm that you want to delete a partition.
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EXERCISE 1.2 (continued)

1.

12.
13.
14.

After pressing C to create a new partition, type the size in megabytes that you want to use
for the partition and press Enter, or just press Enter to create the partition using the max-
imum available size.

Repeat Steps 10 and 11 to create additional partitions.
Select the format option that you want to use for the partition, and press Enter.

After the setup program formats the partition, you can follow the instructions to continue
installing the operating system.

Installing the Windows XP Operating System

Once all of the preparation is done, you are ready to install the operating system. Installing the
operating system includes running the setup program, configuring the options for networking,
choosing a Windows Update option, and activating the software. We will now discuss each of
these steps in greater detail, examining potential problem areas and the methods that you can

use to troubleshoot the problems.

Running the Setup Program

The setup program installs the operating system in four basic steps as outlined below:

1.

File Copy: Windows Setup files are copied to a temporary folder on the partition where
they can be run when you restart the system.

Text Mode: In this step you select the partition to use to install the operating system. You
should press F6 at this step to load any custom drivers. If you have custom hardware for
which Windows does not have drivers and you do not press F6 at this step, then you may
experience a stop error. If this happens, restart and press F6 when prompted.

GUI Mode: This is the graphical portion of Windows Setup, which is also known as the
Setup Wizard. In this step, you can select regional settings, such as language and time zone,
and enter details, such as the product key, computer name, and administrator password.

Windows Welcome: This is the final portion of Setup, when you have the option to create
user accounts and activate Windows. Sometimes manufacturers use this step to customize
the installation, adding their own logos, custom registration screens, and other features.

ING and the operating system will basically install itself. However, if Setup detects

ﬁl‘ In a successful installation, Setup will progress through each of these steps,

any hardware for which it does not have appropriate drivers, it may ask you for
some help. If you have a custom piece of hardware in your system, you should
look for a prompt during the Text Mode portion of Setup and press F6 when
prompted. You can then install the custom drivers. If you do not press F6, the
installation may terminate with a stop error.
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Installing Network Components

If the Windows XP operating system that you have just installed detects the presence of network
hardware on your system, the Installing Network Components window will appear automati-

cally. You should select either Typical Settings or Custom Settings. Your choice is determined by
how you are planning to use the computer. We will now discuss the guidelines for each setting.

Typical Settings

When Typical Settings is selected, the system will configure the computer to obtain its Internet
Protocol (IP) address and its Domain Name System (DNS) server address from the Dynamic Host
Configuration Protocol (DHCP) server. This setting should be used only if you know that that a
DHCP server is available in your organization or through your Internet Service Provider (ISP).

Custom Settings

When Custom Settings is selected, Setup displays screens to allow the user to enter the IP address
and DNS server address manually. If you choose this setting, then you should obtain a proper
IP address from your network administrator. If the IP address is not properly configured, the

computer will not be able to communicate on the network and could potentially affect the com-
munication of other computers on the network.

Setting Windows Update

Once you have your operating system installed and a network connection established, the next
step is to protect the operating system from unwanted intrusion. Periodically, Microsoft dis-
covers a security threat to the operating system and publishes a patch on its website, making it
available for download. The best way to keep up with all of the available patches is with the help
of the Windows Update feature of Windows XP. Exercise 1.3 illustrates the steps to set the
Windows Update feature.

load, and install other Windows Updates and newly released drivers, you should

- Windows Automatic Update retrieves only the critical updates. To view, down-
JTE
visit the Windows Update site at http://windowsupdate.microsoft.com.

Activating Windows XP

A new feature has been added to Windows XP to combat software piracy and casual copying.
In addition to entering the 25-character product key during the setup process (as with previous
versions of Windows), you must also activate the software within 30 days of installation. This
new feature is referred to as Windows Product Activation (WPA).

In most cases, activation of the software is automatic. After the installation has completed
successfully and you have established a network connection, Windows XP will ask you if you
would like to activate the software. The system will use your Internet connection to connect to
Microsoft to activate the software. The whole process takes only a few seconds to complete.
You can also activate the software by calling Microsoft, giving the automated system the prod-
uct key that came with the software, and following the instructions that you are given.
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Setting Windows Update

1. Open the System applet in Control Panel.

2. Click the Automatic Updates tab.

System Properties ? M
Genaral I Caomputer Name Hardware Aduanceu
System Restore Automalic Updates Remote

% Windaows can find the updates you need and deliver them direelly to
Your computer.

E' Keep my computer up to date. With this sefting enabled, Windows
Update sofiware may be automatically updated prior to applying any
other updates.

Learn mare about 2ul

Seltings

O Motify me before downloading any updates and notfy me again before
' installing them on my computer

O Download the updales aulomatically and nobify me when they are ready
to be installed

=y Automatically download the updates. and install them on the schedule
= that | specify
Every day [#] 2t [z00am v

Leam more about scheduled installing

f Declined Updates

| ok | [ _cancet |

3. Select the Keep My Computer Up To Date check box.
4. Choose from the following options:

a. Notify Me Before Downloading Any Updates And Notify Me Again Before Installing
Them On My Computer

You should choose this option if you are using a dial-up connection and you do not
want to tie up the connection with the downloads.

b. Download The Updates Automatically And Notify Me When They Are Ready To
Be Installed

You should choose this option if you are using a high-speed, always-on connection
such as a cable modem or digital subscriber line (DSL) connection. An alert bubble will
pop up from the system tray area to let you know when the download has arrived. You
can accept or reject any download.

c. Automatically Download The Updates, And Install Them On The Schedule That | Specify

You should choose this option when you want to specify the time that Windows Update
runs. The default time is 3:00 A.M. every day. Windows Update will download and
install each critical update that is available when it runs.
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) Activation and registration are very different. Activation does not require you
TE to divulge your name or any personal information. Your choice to register the
software is completely separate from your choice to activate it. Registration
does ask for some personal information.

As part of the activation process, Microsoft examines and registers key hardware compo-
nents in your computer system. Because of this, if you decide to reinstall the operating system
on the same computer, you can reinstall it without activating it again. However, if you
upgrade your hardware or replace your computer completely and then reinstall the operating
system, you might have to reactivate the Windows XP operating system as well. In this case,
the activation will not be automatic, and you will need to call your Microsoft customer rep-
resentative at the telephone number listed on the software in the activation wizard. You will
need to explain the situation to the Microsoft customer representative and then follow the
directions given by the representative.

There are some cases where you may not need to activate the Windows XP operating system
software. These are as follows:

*  The manufacturer of the computer has activated the software: In this case, the software is
likely to be associated only with the computer BIOS. You can therefore reinstall the oper-
ating system and upgrade the hardware as many times as you want as long as you don’t
change the BIOS of the computer.

= Volume License Agreements: Businesses that purchase multiple copies of operating system
software might receive software and a product key from Microsoft that allows them to
install the software without requiring activation.

Using Log Files to Troubleshoot Installations

Windows XP automatically generates log files that can help you determine the cause of a
failed installation. These files are automatically created in the folder that you designated as
the systemroot, usually the Windows folder. Depending on how far the installation pro-
gressed, you can view these files on the computer on which you are installing the operating
system or copy them to another computer and view them there. You should open the files with
Notepad and examine them for clues as to what may have gone wrong in the installation pro-
cess. The following are log files created by the installation and a brief description of the clues
that they may contain:

= Setuplog.txt: Describes the tasks performed during setup.

=  Setupapi.Tlog: Lists hardware and driver detection and installation issues.
= Setuperr.log: Created if errors occur during setup.

= Setupapt.log: Records actions that are taken during setup.

= PNPlog.txt: Lists Plug and Play hardware and driver detection issues.
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Performing and Troubleshooting an
Unattended Installation of Windows XP

If you install client operating systems infrequently, then you might be completely satisfied with
the attended installation method. On the other hand, if you are responsible for installing many
client operating systems, then you might like to know of ways to further automate that process
and answer the questions that the system asks on every installation.

Administrators who are responsible for many installations of operating systems might use
the Setup Manager Wizard or text editor to create special files called answer files and unique-
ness database files (UDFs). As a desktop support technician, you should be aware of how these
files are used in the installation of the operating system.

Another tool that administrators might use to install many client operating systems is Remote
Installation Services (RIS). In this case, the administrator might create and test a client computer
and then image that client computer into a server so that it can be installed on future client com-
puters. This method requires specific hardware and configuration to function properly.

We will now discuss each of these methods of unattended installation in greater detail.

Answer Files

An answer file is a text file that provides configuration settings that would otherwise be entered
by the administrator during setup. The answer file provides answers that are common to all of
the computers that are to be installed using it. Each entry in the answer file is divided into two
parts, the section title and the settings. Figure 1.3 shows an answer file that was created using
the Setup Manager Wizard. We will now discuss each of these parts in this file.

Section Title

A section title indicates the category of the settings that follow it. Section titles in an answer file
might include Userdata, Identification, Networking, etc. The more complex the file, the more
section titles will be included in it. Each section title can contain many settings.

Settings

Within each section title, the configuration settings are created using keys and values. These
take the form of Key=Value, where the key represents the parameter and the value represents
the actual configuration setting for the computer. For example, Computer Name=Sybex1 is a
setting. As mentioned before, each section title can have many settings.

Uniqueness Database Files

Whenever more than one computer name is entered into answer file created by the Setup Man-
ager Wizard, a uniqueness database file (UDF) named unattend.udb is automatically created.
The UDF provides computer settings that are unique to each computer. It is created with syntax
that is very similar to that used for an answer file.
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FIGURE 1.3 Example of unattend.txt file
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[Data] E

AutoPartition=1
MsDosInitiated="0"
UnattendedInstall="Yes"

[Unattended] |
UnattendMode=FullUnattended =|
OemSkipEula=Yes
OemPreinstall=No
TargetPath=\WINDOWS

[GuiUnattended]
AdminD: q—n
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EncryptedAdminPassword=NO
OEMSkipRegional=1
TimeZone=20
OemSkipWelcome=1

[UserData]
ProductID=FP638-3163D-T717F-RFWGC-BWT3Y
FullName="Bill Ferguson"

OrgName="Sybex"
ComputerName=*

A UDF is divided into two sections. The first section, named UniquelDs, provides the com-
puter names and the sections of data to be replaced or merged with the answer file for each indi-
vidual computer. Figure 1.4 is an example of the first section of a UDF.

The second section contains the actual values that Setup will use for these sections. Figure 1.5
shows the settings in the second section of a UDF. Initially, the UDF contains only the computer
names to be used, but it can be modified to contain other settings that can be individually con-
figured during setup.

In most cases the values in the UDF will be used instead of the values in the answer file for
the same computer. The only time that a value will be used from the answer file is when there
is no corresponding value in the UDF. In some cases, if there is a key specified but no value spec-
ified in a UDF, then no value will be automatically set and the user will be prompted to input
the information. If the UDF has an entire section that the answer file does not have, then Setup
will use the section and its keys and values. Table 1.2 illustrates the priority that Setup gives
answer files and UDFs.

FIGURE 1.4 Example of the first section of an unattend.udb file

" unattend.udb - Ng@
File Edit Format View Help

;SetupMgrTag ~
[Uniquelds] =l
Sybex1=UserData
Sybex2=UserData
Sybex3=UserData
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FIGURE 1.5 Example of the second section of an unattend.udb file
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[Sybex1:UserData]
ComputerName=Sybex1

[Sybex2:UserData]
ComputerName=Sybex2

[Sybex3:UserData]
ComputerName=Sybex3

TABLE 1.2 Priority and Use of Answer Files and UDFs

Answer File UDF Result

Key and value specified Key not specified Value in answer file used
Key not specified Key and value specified Value in UDF used

Key and value specified Key and value specified Value in UDF used

Key not specified Key specified without value No value set; user may be

prompted for input

Section and/or key not specified Key and value specified Section and/or key created
and used by Setup

Remote Installation Services

Remote Installation Services (RIS) allows network administrators who are in charge of many
computer installations to more easily deploy those installations through the network. The only
clients that can use RIS are Windows 2000 Professional and Windows XP Professional. As a
desktop support technician, you are responsible for understanding only the client portion of the
RIS setup. Since RIS requires significant setup on the server and the network as well, many
issues related to RIS will be escalated to the network administrator.

In order for computers to use RIS, they must have at least one of the following three
components:

= A Net PC-compliant motherboard: A RIS-compliant network interface card built into the
motherboard of the computer.

= A preboot execution environment (PXE)-enabled network interface card installed in the
computer.
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= A network interface card that is compliant with the software but not PXE-compliant and
the special RIS boot disk created by the network administrator. The RIS boot disk must be
in the floppy drive of the client computer on which the software will be installed.

Once the computer has met one of these conditions and the network administrator has pre-
pared the image and made the connections to the computer, the client software can be installed
through the network as follows:

1. The user or administrator restarts the computer and presses F12 to perform a network boot.

2. The computer broadcasts on the network for the presence of a Dynamic Host Configura-
tion Protocol (DHCP) server.

The DHCP server responds with the address of the RIS server.

The computer connects to the RIS server, and the user or administrator is presented a selec-
tion of operating systems from which to install. These can be in a user-friendly format, such
as “Windows XP for 3rd Floor Accounting.”

5. The user or administrator selects the appropriate image, and the installation proceeds

automatically.
) Since RIS requires that the DHCP server, DNS, Active Directory, and all physical
TE connections be correct, many issues related to its installation will be escalated

to the network administrator. As an MCDST, you should be familiar with what
is required for the system to operate properly, so you know when to escalate
the issue.

Performing and Troubleshooting an
Upgrade Installation of Windows XP

If a user currently has a working installation of Windows but wishes to upgrade the client soft-
ware to Windows XP, she can begin the upgrade by simply placing the Windows XP CD into
the CD-ROM drive and closing it. The computer will likely detect the Windows XP CD and
offer to run the upgrade. As a desktop support technician, you should be aware that what
seemed to start out very simply can get much more complicated very quickly. Whether the com-
puter can be successfully upgraded to Windows XP will depend upon the hardware installed in
the computer. How well the upgrade will work will further be determined by the drivers and
other software that are to be upgraded. All client computers with Windows 95 or later operat-
ing systems can be upgraded to Windows XP.

If a user is upgrading both her computer and her operating system (changing computers),
then the task is further complicated because she may want to make sure that she retains her set-
tings and configurations from the current operating system. These can be very important to
some users.
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You can use the Upgrade Advisor to run a test and create a report that you can examine for
any inconsistencies with the Windows XP operating system. In this way, you can ensure that the
upgrade installation will go smoothly, without any surprises. In addition, if the user is changing
computers, you can use the User State Migration Tool and/or Files and Settings Transfer (FAST)
Wizard to transfer configuration settings and files from the current computer to the new one.
We will discuss these tools and their use in greater detail in this section.

Using the Upgrade Advisor

The Upgrade Advisor is software built into the Windows XP operating system disk and/or avail-
able from Microsoft’s website at http://www.microsoft.com/windowsxp/pro/howtobuy/
upgrading/advisor.asp. The software checks a computer for compatibility and automatically
creates a report listing problems that you might encounter during the upgrade process. The report
might even direct you to install a service pack or patch before continuing the installation. When
upgrading from Windows 98 or Millennium Edition, the system may even suggest that you unin-
stall some programs before continuing an installation and then reinstall them after the installation
is complete. Exercise 1.4 outlines the steps for using the Upgrade Advisor. This exercise can be
performed on a computer running Windows 95, Windows 98, Windows Millennium Edition,
Windows 2000 Professional, Windows XP Home Edition, or even Windows XP Professional.

Using the Upgrade Advisor for Windows XP
1. Insert the Windows XP CD into the CD-ROM drive and close it.

2. The system will recognize the CD, and you will see a screen that says “Welcome to
Microsoft Windows XP.” If you do not see this screen, then browse the disk and click on
the setup.exe file to access the Welcome screen.

3. Click on Check System Compatibility.
4. Click on Check My System Automatically.

5. The system will run an abbreviated version of Setup and produce a report that lists prob-
lems that you might encounter regarding hardware and software. The report might con-
tain instructions to download upgrade packs or temporarily uninstall some software. You
should follow the instructions in the report.

Using the User State Migration Tool

A user state refers to the configuration settings applied to a user’s computer. These could

include settings such as background, screen saver, font, resolution, etc. In a large organization,
administrators might want to standardize and record these settings so that they can be repro-
duced on computers throughout the organization. Administrators use the User State Migration
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Tool (USMT) built into Windows XP to record and distribute a user state to multiple comput-
ers. The USMT is located on the Windows XP CD in the VALUEADD\MSFT\USMT folder. You can
also copy the entire USMT folder to your computer to use the tools it contains.

The USMT consists of two main commands, each with multiple switches. We will discuss the
two main commands in the User State Migration Tool in this section.

Scanstate

Scanstate is used to create an “electronic recording” of the settings in a computer. You can use
scanstate to record the settings on all Microsoft clients later than Windows 95. Using the switches
provided by the USMT, you can further configure scanstate to record registry settings or give more
or less output. To see the syntax and switches for scanstate, you can type scanstate /? on the
command prompt in the folder that contains the USMT files.

Loadstate

Loadstate is used to configure a computer or computers with the settings that were recorded with
scanstate. You can use loadstate with all clients later than Windows 95. Using the switches pro-
vided by the USMT, you can configure loadstate to migrate registry settings, log errors, and load
only specified files. To see the syntax and switches for loadstate, you can type loadstate /? on
the command prompt in the folder that contains the USMT files.

4 Remember that Scanstate gathers the information from the source computer
ITE and Loadstate configures the information to the destination computer.

Using the Files and Settings Transfer Wizard

The Files and Settings Transfer (FAST) Wizard can be used only on computers that are not a
member of a domain. On stand-alone computers or computers that are part of a workgroup, the
FAST Wizard can be used to make it easier to copy files and settings from an old computer to
anewer one. To locate the FAST Wizard, you should choose Accessories from the All Programs
menu and then choose System Tools.

The FAST Wizard refers to the two computers involved in the transfer as the Old computer
and the New computer. On the Old computer, the wizard walks the user through the process
that allows him to choose whether to transfer files, settings, or both. The user can even create
a custom list of files that he wants transferred from the Old computer to the New computer.
The files and settings are then stored on a shared drive or removable media or are sent to the
computer through a direct transfer. Figure 1.6 shows the options available in the FAST Wiz-
ard. The computer that will receive the files must be configured with the FAST Wizard as the
New computer. Similar configuration settings are required for the Old computer. The user
chooses where the files and information will be read from and how the computer will be con-
figured. He can configure to read the shared drive, use removable media, or use direct transfer
to receive the data.
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FIGURE 1.6 Transfer method selection dialog box in FAST Wizard

Files and Settings Transfer Wizard

Select a transfer method.

@_l Direct cable (a cable that connects your computers' serial ports)

() Floppy drive or other removable media
Make sure both computers have the same type of drive.

8

C] Other (for example, 2 removable drive or network drive)
You can save files and settings to any disk drive or folder on your computer.

MNext > | [ Cancel
4 The FAST Wizard transfers only data files to the new computers. You still have
ITE to install the applications that run the data files.
4 You should be familiar with the basic workings of the Files and Settings Trans-
ITE fer Wizard. You should also know that you are unlikely to have to troubleshoot

this tool in a corporate environment because it cannot be used on computers
that are members of a domain.

Performing and Troubleshooting a
Multiboot Installation of Windows XP

If the computer that you are using already has a Windows 32-bit (Windows 95 or later) oper-
ating system and you have at least two partitions defined, then you can install a clean copy of
Windows XP without disturbing your current installation or any of the applications that it uses.
If you do this properly, then the system will automatically change the boot.ini file, and you
will be prompted to choose the operating system that you wish to boot to at each new startup.
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You can use this multiboot installation method to run multiple and different Windows operat-
ing systems on the same computer. You can also use this method to install multiple instances of
Windows XP on the same computer. In this way, you could use one instance for experimenta-
tion and troubleshooting and another for your main operating system.

@ Real World Scenario
Creating Your Own Test Environment

One thing that has been invaluable to me is the hands-on experience that I've received through
network administration, consulting, and setting up classrooms. Even if you don’t get the
chance to work with a large number of computer installations, you can still benefit greatly from
the experience of setting up a multiboot computer test environment. If you have an old desktop
that is at least a PIl 233 with 64 MB of RAM, it will do just fine. If you have an old laptop, that
might be even better.

Start out by obtaining as many types of operating system software as you can find. You can
often get free evaluation software by attending a Microsoft class or by browsing the Microsoft
website at www.microsoft.com/technet/downloads. Get a trial copy of some client and server
operating systems.

After you have the software in hand, completely format and repartition the computer that will
be your test computer. Of course, you should make sure that you have a backup of anything

that was on the computer that you might need later. Create partitions that are about 4 GB in

size, and create as many as you can on your disk.

Next, begin installing the operating systems that you have obtained in order of their hierarchy
from lowest to highest. As you install each system, you will test yourself on display drivers, net-
work card drivers, USB drivers, and perhaps printer drivers. See if you can make everything
functional on one operating system before moving on to the next one. See how many operat-
ing systems you can get working on one computer!

You will learn a tremendous amount from setting up a computer in this fashion. In addition,
you will then have a tool that you can use to test drivers and applications. Finally, you can also
load your certification study material on the computer and study for the test in the operating
system that you are learning. If you don’t know the answer to a question, you can often just
Alt+Tab out of the study material and find the answer within the operating system software. If
you find the answers that way, you are much more likely to retain the information for the test
and for real life.

P can also use virtual operating system software such as VMWare or Microsoft's

é/ To run multiple virtual operating systems within one operating system, you
Virtual PC.
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If you are troubleshooting a multiboot installation that was attempted by a user, then you
should be aware of the following:

= The operating systems should be installed in hierarchical order with the lowest first. For
example, if a user wants to multiboot Windows 98 and Windows XP Professional, then he
should install Windows 98 first.

= Each operating system must be installed on its own partition. Microsoft recommends that
you install each operating system on a primary partition.

= Theactive partition will contain the boot . ini file and must be formatted with a file system that
is common to both operating systems. For example, if you are dual-booting Windows 98 and
Windows XP Professional, then the active partition must be formatted with FAT or FAT32.

=  The boot.1ini file will bring up the operating system selection screen when the computer
is booted. You can choose the operating system to boot to or let a 30-second timer run
down and accept the default.

=  You can change the operating system selection and timeout value in the Startup and Recov-
ery Settings within the Advanced tab of System properties.

Summary

It’s important that you understand how operating systems should be installed so that you can
troubleshoot failed installations. There are four main types of operating system installation:

= Attended

= Unattended
= Upgrade

= Multiboot

An attended installation is the most time-consuming to perform because the user or admin-
istrator has to “baby-sit” the installation and respond to all of the prompts and questions. The
main concerns with an attended installation are the preparation before the installation. Com-
patibility issues with hardware and software can cause an installation to fail. You can reduce
failures and troubleshoot failed installations using the Windows Catalog and the hardware
manufacturer’s websites to obtain the latest information regarding compatibility.

An unattended installation uses either an answer file or Remote Installation Services. In the
case of an answer file, you should know how to examine the file for obvious errors and then
escalate the problem to the network administrator who created it. In regard to Remote Instal-
lation Services, you should be familiar with the client portion of the remote installation. The cli-
ent requires connectivity to the network and some type of network boot provided by a Net PC-
or a PXE-compliant card. You can also use a Windows XP—compliant card and a RIS boot disk
on the client.

An upgrade installation is an attempt to gain greater benefits from the new operating system
features without losing anything else. The main concern regarding an upgrade installation is the
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compatibility of the currently working hardware and software with the new operating system.
Users will also be concerned about losing data and/or functionality as a result of the upgrade.
A multiboot installation means adding another operating system to a computer that is
already functioning with one or more. The trick is to keep both of the operating systems func-
tional. You should install operating systems in hierarchical order with the lowest first. The sys-
tem will automatically change the boot.in1 file to accommodate the new operating systems.
You can use these new systems for fault tolerance and for testing and experimental purposes.

Exam Essentials

Know the minimum requirements to install Windows XP. Although you will probably never
install Windows XP on a computer that meets only the minimum requirements, it is still impor-
tant to know these specifications for the test. You may need to define which components will
need to be upgraded to install the operating system.

Understand the differences between file systems. You should understand the advantages and
disadvantages of the main file systems that Microsoft clients use. You should also know which
clients can use which file systems. Multiboot scenarios might require this knowledge.

Understand how answer files and UDFs operate. You don’t need to be an expert on the syn-
tax in answer files, but you do need to know what happens if a setting in a UDF conflicts with
a setting in an answer file. You should also know what will happen if there is a section in a UDF
that does not exist in an answer file for the same computer.

Know how to use the Upgrade Advisor. You should know how to use the Upgrade Advisor
by inserting the Windows XP CD and selecting the options to check compatibility. You should
also know the location of the file on the Windows CD and on the Internet.

Know what is required to create a successful multiboot. You should know the basics of what
is required to create a successful multiboot, for example, the order of installation of multiple
operating systems and your options for file systems on the system partition. You should be
familiar with the fact that the boot.ini file will be changed automatically by the operating sys-
tem when you create a multiboot installation.
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Review Questions

1. You are the desktop support technician for a large company. Management is considering
upgrading some older Windows 98 clients to Windows XP Professional. The client computers
have PII 233-MHz processors with 16 MB of RAM. They all have at least 2 GB of free disk
space. In addition, they have 8X CD-ROM drives and SVGA display adapters. Which compo-
nent(s) will require upgrading before installation can begin? (Choose all that apply.)

A. Processor
B. RAM
C. CD-ROM
D. Free disk space

2. You are the desktop support technician for your organization. One of the users who is
attempting to install Windows XP is encountering stop errors. You suspect that some of the
hardware in the computer is not compatible with Windows XP. You obtain a list of the hard-

ware installed in the computer. Which of the following resources should you use to determine
the compatibility of the hardware? (Choose two.)

A. The Windows Update website
B. Windows Catalog
C. The website of the manufacturer of the hardware
D. Microsoft TechNet
3. You are the desktop support technician for a large company. You are called in to assist on a
failed Windows XP installation. You want to make sure that the correct bootstrap files are on

the system partition. Which of the following files must be on the system partition in order for
Windows XP to load and start? (Choose three.)

A. autoexec.bat
ntldr
boot.ini

ntoskrnl.exe

moow

config.sys

4. You are the desktop support technician for your company. You want to multiboot a computer
with Windows 98 and Windows XP Professional. Which of the following file systems could you
use for the system partition of the computer? (Choose all that apply.)

A. FAT
B. NTFS
C. FAT32
D

. None of the above
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You are the desktop support technician for your company. You have installed a new (out of the
box) hard drive on a computer and you want to begin setting it up to store data. Which of the fol-
lowing should be your first step?

A. Format the hard drive to create the partitions.

B. Ensure that the boot order in your setup reads the hard disk first.

C. Use fdisk to create the partitions on the drive.

D. Delete the low-level format installed at the factory.

You are the desktop support technician for your company. You are troubleshooting a failed
unattended installation. Upon examination of the answer file and UDF used for the installation,

you discover that there is a section in the UDF that is not mentioned at all in the answer file.
Which of the following should occur during installation?

A. The section and its keys will be created and used by Setup.

B. The installation should fail because the answer file is incomplete.

C. Setup should prompt the user for a response.

D. The section and its keys should be ignored by Setup.

You are the desktop support technician of a large company. You want to create a standard for
settings such as background, screen saver, and font size. You have configured the computer set-
tings on your test computer connected to your domain. You would like to save the settings to a

file and load them to other computers on your domain. Which tool should you use to capture
and save the configuration settings?

A. Toadstate.exe

B. Files and Settings Transfer (FAST) Wizard

C. fdisk.exe

D. scanstate.exe

You are the desktop support technician for your company. You are troubleshooting a failed RIS
installation. You suspect that the computer was unable to obtain an IP address. You wish to

escalate the problem to the network administrator. Which type of server should have assigned
the computer an IP address during the installation?

A. Domain controller
B. DHCP server

C. DNS server
D

. RIS server
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You are the desktop support technician for a large company. You are troubleshooting a failed
installation using the log files created by the installation. Which file describes all of the tasks per-
formed during startup, whether they succeeded or not?

A.
B.
C.
D.

setupTlog.txt
PNPTog. txt
setuperr.log

setupapi.log

You are the desktop support technician for your company. Security is always a key concern in
your organization. You are creating a multiboot installation with Windows 2000 Professional
and Windows XP Professional on the same computer. Which of the following file systems should
you use for the system partition?

A

FAT

B. NTES
C.
D

. All file systems are equal in this case.

FAT32
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Answers to Review Questions

1.

B. The minimum RAM requirement for installing Windows XP is 64 MB. The installation will
fail if the client computer does not have at least the minimum requirement. The processor should
probably be upgraded as well, but it barely meets the minimum requirement. The 8X CD-ROM
(or any CD-ROM) meets the requirement. The minimum requirement for free disk space is
1.5 GB, so the client computers exceed the minimum requirement.

B, C. The Windows Catalog contains a list of hardware that is designed for and/or compat-
ible with Windows XP. You should check the catalog first. If you do not find the hardware
listed in the Windows Catalog, then you can also check the website of the manufacturer of
the hardware. The Windows Update and TechNet websites do not contain information
about hardware compatibility.

B, C, D. The system partition contains the files that are required to boot the Windows XP operating
system. The files that must be in the system partition in order for Windows XP to load and start are
ntldr, boot.ini, and ntoskrn1.exe. The autoexec.bat and config.sys files are configuration
files for Windows 9x operating systems, not for Windows XP.

A, C. You must format the system partition with a file system that is common to both operating
systems. Windows 98 cannot use the NTFS file system, but Windows XP can use all three of the
file systems; therefore, you should format the system partition with FAT or FAT32.

C. If you have a new hard drive from the factory, then the only formatting on it is low-level for-
matting. Your first step should be to use the fdisk tool or the Windows XP CD to create parti-
tions. Formatting does not create partitions; you can format a partition only after you have
created it. You should not delete the low-level format installed at the factory.

A. When a section and/or key is mentioned in the UDF but not in the answer file for the same

computer, the section and/or key will be created and used by Setup. If this does not happen, then
you should escalate the issue to the network administrator or the creator of the files. The instal-
lation should not fail because of this occurrence. Setup will not prompt the user for a response.

The section and/or key should not be ignored by Setup.

D. You should use the scanstate tool from a command prompt to capture configuration settings
of a computer that is a member of a domain. You should use Toadstate.exe to distribute the
settings to the other computers in the domain. You can use the Files and Settings Transfer
(FAST) Wizard only for stand-alone computers or for computers that are part of a workgroup.
Fdisk.exe is not the correct tool to use to collect computer settings.

B. In order for a Remote Installation Services (RIS) installation to succeed, the computer must
obtain an address from the Dynamic Host Configuration Protocol (DHCP) server. Domain con-
trollers, DNS servers, and RIS servers are all involved in the process of a RIS installation, but
they do not assign IP addresses to the client.

A. The setuplog. txt file records all of the events in a startup. You can examine it to see what
occurred just prior to the failure of the installation. The PNPTog. txt file and setupapi.Tog file
record the detection of devices and drivers. The setuperr.log file is created only when errors occur
and records only the errors.
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10. B. Since security is always a key concern in your organization, you should use the file system that
is the most secure and is common to both of the operating systems that you are installing. In this
case, since both Windows 2000 Professional and Windows XP Professional can use NTFS and
since NTFS has much greater security, you should use NTFS. All file systems are not equal; FAT
and FAT32 do not offer the security features that NTFS offers.
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The main reason that we create a network is to share resources. The
resources that we can share on a network include hardware, such as
computers, printers, and fax machines, and software, such as files,

folders, and applications. Sharing resources means that more than one person can receive the benefit

from that resource, often simultaneously. Resource sharing provides many benefits to the organiza-
tion as well. For example, the ability to share a color printer with many users in an organization
means that each user does not need to have their own color printer, thus saving a tremendous
amount of money. In addition, the ability to share files, folders, and applications aids in the collab-
orative effort of teams within your organization.

The challenge to you as a desktop support technician is to understand how resource sharing
operates within a network and how the various forms of permissions that can be assigned to
resources will affect the end user. In this chapter we will focus on managing and troubleshooting
access to files, folders, and printers. We will focus on the four main types of resource access,
which include the following:

Files and folders A user stores important data on the computer in the form of files and folders.
Some folders may contain many important and/or confidential files. When a user logs on to his
Windows XP computer, the access token generated by the operating system gives the user access
to all of the files and folders to which he has NTFES permissions. It’s important to understand
how this access is granted and what can affect a user’s access to a file or folder.

Shared folders While file and folder permissions in NTFES control the local access to a resource,
share permissions control the access to shared folders on a network. When a resource is shared,
users can gain access to the resource through the network from other computers on the network.
It’s important to understand how shared permissions operate and how they combine with file and
folder permissions.

Printers Print permissions are specific to software on the network called printers. Printers are used
to control the hardware that actually makes the hard copy, which is called a print device. Users
should be able to use the printers that they need in a transparent fashion. They should also be pre-
vented from using printers that are set aside for special users or groups. You should understand how
print permissions operate and what can affect a user’s ability to print to a specific print device.

Offline files and folders Many users now work at home or on “the road” while traveling on
business. When they are in the office, they connect their laptop computer to the network to syn-
chronize files and folders with those of the network server so they can work on the files while
they are away from the office. When they return to the office, they will synchronize any changes
that they have made while they were not connected. You should be aware of the additional chal-
lenges of managing and troubleshooting these offline files and folders.

The rest of this chapter discusses the management and troubleshooting of these four types of
resource access.
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Files and Folders

The primary benefit of the NTFS file system is its ability to control access to specific files and
folders. This is accomplished by assigning NTES permissions for the file or folder. NTFS per-
missions are a characteristic that can be assigned to any file or folder and that controls who may
access that resource and what tasks they can perform after accessing it. NTFS permissions pro-
vide security for files and folders whether they are accessed by local logon or connected to
through a network share.

NTFS permissions can be assigned to a user directly or inherited based on a security group
of which they are a member. Microsoft recommends assigning permissions to security groups
and then placing the user account in the appropriate security group to give the permissions.
NTFS permissions are divided into two main categories: file permissions and folder permissions.
As a desktop support technician, you must understand how these permissions are assigned and
how they affect the end user.

You can access and control the NTFS permissions for any file or folder on a partition for-
matted with NTFS by right-clicking the file or folder in Windows Explorer or My Computer
and clicking the Security tab. We will discuss the two main categories of NTFS permissions, ver-
ifying permission settings, and some special permission considerations in the following sections.

NTFS File Permissions

NTES file permissions can be assigned to each file within a folder and are specific to that file.
Different files within the same folder can have different NTFS permissions assigned to them. In
this way, you can control a user’s access to resources in a very granular fashion. This can also
create a troubleshooting problem for a user who does not understand how these permissions
operate. Table 2.1 shows the available standard NTEFS file permissions.

TABLE 2.1 Standard NTFS File Permissions

NTFS File Permission Enables User To:

Read View the file, open the file, right-click the file, and choose Properties
to view its attributes and ownership.

Read and Execute Perform all tasks described above plus double-click the file to open
the application that can be used to view it.

Write Perform all tasks described above plus change the file.
Modify Perform all tasks described above plus delete the file.
Full Control Perform all tasks described above plus take ownership and thereby

give other users permission for the file.
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NTFS Folder Permissions

NTEFS folder permissions can be assigned to each folder in a folder hierarchy and are specific
to that folder. In addition, folders within other folders can be assigned different NTFS permis-
sions. This allows you to create, for example, a hierarchy of folders that are accessible at the
root (top) by administrators or managers but within the hierarchy by only a specific user for
each folder. This type of granular control can also lead to confusion for a user who is unaware
of how it operates. You should make sure that users have transparent access to the folders that
they need to use and that they cannot even view those that they do not need to use. Table 2.2
shows the available standard NTFS folder permissions.

TABLE 2.2 NTFS Folder Permissions

NTFS Folder Permission Enables User To:

List Folder Contents View the folder, click the folder, and view the files and
folders within the folder.

Read Perform all tasks described above plus right-click the folder
and view its permissions, attributes, and ownership.

Read and Execute Perform all tasks described above plus double-click the
folders within the folder to view their contents (traverse
the folders).

Write Perform all tasks described above plus create new files and

folders within the folder and change the folder’s attributes.

Modify Perform all tasks described above plus delete the folder.

Full Control Perform all tasks described above plus take ownership of
the folder and thereby give other users permissions for the
folder.

Verifying NTFS File and Folder Permissions

If a user cannot view a file or folder or cannot perform the actions that he needs to perform, then
verifying his NTFS permission settings should be your first step to troubleshooting the problem.
If he can at least view the file or folder, then you might be able to help him verify his own per-
missions. If he cannot even view the resource, then you or someone with the appropriate level
of permissions will have to get involved.

Verifying NTFS permissions can be accomplished by looking at the properties of the file.
Exercise 2.1 walks you through the steps to verify permissions for a user.
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Verifying NTFS Permissions

1.
2.
3.

8.

Click Start, and then choose My Computer.

Folder 4 Properties

Generzl | Shanng  Securty | Customize |

Locate the file or folder that you want to verify, in this case Folder A.

Right-click the file or folder, choose Properties, and then click the Security tab.

Group of eser names.

£} Eill Ferguzon (XP1\Bill Farguson)
€T CREATOR OWNER

€HSYSTEM

€5 Users KP1\Users)

Permisaions for Administratars Allow

Full Contral

Modify

Read & Execute
List Folder Contents
Read

Write

For special permissions or for advanced setings, Advanced
click Advancad

(mins=i==

-

oK Cancel

Select Users or Groups

Select this object typa:
Users, Groups, or Buill-in securily principals

From this location:

In the Group Or User Names box, select the user or security group of which the user is a
member, in this case Bill Ferguson.

View the permissions assigned in the Permissions For box.
Adjust the permissions based on the minimum needs of the user.

To add a user or group, click Add and then type the name of the user or group that you
want to add.

FAX)

Object Types..

o
Enter the objact names to selecl (gxamples):

bill black Check Names

T e

To remove a user or group, select the user or group in the Group Or User Names box and
click Remove.
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) If the Security tab is not available, the file or folder is either not in an NTFS vol-
TE ume or simple file sharing is enabled. You can enable and disable simple file
sharing in the View menu of Folder Options within the Tools menu of My Doc-

uments or Windows Explorer.

Using the NTFS Effective Permissions Tool

When a user is a member of multiple security groups, it may not be as easy to determine his
effective permissions by just reviewing the permissions of all of the groups of which he is mem-
ber. For this reason, Windows XP and Windows Server 2003 have a new feature called the
Effective Permissions tool. You should be aware that this tool calculates only the effective NTFS
permissions and does not factor in share permissions or encrypted files and folders, which we
will discuss later in this chapter.

The Effective Permissions tool is located in the Advanced Security settings for each file or
folder. Exercise 2.2 walks you through the steps to determine a user’s effective NTFS permis-
sions using the Effective Permissions tool.

2 You should be aware that the Effective Permissions tool calculates only the
ING effective NTFS permissions to a file or folder and does not factor in share per-
missions or encrypted files and folders.

Special Considerations with Managing and
Troubleshooting Permissions

In a completely static environment with very few users, permissions are relatively easy to man-
age and troubleshoot. It gets a bit more complicated when there are many (or hundreds) of users
and many resources to manage as well. Also, users have the nasty habit of not staying in the
same jobj; therefore, their security group memberships and their file and folder needs are likely
to change with their job.

In this section, we will discuss the special considerations that make managing permissions a
little trickier than just understanding standard file and folder permissions. In particular, we will
discuss managing permissions inheritance, deny permissions, copying and moving files and
folders, special permissions, and special troubleshooting issues.

Managing Permissions Inheritance

By default, NTFS permissions follow rules of inheritance. When you apply permissions to a
folder, the permissions are inherited by all of the files and folders that are in that folder. Also,
if you create a new file or folder within that folder, the new file or folder will also inherit the
permissions of the folder in which it is contained, also referred to as its parent folder.
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Using the Effective Permissions Tool

1. Click Start, and then choose My Computer.

Locate the file or folder that you want to verify.

Right-click the file or folder and click the Security tab.

Click the Advanced button.

In the Advanced Security Settings dialog box, click the Effective Permissions tab.

Click Select.

N o o & w N

In the Enter The Object Name To Select box, type the name of the user for whom you want
to verify NTFS permissions, in this case Bill Black.

8. The check boxes that are selected indicate the effective NTFS permissions for that user.

| Advanced Security Settings for Folder A @

Pemissions | Auditing | Owner | Effective Permissions

The following list displays the permissions that would be granted to the selected group or user. based on all
relevant permissions.

GlOL}p orusername:

Bill Black

Effective permissions
@ Full Control
B Traverse Folder ] Execute File
M ListFolder /| Read Data
M Read Attributes
M Read Extended Atfributes
[ Create Files [ Write Data
[ Create Folders [ Append Data
O Write Atibutes
O Write Extended Atributes
0O Delete Subfolders and Files
O Delete
M Read Permissions
O Change Pemissions
O Take Ownership

OK ] [ Cancel
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If you do not want the files and folders to inherit permissions, then you must clear the default
setting in the Advanced Security Settings dialog box. Exercise 2.3 walks you through the process
of preventing NTFS permissions inheritance.

Using Deny Permissions

You may have noticed that there are two columns for each type of permission for a resource,
namely Allow and Deny. So you might be thinking, “What’s the difference between a permis-
sion box that is just not checked Allow and a permission box that is explicitly checked Deny?”
Well, I'm glad you asked.

Preventing NTFS Permissions Inheritance

1. Click Start, and then choose My Computer.

2. Locate the file or folder you want to prevent from inheriting permissions.
3. Right-click the file or folder and click the Security tab.

4. Click the Advanced button.

Advanced Security Settings for Folder A

)
X

| Permissions | Auditing | Owner | Effactive Permissions |
[ To view more information about Special permissions, selecta permission antry. and then click Edit. ‘

[ Permission entries: |

Type Mame Permission Inherited From Apply To
| Allow Bill Black (XP1\Bill Black) Read & Execute <notinherited=> This folder, subfolders a...
Allow Administrators (XPT\Ad..  Full Control CA This folder. subfolders a...
Allow SYSTEM Full Contral CcA This folder, subfolders a
Allow Bill Ferguson (XP1\Bill Full Control A This folder only
Allow CREATOR OWNER Full Coniral C\ Subfolders and files only
Allow Users (XP1\Usars) Read & Execute (o4} This folder, subfolders a
| Allow Users (XP1\Usars) Special c\ This folder and subfolders | |
|
|
|
[ [ Add. | [  Edt.  |[__ Remove |

| Inheritfrom parent the permission entries that apply to child objects. Include these with entrias explicitly defined
hare

[[1Replace permission entries on all child objects with entries shown here that apply to child objects

OK I [ Cancel
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EXERCISE 2.3 (continued)

5. CleartheInherit From Parent The Permissions Entries That Apply To Child Objects. Include
These With Entries Explicitly Defined Here. check box.

6. Selectto copy the current permissions and make changes by clicking the Edit button or to
remove all permissions and set your own by clicking the Remove button.

Security @

Selecting this option means that the parent permission entries that apply to dit
<z child objects will no longer be applied to this object
\.‘/
-To copy the permission entries that were previously applied from the parent
to this object click Copy.
-To remove the permission entries that were previously applied from the parent
and keep only those permissions explicitly defined here, click Remove. . subfolders a..
r. subfolders a..
-To cancel this action, click Cancel. r. subfolders a..
r only
= and files only
Copy ] I Remove ] I Cancel r. subfolders a..
Ir and subfolders
[ Add., | [ Edit.. ] [ Remave

0 Inherit from parent the permission enfries that apply to child objects. Include these with entries explicitly defined
hare.

[[JReplace permission entries on all child objects with enfries shown hare that apply to child objects

[ OK J[ Cancel J

28 SEEEY /58 AL b/

In most cases, a Deny permission will override an Allow permission. This means that if a user
is a member of multiple groups and some of the groups are set to Allow Read on a resource but
one of them is set to Deny Read, then the user will not be able to view the resource. The Deny
permission on one group will override all of the other Allow permissions.

Now, you might have noticed that I said “in most cases,” so here’s the tricky part. If the
folder inherits conflicting settings from different parent folders and has no settings directly
applied to it, then the precedence will be given to the folder that is closest to the position of the
resource object in the folder tree. I told you it was tricky! Just think of it this way: The one who
is closest to me knows me best. The parent folder closest to the resource object has the correct
permission for the object.

Managing Permissions When Copying and Moving Files and Folders

So far, we have discussed permissions of files and folders that are applied in place, right
where they are at the time permissions are applied. Unfortunately, real life isn’t always that



42 Chapter 2 - Managing and Troubleshooting Access to Resources

“neat and clean”; files and folders are often copied or moved from one hierarchy to another
by cut-and-paste operations in Explorer and My Computer, commands entered on the com-
mand line, or other applications. As a desktop support technician, you need to know how
these copy and move operations affect the user’s permissions to the resource.

There are only two possibilities to consider. Either the file or folder will retain the same per-
missions that it had before it was moved or it will inherit all of its permissions from its new par-
ent folder. This depends on whether the file is copied or moved and whether it is moved within
the same volume or to another volume. Fortunately, it’s all of one or all of the other; there is no
in-between or mix to consider. Table 2.3 illustrates the NTFS permissions consequences when
files and folders are copied or moved.

Managing Special Permissions

So far, we have discussed only standard NTFS permissions. There are actually two major
categories of NTFS permissions, standard and special. In this section we will examine special
NTFS permissions.

TABLE 2.3 NTFS Permissions Consequences When Moving or Copying Files or Folders

Action NTFS Permissions Consequence

Copying afile or folder to an NTFS drive onthe The new copy of the file or folder inherits the
same volume as the original permissions of the destination folder.

Copying a file or folder to an NTFS drive ona The new copy of the file or folder inherits the
different volume than the original permissions of the destination folder.

Moving a file or folder within a single NTFS The moved file or folder retains the permis-
volume sions that it had before it was moved.

Moving a file or folder from one NTFS volume The moved file or folder inherits the permis-

to another sions of the destination folder.

Copying or moving a file or folder from a The newly created folder inherits the permis-
FAT32 partition to an NTFS volume sions of the destination folder.

Copying or moving a file or folder from an The moved or copied file in the new destina-
NTFS volume to a FAT32 partition tion loses all NTFS permissions.

Special permissions are actually any NTFS permissions that are not standard. You can set
special permissions by accessing the Advanced Security options of a file or folder. Exercise 2.4
walks you through viewing and configuring special NTFS permissions for files and folders.
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Viewing and Configuring Special NTFS Permissions for Files and Folders

1. Click Start, and then choose My Computer.

Locate the file or folder.

Right-click the file or folder and click the Security tab.

Click the Advanced button.

Select the user or group for which you wish to define special permissions.

Click the Edit button.

N o o & w N

The checked boxes indicate the granular settings of NTFS standard permissions assigned
to the user or group. Any change to the standard settings check boxes will create special
permissions.

Permission Entry for Folder A @@
| Object

Name: |Bill Black (XP1Bill Black)

Apply onto: | This folder, subfolders and files .VJ

Permissions: Allow

Full Control

Traverse Folder [ Execute File
ListFolder /Read Dala

Read Atributes

Read Extendad Attributas
Create Files [ Write Data
Create Folders [ Append Data
Write Atirbutes

Write Extended Attributes
Delete Subfolders and Files
Delete

|

Read Permissions
b

IO0O00O0O0O0O0O00O0000 g

IRO0O0000REREEO

Mhanna Barmiceinne

DApply these permissions to objects and/or Clear All

containers within this container only

OK ‘ | Cancel ‘
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EXERCISE 2.4 (continued)

8. Clear any checked boxes except Full Control, and then click OK.

9. Note thatthe Permission entry has changed to Special for the user or group that you selected.

Advanced Security Settings for Folder A L?J%
Permissions :_Audinng | Qwmer | Effective Permissions

To view more information about Special p issions, select a permission entry, and then click Edit

Permission enfries

FPermission inhented From Apply To

Special _<notinhented> _ This folder. subfolders a. |

Full Control Cy This folder, subfolders a...
Allow Bill Fergusan (XP1\Bill Full Contral Ch This folder only
Allow CREATOR OWNER Full Conirol cy Subfolders and files only
Allow SYSTEM Full Contral cA This falder. subfalders 2
Allow Users (XPT\Users) Read & Execute ;A This folder. subfolders a... |
Allow Users (XP1\sers) Special cy This falder and subfalders

|
l Add. | | Edit. | I Remove

— here.

|
|7 Inherit from parent the permission entries that apply to child objects. Include these with entries explicity defined ‘
E Replace permission enfries on all child objects with entries shown here that apply to child objects

QK | Cancel I | Apply

Special Considerations When Troubleshooting NTFS Permissions

It may seem as if we have covered everything there is to know about file and folder access and
NTFS permissions. Actually, though, there are a few situations that require you to “think out-
side the box” that are worth mentioning at this point. For example, “What happens if you
change a user’s permissions to a resource while the user is logged on?” Also, “What if the person
who created a file makes sure that she is the only one who has permissions for it and then leaves
the company?” Finally, “What about files that are encrypted as well as protected by NTFS?”

In this section, we will fill in the gaps in regard to NTFS file and folder permissions. In par-
ticular, we will discuss access token generation, taking ownership of files and folders, and
troubleshooting encrypted files versus files protected by NTFS.

Access Token Generation

When a user logs on to a domain, the domain controller examines the permissions assigned to
the user and to the groups of which the user is a member. The domain controller then gives this
information to the client computer, which uses it to create an access token that will be used to
gain access to resources on the network. The user’s access token is not changed until she logs
off and logs back on, even if the permissions for the user are changed while she is logged on. For
this reason, if a user complains that she cannot access a resource for which she has just been
given permissions, then you should ask her to log off and then log back on again.
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Taking Ownership of Files and Folders

When a user creates a file or folder, he becomes the Creator Owner of that file or folder. This
means that he has Full Control permissions and nobody else has any permissions at all. If the per-
son leaves the company, the easiest thing to do is to change the name of their account so the new
user has access to the files and folders; but what if the user is promoted instead? In that case, the
new person will not have access to the file or folder and may not even be able to view the file or
folder, that is, unless the original user or the administrator gives the new user the right to take
ownership of the file or folder and assign himself the permissions to use the file or folder. The right
to take ownership can be set in the Advanced Security settings for each file and folder. You should
click the Owner tab and then select the new owner of the file from the users and groups in the
Change Owner To box. The new user must have the special permission of Take Ownership
assigned to him to be listed in Change Owner To box.

Troubleshooting NTFS Permissions versus Encrypted Files

If a user can view a file or folder but cannot open the file or folder, then she may not have the

permissions to open it or the file or folder may be encrypted so that only certain users can open

it. As a desktop support technician, you should be able to determine which of these problems

is occurring. The clue that will allow you to determine the problem is in the error message itself.

If a user is denied access to a file or folder due to insufficient NTFS permissions, then she will

receive a message that has the folder name that is not accessible and an “Access is denied” error

message like the one in Figure 2.1. If, on the other hand, the user is denied access because the file

or folder is encrypted, then the message will be a simple “Access is denied” message, like the one

in Figure 2.2. Determining the true nature of the problem will allow you to fix it yourself or esca-
late it to a network administrator.

FIGURE 2.1 AccessIs Denied message caused by insufficient NTFS permissions

-Local Disk (C:)

@ C:\Folder A is not accessible.
Access Is denied.

FIGURE 2.2 Accessls Denied message caused by encryption

f Notepad @

ﬁ Access s denied.
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Managing Encrypted Files

You can manage the encryption of a file or folder using the Advanced button in the General tab of
its properties. In most cases, you should encrypt folders and then place files into them. You should
know that files placed into an encrypted folder will become encrypted. You can encrypt only the root
folder or the entire folder hierarchy based on your needs. Once files are encrypted, only the user that
encrypted the files, and therefore possesses the private key, will be able to use the files normally. In
most organizations, the administrator is also designated as a Recovery Agent who can decrypt the
files if the user's private key should become corrupt.

Shared Folders

Actually, no matter how you set the NTFS permissions on a file or folder, if the file or folder is
not shared, then it will be available only locally on the computer where it exists. Sharing folders
is like opening the main gate that allows access to the folder from other computers on the net-
work. The permissions that you assign to the share will combine with the NTFS permissions
assigned to the resource to create a result called the effective permissions to the resource.

You should understand that the true effective permissions to the resource are not just the permis-
sions obtained by the Effective Permissions tool that we discussed earlier. The Effective Permissions
tool provides only the effective NTFS permissions. Determining the true effective permissions
requires a little more work on your part. In this section, we will discuss creating and troubleshooting
shared folders and determining the effective permissions of a user to a shared folder.

In Windows XP, there are basically two types of file and folder sharing. We will discuss each
type and its relation to troubleshooting effective permissions.

Simple File Sharing

Simple file sharing is enabled by default in Windows XP Home Edition. It is available on Win-
dows XP Professional only if the computer is not in a domain. It is not available to any computer
that is running Windows XP on a domain. For this reason, you are unlikely to have to trouble-
shoot simple file sharing, but it still bears mentioning since you might run into it on a stand-
alone computer or one that is in a workgroup.

Simple file sharing enables you to share a resource on the network by selecting a single check
box. Through the Guest account, Windows XP automatically makes the resource available to
everyone and sets the appropriate NTFS permissions on the object as well. You cannot control
the NTFS permissions directly when using simple file sharing; in fact, there isn’t even a Security
tab on the folder properties. Figure 2.3 shows the user interface on a computer that is configured
for simple file sharing.

Classic Sharing

Classic sharing is the type of sharing that is used in domains and therefore in most organiza-
tions. With classic sharing, you can control access to a resource by user and/or group. When
resources are shared, Windows XP automatically searches the network for the shares that are
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available to the user that is currently logged on. Users can locate these shares through their My
Network Places tool, as shown in Figure 2.4. My Network Places is located on the Start menu

in Windows XP.
FIGURE 2.3

Simple File Sharing on Windows XP

| General | Sharing C ize |
~Local sharing and secunty

[ Ta share this folder with other users of this computer anly,
dragitto the Shared Documents folder.

To make this folder and its subfolders private so thatonly
you have access, selectthe following check box,

| Make this folder prvate

Metwork sharing and security ™
To share this folder with both network users and other users
of this computer, select the first check box below and type 3
share name.

Share this folder on the network

Share name: | Falder A

DAI.Iow network users to change my files

Leam more about shanng and secunty

[ o ]|

Cancel ] [ Apply J

FIGURE 2.4 My Network Places in Windows XP

Q3 Bacl

Fle Edt View Favortes Tooks Help [ 4
O - ¥ | Psearch 1 Folders | My
Actdress 6 My Network Places BEE:
TN ame A | Cx Computer
RetwurkdsaC A2 CD Drive (H) on Del Desktop (Xp1) \WP1\CD Drive (H) Dell Desktop (Xp1
€3 Add  rehwinr plrioe = moredocs on XPCLIENT (Xpcient) \WPCLIENT\moredocs Unknown
2 My Documents on Del Desktop (... \\P1\My Documents Unknown
& View network connections 1 My Documents on XPCLIENT (Xp... \\Xpcient\my documents  Unknown
9 setup 2 home or smal = My eBooks on Del Desktop ((pI)  \WXP1\My eBooks Dell Desktop (Xp1
office netwark | hitpe/, com bk
@ Visw workgroup computers ServerCD on Dell Desktop (xp1)  \WP1\ServerCD Dell Desktop (Xpl
| 2 SharedDocs on Dell Desktop (Xp1) \\XP1\SharedDocs Dell Desktop (¥pl
- sharedDocs on XPCLIENT (Xpclie... \\PCLIENT\SharedDocs  Unknown
Other Places | %=v and q (d) on Del Desktop (Xp1)  \\xpliv and g (d) Unknown
@ Deskt < video2 () on Dell Desktop (Xp1)  \\xplwvideo2 (&) unknown
Destap 2 2p250 (f) on Dell Desktop (Xp1)  \\pl\zp250 () Dell Desktop (¥pl
2 1y Computer 2 g on Del Deskiop (Xp1) Wxplg Del Desktop (Xp1
) My Documents
=3 Shared Documents
%4 Frinters and Faxes
7 ] u - Ea

13 objects
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Access is controlled by share permissions that you can set. These share permissions will then
combine with the NTFS permissions to create the effective permissions for the share. In this sec-
tion we will examine share permissions and effective permissions at greater depth.

Share Permissions

Share permissions can be assigned individually to each folder in a hierarchy of folders. In
addition, share permissions are inherited by default through a folder hierarchy. You can
assign share permissions for a folder specifically to users and groups. Table 2.4 illustrates the
type of share permissions available and what they enable a user to do.

TABLE 2.4 Shared Folder Permissions

Shared Folder Permission Enables User To:

Read View filenames and subfolder names, traverse to subfolders,
view data in files, run program files.

Change Perform all tasks described above plus add files and subfolders,
change data in files, delete subfolders and files.

Full Control Perform all tasks described above plus change NTFS permis-
sions, take ownership, and thereby give other users permissions
for the resource.

You can set the share permissions for a folder within the properties of the folder. In addition,
you can control how many users can connect to the share simultaneously. This can be useful if
there are limited resources such as processor or memory to support the share. Exercise 2.5 walks
you through the steps to create and configure a share with classic sharing.

Effective Permissions When Combining Shares and NTFS

If a folder located on a drive that is formatted with NTFS is shared on a network and a user is
accessing that folder through the share, then the effective permissions of the user are a combi-
nation of the user’s share permissions and the user’s NTFS permissions. As a desktop support
technician, you should know how to combine these permissions to determine the effective per-
missions for the user.

Creating and Configuring a Share

1. Click Start, and then choose My Computer.

2. Locate the folder that you want to share.
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EXERCISE 2.5 (continued)

3. Right-click the folder and choose Sharing And Security.
| Folder A Properties .

General | Sharing Sacurity Cus?omLze.:

- You can share this folder with other users on your network. To
= enable sharing for this folder. click Share this folder.

(O Do not share this folder
(8) Share this folder

Share name: Folder A

Comment

User limit (@) Maximum allowed

C) Allow this number of users: [ :!

To set permissions for users who access this | Rerisainis
folder over the network, click Permissions.

To configure setiings for offine access, click
Caching.

i OK. l [ Cancel ‘ | Apply |

4. Selectthe Share This Folder option, and type the share name that you would like to use or
accept the default (the folder name).

5. Accept the Maximum Allowed option or select Allow This Number Of Users and enter the
number of users that you want to able to use the share simultaneously.

6. Click the Permissions button to configure the permissions for the users and groups.
7. Click Add to configure permissions for users and groups that are not yet listed.

8. Typethe name of the user or group in the Enter The Object Names To Select box, and press
Enter. Repeat to add permissions for additional users and groups.

To determine the user’s effective permissions to a folder, you should follow this three-
step method:

1. Determine the effective permissions for the share.

This is accomplished by determining the maximum shared permissions that are assigned
to the user or to a group of which the user is a member. For example, if a user has Allow
Change permissions from one group and Allow Read from another, then the effective share
permissions would be Allow Change.
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You should also remember that Deny overrides all other permissions. For example, if a user
has Allow Change permissions in one group and Deny Change in another group, then the
effective share permissions would be Deny Change, which would include Deny Read and
therefore would block all access to the resource.

2. Determine the effective NTFS permissions.

This can be accomplished by determining the maximum NTFS permissions that are assigned
to a user or group, keeping in mind that Deny permissions always override Allow permissions
unless the Allow permissions are explicit and the Deny permissions are inherited.

An easier method would be to use the Effective Permissions tool that we described earlier
in this chapter. Using the Effective Permissions tool will allow you to determine the effective
NTFS permissions of a user to a resource.

3. Compare the effective share permissions with the effective NTFS permissions. The more
restrictive of the two will be the true effective permissions to the share. For example, if the
combination of share permissions creates an effective share permission of Allow Full Control
but the combination of NTFS permissions creates an effective NTFS permission of Allow
Change, then the true effective permission for the user to the resource is Allow Change.

@ Real World Scenario
Setting Up Permissions—Backwards!

Some things are easier when you do them backwards! If you were suddenly in charge of setting
permissions in a large organization with many users and groups, it could be a little overwhelm-
ing. You might ask yourself, “What if | don’t get everything set just right and there are problems?”
As a desktop support technician, you may or may not have the rights to set permissions, but you
should still know a little about the methodology so that you understand how the file and folder
permission settings may have ended up the way they are now.

A good technique when configuring permissions is to think about it in reverse. In other
words, ask yourself, “Which files and folders do | want to make sure that only a few users or
groups can get access to or even view?” Configure the NTFS permissions and shared folder
permissions for those resources first, and then you can put on the next layer of permissions
thatis a little less restrictive and continue to add layers until you get to the layer that includes
just about everybody.

At each layer, you can check to make sure that you do not change anything that puts the pre-
vious layers at risk. In this way, you can gradually make sure that the most important files and
folders are protected but that users can access the files and folders that they need. It will still
require some research and thought on your part, but doing it backwards will make the whole
process a lot smoother.
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Printers

As we try to develop a “paperless society” we seem to be using more and more paper. In fact,
I understand that the document that was circulated through Congress about how to use less
paper was about 500 pages long! Since people must have their “hard copy,” you have to know
how to keep their printers operational.

The term printers is often misused by users. Actually a printer is software installed in a com-
puter that drives the print operation and sends the print job to the print device that makes the hard
copy. There are basically two different types of printers, local and network. In this section we will
discuss how to install, configure permissions for, and troubleshoot these two types of printers.

Local Printers

A printer is considered local when the computer communicates directly with the printer without
having to go through another computer. Local printers can be installed and shared on any com-
puter in the network. Installing and sharing a printer on a computer in a network creates a print
server. Users can connect to the print server to use the shared printers.

You can install printers using the software on the CD that came with the printer or by using
the Printers and Faxes tool in Windows XP. Exercise 2.6 walks you through the steps of install-
ing and sharing a local printer on Windows XP.

Installing and Sharing a Local Printer

1. Physically attach the print device to the computer using a parallel cable, USB cable, or
network cable.

2. Click Start, choose Control Panel, and then choose Printers And Faxes.

3. Choose Add A Printer to start the Add Printer Wizard.

= [ |
|- =i Printers and Faxes |.L| Sm
Fe Fdt View Favortes Took  Hep ir
¥ - search [ Folders | T
S Penters and Faxes v | E o
2
i, A be POF o XPCLIERT
[
\\f Reaty
See Also k3 T\ HP Desklet 600
g Wi
[ Troubieshoot proting [‘é Reah J
) ot help wath pren i
= = L] J i Mirosoft Office Document Emage
'l Wiritar
Other Places Ed 7
O contal Pans
S Scanners and Cameras
& My Documents
0 My Fichuras
4 My Compuser
Destails ¥
4 ohjecs.
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EXERCISE 2.6 (continued)

4. Click Next.

Add Printer Wizard

Local or Network Printer
The wizard needs 1o know which type of printer to selup

Select the option that describes the printer you wanl to use
@, Local printer aftached to this computer
[V] Autamnatically detact and install my Plug and Play printer

() A network printer, or a printer attached to another computer

To setup a network printer that is not attached to a print server,
‘\1) use the "Local prnter" option

[ <Back [ New> | [ canca |

5. Select Local Printer Attached To This Computer and verify that the Automatically Detect
And Install My Plug And Play Printer check box is selected.

6. Click Next.

7. Follow the instructions in the wizard to finish setting up the printer.

TE and installed by the Found New Hardware Wizard. The Found New Hardware
Wizard may ask for the CD that came with the printer if the drivers are not found
in the operating system’s driver cache.

%)’ Printers that use USB or infrared connections may be automatically detected

Removing a local printer is just as easy as installing one. Exercise 2.7 walks you through
removing a local printer and removing the printer driver.

EXERCISE 2.7

Removing a Local Printer

1. Shut down the computer and physically remove the print device connection.

2. Restart the Windows XP operating system, click Start, choose Control Panel, and open
Printers And Faxes.
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EXERCISE 2.7 (continued)

3. Right-click the printer that you want to remove, and select Delete.
4. Choose File in the File menu, and then select Server Properties.

5. Click the Drivers tab, select the driver for the printer that you deleted, and click Remove.

Network Printers

When printers are installed and shared on a network, a user can connect to and install the printer
through the network. These types of installed printers are referred to as nefwork printers. You
should know how to install and troubleshoot these printers.

Installing a network printer is very similar to installing a local printer, except that there is no
physical installation required. This is because the print device has already been installed and
shared as a local printer and you are just connecting to a device that already exists. Exercise 2.8
walks you through the steps to install a network printer on Windows XP in a domain.

Installing a Network Printer

1. Click Start, choose Control Panel, and then choose Printers And Faxes.

2. Choose Add A Printer to start the Add Printer Wizard, and then click Next.

3. Select A Network Printer, Or A Printer Attached To Another Computer, and then click Next.
. Add Printer Wizard

Local or Network Printer 7
The wizard needs to know which type of printer to setup.

Selectthe option that describes the printer you wantto use:

{_) Local printer attached to this computer
{\'.T-_"nhnetwork printer, or a printer attached to another computer

1 To setup a netwark printer that is not attached to a print server,
\\) use the "Local printer” option

[ < Back " MNext > ][ Cancel ]
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EXERCISE 2.8 (continued)

4. Select Find A Printer In The Directory, and then click Next.
5. Define your search parameters (name, location, model), and then click Find Now.

6. Select the printer that you want to install, and then click OK.

- Installing a network printer in a workgroup, without the benefit of Active
TE Directory, requires a few more steps because Active Directory cannot be
used to search for the printer. In this case, you should use the Universal
Naming Convention (UNC) command of \\server\printer to locate and

install the printer.

Uninstalling a network printer is also very similar to uninstalling a local printer, except
that there is no need to physically uninstall the print device. In fact, you might be uninstall-
ing the network printer on only one computer, while other computers may continue to
use the printer. Exercise 2.9 walks you through the steps to uninstall a network printer in
Windows XP.

Uninstalling a Network Printer

1. InPrinters and Faxes, right-click the icon for the printer that you want to remove, and then
select Delete.

2. Todelete the printer driver, choose File in the File menu, and then choose Server Properties.

3. Clickthe Drivers tab, select the driver for the printer that you deleted, and then click Remove.

Printer Permissions

Users should have transparent access to printers that they need to use to do their job. At the
same time, there may be some printers that are restricted to only specific users and groups. This
is accomplished using printer permissions.

In some ways, printer permissions are similar to shared folder permissions in that there are
two categories, Allow and Deny. In other ways, printer permissions are completely different.
Table 2.5 illustrates the printer permissions that are available and what actions they enable a
user to perform.
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TABLE 2.5 Shared Folder Permissions

Printer Permission Enables User To:

Print Connect and send documents to a printer and delete his documents
from the print queue.

Manage Documents Pause, resume, restart, cancel, and rearrange the order of documents.

Manage Printers Perform all tasks described above plus have complete administra-
tive control over the printer.

Deny Cannot use or manage the printer or adjust permissions.
4 You should note that a user who has Manage Documents permission but not
P Print permission for a printer will not be able to send documents to the printer.

You can configure printer permissions on the Security tab in the properties of the printer.
Exercise 2.10 walks you through setting permissions on a printer.

Troubleshooting Printers

It’s important that users be able to get their hard copy to create their reports, presentations, let-
ters, memos, and the like. Because of this, a desktop support technician must be able to quickly
troubleshoot printers when needed. In this section, we will discuss the four areas of printer
troubleshooting that are most common in business environments: drivers, the print spooler,
connectivity issues, and redirecting print jobs.

Printer Drivers

A printer driver is a software program that enables the operating system and programs that it runs
to communicate with a particular printer. Many printing problems are the result of an improper
installation of a printer driver or using the wrong printer driver. If a print job has illegible char-
acters or only a few characters per printed page, this is an indication of an improper driver.
Another indication of an improper driver is the inability to change the properties of a printer.

Configuring Printer Permissions in Windows XP

1. Click Start, choose Control Panel, and then choose Printers And Faxes.

2. Right-click the printer for which you want to set permissions.



56 Chapter 2 - Managing and Troubleshooting Access to Resources

EXERCISE 2.10 (continued)

3. Choose Properties, and then click the Security tab.

-2 HP Color LaserJet Properties ? %
General Sharing Ports L Advanced
Color Management Security Device Setfiings

G[OLIp orusernames;

| eniAdmini (XP1iAdministrators)
€7 CREATOR OWNER
€7 Everyone

€7 Power Users (XP1\Power Users)

Add. || Remove |

Pemissions for Administrators Allow Deny
Print v [l
Manage Printers O
Manage Documents ™ [l

Special Permissions

For special permissions or for advanced settings,
click Advanced.

[ OK H Cancel ‘

4. Selectthe user or group for which you wish to set permissions, or click Add to add a new
user or group to the list.

5. To remove permissions from a user or group, select the user or group and click Remove.

You should know how to properly install and repair printer drivers when necessary.
Exercise 2.11 walks you through installing a new printer driver on a print server.

Installing a Printer Driver in Windows XP

1. Click Start, choose Control Panel, and then choose Printers And Faxes.
2. Onthe menu bar, at the top of the screen, choose File.

3. Ifthere are multiple printers, select the appropriate printer. Otherwise move ahead to Step 4.
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EXERCISE 2.11 (continued)

4. Select Server Properties, click the Drivers tab, and then click Add.

S PARUSeTer PropeTee k3

Forms | Ports | Drivers | Advanced

MName Environment Version
Adobe PDF Converier Inte] Windaws 2600 or X8
HP Color Laserlet Intal Windows 2000 or XP
HP DeskJet 600 Inte! Windows 2000 or XP
Micresoft Office Documentl.. Intel Windows 2000 or XP
Add... | i Remove I Replace J I Properties
[ ok ][ cenca |

5. Complete the Add Printer Driver Wizard by selecting the manufacturer and model of the
printer and the operating system.

From time to time, manufacturers update their printer drivers to provide for more function-
ality or better quality printing. Often you can download a program from the manufacturer’s
website that installs and configures the new driver; however, there may be instances when you
must update drivers manually. It’s important that you understand how to update printer drivers
in all circumstances. Exercise 2.12 walks you through the steps of updating a printer driver
manually in Windows XP.

Updating Printer Drivers in Windows XP
1. Click Start, choose Control Panel, and then choose Printers And Faxes.
2. Right-click the printer icon that you want to update, and then choose Properties.

3. Onthe Advanced tab, choose New Driver to start the Add Printer Driver Wizard. Click Next,
and then choose Have Disk.

4. Browse forthe correct driver on the disk and select it, and then finish the wizard installation
by following the prompts.
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The Print Spooler

The print spooler is a service that receives a print job into a print server and holds it there until
the print device is ready to print. The print spooler folder is located by default in Windows XP
at C:\Windows\System32\spooT1\Printers. There may be instances, such as when the disk
space in C: becomes full, when you need to move the location of the print spooler folder. Exer-
cise 2.13 walks you through the steps to move the print spooler folder in Windows XP.

You may also need to restart the print spooler service from time to time to clear the print
queue and resume normal printing. You should know that users will have to resend their doc-
uments if you have to restart the print spooler. Exercise 2.14 walks you through the steps to
restart the Print Spooler service in Windows XP.

Resetting the Print Spooler Folder

1. Click Start, choose Control Panel, and then choose Printers And Faxes.
2. Onthe File menu, choose Server Properties, and then click the Advanced tab.

"3 Print Server Properties .

| Forms || Poris | Drivers | Advanced
4
& XP1

Spool folder CIWINDOWS|System32|spool\PRINTERS

[¥] Log spooler error events

[Vl Log spoolerwaming evenis

[T]Log spooler information events

[[1Beep on ermors of remote documents

L— Show informational notifications for local printers

EE Show informational notifications for network printers

Printer notifications for downlevel clients:

[CINotify when remote documents are printed

| OK l | Cancel |

3. Inthe Spool Folder box, type the path that you want to use, and then click OK.
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Restarting the Print Spooler Service

1. Click Start, and then choose Run.

2. Type services.msc, and then click OK.

3. Right-click the Print Spooler service, and then select Restart.

|‘!§> Services

M=

Flle Action View Help

4 Services (Local)

% services (Local)

Select an tem to view its
description.

Name

| Description

| status |~

&y Network Location Aw...

&y Norton AntVirus Auto...
& Norton Unerase Prote...

S NT LM Security Supp...
% Office Source Engine
% Performance Logs an...
&% Plug and Play

S Portable Media Serial ...
& Print Spocler

&4 Protected Storage

%5 QoS RSVP

%% Remote ACcess AULD ...
%% Remote Access Conn...

%% Remote Desktop Help...
&% Remote Procedure Ca...
&4 Remote Procedure Ca...

& Remote Regstry

&% Removable Storage

% Routing and Remote ...
& SAVScan

8 SrrintBlinckinn Sarvice
ligel. !

Collects and stores network c...

Handles Norton AntiVirus Auto...

Provides security to remote p...
Saves installation files used for...
Collects performance data fro...

Enables a computer to recog...

Retrieves the serial number of...
Loads files to memory for late...
Provides protected storage fo...
Provides network signaling an...

Creates a connection to a re...
Creates a network connection.
Manages and controls Remot...

Provides the endpoint mappe...

Started
Started
Started

Started
Started
Started
Started | =

Started —
Started

Started

Manages the RPC name servic...

Enables remote users to modi...

Offers routing services to busl...
Handles Norton AntiVirus Auto...

Started

Started

»

(i)

Extended A Standard /

L
ING

Restarting the Print Spooler service will clear the print queue of all documents.
Users will have to resend their documents to the printer.

Troubleshooting Printer Connectivity

When a user cannot print to a print device, you may be called in to troubleshoot the problem.
Your first step in troubleshooting should be to isolate the problem to the printer, the connec-
tion, or the user’s application. You can do this with the help of the user if you are on the phone
or on your own if you are physically at the location.
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The tools that you will use to isolate the problem are located in the print device and in the
operating system software. You should begin by printing a local test page at the print device
itself. If the test page will print, then you know that the print device is not the problem. If the
test page will not print, then the problem is in the print device itself.

Once you can successfully print a test page on the print device, you should print a test page
from the Windows software. Exercise 2.15 walks you through the steps to print a test page from
Windows XP.

Printing a Test Page from Windows XP

1. Click Start, choose Control Panel, and then choose Printers And Faxes.
2. Right-click the printer on which you wish to print a test page.

3. Choose Properties, and then choose Print Test Page on the General tab.

If you can print a test page from Windows XP, but the user cannot print a test page from her
application, then you have isolated the problem to the application. If, on the other hand, you
cannot print a test page from Windows XP, but you were able to print the test page at the print
device itself, then you have isolated the problem to the operating system. If the problem is with
the operating system, then it is likely that the driver is at fault and that you should reinstall the
printer driver.

Redirecting Print Jobs

If you have print devices that are the same or at least use the same driver, then you can redirect
print jobs from one printer to another. This might be necessary when a print device is very busy
or if a print device should fail with many print jobs in the queue. Exercise 2.16 walks you
through the steps to redirect print jobs.

Redirecting Print Jobs

1. Click Start, choose Control Panel, and then choose Printers And Faxes.
Choose Add A Printer to start the Add Printer Wizard, and then click Next.

Select Local Printer, and then click Next.

2
3
4. Select Create A New Port, select Local Port from the Type box, and then click Next.
5. Type a share name for the port: \'

6

Continue with the wizard and install the appropriate driver for the device.
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To successfully redirect print jobs to another printer, the two printers must use
P the same or a very similar and compatible driver.

Offline Files and Folders

Since many users work on laptop computers while outside the office, the newer Windows client
operating systems, such as Windows XP Professional, have a feature named Offline Files and
Folders. With Offline Files and Folders properly configured, a user can have the best of both
worlds, in and out of the office. Offline Files and Folders allows a user to cache the files that he
is working on when connected to the network. The original file may be contained on a network
file server, but a cached copy of the file, the folder, and even the drive can be created on his lap-
top for easy continued use while out of the office. When he returns the laptop to the office and
connects it to the network again, he can synchronize the files and folders from his laptop to the
file server. As a desktop support technician, you need to understand how to configure and trou-
bleshoot offline file settings and synchronization settings.

Offline File Settings

Before you can take advantage of the Offline Files feature, you have to enable it. Once you
enable Offline Files, you can then decide how and when you want to synchronize the files on
the laptop with those on the server. Actually, configuring offline file settings involves these
three settings:

=  Configuring the client computer to use offline files
= Configuring offline files and folders on the client
= Configuring the file and folder caching on the server

= In this section, we will discuss each of these three settings at greater depth.

Configuring the Client Computer to Use Offline Files

You can configure each Windows XP Professional computer to use offline files or not to use
them. By default, Windows XP Professional is configured not to use offline files. Exercise 2.17
walks you through the steps to configure a computer to use offline files.

EXERCISE 2.17

Configuring Windows XP Professional for Offline Files

1. Click Start, and then choose My Computer.

2. Onthe Tools menu, choose Folder Options.
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EXERCISE 2.17 (continued)

3. Click the Offline Files tab, and then select the Enable Offline Files check box.

. Folder Options m%

General | View | File Types Offine Files

¥ xaj Usze Offine Files to work with files and programs stored on the
[ network even when you are not connected.

Enable Offiine Files

[[]Synchronize 2l offine files when logging an
[] Synchronize all offine files before logging off
[] Display a reminder every:

6015 minutes

[ Create an Offine Files shortcut on the desktop

[ ] Encrypt offiine files to secura data
Amount of disk space to use fortemporary offine files:

J 1.93 GB (2% of drive)

!Dele‘.anes ]l View Files ], Advanced

I 0K | | Cancel J

4. Click OK.

After Offline Files and Folders has been configured, a user will be able to cache files that are
shared on the network servers, as long as the network administrator has made them available for
caching. Exercise 2.18 walks you through the process making files and folders available offline
while working on them.

Making Files and Folders Available Offline

1. Browse to the file or folder on the network server, right-click the file or folder, and then
select Make Available Offline.

2. In the Offline Files Wizard, click Next.

3. Select the Automatically Synchronize The Offline Files When | Log On And Log Off My
Computer check box, and then click Next.

4. If you wish to create a shortcut on your desktop, select the Create A Shortcut To Offline
Files Folder On My Desktop check box.

5. Click Finish.
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Users can cache files and folders from network servers only if they are available for caching.
File caching is used both to enhance network performance and as part of Offline Files and Fold-
ers. To troubleshoot a user’s ability to cache a file or folder, you must understand the options
that can be set on the computer where the file or folder resides. There are three options available
for cache settings, as follows:

Manual Caching Of Documents Manual caching of documents provides caching only to
those files that users specifically identify for offline use. Manual caching is the default setting
when you create a share. This option is ideal for a shared folder that contains files that may be
cached and modified by several users.

Automatic Caching Of Documents With this setting, every file that is opened through a share
is automatically cached to the client computer. When you open a cached copy of the share, the
cached copy on the computer is used but the original folder is also opened to prevent other users
from changing the file while you have it open.

Automatic Caching Of Programs And Documents This setting provides automatic, read-only
caching of files from the share. This is ideal for shares that contain static configuration files for
network-based applications.

You may not have the permissions to adjust the settings for the caching of shared folders on
another computer or server. You should, however, understand what is involved in case you need
to adjust the settings or escalate the issue to the network administrator. Exercise 2.19 walks you
through the steps involved in configuring the caching settings on a shared folder.

Configuring Caching Settings
1. Right-click the shared folder in My Computer or Windows Explorer, and then choose Properties.
2. Click the Sharing tab, and then choose Caching.

3. Select the appropriate caching setting based on your use of the shared folder, and then
click OK.

Caching Settings @
.:J You can specify if and how files within this shared folder are cached
= locally when accessed by others.

[+#] Allow caching offiles in this shared faldar

Setting: il‘ﬁanuaicaching of documents w |

Automatic caching of documents
Automalic caching of programs and dacuments
Rec{Manual caching of documents

Users must manually specify any files they want available when working
offine. To ensure proper file sharing, the server varsion of the file is
abways opened.

OK ] | Cancel
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) You can also disable file caching for a share by clearing the Allow Caching Of
TE File In This Shared Folder check box in the Caching Settings dialog.
Synchronization

Synchronization is the process of ensuring that shared folders and the offline copies of the fold-
ers have the same content. This process takes place automatically when a computer containing
offline content is logged on to or off of a network. You can also configure the synchronization
to take place at scheduled times or based on an interval.

Most of the time, synchronization should be automatic, but users might have an issue if the
shared resource changes while the computer containing the offline content is disconnected from
the network. During synchronization, the operating system compares the two copies of the
folder and, depending on the states of the two copies, makes a decision itself or gives the option
to the user. You should always instruct users to retain a file if they are not sure what to do.
Table 2.6 illustrates the decision process for synchronization.

TABLE 2.6 Offline File Synchronization

Offline File State Shared Copy State  Result

Changed Not Changed OS updates the shared copy with the offline copy.
Not Changed Changed OS updates the offline copy to reflect the changes.
Changed Changed User can choose to keep either or both copies.
Deleted Not Changed OS deletes the file.

Deleted Changed User can choose to delete the shared copy or replace

the offline file with the shared copy.
Not Changed Deleted OS deletes the offline file.

Changed Deleted User can choose to save the file or delete it.

Summary

Networks are created to share resources and thereby increase productivity within an organization.
A desktop support technician must understand how resources are shared and how permissions
affect a user’s ability to use them. Resources that can be shared include files, folders, and printers.
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Permissions can be assigned directly to files and folders on NTFS partitions using NTFS per-
missions. These permissions can be used to allow or deny access to a resource for a user or a
group of users based on security group memberships. Permissions assigned to a folder are auto-
matically inherited by the files and folders within that folder; but you can control this inherit-
ance using advanced security options. The main goal is to give transparent access to resources
for users who need access, while at the same time preventing access to those who are not autho-
rized. You may be called in to troubleshoot a situation where this goal has not been achieved.

File and folder permissions are only one piece of the puzzle that makes up the true effective per-
missions for a user to a resource. Another piece of the puzzle is shared folder permissions. While
NTFS file and folder permissions control a user’s access to a resource from a local logon or through
the network, shared folder permissions control a user’s access to a resource only through the net-
work from another computer. True effective permissions for a user to a resource are a combination
of NTFS permissions and shared folder permissions. You should also remember that Deny permis-
sions override Allow permissions, unless the Allow permissions are assigned directly to the resource
and the Deny permissions are inherited through a folder hierarchy.

Another resource that users share on a network is a printer. A printer is actually software that
controls the print drivers that send the print job to the print device. Since a printer is software, access
to a printer can be controlled using permissions. Printer permissions can be assigned directly to a
printer through the Printers and Faxes tool in Windows XP. Printer permissions are not inherited.
Users should be able to use the printers that they need in a transparent fashion. Some printers may
be restricted for use by only specific users and groups. As a desktop support technician, you should
know how to redirect a printer and its queue to another port and thereby another print device. In
addition, you should know how to stop and restart the print spooler. Your understanding of printer
permissions and printer troubleshooting is essential to ensure user productivity.

In today’s business world, many users work from outside the office, in their homes or from
a hotel “on the road.” While they are in the office, they may synchronize their laptops with files
and folders from the servers, caching the information onto their hard drives. When they leave
the office, they will use these cached files and folders as if they were still connected to the servers.
When they return to the office, they will resynchronize the files and folders on their laptop with
those on the servers. If both of the copies of the files have been changed, then the user will be
asked to make a decision as to which one to keep. While this may seem simple, it can bring up
some interesting situations that could potentially result in data loss if you are not careful. You
should understand how to set up file caching for offline files and folders and how to trouble-
shoot their use when necessary.

Exam Essentials

Understand NTFS permissions. You should understand NTFS permissions for files and
folders. Your understanding should include standard and special permissions, as well as per-
mission inheritance. You should also be familiar with the new Effective Permissions tool in
Windows XP. Be aware that this tool calculates only the effective NTFS permissions of a user
or group to a resource.
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Understand shared folder permissions. You should understand shared folder permissions in
Windows XP. This includes simple file sharing and classic file sharing. You should know when
each type of file sharing is appropriate and when simple file sharing cannot be used. In addition,
you should be aware of how shared folders are created and configured in Windows XP.

Know how to determine effective permissions. You should understand how NTFS file and
folder permissions combine with shared folder permissions to create the true effective permissions
of a user or group to a resource. You might be asked to determine the effective permissions given
a combination of permissions assigned to a user and to groups of which the user is a member.

Understand printers. You should understand what printers are, how they are installed and
configured, and how to troubleshoot them. Your understanding should include printer permis-
sions, printer drivers, and troubleshooting printers. You should be able to redirect a printer to
another port and restart the print spooler when necessary.

Understand Offline Files and Folders. You should know how to configure Offline Files
and Folders on the client software and how to troubleshoot the settings when necessary.
Your understanding should include file caching, encryption, and permissions of Offline
Files and Folders.
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Review Questions

1. You are the desktop support technician for a large company. A user named Joe is having a prob-
lem accessing a folder and the files within the folder. Joe tells you that he has just been promoted
this morning and that the network administrator assured him that he has changed the permis-
sions on Joe’s account so that he has access to the folders that he needs. Joe says that he doesn’t
notice a bit of difference between now and when he received the promotion this morning. What
should you do first?

A. Contact the network administrator and ask him to verify all of Joe’s permission settings
and make sure that he has removed Joe from his previous groups.

B. Place a request to change Joe’s username so that he can access the resources.
C. Contact Human Resources to see if Joe’s promotion is effective.
D. Tell Joe to log off and then log back on again.

2. You are the desktop support technician for a large company. A user named Tara has recently
been moved from the Sales department to the Marketing department. She is having a problem
accessing the folders that she needs for her new job. She has logged off and back on again, and
you have determined that Tara is a member of the Marketing group and that the Marketing
group has the appropriate permissions for the folders. After some research, you are able to deter-

mine that, for security reasons, all Sales personnel are explicitly denied access to the Marketing
department files. What should you do next?

A. Tell Tara to log off again and log back on again.
B. Ask the network administrator to double-check the membership of the Sales group.
C. Remove Tara from the Marketing group and assign the permissions directly to her account.
D. Restart the Marketing department servers.

3.  Youare the desktop support technician for a large company. A user named Sam complains that
he cannot access a file in a shared folder that he was able to access yesterday. To his knowledge,
nothing has changed about his account. He is able to access all other files as normal, including

other files in the same folder as the file that he cannot access. He says that he is receiving a simple
error message that says, “Access is denied.” What should you do first?

A. Contact the network administrator and ask about any changes in NTFS permissions to
the folder hierarchy that the user is accessing.

B. Tell Sam to log off and log back on again.

C. Escalate the issue to the network administrator and tell him that you suspect that the
file has been encrypted by another user.

D. Tell Sam to restart his computer and then log back on and try again.
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You are the desktop support technician for your organization. A user complains that he can view
files in a shared folder on a server through the network but that he cannot change the files. You
view the user’s permissions using the Effective Permissions tool and find that he has NTFS effec-
tive permissions of Allow Write for the folder and its files. What should you do next?

A. Ask the network administrator to change the NTFS permissions to Allow Modify.

B. Tell the user to try to access the resource from another client computer.

C. Determine the effective shared folder permissions for the resource.

D. Ask the network administrator to change the NTFS permissions to Allow Change.
You are the desktop support technician for a large corporation. A user named Darla com-
plains that she cannot access a shared folder on a Windows XP client computer logged on
to a domain. You suspect that NTFS permissions might be involved. You access the shared

folder, but when you right-click the folder, there is no Security tab. Which of the following
could be true? (Choose all that apply.)

A. The computer is using simple file sharing.

B. The share permissions are overriding the NTFS permissions so that you cannot see them.
C. The computer needs to be restarted.

D. The partition that contains the shared folder is formatted with FAT32.

You are the desktop support technician for a large organization. A user named Sally complains
that she cannot print to a printer that she is in charge of maintaining. She can pause and resume
the printer and she can control documents sent by other users, but she cannot send a document

to the printer herself. You want to make sure that Sally can print to the printer but that she can-
not adjust the properties of the printer. What should you do next?

A. Ask Sally to try to print to another printer.
B. Ask the network administrator to add Print to Sally’s permissions for the printer.

C. Ask the network administrator to add Manage Printers to Sally’s permissions for
the printer.

D. Restart the print spooler.
You are the desktop support technician for your organization. A user reports that when he prints

to a network printer the printout has illegible characters and there are only a few characters per
page, with many pages. What do you suspect is causing the problem?

A. The network connection to the printer is damaged.
B. The user’s computer does not have enough RAM.

C. The driver for the printer is incorrect or corrupt.
D

. The print spooler has run out of space.
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You are the desktop support technician for your company. A user named Donna reports that she
cannot print from the application that she is using. You walk her through printing a test page from
the Windows XP software on her computer, and it prints normally. Which of the following should
you do next?

A. Tell her to go to the print device and walk her through printing a test page on the print
device itself.

B. Reinstall the Windows XP operating system software on her computer.

C. Reinstall the printer on her computer.

D. Reinstall the application on her computer.

You are the desktop support technician for your company. A user named Hal complains that he
cannot get some shared folders and files that he is using to cache onto the hard drive of his lap-

top, which is configured to use offline files and folders. Other folders and files cache normally.
What should you suspect?

A. Hal does not have permission to use the share.

B. Hal’s computer is not properly configured.

C. The network administrator has prevented some files and folders from being cached.
D. The files and folders are encrypted by another user.

You are the desktop support technician for your company. A user suspects that Offline Files and
Folders is not working properly. She asks you what should happen if a file that she has cached

on her laptop is changed on the server while she is out of the office. What should you tell her?
(Choose all that apply.)

A. Tt depends on whether you have changed your cached copy of that file or not.
B. The file on the server will always take precedence over the cached copy.

C. You will get a choice if you have changed your copy as well; otherwise, the new server
copy will replace your cached copy.

D. The file that was changed last will always take precedence.
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Answers to Review Questions

1.

D. Joe was evidently logged on when the network administrator changed the permissions that
affect his account. He will need to log off and then log back on to receive his new access token. If
logging off and then back on again does not fix the problem, then you may want to escalate it to
the network administrator, but this should not be your first step. Joe’s promotion being effective
at Human Resources has nothing to do with his effective permissions to the resources.

B. The Sales group is explicitly denied access to the Marketing department files; therefore, if
Tara is still in the Sales group as well as the Marketing group, the explicit Deny will override all
of the Allow permissions that she has from the Marketing group. You should politely ask the
network administrator to double-check and make sure that he removed Tara from the Sales
group. Tara will have to log off and log back on again once the permissions are fixed, but this
should not be the first step. Removing Tara from the Marketing group will not fix the problem.
Restarting the Marketing department servers will not fix the problem.

C. Since the error message reads “Access is denied” and has no other information, such as the
name of the folder or file that he was attempting to access, you should suspect that the file has
been encrypted by another user and escalate the issue to the network administrator. Based on the
error message and the fact that Sam can access all other files and folders normally, this is prob-
ably not an NTFS issue. Restarting the computer or logging off and then back on again will not
fix this problem.

C. The true effective permissions of the user to the shared folder are the most restrictive permis-
sions result between the effective NTFS permissions and the effective shared folder permissions.
In this case, the effective shared folder permissions are probably only Allow Read, which would
explain why he can view the files in the folder but he cannot change them. Changing the user’s
NTES permissions to Allow Modify will not affect the shared folder permissions and therefore will
not affect the true effective permissions. Trying to access the resource from another computer will
not fix the problem. Allow Change is a shared folder permission and not an NTFS permission.

D. If you right-click the folder and there is no Security tab, then one of two things is true: Either
the computer is using simple file sharing or the partition is not formatted with NTFS. In this
case, however, the computer is logged on to a domain and therefore cannot use simple file shar-
ing. The share permissions cannot prevent you from seeing NTFS permissions. Restarting the
computer would have no effect.

B. Since Sally has only Manage Documents permission for the printer, she cannot print to the
printer; therefore, you should ask the network administrator to add Print permission to Sally’s
permissions for the printer. Adding the Manage Printers permission would allow Sally to change
the properties of the printer itself; therefore, you should not add the Manage Printers permis-
sion. Restarting the print spooler will not affect Sally’s permissions for the printer.

C. When a user’s printout has illegible characters and only a few characters per page, you should
suspect the printer driver first. A damaged network connection would not cause this symptom,
nor would a computer’s not having enough RAM. A print spooler that has run out of space
would not create this symptom.
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D. Since the test page from the Windows XP software printed normally, you can exclude the
Windows XP operating system, the printer, and the print device itself from being part of prob-
lem. This isolates the problem to the application. You should save her documents and reinstall
the application on her computer.

C. The network administrator must have cleared the check box setting on those folders and files
that allows them to be cached. Since Hal is currently using the folders and files, you know that
he has permission to use them and that they are not encrypted by another user. Since he can
cache some folders and files normally, his computer is configured properly.

A, C. If a cached copy of a file is not changed but the original shared file is changed, then the new
shared file original will be updated to the cache when the user performs a synchronization. If
both the original shared file and the cached copy are changed while the client is offline, then the
operating system will display a dialog box giving the user a choice of which file to keep or even
to keep both files on their next synchronization.
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There are many components in a typical computer that have little
to do with the actual computations that the computer performs.
The purpose of these components is to make it possible for us to
store information on and communicate with the computer and to make it possible for the com-
puter to communicate with us. Examples include hard drives, CD-ROM drives, monitors, and
input/output devices such as keyboards and mice.

Each of these components typically has a hardware element and a software element. The
hardware element is either installed in or connected to the computer for an express purpose.
The software element is in the form of a driver that allows the hardware to communicate with
the operating system. As a desktop support technician, you should understand how to configure
and troubleshoot these devices and their drivers. You should also be able to answer questions
from end users regarding these devices. Hardware devices can be divided into four categories:

Storage devices A storage device is any device that is installed in or connected to a computer
for the purpose of storing data. There are two main types of storage devices: fixed and remov-
able. Hard disks that are installed in a computer are considered to be fixed storage devices. All
others are considered to be removable storage devices. You should be able to configure and
troubleshoot both types of storage devices.

Display devices A display device produces visual output that a user can see and interpret. This
output can be in the form of text, menus, or images on a screen. This visual output provides a
way for the computer to communicate with the user and is also a large part of the graphical user
interface (GUI) that the user controls to communicate with the computer. Display devices have
evolved over time. A typical organization has many types of display devices. You should be able
to recognize, configure, and troubleshoot the most common display devices.

Advanced Configuration Power Interface (ACPI) Advanced Configuration Power Interface
(ACPI) is an open industry specification that defines a flexible method of controlling power to
components on a system board. ACPI is installed automatically with Window XP, as long as all
of the components in the computer can function with ACPI. ACPI can also be used with some
prior operating systems, such as Windows 2000 Professional. While ACPI can provide a useful
service (especially for a laptop user), it can also be the source of a troubleshooting headache when
the computer has legacy components that do not support ACPL. You should know how to con-
figure ACPI for a user and answer user questions regarding ACPI. You should also be able to
recognize a problem caused by ACPI and troubleshoot the problem appropriately.

Input/output (I/O) devices An input/output (I/0O) device is any device that can send and receive
data to and from a computer. I/O devices have evolved over time and now come in many different
forms depending on their purpose. An I/O device can be something as simple as a mouse or a key-
board or something much more complex, such as an infrared port on a laptop. You should be able
to configure and troubleshoot the most common I/O devices and their drivers.



76 Chapter 3 -« Configuring and Troubleshooting Hardware Devices and Drivers

The rest of this chapter will focus on configuring and troubleshooting the four main catego-
ries of hardware devices and their drivers.

Storage Devices

The computers that we use are capable of processing tremendous amounts of data. After the
data is processed, it is then stored in some format so that we can view and use it. Any device that
stores the data for a computer is called a storage device. A computer may have many different
types of storage devices depending on the type of computer and its use.

We can divide all storage devices into two categories: fixed and removable.

Fixed Storage Devices

Hard drives installed in a computer are commonly recognized as fixed storage devices. The
word recognized is important here because many client computers and servers actually have
removable hard drives. Even if a hard drive is removable, Microsoft still refers to it as a fixed
storage device.

Hard disk storage can also be divided into two categories: basic and dynamic. Basic disks
have been around since the earliest operating systems, while dynamic disks were new with
Windows 2000 operating systems. We will now discuss the difference between basic disks
and dynamic disks, how to configure dynamic disks, and how to troubleshoot dynamic disk
configurations.

Basic Disks

Basic disks started with the earliest Microsoft operating systems. When you first install any
operating system, including Windows XP, the disk that it is installed on is a basic disk. When
you install a new disk into a computer, it is, by default, a basic disk.

Basic disks have limitations that dynamic disks do not have. For example, you must divide
a basic disk into primary partitions and extended partitions. Extended partitions can further be
divided into logical drives. Both the primary partitions and the extended partitions must be rep-
resented with a letter in the alphabet (A-Z). This would limit the number of logical divisions on
a computer to 26 (the number of letters in the alphabet); however, it’s even worse than that! The
letter A is universally considered to be the 312" floppy drive of the system, while the letter B is
considered to be the 51/4" floppy drive or a second 31/2" floppy, neither of which often actually
exists on the computer. Therefore, if you use only basic disks, you can have only 24 logical divi-
sions (primary partitions or logical drives on the extended partition) no matter how many drives
you have or how much drive space you have. While this might not seem like much of a limitation
to most client computers, it can be a significant limitation to servers and specialized client com-
puters that need many drives.

Another major limitation of basic disks is that their partitions cannot be extended (made
larger) using the operating system software. This means that even if you have a large amount
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of unallocated space that is contiguous to a partition, you cannot extend the basic disk’s parti-
tion into that space using the operating system software. It also means that you might not get
the best efficiency from a disk using only the operating system tools. Finally, you cannot join
basic partitions to form larger volumes, as you can with dynamic volumes on dynamic disks.

) It is possible to extend basic partitions using third-party software such as
TE PowerQuest’s Partition Magic.

Dynamic Disks

A dynamic disk is a hard disk that contains dynamic volumes. Now, you might ask, “How did
the volumes become dynamic?” Well, the volumes became dynamic when we converted the disk
to a dynamic disk using the Disk Management tool, shown in Figure 3.1, included with all oper-
ating systems later than Windows 2000. Exercise 3.1 walks you through the steps to convert a
disk from basic to dynamic.

FIGURE 3.1 The Disk Management Tool
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Converting a Disk from Basic to Dynamic

1. From the Windows XP Desktop, right-click My Computer, and then choose Manage.
2. Inthe Computer Management MMC, expand Storage, and then choose Disk Management.

3. After the disk configuration has loaded, right-click the disk that you wish to convert. Note
that the disks are labeled toward the left side of the tool.

4. Choose Convert To Dynamic Disk.

5. Ifyouhave morethan one disk, then you can select to convert multiple disks at once. Select
all the disks that you want to convert and click OK.

Convert to Dynamic Disk @
Selectone or more basic disks to convertto dynamic disks
Disks:
WEDisk 0
[ Disk1
I OK ] [ Cancel ]

6. Follow the remaining directions of the wizard; you may need to restart your computer
twice to complete the process.

Now you might also be asking, “Why do I want to convert my disks from basic to dynamic?”
Well, you might not want to convert them at all, but if you do convert them you will receive the
following benefits:

*  You can name the volumes anything that you wish and have as many volumes as your disks

will hold.

= You can extend any dynamic volume that was originally formatted with NTFS as long as
it is not a system volume or a boot volume.

*  You can configure other special types of volumes that combine dynamic volumes for spe-
cific purposes. These include striped volumes, spanned volumes, and mirrored volumes.

Configuring Dynamic Disks

The types of dynamic volumes that you configure on your dynamic disks will depend on your spe-
cific use for the disk. Some dynamic volumes improve input/output (I/O) performance, while oth-
ers provide fault tolerance. There are five types of dynamic volumes that you can configure on a
dynamic disk. In this section, we will describe each type of dynamic volume and discuss its use.
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Simple A simple volume consists of a single region on a hard disk or multiple regions on the
same hard disk that are linked together. Simple volumes are not fault tolerant within them-
selves, but they can be mirrored with other simple volumes.

Spanned A spanned volume consists of disk space on more than one hard disk. The size of
the spanned volume has been increased by extending it onto additional dynamic disks. Spanned
volumes are not fault tolerant. When spanned volumes are filled with data, the first disk is com-
pletely filled before data is written to the second disk...and so on.

Striped  Striped volumes are composed of “stripes” of data of equal size that are written across
all of the disks in the volume. Striped volumes write to all disks in the volume at the same time,
alternating between the disks as they stripe the information across the volume. Therefore,
striped volumes improve disk drive I/O performance because I/O requests can be distributed
across multiple hard disks. Striped volumes do not offer any fault tolerance.

Mirrored A mirrored volume is a fault-tolerant volume that duplicates data on two separate
hard disks. All data is written twice, once to each hard disk. If one of the disks should fail, the
other disk will still contain the needed data. Mirrored volumes are sometimes used to create
fault tolerance for the operating system files themselves.

RAID-5 A Redundant Array of Inexpensive Disks (RAID-5) volume is a special type of striped
volume that creates fault tolerance as it stripes the data. The additional data coupled with the par-
ity information to rebuild the disk is striped across all of the disks in a RAID-5 volume. Parity data
is striped across the disks based on a mathematical calculation, such that if one (and only one) disk
fails, the parity data that is on the other disks can be used to keep the system running and to even-
tually rebuild the information on the disk when it is replaced with a new disk. RAID-5 volumes
are generally used to store large amounts of data that is essential for an organization. Software
RAID-S is supported by Windows XP Professional and by all Microsoft server operating systems.
Hardware RAID-5 solutions are also available from third-party manufacturers.

Troubleshooting Fixed Storage Devices

Most client computers have only one hard disk installed. When the disk fails or becomes cor-
rupted, the computer will not start. Sometimes the system will report an error that you can inter-
pret. At other times, it may show a stop error screen, referred to as a “blue screen of death.”
Some client computers and most servers have multiple disks that may be dynamic or basic. You
should know how to troubleshoot the most common errors for all types of storage devices
including startup errors, stop errors, and errors related to dynamic disks. In this section we will
describe each type of error that you might encounter with Windows XP client computers and
discuss how to troubleshoot each one.

Startup errors

If the computer is unable to locate the active partition or the boot sector volume that contains
the operating system files, the user could receive one of these startup error messages:

= Invalid partition table
= Missing operating system

= Error loading operating system
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If the computer cannot locate and load the NT Loader (NTLDR), the user could receive one
of the following startup error messages.

= A disk read error occurred.
= NTLDR is missing.
= NTLDR is compressed.

Both of these issues might be resolved by using the Recovery Console that is included
with the Windows XP operating system. Exercise 3.2 walks you through the steps to use the
Recovery Console.

Troubleshooting with the Recovery Console

1. Assure that the BIOS boot sequence is configured to recognize the CD-ROM before the
hard drive.

Start or restart the computer with the Windows XP CD in the CD-ROM drive.
At the Welcome to Setup screen, press R (for repair) to start the Recovery Console.
Type fixboot to replace the boot partition or fixmbr to replace the master boot record.

Follow the prompts to complete the fix.

o o & w0 N

You can also type help to see all of the commands available from the Recovery Console.

Stop errors

Sometimes Windows detects an error from which it cannot recover. This may be at startup or even
while the computer is running. Windows reports this error in a full blue-screen non-windowed text
mode. These “blue screens of death” sometimes provide information that is specific to the problem
that caused the stop error. You should read the screen carefully and then search the Microsoft
Knowledge Base at microsoft.com/support or Microsoft Technet at mi crosoft. com/technet.
You should enter as much information as you can about the error to obtain the best results.

Dynamic disk errors

You can troubleshoot most errors regarding dynamic disks using the Disk Management tool
included with Windows XP. The Disk Management tool reports the status of each disk in a
computer. Based on the status of the disk, you should be able to resolve the problem. The fol-
lowing is a list of possible statuses for a disk, their cause, and their resolution.

Foreign This status occurs when you install a new disk or a disk from another computer. Since
the computer does not recognize the disk as one of its own, it is considered foreign. You should
right-click the disk and then choose Import Foreign Disks.

Missing/Offline This status occurs whenever a dynamic disk becomes inaccessible. Missing
means that the system has recognized the disk before but can’t find it now. Offline may mean
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that the disk was not available on the last startup. To bring a disk with a status of Missing or
Offline back online, you should do the following: 1) Repair any hard disk, controller, or cable
problems and confirm the physical status of the disk. 2) In Disk Management, right-click the
disk and then choose Reactivate Disk. 3) If the disk does not come back online, then you will
need to replace the disk and import the new foreign disk.

Not Initialized This status indicates that the disk does not contain a valid signature in the mas-
ter boot record (MBR) or a valid disk globally unique identification (GUID) in the GUID par-
tition table. You should right-click the disk and choose Initialize Disk.

Online (errors) This status indicates that I/O errors have been detected on the disk. You may
be able to repair the errors by right-clicking the disk and then choosing Reactivate Disk.

Unreadable This status occurs when the system can see the disk but the disk is encountering
errors that make it inaccessible. This situation can happen for many reasons, including a cor-
ruption in the disk, a hardware failure, or I/O errors. You should attempt to resolve this issue
by rescanning the disk. Open the Disk Management tool, choose Action, and then choose
Rescan Disks.

Removable Storage Devices

Remouvable storage devices include all types of storage devices except hard drives. There are
many different types of removable storage devices, including floppy drives, CD-ROMs, DVDs,
tape drives, and flash drives. Most of these types of drives are maintenance free and rarely
require troubleshooting of any kind. However, if any drive is powered by a Universal Serial Bus
(USB) port, you should make sure that the device has enough power to operate. If the device
that is malfunctioning is connected to a hub, then you should consider moving its connection
to the computer to give it more access to power.

A USB device that works well on its own but does not work well when other

P devices are used simultaneously could indicate a lack of adequate power. In
this circumstance, rearranging devices or providing another powered hub are
your best choices.

Display Devices

Display devices have evolved over time and with changes in technology, but the old ones and the
new ones all do the same things: They let us know what the computer is “thinking” and they give
us a way of communicating with the computer. There are several types of display devices in most
organizations. In this section we will discuss each of the most common display devices that can be
used with Windows XP. In addition, we will discuss configuring and troubleshooting the display
settings in Windows XP.
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Types of Display Devices

The following are types of display devices that you might encounter in your network.

CRT monitor Cathode-ray tube (CRT) monitors are based on the same technology as most of
today’s televisions. They are the most common type today, but they will probably be superseded
by other types of monitors in the future. An advantage of CRTs is that they are inexpensive
compared to other monitors. Disadvantages include the fact that they are large and bulky and
that they create heat.

Flat-panel monitor Flat-panel monitors are growing in popularity. These are typically pow-
ered by liquid crystal displays (LCDs) or plasma gas displays. Flat-panel monitors are not as
bulky as CRTs and they do not create heat. While the price of flat-panel monitors is dropping,
they are still considerably more expensive than CRTs.

Multimonitor Windows XP can support up to 10 monitors at one time. While you are unlikely
to use 10 monitors on Windows XP, it is sometimes useful to have a second monitor that can
be used in tandem with the first. You can drag and drop images from one monitor to the other
to create the desktop arrangement that you need.

Tablet PC  Tablet PCs typically feature a touch-sensitive LCD screen that can be rotated for
Landscape and Portrait views. They are becoming more popular for users who need a very
mobile device. Tablet PCs generally incorporate handwriting recognition so that the user can
enter information with a special pen.

Smart displays Smart displays are wireless touch-screen monitors that enable you to access
your computer from anywhere within your wireless range. All of the actual computing is done
on the computer with which the smart display communicates.

Display Settings

Users can configure display settings in Windows XP to customize the look of their computer.
As a desktop support technician, you should be able to recognize an errant display setting and
reset the computer for the user. You should also be able to troubleshoot display problems
using VGA mode. Finally, you should be able to recognize and troubleshoot problems related
to DirectX. In this section, we will discuss the types of display settings found on Windows XP
and how to troubleshoot these display settings. We will also define Windows DirectX and dis-
cuss specific troubleshooting scenarios with DirectX.

Types of Display Settings

Using the tools provided by Windows XP, users can customize their display so that it is comfort-
able for them. Most of the time, this is a good thing; however, if a user applies the wrong settings
and then doesn’t know how to reverse the process, then you may be called in to troubleshoot the
problem. The display settings that may have been changed by the user include the following;:

= Background: This setting changes the desktop’s background color, pattern, and image.
You can also use this setting to apply an active desktop and use an HTML document for
the background.
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Screen Saver. This setting is used to save a monitor from “burnout” by automatically
running a pattern or program on the monitor when the keyboard and mouse have not been
used for a specified period of time. These are only necessary for CRT’s, since LCDs do not
have a problem with “burnout.”

Appearance: This setting adjusts the color, text, and icon spacing for windows and menus.

Screen Resolution: This setting controls the size and display of the screen, which is mea-
sured in pixels.

Color Depth: This setting controls the number of colors that can be displayed on the screen.
A higher color depth makes a more realistic picture.

Themes: This setting defines many aspects at once, including background image, icons,
sounds, mouse pointers, and other elements that personalize the desktop for the user.

Refresh Rate: This setting controls the frequency with which the screen is completely
retraced. A higher refresh rate can reduce monitor “flicker” and make the monitor
more comfortable to use. You should ensure that the hardware can support the refresh
rate that is set.

Troubleshooting Display Settings

Most of the display settings that a user might inadvertently change are located in the same area. To
obtain access to the display settings, you should right-click the desktop and then choose Properties.
If a user has made a change that is affecting his display, you will likely be able to correct the problem
by examining the settings on each of the tabs in the Display Properties dialog box, as shown in
Figure 3.2. You can begin to develop a more informed user by telling him that he can right-click the
setting buttons and then choose What’s This? to view more information about that setting.

FIGURE 3.2 The Display Properties dialog box

Display Properties R
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Troubleshooting in VGA Mode

Sometimes just knowing where you would change the display settings does you no good at all,
because when you start the computer there is no Windows display and therefore no way to find
any display settings. This problem can be caused by a screen resolution setting that the monitor
cannot handle or by an improper driver. This issue can often be resolved by restarting the com-
puter in VGA mode to make the necessary changes. Exercise 3.3 walks you through the steps

to troubleshoot a system that has no Windows display.

Troubleshooting a System with No Windows Display
1. Ensure that the monitor has power and that the video cable is attached to the computer.
2. Ensure that the Brightness and Contrast settings are in their center position.

3. Restart the computer, pressing F8 after the computer finishes the startup messages but
before Windows starts up.

4. Select Enable VGA Mode.

5. Examine the Screen Resolution setting and reduce it to 800 x 600 if necessary.

| Display Properties mw

Themes | Deskiop | Screen Saver Appearance Sefings |

Dizplay:
NEC MultSync X\V17+ (-2) on NVIDIA GeForce2 MX/MX 400
Screen resolution Color quality
Less Uy More |Highest (32 bi [¥]
800 by 600 pixels I N B m
|_Tm..|-- h J L Ad d J
i 0K I [ Cancel l

6. Attempt to restart the computer normally.

7. Ifthe Windows display still does not return, then you will need to reinstall the video driver.
Follow the manufacturer’'s recommendations to uninstall and reinstall the video driver.
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Troubleshooting Microsoft DirectX

Microsoft DirectX is an advanced suite of multimedia application programming interfaces
built into Microsoft Windows operating systems. Introduced in 1993, it provides a standard
development platform for Windows computer programming for specific tasks such as three-
dimensional graphics (3D), video acceleration, joystick controls, and sound cards. Yes, as you
may have guessed, it’s mostly for games, but some business applications such as interactive
video programs for training might also use DirectX.

As a desktop support technician, you might have to troubleshoot an application that will not
install properly and indicates an error relating to DirectX. You should know how to determine
the version of DirectX that is installed in the computer. You should also know how to trouble-
shoot the system, either eliminating DirectX as the real cause of the problem or identifying the
problem within DirectX.

Fortunately, DirectX comes with its own diagnostic tool. You can use the DirectX Diag-
nostic tool to test video, sounds, joystick control, and communication. Using the DirectX
Diagnostic tool, you can isolate the problem within DirectX or eliminate DirectX as a possible
source of the problem. Exercise 3.4 walks you through the steps to use the DirectX Diagnostic
tool to troubleshoot a system.

Advanced Configuration Power
Interface (ACPI)

All of the components of a computer consume electricity to perform their functions. Processors,
RAM chips, and electric motors are just a few examples of hardware that consume power. In
large organizations, it’s important to conserve power on desktop computers because the savings
are multiplied over many computers. Controlling computer power usage can also have an indi-
rect effect on the costs in an organization; for example, turning off CRTs reduces heat, which
could save on air conditioning costs in the summer.

Laptop computers create another challenge in regard to power consumption. If you charge
a laptop and then use it where you don’t have access to other electrical power, then you want
the battery to last for as long as possible. In this case, you need to have individual control of all
of the major components that consume power, such as the display, hard drives, network inter-
face cards, and so on.

Advanced Configuration Power Interface (ACPI) is an open industry specification that
allows a manufacturer to develop hardware with power interfaces that can be controlled by
software. This allows computer manufacturers to create computers that can “sleep” while you
are not working on them but “wake” at the touch of a button. It is a great feature, as long as
all of the components in a computer are compatible with it. If some of the components are
incompatible, then problems can arise that require troubleshooting. In this section, we will dis-
cuss how to use ACPI to configure power schemes and enable hibernation and standby features.
We will also discuss troubleshooting problems associated with ACPI.
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Troubleshooting with the DirectX Diagnostic Tool

1. On the Windows XP desktop, click Start and then choose Run.

2. Onthe Run menu, type msinfo32.exe, and then click OK.

3. On the System Information menu bar, click Tools, and select DirectX Diagnostic Tool.
4

On the System tab, view the System Information to determine the DirectX version.

£3DirectX Diagnostic Tool M= X

System | DirectX Files | Display | Sound | Music | Input || Metwork | More Help

This tool reports detailed information about the DirectX components and dnvers installed on your system. Itlets you test
functionality, diagnose problems. and change your system configuration to work best

Ifyou know what area is causing the problem, click the appropriate tab above. Otherwise. you can use the "Next Pagse"” bution
below to visit each page in sequence,

The "More Help" page lists some other tools that may help with the problem you are experiencing.

System Information
Current Date/Time: Tuesday. March 30, 2004, 18:13:05
Computer Name: XPCLIENT
Operating System: Microsoft Windows XP Professional (5.1, Build 2600)
Language: English (Regional Sefing: English)
Processor. Intel(R) Pentium(R) Il Mobile CFU  1200MHz
Memory: 382MB RAM
Pagefile: 184MB used, 736MB available
Direct Version: DirectX 8.1 (4.08.01.0810)

DxDiag 5.01.2600.0000 Unicode Copyright® 1998-2001 Microsoft Corporation. All rights reserved.

I Next Page J [ Save All Information... l [ Exit ]

5. Select the DirectX Files tab to determine the DirectX files installed on the computer and
any problems with the files.

6. Use the Display, Sound, Music, Input, and Network tabs to test and control DirectX.

7. Use the More Help tab to find additional troubleshooting information specific to DirectX.

Power Schemes

A power scheme is a collection of power management settings that allows a user to conveniently
configure power management options for individual components on a computer. The options
that can be configured vary based on whether a computer is a desktop or a laptop computer.
You can create and save power schemes that customize the power consumption of devices on
your computer.
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When the computer hardware is ACPI-compliant and the operating system is ACPI-enabled,
as is Windows XP, the user can make changes to power management settings through the var-
ious tabs of Power Options Properties in Control Panel, as shown in Figure 3.3.

The settings available in the Power Schemes tab of Power Options Properties are as follows:

= Turn Off Monitor: This setting specifies the amount of time the computer can be idle (no
keyboard or mouse activity) before the monitor automatically shuts off. This can be used
to save energy in desktops and save battery life in laptops.

= Turn Off Hard Disks: This setting specifies the amount of time the computer can be idle
before the hard disks will automatically turn off. This is primarily used with laptops to save
battery power. It can also provide a quieter laptop for a sales presentation.

= System Standby: This setting specifies the amount of time the computer can be idle
before going into Standby mode (falling asleep electronically, as discussed in detail later
in this chapter).

= System Hibernates: This setting specifies the period of time that the computer will remain
on before it automatically goes into hibernation. You can define a period of minutes or
hours for both the plugged in state and the battery powered state on most laptops. This set-
ting only applies if hibernation is enabled.

FIGURE 3.3 Power Options in Control Panel
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The remaining tabs of the Power Options Properties dialog control various other attributes:
= Alarms: This tab lets you define when a laptop user will be warned about low battery power.

= Power Meter: This tab allows you to show the power meter icon in the Notification area
and display the current power status.

= Advanced: This tab allows a user to set the default options for power buttons on a computer.

=  Hibernate: This tab enables hibernation (discussed in detail later in this chapter) and allows
the user to confirm whether there is enough disk space.

< You can click and hold the power icon in the Notification Area to quickly change
P between power schemes.

Standby vs. Hibernate

Although both Standby and Hibernate can be used to conserve power, there is a huge difference
between these two power management options. As a desktop support technician, you should
understand the differences between Standby and Hibernate and know how to configure a com-
puter for both power management options. In this section, we will contrast Standby and Hiber-
nate and discuss how to configure each of these for a user.

Standby

Standby is an ACPI feature that can switch the entire computer to a low-power state after a set
period of time. When a computer enters Standby mode, devices such as the monitor and hard
disks turn off and the computer then uses less power. Standby settings override the individual
settings for the monitor and hard disk. You can “wake” the computer simply by pressing any
key on the keyboard or moving the mouse.

Standby is typically used with laptops to conserve battery power, but it can also be used for
desktops to conserve power usage. You can configure System Standby in the Power Options
Properties of Control Panel on the Power Schemes tab. You should know that Standby does not
save the desktop to the hard disk, so a power loss during Standby could result in a loss of any
unsaved data.

Hibernate

When you use the Hibernate feature, the computer saves everything that is in memory to the
hard disk and then completely shuts down. When you restart your computer, the system is
restored to the same desktop, exactly as you left it. Hibernate takes longer to restore a desktop
for a user, but it protects the data and completely conserves power.

Since the Hibernate feature uses hard disk space to store the information that is in RAM, you
must have at least as much hard disk available as you have RAM in your computer in order to
configure hibernation. You can configure a computer for hibernation on the Hibernate tab in
the Power Options Properties of Control Panel. Exercise 3.5 walks you through the steps to
enable and configure Hibernate in Windows XP.
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Enabling and Configuring Hibernation in Windows XP

1. Click Start, choose Control Panel, and then select Power Options.

2. Select the Hibernate tab, and then click the Enable Hibernation check box.

‘Power Options Properties @

Power Schemes || Alarms | Power Mater | Advanced  Hibemate

'n - When your computer hibemnates, it stores whatever it has in memaory
\,’ on your hard disk and then shuts down, When your computer comes
out of hibemation, it retums lo its previous slate.

Hibemate

[¥] Enabile hibematian

Disk space for hibemation
Free disk space: 670 MB
Disk space required to hibemats: 3B3IMB

[ OK ] | Cancel

3. The system will confirm whether you have enough free disk space and either configure
your computer for hibernation or advise that you do not have enough disk space.

4. Once hibernation is enabled, select the Power Schemes tab to configure the amount of
time before your computer automatically hibernates.

5. You will now have the Hibernate option whenever you click Start and then choose Turn Off
Computer.

Troubleshooting ACPI

ACPI features should be available automatically as long as the Windows XP operating system
detects a compatible BIOS and compatible hardware and device drivers. Most often ACPI-related
problems have to do with the compatibility of computers that are being upgraded. Common
ACPI-related problems include the following:

*  Aninability to shut down the computer
=  Standby and Hibernate options not being available
=  Problems resuming from standby or hibernation

*  Monitor not resuming after being powered off by ACPI
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@ Real World Scenario
What You Should Not Do with a Laptop!

One day a user brought me a laptop that was hot to the touch! It would not start properly but
instead would begin to start and then restart itself, over and over. There was smell of burned
plastic or rubber in the air around it! | asked him what happened to it and he said, “It was that
way when | took it out of the carrying case.” He said this had never happened to him before and
that he didn’t think he had done anything wrong.

| asked him if the computer might have been on Standby and not turned off completely when
he putitinthe case. He admitted, “That’s possible because | really just threw itin and didn’t pay
it a lot of attention.” He asked me if | thought the thing was “toast.” | told him that we would
give it about 15 minutes to cool off and then try again and hope for the best.

The next 15 minutes were longer for him than they were for me. We left the laptop turned
completely off, by way of the three-second power switch. The smell of burned wires grad-
ually dissipated.

When we turned it back on after 15 minutes, it started up and ran normally! As far as | know,
it still runs. He was really lucky that he opened that case when he did. In retrospect, it was prob-
ably just an overheating processor that made it keep restarting. Once it cooled off it was okay,
although there must be some cooked wire insulation in there somewhere!

Anyway, it's not something that | would recommend that users try! You should instruct users
to make sure that their laptop is either off or fully hibernated before they put it in the carrying
case. That way, they won't have to experience the “long 15 minutes” that he did.

Determining ACPI Compliance in Windows XP

1.  On the Windows XP desktop, right-click My Computer and choose Properties.
2. On the Hardware tab, select Device Manager.

3. Expand the entry called Computer.

PA% Device Manager QE\

Fie Action View Help
-4 W a8 % A
- B %
+ (\} BACKPACK
= i§ Computer
'd ACPI Uniprocessor PC
+ < Disk drives
+ @ Display adapters
+ g DVD/CD-ROM drives
+-i24 Floppy disk controlers
+-.H Flnnw dick drives o
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EXERCISE 3.6 (continued)

4. Examine the expanded entry. If there is a subentry that identifies ACPI, then ACPI is
installed on the computer. If the subentry says Standard PC, then Windows XP did not
detect that the computer was ACPl-compatible.

5. Ifyourcomputer was not detected as ACPl-compatible, examine the Power section of your
computer’s BIOS to determine ACPI capability, or contact the computer manufacturer.

6. If your computer was detected as ACPl-compatible, but you are still having problems
related to ACPI, then make sure that you have the latest drivers for the components
installed in your computer and confirm that the latest Windows XP Service Pack is
installed.

You should first determine whether the operating system has detected that the computer
is ACPI-compliant. You can determine this by examining the Computer properties in Device
Manager. Exercise 3.6 walks you through the steps to determine the ACPI compliance of your
Windows XP computer.

I/0 Devices

Input/output (I/O) devices provide for communication to and from a computer. There are many
ways to connect to and communicate with a computer. Methods of communication have evolved
over time and with advances in technology. Depending on how you use a computer, you may
require more of these types of devices or less of them. The Windows XP operating system allows
you to control which devices are active depending on how a computer is being used. In this sec-
tion, we will discuss the major types of I/O devices and how they provide communication to and
from a computer. We will also discuss how to create hardware profiles to control the use of spe-
cific I/O devices. In addition, we will examine troubleshooting scenarios related to I/O devices.

Types of 1/0 Devices

The following are types of I/O devices that you might encounter as a desktop support technician.

Serial devices Serial communication is the sequential exchange of information between com-
puters and peripheral devices a bit at a time over a single channel. Serial ports on a computer
are sometimes used for pointing devices or for data exchange with personal digital assistants

(PDAs). Devices that connect through a serial port are generally not Plug and Play—compatible.

Parallel devices Parallel communication sends multiple data bits and control bits simultaneously
over parallel wires. It is typically used with printers, scanners, plotters, and some external storage
devices. Devices use a 25-pin connector called a DB-235 to connect to the parallel port of the com-
puter. Devices that conform to the IEEE 1284 standard are Plug and Play—compatible.
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Universal Serial Bus (USB) Universal Serial Bus (USB) is an external bus that supports Plug
and Play installation. Devices can be connected and disconnected without shutting down the
computer or even powering down a port. You can “daisy chain” many types of devices on a USB
connection, including printers, scanners, mice, joysticks, tape drives, keyboards, and cameras.
A single USB port can support up to 127 devices as long as there are enough powered hubs to
provide adequate power for all of the devices.

There are two versions of USB: 1.1 and 2.0. The major difference between the two is that
version 2.0 provides for higher bandwidth and therefore greater speed. USB version 2.0 is
backward-compatible with version 1.1.

< You should know that the most common error in regard to USB-type devices is
P having too many devices on a hub to support the power requirements for the
devices. This can cause intermittent failure of devices.

IEEE 1394 devices [EEE 1394 is an external high-speed serial bus that supports Plug and Play
installation. Also referred to as FireWire, IEEE 1394 is typically used to transfer data from high-
end video and audio equipment. Other devices such as hard disks, printers, scanners, and DVD
drives might also use IEEE 1394.

Modems The term modem comes from the words modulator and demodulator, which refer to
converting electronic signals into sounds and vice versa. A modem is a device that allows com-
puters to communicate over a standard telephone line. Modems typically use an RJ-11 jack, just
like the ones on the walls of most houses.

Infrared (IR) devices Infrared (IR) devices use infrared (below red) light to communicate signals
and transfer data. Infrared communication is point-to-point and line-of-sight communication
between devices. Devices that have an IR port can use Infrared Data Association (IrDA) standards
to communicate. IR ports can often be found on printers, PDAs, laptops, and cellular phones.

Radio frequency (RF) wireless devices Radio frequency (RF) wireless devices are a new stan-

dard that is growing in popularity. RF devices have an advantage over IR devices in that they use
radio waves instead of light and therefore do not require line-of-sight communication. RF capa-
bilities can currently be found in laptops, printers, PDAs, pointing devices, and cellular phones.

Hardware Profiles

You might be thinking, “With all of these I/O options available on a computer, how can I con-
trol which ones the computer will use and when?” Well, Windows uses hardware profiles to
control which devices are used when the computer is started. Windows creates a default hard-
ware profile called Profile 1, which enables every device on the computer. You can modify Pro-
file 1, but the recommended method is to copy the Profile 1 settings to another profile with a
different name and then change the settings to whatever you need. Exercise 3.7 walks you
through the steps to create and configure a hardware profile in Windows XP.
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Creating and Configuring a Hardware Profile

1.  On the Windows XP desktop, right-click My Computer and then choose Properties.
2. On the Hardware tab, choose Hardware Profiles.

3. Assure that Profile 1 is selected, and then click Copy.

.Hirdware Profiles [_?]E'ﬁ

o You can set up hardware profiles for different hardware
w configurations. At startup, you can choose the profile
you want to use.

Available hardware profiles:
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Hardware profiles selection

When Windows starts:

C.] Wait until I select a hardware profile

(@) Select the first profile listad if T don't select a profile in

30 |5 seconds

o ) [ concel ]

4. Type the name for the new profile that you want to create, and then click OK.
5. Close all windows and restart the computer.

6. Atthe Hardware Profile/Configuration Recovery menu screen, select the name of your new
profile.

7. The computer will now boot to your new profile.
8. Right-click on the desktop, and then choose Properties.
9. On the Hardware tab, choose Device Manager.

10. Locate a device that you want to disable for this profile, right-click the device, and select
Properties.

11. In the properties for the device, select Do Not Use This Device In This Profile.

12. Repeat Steps 10 and 11 for each device that you want to configure.
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Troubleshooting I/0 Devices

Most I/O devices are Plug and Play, so they rarely require troubleshooting. If an I/O device is
not functioning properly, the problem could be hardware-related, software-related, or both.
You can isolate the problem by performing some or all of the following actions:

= Check all power cabling and connections related to the device.

= Check for power and connection indicators on the device itself.

= Check that the device is compatible with the Windows XP operating system.
= Make sure that you have the correct drivers installed for the device.

=  For IR devices, make sure that the device and computer are within range and are not in
bright sunlight.

=  For RF devices, make sure that there are no other RF devices in the area that are blocking
or interrupting the signal.

Drivers

Drivers are specialized software programs that allow hardware to communicate with the oper-
ating system. Every device that is installed in or connected to a computer requires drivers. These
drivers usually come packaged with the device but can also be obtained through the manufac-
turer’s website.

Windows XP has new features that ensure that drivers are compatible with the operating sys-
tem and make troubleshooting drivers much easier. You can update to a better driver without
fear of losing the driver that you currently have installed. In this section, we will discuss updat-
ing and rolling back drivers in Windows XP. We will also discuss how Windows XP can assure
compatible drivers with driver signing.

Updating Drivers

Microsoft and other third parties frequently publish updates for device drivers. Some of
these updates provide new functionality, while others fix problems associated with the cur-
rent driver. These updates may come with a CD-ROM from the manufacturer that installs
the driver automatically. You might also obtain the new driver from the manufacturer’s
website and manually install the driver through Device Manager. In addition, some manu-
facturers post their new drivers on Microsoft’s Windows Update website so that you can
download them from Microsoft. In this section, we will discuss these three main methods
of updating a driver.
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Updating Drivers Using a CD from the Manufacturer

This is the simplest form of update. Simply place the CD into the CD-ROM drive and follow
the instructions from the manufacturer. Note that USB devices should typically be disconnected
before you attempt to update their drivers.

Updating Drivers Using Windows Update

To check for updates from the Windows Update website, you can use tools built into Windows XP.
Exercise 3.8 walks you through the steps to update drivers through Windows Update.

Updating Drivers Using Windows Update
1. Ensure that your computer has a connection to the Internet.
2. Click Start, choose All Programs, and then choose Windows Update.

3. Onthe Windows Update site, click Scan For Updates. The system will scan your computer
and suggest the appropriate updates.

4. To select drivers, choose Driver Updates and then click Add. You can review each of the
driver updates and select them individually.

5. When you are ready to install the updates, choose Review And Install Updates, and then
click Install Now.

Updating Drivers Manually with Device Manager

If you obtain a new driver that does not come with an installation disk or a program that auto-
matically installs it, then you can install it manually using Device Manager. Exercise 3.9 walks
you through the steps to update a driver manually using Windows XP Device Manager.

Updating a Driver Using Device Manager

1. On the Windows XP desktop, right-click My Computer, and then choose Properties.

2. Onthe Hardware tab, choose Device Manager.

3. Double-click the device whose driver you want to update, and then select the Driver tab.
4

Click Update Driver.
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EXERCISE 3.9 (continued)

5. Inthe Hardware Update Wizard, select Install From A List Or A Specific Location, and then
click Next.

Hardware Update Wizard

Welcome to the Hardware Update
Wizard

This wizard helps you install software for

WDC WD1728A

| ‘___.} If your hardware came with an installation CD or
floppy disk. insert it now

What do you want the wizard to do?

<3 Install the software automatically (Recommended)

{_) Install from a list or specific location (Advanced)

Click Nextto continue

[ Next > I : Cancel

Select Don’t Search. | Will Choose The Driver To Install. Then click Next.
Select Have Disk, and then click Browse.

Navigate to the folder where the new driver is located, click Open, and then click OK.

© ©® N o

Select the driver that matches your hardware, click Next, click Next again, and then click Finish.

Rolling Back Drivers

If you have ever installed a driver and then wished you had not installed it, then you can appreciate
the new Roll Back Driver feature in Windows XP. The Roll Back Driver feature keeps a cache of
the current driver when you update the driver. If you then decide that the old driver was actually
better, you can select Roll Back Driver and return to the old driver without uninstalling the new
driver or reinstalling the old driver. Exercise 3.10 walks you through the steps to roll back a driver.

Driver Signing

Microsoft uses digital signatures for device drivers to assure users that the drivers are com-
patible with Windows 2000 Professional and Windows XP Professional operating systems.
Digital signatures indicate that the driver has passed the compatibility tests and has not been
altered after testing. You can configure computers to use only signed drivers, but you should
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be aware that your choices of drivers will be more limited. You can also configure the com-
puter to warn you if a driver is not signed but allow the installation if you still choose to install
it. Network administrators can configure these options on all of the computers in an organi-
zation or on a select group of computers. You should be aware of any unsigned drivers that
are allowed to be used by computers in your organization. In this section, we will discuss how
to configure signed drivers in a single computer. We will also discuss how to determine the

signed and unsigned drivers in a single computer.

Rolling Back Drivers in Windows XP
1. On the Windows XP desktop, right-click My Computer, and then choose Properties.
2. On the Hardware tab, select Device Manager.

3. Double-click the device whose driver you want to roll back, and then select the Driver tab.

'WDC WD172AA Properties 7|

General | Policies | Volumes | Driver

gl WDC WD172AA

Driver Provider Microsoft

Driver Date: 72001

Driver Version: 5125350

Digital Signer: Microsoft Windows XP Publisher

To view details aboutthe driver files.
Update Driver... To update the driver for this device.
- if the device fails after updating the driver, roll back
Il
|_RollBack Driver to the previously installed driver
Uninstall To uninstall the driver (Advanced).

OK ‘ | Cancel

4. Click Roll Back Driver.

5. After the system is finished rolling back the driver, click OK to close the dialog box and
save the settings. You may need to restart your computer to complete the re-installation
of the driver.
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Configuring a Computer for Signed Drivers

Windows XP gives you three options in regard to driver signing: Block, Warn, or Ignore. You
decide which one to use based on your own experience and on the availability of signed drivers
for your devices. Exercise 3.11 walks you through the steps to configure Driver Signing options
on a single Windows XP computer.

Configuring Driver Signing Options for Windows XP
1. On the Windows XP desktop, right-click My Computer, and then choose Properties.
2. Click the Driver Signing button.
3. Select one of the following options:
Ignore: To install unsigned and signed drivers without a warning
Warn: To install unsigned drivers after a warning
Block: To prevent the installation of unsigned drivers

4. Ifyou are logged in as an Administrator, you can select or clear the Make This Action The
System Default check box. If checked, the option applies to all users. If unchecked, it applies
only to the current user.

Determining Signed and Unsigned Drivers

If you decide to use only digitally signed drivers from now on, then you will receive the ben-
efit of not having to worry about driver compatibility issues. The cost of this decision will
be that you are limited in the choices that you can make in regard to drivers. Chances are
good that the computers that you are using currently have a mixture of signed and unsigned
drivers. You can use the File Signature Verification tool to determine which drivers in your
computer are signed and which are unsigned. Exercise 3.12 walks you through the steps to
use the File Signature Verification tool.

Using the File Signature Verification Tool

1. On the Windows XP desktop, click Start, and then choose Run.
2. Type sigverif.exe, and then click OK.

3. On the File Signature Verification Wizard, click Start. The system will build a file list and
scan the files.
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EXERCISE 3.12 (continued)

4. When the system has finished the scan, you can view the files that are not signed.

13‘ Signature Verification Results @

The following files have not been digitally signed:

Name In Folder Modified Fie Type Version
b 1001.5y5 c\windows\systems3... 9/2/2001 SYS File MNone
e NEL8511.5ys c:\windows\system3...  12/11/2000 SYS File 2.3.2000.1110
% ad2kgelp.ini c:\windows\system3... 5/14/2003  Configuratio... None
%) ad2kregp.di c:\windows\system3... 5/15/2003  Application E... 6.0.0.1
%) ad2kuigp.dl c:\windows\system3...  5/14/2003  Application E... 6.0.0.1
= adpdfé.ppd c\windows\system3...  5/14/2003 PPD Fie None
(%) mdigraph.di c\windows\system3...  6/18/2003  Application E... 0.3.1897.0
8] mdiui.dil c\windows\system3... 6/18/2003  Application E... 0.3.1897.0
_j pssul.dl c\windows\systems3... 10/6/2002  Application E... 0.3.1282.1
& pscripts.di c:\windows\system3... 10/6/2002  Applcation E... 0.3.1282.1

Close

Fles found: 3099. Signed fies: 2115, Unsigned files: 10, Fles not scanned: 974.

5. You can also use the Advanced options to view the entire log of all files that were scanned.

Summary

A modern computer is a combination of many devices, most of which have little to do with the
actual calculations that the computer performs. Each of these devices has a hardware compo-
nent and a software component called a driver. As a desktop support technician, you should be
able to configure and troubleshoot these devices and their drivers.

Storage devices hold data before and after it is used by a computer. Storage devices can be
divided into two categories: fixed and removable. Hard disks installed in a computer are con-
sidered to be fixed storage devices; all others are removable. Fixed storage devices can be
divided into two groups: basic disks and dynamic disks. Basic disks are the standard, default
form of storing information on a hard drive. Dynamic disks are new to Windows 2000 Pro-
fessional and Windows XP, and they enable new benefits such as expanding a volume on a
disk using only the operating system software. Dynamic disks are required in Windows XP to
create special volumes, such as striped volumes, spanned volumes, and mirrored volumes.

Display devices produce an output that can be viewed and interpreted by the user. Display
devices can provide a graphical user interface (GUI) that enables a user to communicate with the
computer. Display devices come in many forms, such as CRTs, LCDs, and plasma gas monitors.
Windows XP has many settings that allow users to create a custom display based on their pref-
erences. These settings are generally available to the user and therefore may present a trouble-
shooting issue for a desktop support technician. In addition, new technologies such DirectX are
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being employed for games and business applications. These new technologies bring their own
set of issues and their own set of tools to troubleshoot the issues.

Advanced Configuration Power Interface (ACPI) can help you conserve power and get more
life out of the batteries that you use in your laptops. Manufacturers can create hardware and driv-
ers that allow ACPI to control the power of a device. With ACPI you can configure when and how
your monitors, hard drives, and other devices are powered on and powered down. ACPI can also
present a troubleshooting issue, since some devices are not compatible with ACPI. This will most
likely occur when you upgrade the operating system on an existing computer.

Input/output (I/O) devices enable the transfer of data to and from a computer. I/O devices have
evolved over time and continue to evolve. Most of the I/O devices that we use today are Plug and
Play, which means that they find their own resources and rarely need troubleshooting. I/O devices
can use many types of external connections, including serial, parallel, USB, IEEE 1394, and wire-
less connections. Most of the troubleshooting of I/O devices centers around making sure that the
external connections are solid and that you are using the correct driver.

Drivers are special software programs that enable the hardware device to communicate with
the operating system. Drivers are specific to each device for each operating system. Windows XP
has tools that allow you to update drivers as new drivers become available. You can also use a
new tool that enables you to roll back a driver update if you decide that you were better off with
the previous driver. In addition, Windows XP provides tools that enable you to ensure the com-
patibility of drivers in your operating system by identifying and controlling the installation of
drivers that are not digitally signed. Digital signatures on drivers indicate that the drivers were
tested for compatibility with the operating system and that the drivers have not been altered
since they were tested. Using the new tools provided by Windows XP, you can customize your
driver signing options based on the needs of your organization.

Exam Essentials

Understand the configuration of fixed and removable storage devices. You should know
the difference between fixed and removable storage devices. In addition, you should know the
main differences between basic disks and dynamic disks and the configuration options for
each type. Finally, you should be able to troubleshoot startup errors, stop errors, and errors
related to dynamic disks.

Know display types, display settings, and DirectX. You should be familiar with the major
types of displays that are in use today and the advantages and disadvantages of each type. In
addition, you should know the display settings that users can change to customize the display
for their needs. Finally, you should be able to troubleshoot errors related to displays, display set-
tings, and DirectX.

Understand the Advanced Configuration Power Interface. You should know how ACPI can
be used to control the power consumption of devices in a computer. You should understand

that all devices and the operating system must be ACPI-compatible in order for ACPI to operate
properly. Finally, you should be able to recognize and troubleshoot problems related to ACPIL.
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Understand I/O devices. You should be able to recognize the various types of I/O devices and
device connectors, such as serial, parallel, USB, and IEEE 1394. You should know how hard-
ware profiles are used to control the enabled devices at startup and how to create new hardware
profiles. Finally, you should understand the general uses of each type of I/O device and how to
troubleshoot each type.

Understand drivers. You should understand what drivers are and how they affect the performance
of a device. You should understand that driver compatibility is essential and know how to configure
the computer for the various driver signing options. Finally, you should know how to identify the
drivers that are in a computer and determine whether they are signed or unsigned.
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Review Questions

You are the desktop support technician for a large organization. You have installed a second hard
disk in a computer running Windows XP Professional on a basic disk. You want to create a mir-
rored volume. Which of the following must you do to successfully create the mirrored volume?

A. Format both partitions with the NTFS file system.

B. Convert both disks to dynamic disks.

C. Convert only the second disk to a dynamic disk.

D. Format only the second disk’s partition to NTFS.

You are the desktop support technician for your organization. A user complains that his com-
puter crashed while he was working on it and he received an error message on a blue screen.

Now when he tries to restart the computer he gets the same error message. Which of the follow-
ing should you do first?

A. Completely reinstall the operating system as a clean installation.

B. Start the computer in Windows Safe mode and fix the error.

C. Read the error message and examine the Microsoft Knowledge Base for information.

D. Start the computer with the Recovery Console and type fixmbr.

You are the desktop support technician for your company. A user named Susan complains that
she can no longer see anything on her monitor. She says that it was okay before and that some-

one else was using her computer and tried to change the settings, but they “messed it up.” Which
of the following should you do? (Choose two.)

A. Remove and reinstall the video drivers.
B. Ensure that the Brightness and Contrast levels are not all the way down.

C. Reboot to Safe mode and ensure that the Resolution setting is proper for the video card
and monitor.

D. Replace the monitor with one that works.

You are the desktop support technician for your company. A user is trying to use a new training
application but is getting an error that indicates that she doesn’t have the correct version of
DirectX installed. You want to determine which version of DirectX is installed on her computer

and test the DirectX components. Which of the following should you do? (Choose two. Each
answer is a part of the solution.)

A. Open Device Manager and browse for the DirectX component on her computer.
B. On the Run line, type msinfo32.exe.

C. On the Control Panel, select System Information.

D

. On the System Information tool, select DirectX Diagnostic Tool from the Tools menu.
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You are the desktop support technician for your organization. A user named Sam says that his
laptop “falls asleep™ every time that he stops typing on it for a few minutes, even when it is
receiving power from the wall socket. What should you do first?

A. Check the power schemes and power management settings in Power Options on
Sam’s laptop.

B. Replace the battery in Sam’s laptop.

C. Replace the power supply in Sam’s laptop.

D. Reinstall the video drivers in Sam’s laptop.

You are the desktop support technician for your organization. A user named Dave utilizes his

laptop for sales presentations outside the office. Dave asks you if there is a way to save his pre-

sentation on the desktop when he turns his computer off. He wants to put the computer into the

case to carry it to the next location and then resume with the presentation already on the desk-
top. Which of the following should you tell Dave?

A. There is no way to do what he wants to do.

B. He can simply put the computer into Standby mode between presentations.

C. He can use the Hibernate feature as long as he has enough memory.

D. He can use the Hibernate feature as long as he has enough free hard disk space.

You are the desktop support technician for your company. A user complains that a USB-powered
network interface card is failing intermittently. The network interface card is plugged into a USB
hub that is connected to his computer. The other devices on the hub are working properly. Which

of the following should you do first to troubleshoot the problem? (Choose two. Each answer is a
part of the solution.)

A. Disconnect the network interface card from the hub.

B. Reinstall the software and drivers for the network interface card.

C. Restart the computer.

D. Connect the network interface card to the USB port on the computer itself.

You are the desktop support technician for your organization. A user has a laptop that she uses in
the office as well as out of the office. She says that when she uses the laptop away from the office,

she gets a couple of errors at startup that have to do with the computer trying to find the network.
She would like to eliminate these errors if possible. What should you do?

A. Tell her that those errors are unavoidable unless she can connect to the network
from home.

B. Create a user profile that is specifically for use outside the office.

o

Tell her to always use the Standby feature instead of turning the laptop off.

D. Create a hardware profile that is specifically for use outside the office.
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9. You are the desktop support technician for your company. You want to make sure that some
computers can use only drivers that are digitally signed as compatible with the Windows XP
operating system. Which of the following should you do? (Choose two. Each answer is a part
of the solution.)

A. Access the Driver tab for each device in Device Manager.
B. Select Block to prevent unsigned drivers.
C. Select Allow to permit only signed drivers.
D. Access the Driver Signing Options from System Properties.
10. You are the desktop support technician for a large organization. You want to determine all
of the unsigned drivers on an existing computer. You wish to do this with the least admin-

istrative effort. Which of the following should you do? (Choose two. Each answer is a part
of the solution.)

A. Run the File Signature Verification Wizard.

B. Use the Default settings in the wizard.

C. Use the Advanced settings to identify the folders and drives to check.
D. Use the Advanced settings to view the Log File created by the scan.
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Answers to Review Questions

1.

10.

B. Dynamic disks are required to create any special volumes such as mirrored volumes. You will need
to convert both disks, not just the second disk, to dynamic disks. Dynamic disks can contain volumes
formatted with FAT, FAT32, or NTES, so there is no need to format the partitions.

C. The user has encountered a stop error. You should read the message in the blue screen and
examine the Microsoft Knowledge Base to determine the solution. You should not reinstall the
operating system as a first step. You cannot boot to Safe mode, because the computer is not get-
ting that far at startup. Since the user’s computer initially crashed while he was working on it,
the stop error is not likely to have been caused by a problem with the master boot record; there-
fore, fixmbr is not the correct solution.

B, C. The problem is likely related to the display settings. You should ensure that the Brightness
and Contrast settings are not all the way down and ensure that the Resolution setting is proper
for the monitor and video card. You will need to reboot to Safe mode to examine and change
the Resolution setting. The problem is not likely related to drivers or the monitor itself, since the
monitor was working fine before the Susan’s friend used her computer.

B, D. You can use the DirectX Diagnostic tool to determine the current version of DirectX installed
on the computer and test the DirectX components. You should type msinfo32.exe on the Run line
and then select the DirectX Diagnostic tool from the Tools menu of System Information.

A. The most likely cause of Sam’s computer problem is that the power management settings are
set to a very low amount of idle time. You should check the power schemes and power manage-
ment settings in Power Options.

D. Dave can use the Hibernate feature as long as he has at least as much free hard disk space
as he has RAM in his computer. The Hibernate feature will save his desktop and turn the
computer off completely between presentations. The Standby feature does not completely
turn the laptop off, so it could overheat in the case.

A, D. Since there are multiple devices on the hub and the problem is intermittent, the issue is
likely related to a lack of adequate power for the device. You should disconnect the network
interface card from the hub and plug it directly into the computer to determine whether the
problem is power related. You should not reinstall the drivers or restart the computer as a first
step to troubleshooting this issue.

D. You should create a hardware profile that is specifically for use outside the office. The hard-
ware profile that you create should disable the network interface card to eliminate the error that
she is experiencing relating to the network. A hardware profile, not a user profile, is used to con-
trol which devices are enabled at startup.

B, D. You should access the Driver Signing Options tab from System Properties and select Block
to prevent unsigned drivers from being installed in the computer. You do not need to identify
each device. Allow is not an option in Driver Signing Options.

A, B. You should run the File Signature Verification tool with the default settings. The default
settings will scan all of the drives and folders in the computer and identify and indicate all
unsigned drivers in the computer. You do not need to use the Advanced settings in this case.
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As a desktop support technician, you are responsible for pro-
viding and maintaining the tools that keep users productive.

Users’ productivity increases when they can customize their
desktop for their specific needs. Some users have special needs to address, such as a disabil-
ity or a second language, while others simply need reliable access to their computer and/or
to the domain resources.

A user’s access to resources not only is controlled locally but is also influenced by many
other factors, such as network security and Group Policies. Depending on how a user is
logged on, he can gain access to only a specific set of resources. His productivity will also be
affected by the performance of his computer. Your ability to provide reliable access to com-
puter resources is dependent upon your understanding of the “big picture.” In this chapter,
we will discuss configuring and troubleshooting the user’s desktop and the user’s environment
to keep users productive.

Maintaining the productivity of users requires an understanding of six categories of resource
configuration and troubleshooting;:

User environment Let’s face it; people just do better work when they are comfortable. Win-
dows XP has many tools and settings that are designed to make users more comfortable and
therefore more productive. These tools include task and toolbar settings, accessibility options,
pointing device settings, and fast-user switching. You should be able to configure and trouble-
shoot these tools and settings.

Multiple languages or multiple locations Windows XP and Windows 2000 Professional are
offered in three distinct variations: English, Localized, and Multilanguage User Interface (MUI).
In addition, each of these variations provides users with the ability to change their input language.
You should know the difference between Regional Language Options and MUI software. You
should also know how to configure and troubleshoot these features.

Security settings and local security policy When computers are in a workgroup, each computer
controls its own security, making security management relatively simple. In a domain environ-
ment, many other factors can control the security of a computer, including network security
policies and Group Policies. You should know the factors that can affect security on a computer
in each environment. You should also know how to troubleshoot problems and when to escalate
the issue to a network administrator.

Local user and group accounts In order for a user to log on locally to a computer, she must
have a user account. User accounts are generally created by the administrator to identify the
user and define the actions that she can perform. There are only two built-in local user accounts
in Windows XP: Administrator and Guest. You should know how to use the User Accounts set-
tings in the Control Panel to identify the local accounts in a computer.
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System startup and user logon When a user starts up a computer and logs on to the computer
locally, a process of authentication and validation takes place that will determine what the user
can see and do after he is successfully logged on. This process is very similar when the user logs
on to a domain, but there are some differences. You should understand the logon process and
how logging on to a computer is different than logging on to a domain.

System performance There are four essential resources in most computer systems: processor,
memory, disk subsystem, and network subsystem. Each resource performs a specific function, but
they also work together with all of the other resources. A weakness in one resource can affect the per-
formance of all of the resources on the computer, creating a bottleneck. You should understand this
balance of resources and know how to use the Windows XP Task Manager and Windows Perfor-
mance tools to identify and troubleshoot bottlenecks and to create a baseline of performance.

The rest of this chapter discusses configuring and troubleshooting these six categories of
resources that are essential to the productivity of users.

User Environment

A computer can provide many resources for a user, such as e-mail, word processing, spread-
sheets, web access, and much more. Since each user utilizes a computer in her own way, each
Windows operating system has become more flexible in regard to the way that the user can
organize and access the tools that she needs. A user can create her own environment using the
Taskbar and toolbar settings included in the Windows XP operating system. Windows XP
also has special features to adjust to the needs of a person who has a physical disability. In
addition, a user can customize the pointing devices that she uses to communicate with the
computer. In a workgroup environment, users can even share a computer without the need for
either user to log off. In this section we will discuss how to configure and troubleshoot these
important elements of a user environment.

Taskbar and Toolbar Settings

A user of Windows XP can customize the look and feel of his desktop and applications for his
own needs. Taskbar and toolbar settings allow a user to have the tools that he uses in his view,
while the tools that he rarely uses are still accessible but not as obvious. As a desktop support
technician, you should know how to customize these tools for a user. In this section, we will dis-
cuss configuring and troubleshooting the Taskbar and the toolbars in Windows XP.

Taskbar Settings

The Taskbar, which holds icons indicating programs that a user is currently using, can be cus-
tomized to hold miniature icons of all types. In addition, the Taskbar can hold the clock and the
Notification Area, which Windows XP uses to report events such as available updates.

Exercise 4.1 walks you through the steps to configure the Taskbar in Windows XP.
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Configuring the Taskbar

1. Onthe Windows XP desktop, right-click an empty area of the Taskbar. Note: The Taskbar
is initially located on the bottom of the screen and contains the clock.

2. Choose Properties.

Taskbar and Start Menu Properties @ﬁ

Taskbar | Start Menu|

Taskbar appearance

Lock the taskbar

Auto-hide the taskbar

[¥] Keep the taskbar on top of other windows
Group similar taskbar buttons

Show Quick Launch

Notification area

[T B8 = 1223 PM

Show the clock

You can keep the notification area uncluttered by hiding icons that you have
not clicked racently.

|:| Hide inactive icons

[ OK ] | Cancel |

3. Click the check boxes to select the individual items, such as Show the Clock, Show Quick
Launch, and Hide Inactive Icons.

4. Click OK to close the window and save your changes.

Toolbar Settings

Toolbars are located in every Windows application and are initially found at the top of the
screen. Toolbars are specific to an application and can generally be customized within each
application for the user. An application might have many toolbars, each with different settings
and locations on the screen. We will discuss configuring and troubleshooting applications in
greater detail in later chapters, but you should know that toolbar settings can affect what a user
can see and therefore what she thinks she can do. Figure 4.1 is an example of a toolbar in
Microsoft Word for Office System 2003.

FIGURE 4.1 A toolbar in Microsoft Word for Office 2003
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Accessibility Options and Features

Windows XP has built-in features and settings to enable a person with physical disabilities to
use a computer. These are divided into two groups: accessibility options and accessibility fea-
tures. You should know how to configure and troubleshoot these settings. In this section, we

will discuss the location of accessibility options and accessibility features and show how to con-
figure and troubleshoot each of them.

Accessibility Options

Accessibility options are methods of modifying the use of an existing tool to enhance its capa-
bilities for a person who has a physical disability. You can select and apply these options by
opening the Control Panel and then clicking Accessibility Options. Figure 4.2 shows the Key-
board tab of the Accessibility Options dialog box. The following is a list of tools and the options
that you can apply to each tool:

= Keyboard

= StickyKeys: Automatically locks keys to allow users to press single keystrokes to accom-
plish multiple-keystroke combinations, e.g., Ctrl+Alt+Delete.

= FilterKeys: Ignores brief or repeated keystrokes.
= ToggleKeys: Plays tones when the Num Lock and ScrLk keys are pressed.

FIGURE 4.2 Accessibility Options dialog box

Accessibility Options @

Keyboard | Sound | Display | Mouse | General|

Stickykeys

Use StickyKeys if you wantto use SHIFT, CTRL, ALT, or Windows
logo key by pressing one key ata time.

S ——

Filterkeys

Use Filterkeys if you want Windows to ignore brief or repeated
keystrokes, or slow the repeat rate.

[[JUse FilterKeys

ToggleKeys

Use ToggleKeys if you want to hear tones when pressing CAPS
LOCK, NUM LOCK, and SCROLL LOCK.

[Juse ToggleKeys

|:| Show extra keyboard help in programs

OK ] | Cancel
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= Sound

= SoundSentry: Gives a visual warning to indicate that Windows is playing a sound, e.g.,
flashes the window.

= ShowSounds: Works with programs to display captions of sounds that are being played.
= Display
= High Contrast: Enables very high-contrast colors for individuals with a visual impairment.
= Cursor Options: Alters the width and blink rate of a cursor.
=  Mouse

*  MouseKeys: Enables the control of the mouse pointer from the arrow keys on the
numeric keypad of the keyboard.

= General Settings
= Automatic Reset: Shuts off the accessibility options after a set idle time.
= Notification: Alerts the user that the options are being turned on or off.
= SerialKey Devices: Allows the connection and configuration of special input devices.

*  Administrative Options: Determines whether settings apply to just the current user or to
all users who log on to the computer.

Accessibility Features

Accessibility features are additional tools or programs that enhance the usability of a computer
for a person who is physically disabled. These features can be started and controlled from the
All Programs » Accessories » Accessibility menu. The following list shows the accessibility fea-
tures included in Windows XP and the function of each:

= Accessibility Wizard: Adjusts Windows display settings and configures accessibility options.

= Magnifier: Enlarges part of the screen, as configured by the user, to make it much easier to
see and read.

= Narrator: Converts on-screen elements to speech and reads the content and text on the
screen for a person who is blind or has a severe vision impairment.

= On-Screen Keyboard: Creates a virtual keyboard on the computer screen on which users
can point and click with the mouse to enter text and commands into the computer.

= Utility Manager: Indicates which of the Accessibility programs are currently running and
allows configuration for automatic startup of Accessibility programs when a user logs or
locks his desktop.

Pointing Device Settings

Most users utilize a keyboard and a pointing device referred to as a mouse to communicate with
a computer. Some users utilize other pointing devices such as a roller ball or touchpad. Since all
users are unique, pointing device settings must be flexible enough to adjust to each user. You
can configure and troubleshoot the type and behavior of the pointer in the Mouse settings in

Control Panel, as shown in Figure 4.3.
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FIGURE 4.3 Mouse settings in Control Panel

Mouse Properties 24

Buttons iPoinlers PaimerOpﬁ_ons' Wheel | Hardware

Button configuration
[T Switch primary and secandary buttons

Select this check box 1o make the button on the right
the one you use for primary functions such as
selecting and dragging.

Double-click speed

Double-click the folder to test your setting. [fthe folder
does not open or close, try using a slower sefting

Speed: Slow —

W |
ClickLock
[] Tum on ClickLock

Enables you to highlight or drag without halding down the mouse button
To set, briefly press the mouse bution. To release. click the mouse button
again.

OK | | Cancel

Fast User-Switching

Users who share computers in a workgroup can use fast user-switching to save time logging on
and off. Fast user-switching allows a user to let another user log on, without logging off or even
closing any programs. For example, if Bob is in the middle of a project and Sue just wants to
check her e-mail, then Bob can let Sue log on and check her e-mail without having to log off or
close the project. When Sue is finished, she can log off and Bob will be returned to the program
just as he left it. Sounds great doesn’t it?

Well, don’t get too attached to it because fast user-switching is not available when a computer is
a member of a domain. Since most organizations use domains, you probably won’t get the oppor-
tunity to configure or troubleshoot fast user-switching very often, at least not at work. You should
be aware that fast user-switching is available for computers that are a member of a workgroup and
that it can be configured in the User Accounts settings of Control Panel. You should also know that
fast user-switching is not an option if a computer is configured for Offline Files and Folders, which
we discussed previously in Chapter 2, “Managing and Troubleshooting Access to Resources.”

< You should know that fast user-switching is not available when a computer is a
P member of a domain or when a computer is configured for Offline Files and Folders.
- You should know that using fast user-switching may slow down the performance
TE of the computer for each of the users who are logged on. This performance reduc-

tion may or may not be noticeable depending on the applications in use.
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Multiple Languages or Multiple Locations

Large organizations might contain users from many countries and regions. Windows XP and
Windows 2000 Professional software can be configured to accommodate users from all over the
world. To do this, Microsoft offers special options on the English version of the Windows XP
software as well as special variations of the software itself.

The three distinct variations of Windows XP are as follows:

= English version: Standard U.S. version
= Localized versions: 24 varieties of Windows XP
=  Windows XP Multilanguage User Interface (MUI)

These variations provide two levels of multilingual support for Windows XP and Windows 2000
Professional: Localization and Regional and Language Options. In this section, we will discuss the
difference between these offerings and how to configure and troubleshoot each of them.

Localization

Localization refers to the language that is displayed by the operating system itself on the
Start menu, Taskbar, and Help screens. There are 24 localized languages for Windows XP.
This means that you can buy the software in any of 24 different languages. You can also buy
a Multilanguage User Interface (MUI) version that contains all 24 Localizations. You
cannot change the Localization of Windows XP unless you are using the (MUI) version
of the software. You should also make sure that you have the latest Service Pack installed
before attempting to change the Localization of the MUI version of the Windows XP oper-
ating system.

You should know how to change the Localization of the MUI version of Windows XP.
Exercise 4.2 walks you through the steps to change the language setting.

Changing the Localization of Windows XP MUI version

1. On the desktop of Windows XP MUI version, click Start, and then choose Control Panel.

2. Select Date, Time, Language, And Regional Settings, and then choose Regional And
Language Options.

3. Onthe Languages tab, select the language that you want to use under Language Used In
Menus And Dialogs.

4. Click the Advanced tab, select the Apply All Settings To The Current User Account And To
The Default User Profile check box, and then click OK.
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) The steps in this exercise are appropriate for a Windows XP computer with the
TE Control Panel display option set to the default setting of “Display as a link”.

Regional and Language Options

Regional and Language Options provide the ability to view, edit, and print documents that are
Unicode-enabled in any localized version of Windows. In addition, they provide the ability to
change the standards and formats that the operating system uses to specify local currency units,
number formatting, time and date, and so on. Collectively, these format and style settings are
known as regional settings.
You should know how to configure regional settings and choose input languages in Win-

dows XP localized versions. Exercise 4.3 walks you through the steps to configure these settings
in Regional and Language Options.

Configuring Regional Settings and Input Languages

1. On the Windows XP desktop, click Start, and then choose Control Panel.

2. Select Date, Time, Language, and Regional Options, then choose Regional And Lan-
guage Options.

3. Onthe Regional Options tab, set the regional settings by selecting your language and location.

4. On the Languages tab, click Details to select the default input languages and install addi-
tional input languages, and then click OK.

4 The use of additional input languages may require a special keyboard or a spe-
ITE cial overlay for the user’s keyboard.

Security Settings and Local Security Policy

A security policy is a combination of security settings that affect the security of a computer. When
a computer is a member of a workgroup and not a domain, it is subject only to the local security
policy for which it is configured. In other words, computers that are members of a workgroup

control their own security policies. On the other hand, when a computer is a member of a domain,
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then the local security policies may be overridden by network security policies. You should know
how to configure and troubleshoot local security policies and when to escalate a network security
issue to the network administrator.

Configuring and Troubleshooting Local Security
Policy Settings

Security policies can be used to configure the following:

= Who accesses the computer

= Which resources users are authorized to use on their computer

= Whether a user’s or a group’s actions are recorded in an event log

There are many individual settings in a computer’s Local Security Settings dialog. You can
configure each of these settings individually for a computer that is a member of a workgroup.
These settings include the following:

= Account Policies: These are policies defining password restrictions and account lockout for
errant logons.

= Local Policies: These settings define Audit Policy, User Rights Assignment, and Security
Options related to the local computer.

= Public Key Policies: These policies define the certificates and data recovery agents used by
the Encrypting File System (EFS).

= Software Restriction Policies: These policies define whether a user is prevented from install-
ing specified software on the computer.

= IP Security Policies On Local Computer: These policies define how and when your com-
puter will communicate with other computers on the network, e.g., the encryption and
authentication protocols that will be used.

You should know how to configure the settings for local security policies on a computer.
Exercise 4.4 walks you through the steps to configure security policy settings.

4 When a local security policy is changed on a computer in a workgroup, only the
P computer on which the policy is changed is affected.

Configuring Local Security Policy for a Computer
1. On the Windows XP desktop, click Start, and then choose Control Panel.

2. Onthe Control Panel, select Administrative Tools, and then select Local Security Policy. (If
Administrative Tools is not listed, right-click on Control Panel in the Start menu and then
choose Explore.)
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EXERCISE 4.4 (continued)

3. Click on the plus sign (+) of each category in the console pane (on the left) to expand each
category and view the options.

|E$ Local Security Settings =X
Fle Acton View  Help
e+ B RAE @ B _ _
|BR secunty Settings Name | Description | Poicy Assigned
+ () Account Polcies BACkent (Respand Oniy) Communicate normaly (uns...  Yes
| [ Local Policies B4 secure Server (Requie Se... For al IP traffic, ahways requl... No
| 3 Publc Key Poicies (B 5erver (Request Securty)  For al 1P traffic, always requ.., o
| 23 Software Restriction Polcies
#,IP Security Poices on Local C
ofiny
-
£ 1 |2

4. Right-click each option in the details pane (on the right), and then choose Properties to con-
figure the option or choose Help to find more information about the option.

5. Whenyou have finished configuring options, close the Local Security Policy console. Note:
Some changes may require that you restart the computer.

Recognizing Network Security Policy Settings

Windows security in a domain environment is often managed using Group Policy. Group
Policies are groups of policies that are used to manage users and computers in sites, domains,
and organizational units. They can be used to control what users can see and access and what
actions they can perform. Since Group Policies can be applied to all levels of a hierarchy, more
than one Group Policy may apply to an object in the hierarchy. For example, if a user account
is in an organizational unit that is in a domain that is in a site, and each of these containers has
its own Group Policies applied, then the user account will be subject to all of the Group Policies
in all of the containers—but it’s not quite that simple.

Actually, all of the policies will be run for the user account, but if any of the settings on the
policies that are run last conflict with the settings of the policies that were run previously, then
the last settings win and will be the effective settings. The settings that do not conflict will all
apply to the user, like a snowball effect.
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Now, you might be asking, “Well, which ones run first and which ones run last?” 'm glad
that you asked. The order in which the policies are always run is as follows:

1. Local computer policy
Site policy
Domain policy

Organizational unit policy

o~ 0N

Child organizational unit policy

If you think about it, it makes sense that the policies that are closest to where the object actu-
ally resides (in this case, the child organizational unit) will be the ones that take precedence. The
group of settings that ends up taking precedence is called the Resultant Set of Policy (RSoP). The
challenge for you is to determine which policies apply to the user or computer.

Using the Gpresult Tool in Windows XP

One way to determine whether Group Policies apply to a user or computer is to use a tool that
is built into Windows XP called gpresult. This tool examines the policies that apply to the com-
puter and the currently logged-on user. You should know how to use the gpresult tool to deter-
mine if Group Policies are being applied to a computer or user. Exercise 4.5 walks you through
the steps to use the gpresult tool.

Using the Gpresult Tool

1. On the Windows XP desktop, click Start and then choose Run.
2. Onthe Run linge, type cmd and then press OK.

3. Atthe Windows XP command prompt, type gpresult.

4

Examine the output to determine which Group Policies are applied to the computer and
the currently logged-on user.

B CWINDOWS\System3 Ziemd. exe M
Microsoft Windows XP [Uersion 5.1.26080] -
(C) Copyright 1985-2081 Microsoft Corp.

C:hDocuments and Settings\Bill Ferguson.iP1>gpresult

Microsoft (R) Windows (R} XP Operating System Group Policy Result tool w2.0
Copyright (C) Hicroseft Corp. 1981-20081

Created On 4/13/2004 at 12:88:17 PH

RSOP results for ¥P1\Bill Ferguson on X¥P1 : Logging Mode

05 Type: Microsoft Windows XP Professional

05 Configuration: Standalene Weorkstation

035 Uersion: 5.1.2680

Domain Name: XP1

Demain Type: N/A<Local Computer:

Site Name: N/A

Roaming Profile:

Local Profile: C:\Documents and Settings\Bill Fergusen,XP1

Connected over & slow link?: Yes

COMPUTER SETTINGS -
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Local User and Group Accounts

User accounts are created by an administrator to uniquely identify individuals and define the
actions that they can perform in the Windows operating system environment. Each user account
is assigned a security identifier (SID) by the operating system. The SID is always unique and is
never reused, even if an account is deleted and a new account is created with the same name.
Windows uses the SID to control a user’s access to resources based on permissions that are
assigned to the user or to a group of which the user is a member.

Users can also inherit rights to perform actions within the operating system based on their
group membership. You should understand the different types of user accounts and group
accounts that you can use within the Windows operating system. In this section, we will discuss
the different types of user accounts and group accounts and how to configure and troubleshoot
each of them.

User Accounts

Windows includes several types of user accounts. You should understand the differences
between these accounts and know how to create new accounts on a Windows XP client com-
puter. Windows XP uses the following types of accounts:

Administrator account This account type allows users to log on to a computer with full
administrative access rights to the computer. An administrative account named Administrator
is installed in every computer running Windows XP and Windows 2000 Professional. The
administrator can create new administrative accounts.

System account This account is used by the operating system itself to allow access to resources
to run hardware, software, and applications within the computer.

Guest account This account allows users to log on temporarily without the need to create a
new account. It should be used only for temporary logons and should be given very few rights
or permissions.

Local accounts This is a broader term that includes all of the accounts mentioned before in
addition to any accounts that an administrator creates for the purpose of giving access to local
resources or rights to perform actions locally.

Domain accounts This type of account is not local. Domain accounts give access to resources
that are in the domain, not just the local computer. These accounts are generally created and
controlled by network administrators. They reside in the Windows Active Directory, a shared
database, not just on one computer.

Viewing and Creating User Accounts

There are two main tools that you can use to view user accounts and create new user accounts
on a computer, User Accounts and Local User Accounts and Groups. You should know how
to use each of these to configure and troubleshoot local user accounts. Exercises 4.6 and 4.7

walk you through the steps to view and configure user accounts with these Windows XP tools.
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Viewing and Creating Accounts with the User Accounts Tool

1. Onthe Windows XP desktop, click Start, and then choose Control Panel.
2. On the Control Panel, select User Accounts.

3. Each of the accounts is represented with its name and a unique picture. You can replace
the “automatic picture” with an image of your choice.

User Accounts

3 User accaunts
1] Usar account types

| [ Swtching users Pick a task...

[+] change an sccouit

[2] treats 2 naw account

[+ hange the way users lag o0 of off

or pick an account to
change

Bill rerguson F il Black
. Compater 'y Computes
MABR sgministrator <4 | administrator ]

4. Choose from the options in Pick A Task or select an account to change the specific prop-
erties of the account. You can change the name, the account type, or the picture or even
delete the account with this tool.

5. To create a new account, select Create A New account from the Pick A Task list, name
the account, specify the account type, and then click Create Account. You can then
select the account from the list to modify its properties.

What do you want to change
about your account?

EX change my name

Prevent & forgatten
password

Change another account
Craate a new account

Bill Ferguson

Computer administrator

Change my pa rd Fassword protectad
Leam About

Remove my password

4 Deleting your own
account

3 switching users Change my picture
Using & .NET
a Passport

Changs my zccount fype

EX change my MET Fasspart
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Viewing and Configuring User Accounts with the Local User Accounts MINC
1.

2.

Chapter 4 « Configuring and Troubleshooting the Desktop and User Environments

On the Windows XP desktop, right-click My Computer and choose Manage.

On the Computer Management Console, expand System Tools and select Local Users

And Groups.

Expand Local Users And Groups in the console pane (on the left) and choose Users.

View the list of users in the details pane (on the right). Note that the system and support

accounts are also listed.

|£|; Computer Management

|=) Fle Acton View Window Help
e BmB @

BEX

RETET

=) Computer Management (Local)

Full Name

| Description

= i System Tools
= [ Event Viewer
+-ga) Shared Folders
- # Local Users and Groups
{3 Users
(1 Groups
= & Performance Logs and Alerts
B Device Manager
- Eg Storage
= @& Removable Storage
& Disk Defragmenter
& Disk Management
+ { Services and Appiications

FHelpassistant
& sqLagentCmdExec
&2 SUPPORT_388945a0

Bil Black

Remote Desktop Hel...
SQLAgentCmdExec
CN=Microsoft Corpo...

Buit-in account for administe...

Buit-in account for guest ac...

Account for Providing Remo...
SQL Server Agent CmdExec ...
This is 2 vendor's account fo...
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EXERCISE 4.7 (continued)

5. To create a new account, right-click Users in the console pane and then choose New User.

6. Type the name and password of the user. You can also type a description and indicate
whether the user must change his password when he logs in.

New User @@

User name: bjones

Full name: Bob Jones
Description:

Password: sesnnees
Confirm password: sssasese

[¥] User must change password at nextlogon

[ Accountis disabled

Create i [ Close

Troubleshooting User Accounts

Most problems associated with a user account stem from the type of account that is being used to
access a resource. You should use the User Accounts and Local Users and Groups tools to deter-
mine whether the account has limited rights that are keeping it from using a resource. You should
also understand that local accounts give access only to a resource that is on the local computer.

If the resource is on another computer in the domain, then a domain account will be required.

User Groups

Microsoft recommends that a user be given permissions to use resources and rights to perform
actions based on being a member of a group, rather than directly assigning the permissions and
rights to the user account. For this purpose, Windows XP includes many default user groups
with each computer installation. You can give a user rights to perform actions by making the
user a member of one of these groups. You can also create your own groups to assign permis-
sions to resources. Windows XP has the following built-in groups:

Administrators  This group has full, unrestricted access to the operating system configuration
and use.
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Backup Operators This group has the right to back up and restore files and folders.

Guests This group initially has the same rights as users, but it should be restricted and used
only for temporary access.

Network Configuration Operators This group has some administrative rights to manage net-
working features.

Power Users This group has most of the administrative rights on a computer with some restric-
tions. It is primarily used to allow users to run legacy applications and certified applications.

Remote Desktop Users This group allows members to log on remotely.
Replicator This group contains system accounts that support file replication in a domain.

Users This group contains the users that are created by the administrator. It has limited rights
as assigned by the administrator.

Help Services Group This group contains system accounts that are used for the Help and Sup-
port Center.

Viewing and Creating User Groups

You should know how to use the Local Users and Groups MMC to view and create user groups.
The Local Users and Groups MMC is part of the Computer Management Console. Exercise 4.8
walks you through the steps to view and create user accounts.

EXERCISE 4.8

Viewing and Creating User Accounts with the Local Users and Groups MNIC

1. On the Windows XP desktop, right-click My Computer and then choose Manage.

2. Onthe Computer Management Console, expand System Tools and select Local Users
And Groups.

3. Expand Local Users And Groups in the console pane (on the left), and then choose Groups.

4. View the groups that are listed in the details pane (on the right). Note that a brief descrip-
tion is listed with each group.

5. To add a new group, right-click Groups in the console pane and then choose New Group.
6. Type the name of the group and a brief description of the purpose of the group.

7. To add members to the group, click Add, then type or click Advanced to create a custom
query for the names of the users or groups that you wish to add.

8. When you have finished configuring the group, click Create.
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Troubleshooting User Groups

Most issues in regard to user groups concern a user’s membership in more than one group. As
we discussed in Chapter 2, if a user is a member of a group that is explicitly denied access to a
resource, then she will be denied access to the resource, even if she is also a member of other
groups that are allowed access. This applies to local groups as well as domain groups. You
should examine a user’s group membership using the Local Users and Groups tool. Exercise 4.9
walks you through the steps to troubleshoot group membership for a user.

Troubleshooting Group Membership for a User
1. On the Window XP desktop, right-click My Computer and then choose Manage.

2. On the Computer Management Console, expand System Tools and select Local Users
And Groups.

3. Choose Users, right-click the user that you want to troubleshoot in the details pane, and
then choose Properties.

4. Selectthe Member Of tab on the user’s properties to view the groups of which the user is
a member.

5. You can also choose Groups and then right-click the group and choose Properties to view
the membership of each group.

System Startup and User Logon

No matter how many resources a computer or network may have, users will not be able to
access any of them until they can successfully start a computer and log on to the computer or
log on to the domain. For this reason, you should know what is supposed to happen and what
can go wrong when a user attempts to start a computer and log on. Problems can occur in three
areas: system startup, user logon to a computer, and user logon to a domain. In this section we
will discuss troubleshooting each of these areas.

System Startup

We refer to the act of starting up a computer as “booting” it. Did you ever wonder why? After all,
we are not kicking it! Booting a computer comes from the term “bringing it up by the bootstraps,”
or starting at the very beginning. Every time a computer is started, it goes through a series of phases
that verify the presence of and test the components that the computer needs in order to function
properly. These phases are collectively referred to as a boot sequence. Since errors can potentially
occur in each of these phases, you should know what is supposed to happen so you can troubleshoot
any errors that occur. In this section, we will discuss the major phases of system startup.



126 Chapter 4 « Configuring and Troubleshooting the Desktop and User Environments

The five major phases of the boot sequence are as follows:

Pre-boot The pre-boot phase begins when the computer is first started, before the operating
system is loaded. The computer runs a power-on self-test (POST) that identifies the hard drives
and other hardware necessary for operation. Also, any Plug and Play devices are located and
installed in this phase. Then, the basic input/output system (BIOS) locates the Master Boot
Record (MBR), which it uses to locate and start the operating system.

Boot In the boot phase of the boot sequence, the startup files that we discussed in Chapter 3,
“Configuring and Troubleshooting Hardware Devices and Drivers,” are used to begin the pro-
cess of starting the operating system. First, the NTLDR file is used to initialize the system and
change the microprocessor from real mode to 32-bit flat memory mode, which is used by Win-
dows XP, Windows 2000 Professional, and Windows NT. Next, NTLDR, Ntdetect.com, and
the Boot.ini files are used to locate and load the operating system. If any of these files is miss-
ing or corrupt, the operating system cannot start. You can use the Recovery Console, as illus-
trated in Chapter 3, to troubleshoot this phase.

Kernel load During the kernel load phase of the boot sequence, the NTLDR file loads the
NtoskrnTl.exe file (NT Kernel) but does not initialize it. NTLDR also loads the Hardware
Abstraction Layer (HAL), which provides a filter that allows a wide variety of hardware devices
to be used by the system. NTLDR then loads the HKEY_LOCAL_MACHINE Registry key. This Reg-
istry key is used to load the device drivers and services for some of the low-level services of the
computer. The information that is created at this phase is called the control set. After this is
done, NTLDR initializes and passes control over to the NT Kernel.

Kernel initialization Up to this point, the screen has been in text mode. At this point, the
Microsoft logo with the multi-colored window is displayed in the middle of the screen. During
the kernel initialization phase, four tasks are accomplished. First, the hardware key is created
using the data found by ntdetect. com. Second, the clone control set is created. The clone con-
trol set is a copy of the control set that was created in the kernel load phase. Third, the kernel
initializes the low-level device drivers that were loaded in the kernel load phase and loads and
initializes the higher-level device drivers that are dependent upon the low-level device drivers.
Finally, the Session Manager loads all of the highest-level services, including the Win32 Sub-
system. The Win32 Subsystem controls the graphical user interface, the video display, and all
I/O devices. The Session Manager also starts the WinLogon process.

Logon In the logon phase, WinTlogon.exe starts the Local Security Authority (LSA), which
provides a logon screen. At this point you may log on to the system, even though some services
may be still be starting in the background. After a successful logon, the system copies the clone
control set to the Last Known Good configuration (LKG) control set. The LKG control set will
not be changed again until the next successful logon.

User Logon to a Computer

Logging on to a computer is a process of authentication and validation. Authentication occurs
when a user provides a set of credentials to prove his identity. These credentials can be in the form
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of a username and password, a smart card, or some type of biometric identification, such as a fin-
gerprint or retinal scan. After the user provides the credentials, the computer checks the Security

Accounts Manager (SAM) database to locate the account and validate the logon. If the account

is validated, the user receives an access token and is permitted to log on to the computer. A suc-
cessful logon to a computer provides a user access to the resources for which he has permissions,

on that computer only. If the account cannot be validated in the SAM, then the user will receive

an access-denied message.

Check the Simple Solutions First

One day a user called me in a panic. She said that she absolutely had to get her computer run-
ning again and that | had to help her. | asked her to calm down and describe the problem to me.
She took a couple of deep breaths and then began to tell me about it.

“l just finished installing some new software that | thought would help me do my job better, but
it messed up my computer really badly!” she said. She continued, “As soon as | finished install-
ing the software, the computer said that it had to reboot to finish the installation, and that's
when the problem started. When | rebooted the computer, it would not come back up!”

| asked her if there was an error message, and she said, “Yes, it said that it couldn’t find the
ntoskrnT.exe file. Is that bad?” At first | was envisioning trying to walk her through the Recov-
ery Console or possibly a reinstallation of the software. This would have been an interesting
challenge over the phone. Then, | had an idea and | decided to check one more thing.

| asked her if there was a floppy disk in the floppy disk drive. She said “Yes, that’s what the soft-
ware was on. Should | take it out now?” | told her to remove the floppy disk and restart the com-
puter. She did and, of course, everything was fine.

As you might have guessed, the floppy disk was higher in the boot order and was therefore
being read instead of the hard drive. Of course the system couldn’t find the ntoskr1.exe file on
the floppy disk! This would have been obvious to me if | had been there with her, but because
of her panic and the fact that | couldn’t “see” the whole situation, | nearly missed the obvious
solution to the problem.

My main point here is that the user might be very upset and think that she has a huge problem.
If you fall into the emotion of the situation, then you might miss an obvious and simple solution
to the problem. You should, therefore, always think it through and check the simplest of solu-
tions first.

User Logon to a Domain

Logging onto a domain is similar to logging on to a computer, except that the user is authen-
ticated by a domain controller instead of just the local computer. In Windows 2000 and
Windows Server 2003 networks, the domain controller has a copy of the Active Directory,
which lists all of the accounts and their credentials. When the user enters his credentials,
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they are compared with the account database in the Active Directory. If the credentials
match those of an account in the Active Directory database, then the domain controller pro-
vides the user rights and group membership information to the LSA of the computer, which
then creates the access token. If the domain controller cannot be located, then the user may
be allowed to log on with cached credentials. In other words, if the user has logged on
before, he can log on again with the same rights and permissions that he had on his last
logon. A successful logon to a domain provides the user access to resources in that domain
and any trusted domains, provided that he has the permissions to use the resources.

ING domain logon credentials and then accidentally selects to log on to the local

ﬁl‘ One of the most common errors in logging on occurs when a user enters his
computer rather than the domain.

System Performance

Just as a chain is only as strong as its weakest link, a computer is only as strong as its weakest
essential resource. There are four resources that are essential to the performance of a computer:
processor, memory, disk subsystem, and network subsystem. If any of the components is not
adequate or is malfunctioning, the computer’s performance could be affected in all areas. A
weakness of one resource that affects all of the other resources is referred to as a bottleneck. You
should monitor the computer resources to create a standard of configuration that allows the
best system performance for the available resources. This standard is referred to as a baseline.
As a desktop support technician, you must know how to identify and troubleshoot bottlenecks
and create a baseline of performance.

There are several tools included with Windows XP that can assist you in monitoring
resources, identifying bottlenecks, and creating a baseline. These include system configuration
tools in Help and Support, Task Manager, and the Windows Performance tool. You should
know how to use each of these tools to identify and troubleshoot problems associated with sys-
tem performance. In this section, we will describe the four resources that affect a computer’s
performance and discuss how to use the system performance tools built into Windows XP.

Computer Resources

In order for a computer to perform properly, it must have the proper amounts of four essential
resources. A lack of any of the essential resources can cause a bottleneck, which can affect the
performance of the entire computer. You should be familiar with each of the four essential
resources for a computer and know how they might affect system performance. In this section,
we will describe each resource and its role in system performance.

Processor The processor, or central processing unit (CPU), is the main chip that makes the
computer, well... a computer. The faster the processor is, the more work the processor can do
in any given period of time. At the time of this writing the fastest processors are about 3 GHz,
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or 3 billion cycles per second. Most client computers have only one processor. Some client com-
puters and most servers have multiple processors.

Memory The memory that the computer uses consists of physical memory, referred to as
RAM, and virtual memory that is actually stored on the hard drive and then moved into RAM
just before being used. The process of moving the memory between the hard drive and the
RAM chips is called paging. The area of the hard drive that temporarily stores the virtual
memory is called the page file. It takes longer to use memory that is on the page file than it
does to use memory in physical RAM. For this reason, you should avoid excessive paging to
improve system performance.

< Adding RAM is often a good answer on a test as well as a good solution to
P many real world problems.

Disk subsystem The disk subsystem consists of the hard disks and hard disk controllers. Disks
come in all sizes and speeds. The hard disk in a client should be large enough to store the data
and software that users need and still have extra space for paging and other functions, such as
a printer spool. If a disk becomes too full, performance can be affected because the computer
will have to use more processor time to write to the disk. You can also use high-speed Small
Computer System Interface (SCSI, pronounced “scuzzy”) disks to speed up disk performance if
needed. SCSI disks are often used in servers.

Network subsystem The network subsystem consists of the network interface cards and other
communications components within a computer and within the network to which it is con-
nected. Most of today’s network interface cards are dual-speed 10 Mbps/100 Mbps depending
on the network devices to which they are attached. You can speed up the network subsystem
by using bus-mastering cards that have their own processor and can “think” for themselves
instead of having to rely on the CPU. Since the CPU is responsible for all of the processing that
occurs in a computer, a card that can bypass the CPU can in effect "take a shortcut" and there-
fore speed up the Network Performance of a computer.

Performance Monitoring Tools

Windows XP comes with a set of tools that you can use to monitor system performance and cre-
ate a baseline of performance. Each computer and each network is unique, so the use of these
tools is as much of an art as it is a science. In this section we will discuss the tools that you will
use most often. These include a set of tools that can be found in Help and Support as well as
Task Manager and the Windows Performance tool.

Help and Support Tools for Performance

Windows XP contains a set of tools that specifically enable you to maintain the performance of
a computer. You should know how to access these tools so that you can use them yourself and
teach the users to use them. These tools are located in the Performance and Maintenance section
of the Help and Support Center, as shown in Figure 4.4. The Help and Support Center will
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guide you or the user to the appropriate tools or features in the operating system based on the
description of the tasks that you want to perform. To access these tools, you should choose Help
And Support from the Start menu (or press F1 from the desktop).

Task Manager

Windows Task Manager is an easily accessible tool that provides information about perfor-
mance and displays details about programs and processes that are currently running on the
computer. You should know how to use Task Manager to troubleshoot problems related to
applications and networking. To access Task Manager, right-click the Taskbar and choose Task
Manager. As illustrated in Figure 4.5, Task Manager contains the following tabs:

= Applications: Displays a list of the programs that are running on the computer and the sta-
tus of each one.

= Processes: Displays information about the processes running on the computer. You can use
the View menu’s settings to add more details to this tab.

*  Performance: Displays a dynamic overview of the computer’s performance, including
graphs for CPU and memory usage.

= Networking: Displays a graph of network performance. This enables you to determine the
status of the network to which the computer is connected. This tab is displayed only if a net-
work interface card is installed in the computer.

= Users: Displays a list of users who can access the computer and the status of each user. This
tab is available only for computers that are members of a workgroup and that are enabled
for fast user-switching.

FIGURE 4.4 The Performance and Maintenance section within Help and Support
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FIGURE 4.5 The Task Manager dialog box
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Windows Performance Tool

The Windows Performance tool is actually two tools in one. You should be familiar with both
tools and understand the difference between them and when each tool should be used. You can
access Windows Performance through Administrative Tools. As shown in Figure 4.6, the two
tools contained in Windows Performance are the following;:

= System Monitor: This tool can be used to collect real-time information about processor,
memory, disk subsystem, and network subsystem components. You can display this infor-
mation in digital form or on a graph.

*  Performance Logs and Alerts: This tool can be used to record performance data over
a specified period of time. You can use the recorded data to establish a baseline of
performance.

As a desktop support technician, you should know how to use the Windows Performance
tool to capture and record performance data. It is a good practice to collect data over a few days
or even weeks to establish a baseline of performance. Exercise 4.10 walks you through the steps
to create counters that capture and record the data that you specify.
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Capturing and Recording Data

1.
2.

On the Windows XP desktop, click Start, and then choose Control Panel.
On the Control Panel, select Administrative Tools and then choose Performance.

On the console pane (on the left) of the Performance Console, double-click Performance
Logs And Alerts.

Right-click Counter Logs and then choose New Log Settings.
Inthe New Log Settings dialog box, type the name for your new log (any name will suffice).

On the General tab in the dialog box for your new log, click Add Objects to record all pos-
sible counters for the selected object or Add Counters to specify counters for each object.

Continue to select the objects and counters. You should select at least one counter for each
of the main resources of processor, memory, disk subsystem, and network subsystem.
You can then set the interval at which to collect each counter. Setting the interval to a lower
value will increase the load on your processor.

Click the Schedule tab to start the log immediately or set the date and time to start the log.
You can also schedule the time to stop the log.

After all settings are complete, click OK to save the log. To view the logs that you have set,
select Counter Logs in the console pane and view the list of logs in the details pane.

FIGURE 4.6 Windows Performance tool
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Summary

Users will be much more productive if they are comfortable with their computer and if their

computer is performing well. As a desktop support technician, you are responsible for setting
up and maintaining computers and user environments that offer comfort and performance for
the users. There are six main factors associated with user comfort and computer performance:
user environment, multiple languages and multiple locations, security settings and local security
policy, local user and group accounts, system startup and user logon, and system performance.

Windows XP provides a user environment that includes configurable Taskbar, toolbar, and
pointer device settings to enable users to customize the operation of their computer. In addition,
Windows XP provides accessibility options and accessibility features for users who have special
needs because of a physical handicap. Correct configuration of these settings can improve a
user’s productivity.

Windows XP is available in 24 different languages, or localized versions. In addition, you can
configure regional settings and input languages on any of the localized versions. You can also
install and configure multiple languages of the Windows XP operating system on the same com-
puter using the Multilanguage User Interface (MUI) version of Windows XP software.

Local security policies can be used to control computers that are part of a workgroup. These
policies control who accesses the computer, which resources they are allowed to use, and
whether their actions are recorded in an event log. When computers are members of a domain,
Group Policies on the network can override the local security policies on the computer. You can
determine whether Group Policies are affecting the user or computer by using the gpresult tool
included with Windows XP software.

User accounts uniquely identify a user and can provide him access rights and permissions to
use resources. A local user account gives a user only the right to log on to a local computer and
access the resources on that computer. Domain user accounts give a user the right to log on to
a domain as authenticated by a domain controller, which gives him access to any resources on
the domain for which he has permissions. Users are generally placed into group accounts to
assign the access rights and permissions, rather than directly applying these to the user. You can
view and configure user accounts using User Accounts in the Control Panel or Local Users and
Groups in the Computer Management Console. You can also use Local Users and Groups to
view and configure local groups.

Users cannot access any resources until they are logged on to a computer that has success-
fully started. Problems can occur in any of five phases: pre-boot, boot, kernel load, kernel ini-
tialization, and logon. Each phase performs specific tasks that are required for the next phase.
Understanding what happens in each phase can assist you in troubleshooting failed startups
and failed logons.

Users can be productive only if their computer is working properly. Proper performance of a
computer is dependent upon adequate amounts and the correct balance of four primary resources:
processor, memory, disk subsystem, and network subsystem. You can use Help and Support,
Task Manager, and the Windows Performance tool in Windows XP to monitor and troubleshoot
these resources. You should create a baseline of acceptable performance for a computer. This
baseline can be used as a comparison to troubleshoot the computer later on.
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Exam Essentials

Know how to configure the Taskbar and toolbar settings. You should know how to configure
the Taskbar and toolbar settings in Windows XP and applications that use Windows XP. These
should include settings for the clock, the Notification Area, and the Quick Launch area. In addition,
you should know how to auto-hide the Taskbar and how to troubleshoot this option for a user.

Know the difference between accessibility options and accessibility features and where to configure
each of them. You should know that the accessibility options include settings such as StickyKeys
and SoundSentry and that these are located in the Control Panel. In addition, you should know that
the accessibility features include tools such as Magnifier and Narrator and that these are located
in the Accessories menu of the All Programs menu. Finally, you should know how each of these
options and/or tools operates and how they might be related to a troubleshooting issue.

Know the difference between Localization and Regional and Language Options. You should
know that Localization refers to the language that is in the Windows XP software itself, e.g., the
Start menu and Help screens. In addition, you should know that Regional and Language Options
are available on all localized versions of Windows XP software and on the Multilanguage User
Interface (MUI) version as well. Finally, you should know how to configure each of these settings.

Understand local security policy vs. Group Policy. You should understand that local security
policy can fully control a computer only if the computer is a member of a workgroup and not
a domain. In addition, you should know that if a computer is a member of a domain, then the
network’s Group Policies might override the local security policy of the computer. Finally, you
should know how to troubleshoot network Group Policies and determine which policies are
affecting the computer by using the gpresult tool.

Understand the difference between local accounts and domain accounts. You should know

that local user accounts reside in the Security Accounts Management (SAM) database on each
computer and can be used to log on locally to the computer and gain access to resources that
are on that computer, provided that the user has permissions for the resource. In addition, you
should know that domain user accounts reside in the Active Directory and can be used to log
on to a domain and gain access to resources anywhere in the domain, provided that the user has
permissions for the resources. Finally, you should know that one of the most common logon

mistakes is accidentally attempting to log on locally to a computer with a domain user account
because of an incorrect logon setting.

Know and understand the Windows XP boot sequence. You should know the five phases of
the Windows XP boot sequence and what actions are performed at each step. You should under-
stand the process of logging on to a computer and how it differs from logging on to a domain.

Know and understand the resources involved with System Performance. You should know
the four main resources that a computer uses and understand how a lack of or a malfunction
in any of these resources can cause a bottleneck. In addition, you should know how to use the
Help and Support and Task Manager tools to maintain and troubleshoot system performance.
Finally, you should know how to create a baseline of performance using the Windows Perfor-
mance tool in Windows XP.
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Review Questions

1. You are the desktop support technician for your company. A user complains that his Windows XP
desktop does not have a clock in the Taskbar at the bottom of the screen. What should you tell him?

A. The clock option is an advanced option that is available only on special versions of
Windows XP software.

B. He can add the clock by going to the Regional Options in Control Panel.

C. He can add the clock by accessing the Taskbar properties and removing the check mark
from Hide The Clock.

D. He can add the clock by accessing Taskbar properties and placing a check mark on
Show The Clock.

2. Youare the desktop support technician for your company. Two users share the same computer.
One of the users needs the Start menu and Help screens to be displayed in English, while the
other would like to have them displayed in French. The computer currently has the English ver-
sion of Windows XP installed. Which of the following should you do?

A. Add the French language to the Regional and Language Options on the English version.

B. Install the French version of Windows XP over the English version.

C. Add the French language to the Localization options in the English version.

D. Install the MUI version of Windows XP and then add the required Localization options.
3.  Youare the desktop support technician for a large company with many users. A user complains

that he does not have rights to perform volume maintenance tasks, such as running Disk Defrag-

menter on his Windows XP computer in your domain. You change the local security policy to

allow the user to run the tool, but less than one hour later he is disallowed again. What is the
likely cause of this problem?

A. Users are never allowed to run the Disk Defragmenter tool. It just took the computer
some time to take away the rights again.

B. The Group Policy of the domain is overriding the local security policy on the computer.

o

You did not save your change to the Active Directory.

D. You were not allowed to make the change in the local security policy of the computer,
so the change was reversed.
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4. You are the desktop support technician for a large company. A user complains that she cannot
install software on her computer. She says that she is receiving an error that states that she doesn’t
have the rights to install the software. You suspect that Group Policies are affecting her computer
or her user account. Which of the following tools should you use to troubleshoot this issue?

Active Directory Users and Computers
Computer Management

Task Manager

Gpresult

Nslookup

moowp>»

5.  You are the desktop support technician for a large company. A user is attempting to log on to a
computer but access is denied. You have administrative rights for the computer. You wish to view
all of the accounts on the computer, including the system accounts. Which tool should you use to
view accounts on the computer and create a new user account if necessary?

A. Local Users and Groups
User Accounts
Active Directory Users and Computers

Task Manager

moow

My Computer

6. You are the desktop support technician for a large organization. A user complains that he can-
not access a file server on the domain. You examine his permissions for the file server and find
that his account has been given Full Control access to the file server. The file server is available
on the domain, and other users can gain access to it. Which of the following could be causing
this issue? (Choose two answers.)

A. The user should not have been given Full Control. Only the administrator should have
Full Control, so the system is denying access to the user.

B. The user is a member of a group that is denied access to the file server.

o

The file server is not operating properly.

D. The user is logged on to his own computer instead of the domain.
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You are the desktop support technician for a large organization with many users. A user named
Tom has recently been promoted to executive. With this promotion, he is supposed to have
access to the executive files. Tom complains that although he can log on to the domain, he still
does not have access to the executive files. You verify with the network administrator that Tom’s
account has been added to the executive group, which has permissions to the files. Other exec-
utives are currently able to access and use the files. Which of the following could be causing this
problem? (Choose all that apply.)

A. Tom is a member of group that is explicitly denied permissions to the executive files.
B. The domain controller is logging Tom on with cached credentials.

C. Tom has not restarted his computer.

D. The server with the executive files is not available.

You are the desktop support technician for your company. A user complains that he logged onto

a computer with his local account but he cannot view or access any of the domain resources.
What should you do first?

A. Ask the network administrator to re-create the corrupted local account to give the user
access to the domain.

B. Change the user permissions for the domain resources so that he has access to them with
his local logon.

C. Tell the user that he must log on to the domain with a domain user account to gain
access to the resources of the domain.

D. Run gpresult to make sure that the local user account is not affected by the Group Pol-
icies of the domain.

You are the desktop support technician for your company. You want to create a log that rep-
resents a baseline of performance for a computer. Which of the following tools should you use?
(Choose all that apply.)

A. Task Manager

B. System Monitor

C. Performance Logs and Alerts

D. Disk Management

You are the desktop support technician for a large organization. To begin to troubleshoot a
user’s computer, you want to see a list of all of the applications that are currently being used and

the status of each application. You also want to be able to close multiple applications at the same
time and open some applications if needed. Which tool should you use?

A. Task Manager
Computer Management

B.
C. The Taskbar
D. My Computer
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Answers to Review Questions

1. D. The clock option in the Taskbar is available and selected by default on all versions of Win-
dows XP. If the user does not see the clock in the Taskbar, then someone has removed the check
mark from Show The Clock in the Taskbar properties. He should put the check mark back in
to show the clock.

2. D. Since the Start menu and Help screens in the operating system need to be available in both
English and French, you will need to install the Multilanguage User Interface (MUI) version of
Windows XP. Regional and Language options can be used to change the input language but not
the language displayed in the operating system itself, referred to as Localization.

3. B. Group Polices in a domain can override the local security policy set on a computer. You were
able to make the change in the local security policy, but the change was only temporary until the
Group Policy refreshed itself.

4. D. You should use the gpresult tool from a command prompt. The gpresult tool shows the
Group Policies that are applied to the current computer and to the currently logged-on user.
Active Directory Users and Computers, Computer Management, and Task Manager will not
give you this information. Nslookup is a tool that is used to troubleshoot hostname resolution
on Domain Name System (DNS) servers.

5. A. Since you wish to view all of the local accounts on the computer, including the system accounts,
you will have to use the Local Users and Groups tool in the Computer Management Console. You
can view the local user accounts and add a user account with the User Accounts tool in Control
Panel, but you cannot view the system accounts in User Accounts. You would not use Active Direc-
tory Users and Computers to view or create local user accounts. Task Manager and My Computer
are not used to view and create accounts.

6. B, D. If the user is a member of a group that is explicitly denied access to the file server, then he
will be denied access as well, even if he has Full Control permissions assigned to his account. If
the user is logged on to his own computer (locally) instead of the domain, then the user will not
have access to the file server on the domain. Administrators can give Full Control permissions
to users if they choose to, although it is generally not recommended. The file server must be oper-
ating properly, since other users are gaining access to it.

7. A, B.If Tom is a member of a group that is explicitly denied access to the executive files, then
he will be denied access as well, even if he is a member of the executive group. If the Active Direc-
tory has a problem and the domain controller is logging Tom on with cached credentials, then
he will have the same permissions as he did before he was an executive, so he will be denied
access to the executive files. Tom should not need to restart his computer. The server with the
executive files must be available, because other executives are currently using it.

8. C. Local user accounts give access only to resources that are located on the local computer, not
to those on the domain. The user will need a domain user account to gain access to domain
resources. His local account is probably not corrupt, and it would not be affected by Group Pol-
icies on the domain.
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C. The only tool that you need to use to create the log is Performance Logs and Alerts in the Win-
dows Performance tool. Task Manager is a readily accessible tool that lists applications that are
currently running and some basic performance information, but it cannot be used to create a log.
System Monitor is a tool in the Windows Performance tool that enables you to view real-time
data in digital form or on a graph, but it cannot create a log. Disk Management would not be
used to create a log.

A. Task Manager is the only tool listed in this scenario that enables you to list the applications that
are running and view the status of each application. You can also open new applications with Task
Manager if needed. Computer Management does not enable you to view a list of applications run-
ning on a computer. The Taskbar does enable you to view the applications that are running, but
they are not in list form and you cannot see the status of the applications. My Computer does not
enable you to view a list of applications that are running on the computer.
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Successful communication of networked computers requires
three components: a method of connectivity, a common client,

and a common communication protocol. You can establish con-
nectivity by using cables to connect the computers or by using wireless connections. The com-
mon client for computers running Microsoft operating systems is the Microsoft software that
is built into all Microsoft operating systems, referred to as Client for Microsoft Networks. A
protocol is a standard of rules by which communication must take place. There are many dif-
ferent communication protocols, but the protocol that is the most popular today is Transmis-
sion Control Protocol/Internet Protocol (TCP/IP). The main reason for the popularity of TCP/
IP is that it has become the standard protocol for use on the Internet.

Actually, computers recognize one another by a physical address that is burned into the net-
work interface card installed on each computer. This physical address is referred to as a Media
Access Control (MAC) address. To facilitate communication between computers in our own
network and in other networks, we generally use a logical address along with the TCP/IP pro-
tocol. This address is referred to as an IP address. A service that is built into TCP/IP called
Address Resolution Protocol (ARP) is used to convert the IP addresses to MAC addresses so
that packets can be sent to the correct computers.

Since IP addresses are not easy to remember, we use special files and servers to convert the
cumbersome IP address into a name that we can more easily remember. Computers then convert
these user-friendly names back into IP addresses and eventually into MAC addresses. This pro-
cess is referred to as name resolution. Using TCP/IP and name resolution, the Internet connects
computers across the world. We can use our Internet Explorer browser software to connect to
servers, even though we have no idea where the servers are located. We can also use these same
protocols and services to connect to and remotely manage computers in our own organization.

In this chapter, we will discuss configuring and troubleshooting network protocols and services.
We will focus our attention on five main areas of configuration and troubleshooting as follows:

TCP/IP  Transmission Control Protocol/Internet Protocol (TCP/IP) is the most common protocol in
use today. TCP/IP is used within most networks and is also used to connect all of the networks of the
world together through the Internet. As a desktop support technician, you should be able to configure
clients to use TCP/IP. In addition, you should know how IP addresses are assigned and how to use
tools inherent to TCP/IP to troubleshoot connectivity between computers. You should also be able
to configure advanced connection settings, such as the Internet Connection Firewall (ICF).

Name resolution The logical addresses that TCP/IP uses to identify a computer or a network
are called IP addresses. These addresses are long and cumbersome to remember. Because of this,
people like to use easier to remember user-friendly names. Network experts have created files
and services that computers use to convert these user-friendly names back into IP addresses.

You should know how Hosts files, Lmhosts files, WINS servers, and DNS servers are used to
convert user-friendly names to IP addresses. You should also know when it is appropriate to use
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each type of file or service. In addition, you should be able to configure and troubleshoot clients
to use these name resolution files and services.

Remote connections In today’s business world, many users work from home or from a hotel. It’s
essential that they be able to connect to your organization’s network and use resources just as if
they were at a desk in your building, although the connection will probably be quite a bit slower.
There are two main types of remote connections that you can use: dialup and VPN through the
Internet. You should know how to configure and troubleshoot both types of remote connections.

Internet Explorer Most users have no idea how TCP/IP or the Internet actually works. In addition,
they don’t know where the servers to which they connect are physically located. The reason that they
don’t know is that they don’t have to know; it doesn’t matter! Browser software, such as Microsoft’s
Internet Explorer, enables users to locate resources across the Internet by entering their user-friendly
web address or Uniform Resource Locator (URL) address. Provided that Internet Explorer is prop-
erly configured, a user can browse network resources with very little training or knowledge. You
should know how to configure and troubleshoot the properties of Internet Explorer.

Remote connectivity tools Network administrators and desktop support technicians no longer
have to physically visit a user’s computer to assist a user and troubleshoot the computer. Remote
connectivity tools such as Remote Desktop and Remote Assistance enable them to connect to the
user’s computer and make configuration changes through the network or even through the Inter-
net. You should understand the difference between Remote Desktop and Remote Assistance. You
should also know how to use these tools to configure and troubleshoot common user issues.

TCP/IP

TCP/IP has become the de facto standard communication protocol in use today; that means that
it “just sort of happened.” TCP/IP was originally developed as part of a Department of Defense
computer communication project called Advanced Research Project Agency Network (ARPAnet).
Eventually, the government let some corporations use the technology and it continued to grow
from there. Actually, people “unwittingly” chose TCP/IP when they began to use the Internet, and
then it grew so fast that there was really no turning back.

TCP/IP currently uses a 32-bit binary address to provide for unique IP addresses on computers
and networks. TCP/IP addressing schemes can become very complex and confusing. Fortunately, as
a desktop support technician, it is not necessary that you be an expert in regard to TCP/IP or IP
addressing. You should, however, know how to configure a client IP address and know how to con-
figure a client to obtain an IP address automatically. In addition, you should be able to configure the
Internet Connection Firewall in the advanced settings of a connection’s properties. Finally, you
should know how to use tools inherent in Windows XP to troubleshoot connectivity for a client.

TCP/IP configuration and troubleshooting can be divided into four main areas:

=  Manual IP address configuration

*  Automatic IP address configuration

= Internet Connection Firewall configuration
= TCP/IP troubleshooting

Let’s examine each area in detail.
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Manual IP Address Configuration

All Microsoft clients can be configured with an IP address manually. The interface on which this
is done varies slightly on different Microsoft operating systems. We will focus on the interface
used with Windows XP. You should be careful not to use an address that is already in use on
the network, because this can cause communication errors on your computer as well as on the
computer that originally had the address. Exercise 5.1 walks you through the steps to manually
configure an IP address on a Windows XP client.

Configuring a Manual IP Address in Windows XP

1. (Ensure the Control Panel is in Classic view.) On the Windows XP desktop, click Start and
then select Control Panel.

2. On the Control Panel, select Network Connections and then choose the connection that
you want to configure. Connections represent network interface cards in the computer.
Some computers may have multiple connections.

3. Right-click the selected connection and then choose Properties.

4. In the field marked This Connection Uses The Following Items, double-click Internet
Protocol (TCP/IP).

5. SelectUse The Following IP Address, and then enter an address that is unique for your subnet.
If you are not sure of the address to enter, then you should consult your network administrator.
Itis very important not to use an address that is already in use on the network. You should also
consult with the network administrator to determine the correct DNS address to enter.

I-Inumat Protocol (TCP/IP) Properties mm

General

*ou can getIP settings assigned automatically ifyour netwerk supports this
capability. Ofherwise. you need 1o ask your network administrator for the
appropnalte IP setings
() Obtain an [P address sutomatically
(@) Use the following IP address
IP address: 192 _ 168 T .10

Subnet mask: 285 %5 K5 0

Default galeway

(@) Use the following DNS server addresses:

Prefered ONS server 24 1% 17 . 8 |
Alzernate ONS server 24 188 . 17 3
Advanced...
0K Cancel |

6. When you have finished entering the addresses, click OK, and then click OK again to save
the changes.
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Automatic IP Address Configuration

All Microsoft clients later than Windows 98 are set by default to obtain an IP address automat-
ically. If a client’s configuration has been changed to a manually set address, and you need the
client to obtain an IP address automatically, then you can change the client setting back to auto-
matic configuration. Exercise 5.2 walks you through the steps to configure a client to obtain an
IP address automatically.

Configuring Windows XP to Obtain an IP Address Automatically

1. On the Windows XP desktop, click Start and then select Control Panel.

2. On the Control Panel, select Network Connections and then choose the connection that
you want to configure. Connections represent network interface cards in the computer.
Some computers may have multiple connections.

3. Right-click the selected connection and then choose Properties.

4. In the field marked This Connection Uses The Following Items, double-click Internet Pro-
tocol (TCP/IP).

5. Select Obtain An IP Address Automatically. Note that it is not necessary to delete the cur-
rent manually set IP address.

Internet Protocol (TCP/IP) Properties m@

General | Altemnate Configuration.

You can get P settings assigned automatically if your network supports this
capability. Otherwise, you need to ask your network administrator for the
appropriate |P seftings.

(@) Obtain an IP address automatically

() Use the following IP address:

(@) Obtain DNS server address automatically

() Use the following DNS server addresses:

| OK ] | Cancel ‘
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EXERCISE 5.2 (continued)

6. Youcan also setthe client to obtain its DNS server address automatically. You should con-
sult with your network administrator to determine this setting.

7. When you have finished making your selections, click OK, and then click OK again to save
your settings.

Internet Connection Firewall Configuration

You should know that if you are directly connected to the Internet, then the Internet is also
directly connected to you! This means that you might unknowingly give other users access to
resources and information in your computer. To prevent this from happening, you can use hard-
ware or software to filter traffic to and from your computer or your entire network. This type
of hardware and software is referred to as a firewall. While most organizations employ a cor-
porate firewall, it’s still a good practice to use an additional firewall at each client. Windows XP
has a built-in firewall called the Internet Connection Firewall (ICF). You should know how to
configure the ICF for a Windows XP client. Exercise 5.3 walks you through the steps to con-
figure the ICF.

TCP/IP Troubleshooting

As we mentioned before, it’s not necessary that you become an expert at the inner workings of
TCP/IP to be an effective desktop support technician. You should, however, know how to per-
form some basic troubleshooting such as IP address, connectivity, and name resolution trou-
bleshooting. In this section, we will discuss IP address and connectivity troubleshooting. In the
next section, we will discuss name resolution troubleshooting.

Configuring the Internet Connection Firewall in Windows XP

1. On the Windows XP desktop, click Start and then select Control Panel.

2. On the Control Panel, select Network Connections and then choose the connection that
you want to configure. Since connections represent network interface cards in the com-
puter, some computers may have multiple connections.

3. Right-click the selected connection and then choose Properties.
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EXERCISE 5.3 (continued)

4. On the connection’s Properties sheet, select the Advanced tab.

_L Firewalled Internet Praperties 254

| General | Authentication Advanced
ntemet Connection Firewall

[#] Protect my computer and network by imiting or preventing
access to this computer from the Intemet

Learn mare about [t

nternet Connection Sharng

[ Allow other netwark users o connact through this computer's
nlemat conneclion

Learn more about Intemat Connaclion Shanng.

Fyou're not sure how to setthese properbes, use the

Metwark Satup Wizard instead. Satfings ..

[ ok |[ cence |

5. Click the check box marked Protect My Computer And Network By Limiting Or Preventing
Access To This Computer From The Internet. This will prevent all access to your computer
from outside your computer.

6. Click the Settings button to configure access to specific services on your computer. You
can also configure logging of packets that flow through the firewall on the Security Log-
ging tab and configure filtering of error and status information on the ICMP tab.

oo (24 Toinceqestangs 283

Services | Securily Logging :LIEIZM#'

Sarvices '.Securﬂy Logging ICMP
Logging Options: Internet Control Message Protocol (ICMP) aliows the computers on a
network to share ermor and status information. Selectthe requests for |
information from the Intemet that this computer will respond to:

[Log successful connections |

[ Allow incaming eche requast
Lag fil aptions [ Allow incoming timestamp requast
[ Allow incoming mask request
[ Allow incoming router requast
CAWINDOWS\pfirswall log [ Allow outgoing destination unreachable
[0 Allow cutgaing source quench
Erowse. J ] Allow cutgoing parameter problem
—— [ Allow outgoing ima exceedad
Sizelimit (4036 e ] O Alow redirect

Mame

Description:

Messages sentto this computer will ba repeated back to the
sender. This is commenly used for roubleshoobng, for example, to
ping a machine.

Bestore Dafaults

ok ][ camca | ok ][ cancel
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Network administrators often use servers called Dyrnamic Host Configuration Protocol (DHCP)
servers to assign unique IP addresses to client computers when they are connected to the network.
In addition, Windows XP and Windows 2000 clients can automatically assign the computer an
IP address in a special network when no DHCP server is available. This address is referred to as
an Automatic Private IP Address (APIPA). You can recognize an APIPA address because it will
start with 169.254. Typically an APIPA address on a client indicates that the DHCP server was

not available and that the client does not have a valid network address. You should know how to

determine whether a client is configured with an address from a DHCP server, an APIPA address,
or just a manual address. Exercise 5.4 walks you through the steps to use the ipconfig tool built
into Windows XP to determine how a client’s IP address is configured.

Using the Ipconfig Tool to Determine How an IP Address Was Configured
on a Client

1.

2
3.
4

On the Windows XP desktop, click Start and then choose Run.

On the Run linge, type cmd to obtain a command prompt.

On the command prompt, type ipconfig /all.

Read the IP address of the client connection to determine whether it starts with 169.254. If
it does, then it is an APIPA address.

B command Prompt

Microsoft Windows XP [Uersion 5.1.266808]
[C] Capyright 1985-2081 Hicrosoft Corp.

C:\Documents and Settings\EBill

Windows IP Configuration

Host Mame . . . . . . . . . . . .
Primary Dns Suffix . . . . . . . ;
Node Type . . . . . . .« « « & 4 1
IP Routing Enabled. . . . . . . . :
WINS Proxy Enabled. . . . . . . . :

Ethernet adapter Firewalled Internet:

14l

Connection-specific DHS Suffix

Description . . . . . . . . . . .
Physical Address. . . . . . . . .
Dhep Enabled. . . . . . . . . . .
Autoconfiguration Enabled . . . . :
IPAddresse, | . .. v v W oe W 0
Subnet Mask . . . . . .. o0 o
Default Gateway . . . . . . . . .
DHCP Serwver . . . . . . . . . ..
DHS Seruers . . _ . . . . . . . .

Ferguson.XP1»ipeonfig /all

. xpl

Unknown
Yes
Mo

: al.charter.com

: Belkin USE Ethernet Adapter
: BO-05-1B-80-4B-F6

: Yes

Yes
68.185.241.160
25%5.255.248.9

+ BB.185.2%8.1
: B6.168.216.9
: 24.196.17.8

67.97.48.9

-15|x]

-

=
B

If the address does not start with 169.254, then read the ipconfig output to determine

whether the address was obtained manually or assigned by a DHCP server. If DHCP
enabled is followed by “Yes”, then the computer is configured to obtain an address from
a DHCP server. You can read the DHCP Server line at the bottom of the output to determine
the IP address of the DHCP server that leased the IP address to the client.

149
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Windows XP also allows you to set an alternate configuration that will be used

P instead of the 169.254.x.y address, in the event that a DHCP server is not avail-
able. This can be useful on a laptop that is used in two different networks, espe-
cially if one network has a DHCP server and the other does not.

An TP address that starts with 169.254 may indicate that a DHCP server was not available
when the client computer was first started. It’s possible that the DHCP server could have become
available after the client was started. You can force the client computer to ask the DHCP server
for an address using the ipconfig /renew command. Exercise 5.5 walks you through the steps
to force the computer to ask for an address.

Using the Ipconfig /renew command

1. On the Windows XP desktop, click Start and then choose Run.
2. Onthe Run line, type cmd to obtain a command prompt.

3. Onthecommand prompt, type ipconfig /renew and then wait a few seconds to determine
whether the client can obtain an address.

B Command Prompt - & ﬂ
Microsoft Windows XP [Uersion 5.1.2600] =
(C) Copyright 1985-2001 Microsoft Corp.

C:\Documents and Settings\Bill Ferguson.XP1>ipconfig /renew

Windows IP Configuration

Ethernet adapter Firewalled Internet:

Connection-specific DNS Suffix . : al.charter.com
IP Address. . . . . . . . . . . . : B8.185.241.1868
Subnet Mask . . . . . . . ... . 255.255.248.0
Default Gateway . . . . . .. . . : BB.185.240.1

Ethernet adapter Private Network :
Connection-specific DNS Suffix
IP Address. . . . . . . . « oo 5 192.188.1.18
Subnet Mask . . . . . . . o saoce o 4 £299,255.255.8
Default Gateway . . . . . H

C:\Documents and Settings\Bill Ferguson.XP1>

hd

& [

4. If the client obtains a valid address from the DHCP server, then the computer should be
able to communicate on the network. If the client is still unable to obtain a valid IP address,
then you should escalate the issue to the network administrator.
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Connectivity Troubleshooting

As we mentioned before, connectivity of computers in a network requires more than just the
wires or wireless connections that establish the physical network. To have connectivity, com-
puters must also share a common protocol that is properly configured. This is referred to as log-
ical connectivity. You can use tools built into Windows XP to test the physical connectivity and
logical connectivity of computers in a network. There are two main tools that you can use to test
connectivity: ping and pathping. In this section, we will discuss each of these tools and illustrate
how you can use them to troubleshoot connectivity between computers.

Using the Ping Tool

The ping tool is a command-line tool that creates special packets called Internet Control
Message Protocol (ICMP) packets. When you use the ping tool, you send packets to a spe-
cific address, which then sends them back. You might be thinking, “So, why am I sending
these packets back and forth in the first place?” I’'m glad that you asked. The main reason
why you use the ping tool is to see if the packets come back. If the packets can be received
by a computer and then be sent back to you, then you know that you have physical and log-
ical connectivity with the computer. If they can’t, then you may need to start checking your
connections and the link lights on your network interface cards, hubs, and routers. By the
same token, you might also need to make sure that you have assigned an address that is
valid within the subnet. Exercise 5.6 walks you through the steps to test connectivity using
the ping tool.

4 If you receive a reply from a loopback test, you can also ping the IP address
p y ping
P of the local computer to determine whether the network interface card is
functional.

Testing Connectivity between Computers Using the Ping Tool
1.  On the Windows XP desktop, click Start and then select Run.
2. Onthe Run line, type cmd to open a command prompt.

3. Onthe command prompt type ping, then type a space, and then type the IP address of the
computer that you want to ping. For example, if you want to ping a computer at the IP
address 192.168.1.105, then you type ping 192.168.1.105.
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EXERCISE 5.6 (continued)

4.

5.

View the output to determine whether the packets were received by the destination com-
puter and whether you received the reply.

B Command Prompt ;]ﬂﬂ
Microsoft Windows XP [Uersion 5.1.2600] :J
({C) Copyright 1985-2001 Microsoft Corp. _J

C:\Documents and Settings\Bill Ferguson.XP1>ping 192.168.1.105
Pinging 192.168.1.105 with 32 bytes of data:

Reply from 192.168.1.105: bytes=32 time=1ms TTL=128
Reply from 192.168.1.105: bytes=32 time{lms TTL=128
Reply from 192.168.1.105: bytes=32 time=1ms TTL=128
Reply from 192.168.1.105: bytes=32 time=1ms TTL=128

Ping statistics for 192.168.1.105:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = @ms, Maximum = 1ms, Auverage = Oms

C:\Documents and Settings\Bill Ferguson.XP1>_ =
[« | =

If you received a reply, then your computer has physical and logical connectivity with the
other computer. If you did not receive a reply, then you may be lacking physical connec-
tivity, logical connectivity, or both.

The ping tool can also be used to perform a special test that verifies that TCP/IP is installed

and functioning in a computer. This test is referred to as a loopback test. Exercise 5.7 walks you
through the steps to perform a loopback test.

EXERCISE 5.7

Performing a Loopback Test with Ping

1.

2
3.
4

On the Windows XP desktop, click Start and then choose Run.
On the Run linge, type cmd to access a command prompt.
On the command prompt, type ping 127.0.0.1 or type ping loopback.

View the output to determine whether the packets were sent from and received back to the
interface of your computer. If you receive a reply, then TCP/IP is installed and operating. If
you do not receive a reply, then the TCP/IP protocol should be reinstalled in the computer.
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@ Real World Scenario
How to Keep from Standing on Your Head!

I've read in many books that the best way for you to test any new TCP/IP connection is to first ping
the loopback, then ping the local address, then ping a computer in your intranet, and finally ping
something outside your intranet. Personally, | don’t agree with using that method at all—if you set
up the connection to connect to the Internet. If that’s the case, then why don’t you just go to a

browser and type an address that you know will be there, for instance Sybex.com? If you get the
Sybex home page, then | can guarantee you that you will be able to ping your loopback address!

However, there is one very good method that you can use to troubleshoot a new connection.
In fact, if you do this right, it will literally keep you from standing on your head. Are you inter-
ested? Good, then listen closely.

Let’s say that you don’t get Sybex.com and instead you get the dreaded “Page cannot be dis-
played” error message. What do you do next? Well, what a lot of people do is begin making
sure that their network interface card link lights are lit to eliminate the network interface card
as part of the problem. This usually entails pulling the computer away from a wall or desk or
leaning way over the computer (standing on your head) to see if the link light on the network
interface card is properly lit, indicating that the cable is plugged in and the card is working.

WEell, here’s an easier way. First ping the local loopback (127.0.0.1) and see if you get a reply.
If there is no reply, then reinstall TCP/IP. If there is a reply, then ping the IP address assigned
to the computer. (If the IP address is normally assigned by a DHCP server, then assign a tem-
porary address that is not in use, just so you can ping it. The address 1.1.1.1 should do just fine
on most networks.) If you get a reply, then the card works! If you don’t get a reply, then the card
doesn’t work. If the card doesn’t work, it's either a physical problem or drivers.

Now, reach your hand around the back of the computer and make sure that the RJ-45 plug is
securely plugged in. Don’t worry about the link light on that end. Next, check the hub or switch
for a link light. This is often easier than standing on your head. Remember that both sides
would have to be properly connected to get a link light at the hub or switch. If the link light on
the hub or switch is lit, then the only thing left is the drivers. You should uninstall the network
interface card drivers and restart the computer, look for any connection errors when the com-
puter comes back up, and then reinstall the drivers. Oh, and if the light is not lit, then you may
be forced to replace a cable or a network interface card, but at least you didn’t have to stand on
your head!

Using the Pathping Tool

The pathping tool is a command-line tool that is very similar to the ping tool. You can use the
pathping tool to test connectivity between computers. The main difference between the path-
ping tool and the ping tool is that the pathping tool sends back information about each of the
hops that the packets take toward their destination address. If you are in a network that uses a
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series of routers to connect computers and servers, then you can use the pathping tool to deter-
mine which of your routers might be down or improperly configured. You can also use pathping
across the Internet (from firewall to firewall), but the output may be of limited use to your orga-
nization, since you don’t control all of the routers. Pathping also calculates statistics of packets
sent and lost over a 25-second time period and determines the percentage of packet loss. This
allows you to identify a connection that is working intermittently, referred to as “flapping.”

Exercise 5.8 illustrates the use of the pathping tool in Windows XP.

Testing Connectivity between Computers Using the Pathping Tool
1.

2.

5.

On the Windows XP desktop, click Start and then select Run.

On the Run line, type cmd to open a command prompt.

On the command prompt, type pathping, then type a space, and then type the IP address
of the computer that you want to ping. For example, if you want to pathping a computer

at the IP address 192.168.1.105, then you type pathping 192.168.1.105.

View the output to determine the path that the packets are taking as they travel toward
their destination and how far they actually get. You can use this information to determine

which router may be down or incorrectly configured.

B command Prompt

=l=|x|

Microsoft Windows XP [Uersion 5.1.26080]
{C) Copyright 1985-2001 Microsoft Corp.

C:\Documents and Settings\Bill Ferguson.XP1>pathping 192.168.1.185
Tracing route to 192.168.1.105 over a maximum of 30 hops

0 xpl.mshome.net [192.168.1.10]
1 192.168.1.105

Computing statistics for 25 seconds...
Source to Here This Node/Link
Hop RTT Lost/Sent = Pct Lost/Sent = Pct Address

<] xp1.mshome.net [192.168.1.10]

0% |
0% 192.168.1.105

0/ 100 =
1 Oms 0/ 100 = 0% 0/ 100 =

Trace complete.

| C:\Documents and Settings\Bill Ferguson.XP1>
L

i

L

=]

The system will calculate lost/sent packets and determine a percentage loss of packets

sent. You can use this information to identify a connection that is flapping.
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Name Resolution Troubleshooting

As we mentioned earlier, network administrators use user-friendly names to refer to computers
on a network, rather than their cumbersome IP addresses. This makes it easier to manage and
troubleshoot a network that contains many computers. They then use files and services to con-
vert the user-friendly names back to IP addresses. Since the client uses these files and services to
locate computers and resources in the network, you should know how to configure the client

computers to use them. There are two main types of user-friendly names that can be used in a
network: NetBIOS names and hostnames. In this section, we will define each of these types of
user-friendly name and illustrate how you can configure and troubleshoot a client computer for
name resolution in a network.

NetBIOS Names

The term NetBIOS is derived from Network and BIOS. A network is simply a group of con-
nected computers. BIOS, as we discussed previously, stands for Basic Input/Output System.
NetBIOS is therefore the network’s basic input/output system of communication. A NetBIOS
name is the most basic name that a computer can have, sometimes referred to as a computer
name. As you may remember, you enter this name (or accept the default name from the system)
every time you install Microsoft operating system software on a computer and indicate that it
will be used in a network. This name can be up to 15 characters in length. Computers in the
same network can recognize one another by their NetBIOS names, but it’s not that simple. Actu-
ally, each computer is given several similar NetBIOS names based on services that it can offer
the network, so one computer can actually have many NetBIOS names. The only thing that is
really different about the names is the end of the name that is assigned by the system, referred
to as the 16th character.

As you may remember, computers recognize one another by the MAC addresses burned into
their network interface cards. Since we can use ARP only to convert an IP address to a MAC
address, we have to use other services to first convert the user-friendly NetBIOS names to IP
addresses. There are two main methods of converting NetBIOS names to IP addresses: Lmhosts
files and WINS servers. In this section, we will discuss how each of these name resolution meth-
ods operates and illustrate how you can configure a Windows XP client to use them.

Lmhosts Files

An Lmbhosts file is a text file that can be used by a computer to convert a known NetBIOS
name to an IP address. Figure 5.1 is very simple example of a portion of an Lmhosts file. If
Lmbhosts files are used, then the network administrators must manually keep the Lmhosts files
up-to-date. For this reason, not all networks make use of Lmhosts files, and they have largely
been replaced by more sophisticated and more automatic name resolution methods. You do
not need to be an expert at the creation or use of Lmhosts files, but you do need to know
whether your network uses them and how to configure your clients properly based on that
knowledge. Exercise 5.9 walks you through the steps to configure a client to use the Lmhosts
files if they are present.



156 Chapter 5 = Troubleshooting Network Protocols and Services

FIGURE 5.1 Anexample Lmhosts file

102.54.94.97 SQLsrv
102.54.94.102 app server
102.54.94.123 mailsrv
102.54.94.117 localsrv

Configuring Clients to Use Lmhosts Files

1. On the Windows XP desktop, click Start and then choose Network Connections.

2. Onthe Network Connections window, click the connection that you want to configure. On
a computer with multiple connections, you can actually choose any connection because
the Lmhosts configuration change will apply to all connections.

3. Onthe selected connection’s Properties sheet, double-click Internet Protocol (TCP/IP), and
then click the Advanced button.

4. On the Advanced TCP/IP Settings dialog, choose the WINS tab.

5. Examinethe Enable LMHOSTS Lookup check box in the center of the Advanced TCP/IP Set-
tings dialog box. With a default installation of Windows XP, the check box should be
checked, indicating that the computer will use the Lmhosts files.

"Advanced TCP/IP Setting 24

IP Settings | DNs | WINS | Options |

WINS addresses, in order of use
| B
|

Add.,

FLMHOSTS lookup is enabled, it applies to all connections forwhich TCR/IP iz

enabled

[¥]Enable LMHOSTS lookup Import LMHOSTS...
MelBI0S seling
(@) Default

Use NetBIOS setting from the DHCP server. If siatic IP address is
used or the DHCP server does not provide NetBIOS setting, enable
NelBIOS over TCP/IP

() Enable NetBIOS over TCP/IP
(") Disable NetBIOS over TCRAIP

[ QK ] [ Cancel
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EXERCISE 5.9 (continued)

6. If the Enable LMHOSTS Lookup check box is not checked, click in the box to place the
checkmark. You can also click the Import LMHOSTS button to specify the locations of other
Lmhosts files that the computer should also check. You should consult with the network
administrator before taking this step.

7. If you have made any configuration changes, then click OK three times to exit and save
the changes.

ING regarding the name resolution configuration of computers. If the Lmhosts file
is incorrect, then the computers may not be able to obtain proper NetBIOS
name resolution, even if other services, such as WINS, are working properly.

@:" You should consult with the network administrator before making any change

WINS

Windows Internet Name Service (WINS) servers are used by network administrators to auto-
mate the process of name resolution. A WINS server works like a hotel registration desk. When
a client computer is started on a network, it registers its NetBIOS name (computer name) and
its IP address with the WINS server. When another computer wants to convert a NetBIOS name
to an IP address, it can consult the WINS server for the address. When users correctly shut down
a computer, the NetBIOS name is automatically removed from the WINS database. Network
administrators often use DHCP servers to automatically configure the correct WINS address in
clients on their networks. It actually gets “a bit” more complicated than that from administra-
tor’s viewpoint but, fortunately for you, you don’t have to be a WINS expert. You do, however,
have to know how to verify and configure a client’s WINS server setting. Exercise 5.10 walks
you through the steps to verify a current WINS setting and configure a new setting.

Verifying and Configuring a Client Computer’s WINS Setting

1. On the Windows XP desktop, click Start and then choose Network Connections.
2. On the Network Connections window, click the connection that you want to configure.

3. Onthe selected connection’s Properties sheet, double-click Internet Protocol (TCP/IP), and
then click the Advanced button.

4. On the Advanced TCP/IP Settings dialog box, choose the WINS tab.
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EXERCISE 5.10 (continued)

5. Atthetop of the WINS tab, view the WINS Addresses, In Order Of Use field. Clients can be
configured with as many as 12 WINS server addresses but typically will have only one or
two. Verify with the network administrator that the addresses configured are valid
addresses for WINS servers on your network.

Advanced TCP/IP Settings L?_.]@

| IP Settings | DNS WINS Options |
WINS addresses. in order of use:

[10113 &

192168.1.115

Add. | [ Edi. || Remove |

[FLMHOSTS lookup is enabled, it applies to all connections for which TCP/IF is
enabled.

[] Enable LMHOSTS lookup [ mporimHosTs.. |

MNetBIOS setting

(@) Default
Use NetBIOS setting from the DHCP server. If static IP address is
used or the DHCP server does not provide NetBIOS sefting, enable
MetBIOS over TCP/IP.

(O Enable NetBIOS over TCP/IP
(O Disable NetBIOS over TCP/IP

[ ok ][ cancel |

6. Usethe Add, Edit, and Remove buttons to make any necessary changes. You can also use
the arrows to the right of the field to reorder the use of the WINS servers.

7. Click OK three times to exit and save the changes.

Hostnames

Whereas NetBIOS names can be used effectively within each local area network, they cannot
be used between networks. For this reason, network administrators assign yet another type
of name to each computer on most networks. This name is referred to as a hostname. Since
hostnames can be used between networks as well as within the same network, most of the
newest client operating systems and applications make use of hostnames instead of NetBIOS
names. Windows XP and Windows 2000 Professional clients use hostnames by default to
identify computers.
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Network administrators use special servers called Domain Name Service (DNS) servers to
convert hostnames to IP addresses. DNS servers contain databases that pair up a hostname with
an IP address. Network administrators once maintained these databases manually, but now
much of the process of maintaining the DNS servers has been automated. DNS servers can com-
municate with other DNS servers to share their information and redirect clients and servers to
other IP addresses.

Client computers and applications use the DNS server to convert a known hostname to an
IP address so that a client or router can eventually use ARP to convert the IP address to a MAC
address. Client computers rely on these servers for communication within their own network as
well as on the Internet. For this reason, it’s very important that clients be configured with the
proper IP addresses for the DNS servers that they need to use. Network administrators often use
DHCP servers to automate the configuration of the correct IP address on each client. Again,
from a network administrator’s point of view, it gets a bit more complex, but you do not need
to be a DNS expert. You should, however, know how to verify the DNS hostname of a client
and the DNS server addresses that are configured for the client. You should also know how to
configure DNS addresses for a client if needed. Exercise 5.11 walks you through the steps to ver-
ify and configure a hostname.

Verifying and Configuring a Client’s Hostname
1. On the Windows XP desktop, right-click My Computer and then choose Properties.
2. On the System Properties dialog, choose the Computer Name tab.

3. Readthe computer name listed after Full Computer Name. On Windows XP computers, this
isthe hostname. The first part of the name is also usually the NetBIOS name of the computer.
In this case, the hostname is “xpclient” and the Full Computer Name is “xpclient.bfe.com.”
The computer is a member of the domain “bfe.com”.

'System Properties

System Restore | Automatic Updates Remote
Gensral Computer Name | Ad
'j! Windows sses the lollowing inlormation o entify your computer an
- the network.
Computer descrintion: RPCLIENT
Far exarnple: "Kiichen Computer” or "Mary's
Computar*
Full computer name: wpclientbfe com
Damain bife com
To use the Network identification Wizard to join 2 domain NeworkiD
and crezte a loeal user account, click Network D 2

To rename this compulter of join @ domain. click Change

oK Cancel
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EXERCISE 5.11 (continued)

4. Ifyou need to rename the computer, click the Change button, and then type the new com-
puter name in the Computer Name box. You should consult with the network administra-
tor before renaming a computer since it's very important that all computer names be
unigue within a network.

5. To save any changes, click OK twice to exit. You will also need to restart the computer to
make the changes effective.

Exercise 5.12 walks you through the steps to verify and configure DNS server addresses.

Verifying and Configuring DNS Server Addresses for Clients

1. On the Windows XP desktop, click Start and then choose Network Connections.
2. On the Network Connections window, choose the connection that you want to configure.

3. Onthe selected connection’s Properties sheet, double-click Internet Protocol (TCP/IP), and
then click the Advanced button.

4. On the Advanced TCP/IP Settings dialog, choose the DNS tab.

5. Examine the DNS Server Addresses, In Order Of Use field at the top of the DNS tab. Verify
with the network administrator that the addresses listed are valid DNS server addresses.

-Qj
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Advanced TCP/IP Settings

IP Setings| DNS | WINS | Options
DNS server addresses, in order of use
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nj:_.\Append these DNS suffixes (in order):
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DINS suffix for this conneclion
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EXERCISE 5.12 (continued)

6. Use the Add, Edit, and Remove buttons to make changes to the configuration of the
addresses. You can also use the arrows to the right of the field to reorder the use of the
DNS servers.

7. Click OK three times to exit and save the changes.

Name Resolution Troubleshooting Tools

Windows XP and Windows 2000 Professional clients have many tools that you can use to trouble-
shoot name resolution. Many of these tools can be used to troubleshoot other issues as well. In fact,
we discussed some of these tools in relation to troubleshooting connectivity and IP addresses. In this
section, we will focus on the main tools that you can use to troubleshoot name resolution for a client.

Ipconfig

Ipconfig is a very flexible command-line tool that can be used to display, release, and renew IP
addresses and name resolution configurations if they are not manually set. You can use the for-
ward slash switch (/) to indicate the option of ipconfig that you want to use. Table 5.1 illustrates
the ipconfig command options available and the function of each. You can also view these
options by typing ipconfig /? on a command line and pressing the Enter key.

TABLE 5.1 Command Options for Ipconfig

Command Option function

/all Displays all configuration information, including addresses of WINS, DNS,
and DHCP servers

/release Instructs the DHCP server to release the IP address for a specified connection
/renew Instructs the DHCP server to renew the IP address for a specified connection
/registerdns Refreshes all DHCP server leases and registers or re-registers the client’s

DNS name with the DNS server

Ping

I know that we talked about ping as a connectivity tool, but you can also use ping as a name resolu-
tion tool. As you may recall, you can ping the IP address of another computer to establish connec-

tivity with that computer...right? Well, what if you didn’t ping the IP address, but instead you pinged
the computer name of the computer? Then you would test not just connectivity but also name reso-
lution. In fact, if you pinged the IP address and got a reply and then pinged the computer name and
did not get a reply, then you could be sure that name resolution was at fault.
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Now, you might be thinking, “Yes, but would I be pinging the NetBIOS name or the host-
name?” Actually, it depends on which type of client you happen to be using. On Windows XP
and Windows 2000 Professional clients, when you ping from a command line, you are pinging
the hostname of the client first. On older clients, you are pinging the NetBIOS name first. You
can further specify a hostname on a computer that is in a domain by typing the entire hostname
and domain name in succession using decimal points between each part. This is referred to as
a fully qualified domain name (FQDN). For example, the FQDN of a computer with the name
XP1 located in DomainA.com would be XP1.DomainA.com. The name listed as the full com-
puter name for a Windows XP client in a domain will be its FQDN. Only the first part of the
name is the NetBIOS name. You can ping the FQDN of another computer from any client to
make sure that you are testing hostname resolution and not NetBIOS name resolution.

If you don’t get a reply when you ping an IP address or a computer name, then you will receive
an error message. Windows clients use three primary error messages to give you hints as to what
to fix. You should be familiar with the following three error messages and each of their meanings:

= Destination host unreachable. This error message indicates that there is a problem at the IP
routing level between your computer and the remote host. You should escalate this issue to
the network administrator.

= Unknown host hostname. This error message indicates that none of the name resolution
mechanisms recognize the name that you typed. You should check to make sure that you
typed the right name and try again. If you are still unsuccessful, then you should escalate
this issue to the network administrator.

= Request timed out. This message indicates that at least one name resolution mechanism did
recognize the name, but the target either did not receive the request or did not respond to
it. In this case, you should focus on connectivity between the name resolution mechanism
and the remote host.

Nslookup

The nslookup tool is a command-line tool that uses DNS to translate a computer name to
an IP address. You can use the nslookup tool to test hostname resolution and to verify that
the remote computer is registered in the DNS server(s). You can test hostname resolution by
typing nsTookup followed by the FQDN of the computer. The result should be the IP address
assigned to the computer.

You can also use several different nslookup options by typing nsTookup and then typing the
appropriate option. You can run the nslookup tool in interactive mode by typing ns1ookup on
a command line with no options and pressing the Enter key. In interactive mode, you can view
the options available by typing a question mark (?) and pressing the Enter key.

Net

The net command is primarily used to view the network settings assigned to a computer. The
net command also has many options. The main name resolution testing option in the net com-
mand tool is the net config workstation command, which reports the NetBIOS name and
domain name for the computer. You can get more information about the net command by typ-
ing net help on a command line.
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Nbtstat

You can use the nbtstat command to manage NetBIOS name information and display statistics
and details regarding current TCP/IP connections. The nbtstat tool has many options as well.
You can view all of the options of the nbtstat tool by typing nbtstat /? on a command
prompt. You should be familiar with the following three most common options of the nbtstat
tool and the function of each option, as shown in Table 5.2.

TABLE 5.2 Command Options for Nbtstat

Command Function

nbtstat -n  Lists all of the NetBIOS names registered by a client

nbtstat -c¢  Displays the NetBIOS name cache showing recently resolved NetBIOS names to
IP addresses

nbtstat -R  Manually reloads the NetBIOS name cache with special entries from the
Lmhosts file

Remote Connections

Unfortunately, your work doesn’t have to stop just because you leave the office. You and the

users whom you serve can connect to your organization’s network from home or from a hotel
using remote connections. The Network Connections tool in Windows XP enables you to con-
figure two main types of connections: dial-up and virtual private network (VPN). You should
know how to use the Network Connections tool to configure both types of connections. You

should also know the main differences between these types of connections and how to trouble-
shoot each of them.

Dial-up Connections

The term dial-up connections is most often used to refer to connections that are made using ana-
log modems and ordinary telephone lines. Dial-up connections are generally very inexpensive
to use and are readily available, but they have very limited bandwidth. These connections are
usually temporary in nature and are disconnected when the communication is finished. Other
types of dial-up connections include Integrated Services Digital Network (ISDN) connections,
which use special lines, provided by the phone company, that offer greater bandwidth. Both
types of dial-up connections are sometimes used to provide a backup line of communication for
a more costly dedicated line.

You can use the Network Connections tool to configure dial-up connections for a client com-
puter and a user. This tool provides a wizard to help you configure many types of connections.
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These connections can include Internet Service Providers (ISPs) as well as other telephone con-
nections to a configured modem. You should know how to configure and troubleshoot dial-up
connections in Windows XP. Exercise 5.13 walks you through the steps to configure connec-

tions using the Network Connections tool and the New Connection Wizard.

Configuring Dial-up Connections Using the Network Connections Tool

1.

5.

On the Windows XP desktop, click Start, choose Connect To, and then choose Show All
Connections.

On the Network Connections tool, view the connections that are set up, and then select
Create A New Connection under Network Tasks on the top-left corner or choose Network
Connections. This will open up the New Connection Wizard.

On the opening screen of the New Connection Wizard, click Next.

Select Connect To The Network At My Workplace, click Next, and then choose the type of
dial-up connection and click Next again.

-

New Connection Wizard

Network Connection Type ;
What do youwant to do? 4

() Connect to the Intemnet
Connectto the Internet so you can browse the Web and read email.

@c t to the network at my

Connectto a business network (using dial-up or VPN) so you can work from home, a field
office, or another location.

CJ Selup a home or small office network
Connectto an existing home or small office network or setup a new one.

() Set up an advanced connection

Connect directly to another computer using your serial, parallel. or infrared port. or setup
this computer so that other computers can connectto it

I < Back “ Mext > IE Cancel

I

Type a name for your connection (any name will suffice) and then click Next.

6. Type the phone number that you want to dial and then click Next.

7

Click Finish to create the connection and exit the wizard.
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Troubleshooting Dial-up Connections

Troubleshooting dial-up connections, like all troubleshooting, is a process of isolating the prob-
lem. You should understand that the main components involved in the communication are your
modem, the connection between your modem and the remote modem, and the remote modem.
A bad configuration or a problem on either end of the communication can cause the commu-
nication to fail. You should first make sure that the username and password are correctly con-
figured on the connection. Then, since modems sometimes malfunction, you should test your
modem to make sure that the problem is not hardware related. While you cannot always test
the remote modem, you can perform a test on your own modem to determine whether it is
working properly. Exercise 5.14 walks you through the steps to test your modem.

Performing a Test on a Modem

1. On the Windows XP desktop, click Start and then choose Control Panel.
2. Onthe Control Panel, choose Phone and Modem Options and then choose the Modems tab.

3. Onthe Modem properties dialog box, choose the modem that you want to test and then
click properties.

4. Onthe properties dialog box for the modem that you want to test, choose the Diagnostics
tab and then click Query Modem.

Dell Data Fax Modem Properties L?_E‘ﬁ

| General | Diagnostics Advanced

Modem Informabon

Figld Value |
Hardware [0 PCIVEN_14F180EV_10338SUBSYS_020013£08

3 ! 2]
Command Response o
ATQOVIED Success |
| AT+GMM +GMM: HCF 56K Modem |
| AT+FCLASS=? 0.1 |
| ATECLS=? COMMAND NOT SUPPORTED |
< | i B
Query Modem

Logging

r—

ok || canal |

5. View the output in the Response section. A modem that is properly configured and con-
nected to a telephone line should indicate Success. If the output does not read Success,
then examine the output for clues as to why the modem did not test successfully, e.g., No
Dial Tone Detected.
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To perform a very simple test of a remote modem, you can just dial the
P modem with any telephone and see if it answers. Sometimes the simplest

solutions are best!

VPN Connections

In the late 1990s, as remote computing became increasingly popular, dial-up connections pre-
sented two problems. First, they required a modem or modem-type of connection for every com-
munication with the server. Second, and most important, the calls from users who were out of
town incurred long-distance charges. Business needed a way to have secure communications
with less cost.

Since the use of the Internet was also growing during this time, businesses began to use the
Internet to their advantage for remote connections. A new technology emerged called virtual
private networking (VPN). Essentially, VPN operates in the following manner:

1. The user dials his Internet Service Provider (ISP) with a local call.

2. ThelSP provides a VPN server that negotiates which tunneling and encryption protocols it
will use to provide a secure connection through an unsecured medium, the Internet.

The VPN server connects the client to the organization’s corporate servers.
The client logs on to the corporate servers for secure access to resources.
There are two main types of VPNis:

= Network-network. This type of connection is used from one office of an organization to
another office, such as from a branch office to a main office. These are generally used to save
costs compared to leasing expensive dedicated lines.

=  Host-network. This type of connection is used by a remote office worker in an organiza-
tion, such as a person who works from home or from a hotel room. The main reasons that
this type of VPN is preferred over standard dial-up are that it reduces the cost of maintain-
ing modem pools and it eliminates long-distance charges provided that a local ISP tele-
phone number is available.

You can use the Network Connections tool in Windows XP to configure a VPN on a client. All
you need to know is the IP address or FQDN of the server to which you want to connect. Of course,
the user will have to authenticate to the server after the connection is established. Exercise 5.15
walks you through the steps to configure a VPN connection on a Windows XP client.

Troubleshooting VPN Connections

Since VPN connections are relatively simple to create, they are also relatively simple to trouble-
shoot. If there is a problem connecting with a VPN, it will most likely involve the IP address or
hostname used for the connection. You should recheck the connection and make sure that the
computer to which you are connecting has not been changed. If you are using the hostname,

then try using the IP address instead, just in case the problem has to do with name resolution.
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Configuring a VPN Connection

1. On the Windows XP desktop, click Start, choose Connect To, and then choose Show Al
Connections.

2. On the Network Connections tool, view the connections that are set up, and then select
Create A New Connection under Network Tasks on the top-left corner or choose Network
Connections. This will open up the New Connection Wizard.

3. Onthe opening screen of the New Connection Wizard, click Next.
4. Choose Connect To The Network At My Workplace, and then click Next.
5. Choose Virtual Private Network Connection, and then click Next.

New Connection Wizard

Network Connection
How do you wantto connect to the network at your workplace? .

Create the following connection:

() Dial-up connection
Connectusing a modem and a regular phone line or an Integrated Services Digital
Metwork (ISDN) phone line.

(3) Vinual Private Network connection
Connectto the network using a virual private network (VPN) connection over the Internet.

I < Back “ Next > [[ Cancel ‘

6. Type a name for your connection (any name will suffice), and then click Next. (If you have
ISP software installed in your computer, the wizard may also give you the option to let the
connection dial the ISP automatically.)

7. Type the hostname (FQDN) or IP address of the computer to which you want to connect,
and then click Next.

New Connection Wizard
VPN Server Selection
Whatis the name or address ofthe VPN server? i

Type the host name or Internet Protocol (IP) address of the computer to which you are
connecting.

Hostname or [P address (for example. microsoftcom or 157.54.0.1 ):

14225142

I <Back i[ Next > i Cancel

8. Click Finish to create the connection and exit the wizard.
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A common problem with VPN is that a user’s Internet services stop working after she con-
nects to the VPN. This can occur because the VPN is attempting to use the default gateway of
the remote computer for Internet service rather than its own default gateway. If this occurs on
a corporate network, you may be required for security reasons to leave the setting as it is and
provide a proxy connection on the remote network for the connection to use. In this case, you
should consult with the network administrator to get the proxy address set up. On the other
hand, if this occurs on a single computer or even in a small workgroup, then you can change the
default gateway setting to the local default gateway to provide Internet access for the client
while still using the VPN. Exercise 5.16 walks you through the steps to change the default gate-
way setting for the computer.

Changing the Default Gateway of a VPN Connection to the
Local Default Gateway

1. On the Windows XP desktop, click Start, choose Connect To, and then choose Show All
Connections.

2. On the Network Connections window, right-click the VPN connection that you want to
change and then choose Properties.

3. Onthe connection’s Properties sheet, click the Networking tab, select Internet Protocol
(TCP/IP), and then choose Properties.

4. On the Internet Protocol (TCP/IP) Properties dialog box, click Advanced.

5. Onthe General tab of the Advanced TCP/IP Settings dialog box, clear the Use Default Gate-
way On Remote Network check box.

Advanced TCP/IP Settings m%’i@

General DNS | WINS

This checkbox only applies when you are connected to a local network
and a dial-up network simultanecusly. When checked, data that cannot
be sent on the local network is forwarded to the dial-up network.

Use default gateway on remote network

| OK l | Cancel

6. Click OK three times to save your settings and exit.
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Internet Explorer

Microsoft’s Internet Explorer has become the preferred browser of Internet users around the
world. What we refer to as the Internet is actually an internetwork of routers, switches, and
servers that spans the globe. Most people have no idea how it all works any more than they
know how electricity or phone connections come into their home. The main reason that they
don’t know is that they don’t need to know. Browsers such as Internet Explorer make the pro-
cess of finding websites as easy as dialing a telephone, sometimes even easier!

Actually, browsing with Internet Explorer is easy for a user only if his software is configured
properly, so that’s where you come in! You should know how to configure and troubleshoot
Microsoft Internet Explorer for a user. Most of the configuration of Internet Explorer can be
performed in the Tools menu under Internet Options. Your troubleshooting ability relies on
your knowledge of what can be configured and how it should be configured. There are seven
tabs included in Internet Options: General, Security, Privacy, Content, Connections, Programs,
and Advanced. In this section, we will discuss all seven tabs with special emphasis on the Gen-
eral, Security, and Connections tabs.

General Tab

The General tab of Internet Options contains three main tools to assist the user in browsing the
Internet. As shown in Figure 5.2, the General tab has three main areas of configuration:

Home Page The home page is the default page that Internet Explorer opens to when you simply
click the Internet Explorer icon or the Home icon on the toolbar, which resembles a house. You
can set the default page to any address that you choose. You can also browse to a page first and
then click Use Current to set that page as the default page. In addition, you can click Use Default
to return to the default home page atmsn. com. Finally, you can click Use Blank to use a blank page
for your home page. Whichever you select, you can very easily change it at any time.

Temporary Internet Files When a user views pages on the Internet, the software automatically
stores the addresses of those pages so that they can be accessed when she wants to view the same
page again. Some pages download special programs to make it easier to access the site when a user
returns. These special programs are referred to as cookies. You can set the behavior of Internet
Explorer in regard to temporary Internet files and cookies. You can click Delete Cookies to remove
all of the old cookies from a computer. You can click Delete Files to remove offline and online tem-
porary Internet files. Finally, you can click Settings to view the individual cookies and files and con-
figure the amount of space that will be used on your computer for these types of files and the location
of the folder where they will be stored. You can also indicate how often the computer should check
for new versions of pages that are in these files.

History When a user views a page on the Internet, the software keeps a history of the pages
that were viewed. This history can be used to quickly access the pages at a later date using the
History icon on the toolbar. You can set how many days of history are stored. This setting can
range from 0 (no history) to 999 days! The History tool will sort the pages by the day, week,
month, and year that they were last accessed.
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FIGURE 5.2 The General tab of Internet Options
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History
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access to recently viewed pages
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Security Tab

Let’s face it; the Internet is not always a kind place. There are many sites on the Internet that
contain files that might harm your computer. There are also many sites that you probably use
every day and that you therefore trust. Internet Explorer has the capability of automatically
downloading files and running scripts that can make your browsing experience more enjoyable.
Unfortunately, some people can take advantage of these settings to install and run programs on
your computer that could damage your computer and the data it contains.

To get the best of both worlds, you can use the settings on the Security tab of Internet Explorer
Security Options to divide all of the sites on the Web into web content zones for the purpose of
security; then you can allow specific functions based on zone type. As shown in Figure 5.3, there
are four main web content zones:

Internet This is default zone that contains all of the websites that you haven’t placed in any
other zone. This zone should be configured with limited ability to run scripts or download files
that might be harmful to your computer.

Local Intranet This zone contains the websites that are located on your organization’s intranet.
This zone should be configured based on how much you trust your own organization’s content.

Trusted Sites This zone contains sites that you trust not to damage your computer or data.
Trusted sites are typically given the ability to run scripts and download files that other sites cannot
run or download. You can also specify that only secure (https://) connections are allowed in
this zone.
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Restricted Sites  You should add to this list any site on which you discovered harmful content. You
should then configure the site to disallow scripts and downloads. The user will still be able to access
the site, but his content options will be limited and therefore his computer will be more secure.

Privacy Tab

Have you ever accessed a site that required you to enter your username and create a password
in order to access the site? Have you ever accessed that site again from the same computer and
found that it was no longer necessary to enter your username and password? If so, then you
have used a cookie. Cookies are special files that can contain user information and can give that
user information to another party. While cookies can be helpful when used properly, they can
be very dangerous to your privacy if they are used improperly. Some cookies can even track all
of your browsing activity! The Privacy tab of Internet Options contains settings that allow you
to control how cookies can be used on your computer.

Content Tab

The Content tab is divided into three sections: Content Advisor, Certificates, and Personal

Information. Content Advisor contains settings that allow you to use a rating system to deter-
mine sites that can be viewed on the computer. Certificates is used to create and install keys that
will be used for Secure Sockets Layer (SSL) communication to a site. Personal Information con-
tains AutoComplete, which stores previous browser entries and suggests matches, and My Pro-
file, which allows you to choose your personal profile from your e-mail address book or create
a new profile for use on the Internet. It is not necessary that you create a profile, but it can some-
times be used as a convenience instead of entering information into a form on a web page.

FIGURE 5.3 Security options and web content zones

Iﬁbernet Options ’T"ﬂ

General | Security | Prvacy | Content | Connections | Programs | Advanced |

Select a Web content zone 1o specify its security settings.

Localintranet  Trustedsites  Resincted
sites

Internet

@ This zone comains all Web sites you

haven't placed in other zones
Security level for this zone

Custom
Custom setlings.
- To change the sethngs. click Custom Level
- Touse the recommended settings. click Default Level,

| Custom Lavel... | Defaul: Level

I OK ] | Cancel
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Connections Tab

The Connections tab in Internet Options contains two main sections, as shown in Figure 5.4.
You should know how to configure all settings in both sections. In the paragraphs that follow,
we will discuss each section in detail.

FIGURE 5.4 The Connections tab of Internet Options

. Internet Options L?_]ﬁ@

| General | Security | Privacy Contant_j Connections  Programs | Advanced

in% To set up an Internet connection, click Setup.
Dialup and Virtual Private Network settings

Choose Settings if you need to configure a proxy server
for @ connection.

Local Area Network (LAN) seftings

LAN Settings do not apply to dial-up connections. Choose LAN Seftings..

Settings above for dial-up settings.

[ ok ][ canca |

The first section of the Connections tab contains a list of the dial-up and VPN connections
configured on the computer. You can configure a default connection to be dialed automatically
any time Internet Explorer is used or to dial only if a network connection is not present. You
can also configure Internet Explorer to never use a default connection. You can add or remove
connections using the Add and Remove buttons. In addition, you can use the Settings button to
configure a connection to use a proxy server. In this case, you should obtain the correct settings
for the proxy server from your network administrator.

2 You should be aware that removing a connection on the Connections tab of
ING Internet Options in Internet Explorer will delete the connection from the com-
puter, not just from Internet Explorer.
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The second section is for local area network (LAN) settings. You should click the LAN Set-
tings button to configure manual or automatic settings for network connections and proxy serv-
ers. You should consult with your network administrator to obtain the information for these
settings. It may also be necessary to choose the LAN settings options and place a checkmark in
the Bypass Proxy Server For Local Addresses box to give users access to sites that are within
your intranet.

Programs Tab

The Programs tab of Internet Options contains the settings for default applications that Win-
dows will use for specific tasks. Examples include e-mail, Internet calls, contact lists, and so on.
You can choose from among the applications that are installed in your computer and have the
appropriate functionality. You can use the drop-down box in each category to view the options
for that category and make your choice.

Advanced Tab

The Advanced tab contains the fine-tuning settings for all aspects of Internet Explorer. Examples
include browsing options, multimedia, and additional security options. You can choose the options
that you want by clicking each check box to indicate that you want to configure that option.

Remote Connectivity Tools

The days of having to go to a user’s computer to troubleshoot it are long gone. Windows XP
provides two tools that enable a network administrator, desktop support technician, or even
another user to assist a user in troubleshooting and repairing his computer; these tools are
Remote Desktop and Remote Assistance. These two tools are very similar in that they both use
the Remote Desktop Protocol (RDP) to provide the remote connection to the computer. There
are, however, significant differences in regard to the manner in which they are used and the
tasks that can be performed with each tool.

You should know where each of these tools can be found in Windows XP. You should also
understand how to use Remote Desktop and Remote Assistance to troubleshoot a user’s com-
puter. In addition, you should also know what situations call for the use of one tool over the
other. In this section, we will discuss the use each of these tools in detail.

Remote Desktop

The Remote Desktop tool enables a computer to control another computer remotely over the
local intranet or even over the Internet. Once you have established a Remote Desktop connec-
tion, you can control the remote computer as if you were sitting in front of it. The computer that
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is establishing the connection is referred to as the client computer. The computer that it is con-
necting to is referred to as the remote computer. You should know the requirements for each
of these computers to use Remote Desktop. You should also know how to set permissions for
users of Remote Desktop. Finally, you should know how to configure, connect to, and trouble-
shoot Remote Desktop for intranet- as well as Internet-based connections. In the following
paragraphs, we will discuss each of these concepts in detail.

Remote Desktop Requirements

The requirements for Remote Desktop are as follows:

=  The remote computer must be running Windows XP Professional.

*  The remote computer must have Remote Desktop connections enabled.

= The client computer must be running Windows 95 or later and must have Remote Desktop
connection client software installed.

= Only one connection (local or remote) is possible.

Remote Desktop Permissions

By default, the users who connect to the remote computer with Full Control permissions are
the following;:

= The account currently logged on to the computer
= All members of the local Administrators group
= All members of the local Remote Desktop Users group

You can add users and groups to the default permissions using the Remote tab on the System
Properties in Control Panel. Just as with local files, permissions can be used to define the type
of access that a user or group is granted in Remote Desktop. For example, you can allow some
users to read information in files without giving them the ability to change the information,
while other users can read the information and change it.

Configuring the Remote Computer

To connect to the remote computer running Windows XP Professional by using the Remote
Desktop utility, the remote computer must have Remote Desktop enabled. Exercise 5.17 walks
you through the steps to enable Remote Desktop on Windows XP.

Configuring Remote Desktop on Windows XP

1. On the Windows XP desktop, click Start and then select Control Panel.

2. On the Control Panel, choose System.
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EXERCISE 5.17 (continued)

3. Onthe Remote tab of the System Properties dialog, select the Allow Users To Connect
Remotely To This Computer check box.

System Properties @@
Ge_neral Computer Namg HE_lrdwa{e ) Advanced
System Restora Automatic Updatas | Remote

"'1' ; Selectthe ways that this computer can be used from another location

Remote Assistance
[JAllow Remote Assistance invitations to be sentfrom this computer
Learn more about Hemole Assistance

Remote Desktop

Allow users to connect remotely to this computer

Full computer name:
xpl

| Select Remote Users... |

i OK l 1 Cancel | | Apply |

4. Click OK to exit and save the changes.

Using Remote Desktop over an Intranet

Within a local network any computer running the Remote Desktop client can easily connect to
any Windows XP Professional computer that has Remote Desktop enabled. Exercise 5.18 walks
you through the steps to connect to the remote computer using another Windows XP client.

Using Remote Desktop over the Internet

You can connect to a remote computer over the Internet with the same tools as those used to
connect to a remote computer on an intranet, but there are some differences of which you must
be aware. The following items should be considered:

= If the remote computer uses a modem, then it must be installed and functional.

= If the remote computer is behind a firewall, then TCP port 3389 must be open.
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Connecting to a Remote Computer over an Intranet

1. Onthe Windows XP desktop, click Start > All Programs > Accessories » Communications
» Remote Desktop Connection.

:Q Remote Desktop Connection E‘ 1 @
< XQ
Computer: ixpclleni !ll
| Connect H Cancel ” Help ‘ I Options >> |

2. Onthe Remote Desktop Connection window, type the NetBIOS name or the IP address of
the remote computer in the Computer field and then click OK. The client computer will con-
nect to the remote computer, and then you can log on to the remote computer.

*  You will have to use the IP address of the remote computer, which may be more difficult
to obtain, especially if it is assigned by a DHCP server. You should ask a user at the location
of the remote computer to run the ipconfig command to determine the IP address.

Remote Assistance

Remote Assistance is a tool that is specifically designed to enable an administrator, desktop sup-
port technician, or even another user to help a user solve a computer-related problem. In order
for Remote Assistance to work effectively, both users must be present at their computer and
must agree to the establishment of a Remote Assistance connection. Remote Assistance requires
either a Windows XP Professional or Windows XP Home Edition computer. You should know
how Remote Assistance operates and the issues related to the configuration of Remote Assis-
tance. In this section, we will discuss both of these concepts in detail.

Using Remote Assistance

The two parties involved in the Remote Assistance session are referred to as the expert and the
novice. The Remote Assistance session is initialized in the following way:

1. The novice sends a Remote Assistance request, using either Windows Messenger or e-mail. The
user can also initiate this process by clicking Start, choosing All Programs, and then choosing
Remote Assistance. This opens the Remote Assistance tool in Help and Support Tools, as
shown in Figure 5.5. The request creates an invitation that is valid for a limited time as defined
by the novice, with a default of one day.
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FIGURE 5.5 The novice's Remote Assistance console
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The expert accepts the invitation, which opens a terminal window displaying the desktop of
the novice’s computer along with the Control Panel for the expert, as shown in Figure 5.6.

The expert can view the novice’s computer in read-only mode and chat with the user. If the
users have a headset or a microphone and speakers, they can even talk to each other through
the network connection.

The expert’s Remote Assistance console before the expert takes control
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3. The expert can then request to take control of the novice’s computer by clicking the Take
Control button in the console on the expert’s computer. This sends a message to the novice
that the expert wants to take control.

4. The novice must allow the expert to take control before the expert can take control of the
computer.

5. After the novice has allowed the expert to take control, the expert can transfer files to and
from the novice’s computer and change the computer’s configuration to troubleshoot the
problem.

6. After the expert has repaired the problem, he can choose the Release Control button, as
shown in Figure 5.7, to give control back to the novice. He will not be able to start another
Remote Assistance session without another invitation from the novice.

Configuring Remote Assistance

Remote Assistance is mostly configured by default, but you should be aware of the following;:

*  The computer must be a least a Windows XP Home Edition or Windows XP Professional
computer.

FIGURE 5.7 The expert's Remote Assistance Console after the expert takes control and
begins to work
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= If the default settings have been changed, then you can use the Remote tab of the System
Properties dialog to configure the settings that control the issuance of invitations and the
ability to take control of the computer. These are enabled by default.

= Using Remote Assistance through a firewall requires that TCP port 3389 be open.

= Using Remote Assistance through Network Address Translation (NAT) may require some
additional configuration. In that case, you should consult with your network administrator.

Summary

To be an effective desktop support technician, you must understand how to configure network
protocols and services at the client level. You must also understand which problems you can trou-
bleshoot and which problems you will have to escalate to the network administrator. You are not
required to be a networking expert, but you are required to understand the principles of client con-
figuration in regard to TCP/IP, name resolution methods, remote connections, and Internet
Explorer. In addition, you should be able to configure remote connectivity tools such as Remote
Desktop and Remote Assistance and use them troubleshoot client computers remotely.

TCP/IP is a communications protocol that is used by most networks today. It provides for
logical addressing of computers and facilitates communication within an intranet as well as
throughout the Internet. You can manually assign IP addresses to a computer or use a network
service, referred to as a DHCP server. It is extremely important that each computer have its own
unique IP address within a network. TCP/IP comes with its own set of tools. The ipconfig tool
enables you to determine a computer’s current configuration and to release and renew addresses
from DHCP servers. There are many other tools included with TCP/IP that can assist you with
troubleshooting IP addresses, connectivity, and name resolution.

Name resolution on a network is necessary because people can’t remember long IP addresses
such as 192.168.1.105. Computers and routers communicate using IP addresses and eventually
MAC addresses; any other addresses are strictly for the benefit of people. There are two main
types of user-friendly names that we use on a network: NetBIOS names and hostnames. Net-
BIOS names are the older type of name used by clients earlier than Windows 2000 Professional
and applications written at or before that time period. Computers use Lmhosts files and WINS
servers to convert these names to IP addresses. NetBIOS names are valid only in a local intranet.
Hostnames can be used within an intranet and on the Internet as well. Windows 2000 Profes-
sional and later clients use hostnames, as do most applications written today. Computers use
Hosts files and, more often, DNS servers to convert hostnames to IP addresses. TCP/IP has tools
such as nslookup and nbtstat that assist you in troubleshooting name resolution issues.

The most important assets in a company are not its buildings, but rather its people. Whether users
are in the building, at home, or “on the road,” they need to have access to the resources of the net-
work in order to remain productive to the organization. Users can connect to a network remotely
and use the resources of the network as long as the network and the client computers are configured
properly. The network is the responsibility of the network administrator, but the clients are the
responsibility of the desktop support technician—you. There are two main types of connections that
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you can configure on a client computer using the New Connections Wizard: dial-up and VPN. The
type of connection that you configure will depend completely on the type of configuration and
equipment that are provided by your organization. Companies can save money in the long run by
enabling users to use VPN connections to connect through the Internet with a local call to their ISP.
VPNs won’t necessarily provide more bandwidth, if you are still using an analog modem on the cli-
ent side, but they can save on long-distance charges and they can provide enhanced security over that
of dial-up connections. Troubleshooting remote connections is a process of isolating the problem
between the client side, the server side, and the connection between. You can use tools built into
Windows XP to test the modem on the client and eliminate it as the source of the problem. All other
issues will probably require escalation to the network administrator.

Most users know how to use a browser to get to their favorite web page, even though they
have no idea how it all works. Many users know “enough to be dangerous™ about the settings
that can affect their browsing experience. Since users are, by default, allowed to make changes
to their Internet Explorer settings, you should know what changes are possible so that you can
repair what they “fixed”! Most of the configuration options are located in the Internet Options
section of the Tools menu in Internet Explorer. Tabs on this tool include General, Security, Con-
nections, and many others. If you know what is included with each tab, then you will be able
to recognize what the user might have changed.

With the use of new tools, administrators and desktop support technicians no longer have to
physically go to a user’s computer to assist the user and troubleshoot the computer. Tools such
as Remote Desktop and Remote Assistance make troubleshooting possible over an intranet and
even over the Internet. Remote Desktop is primarily a troubleshooting tool that is used by
administrators and desktop support technicians. It can be used to remotely control any Win-
dows XP Professional computer that has the service enabled. Remote Assistance is a tool that
can be used by administrators, desktop support technicians, or any two users. Typically, the
person who is asking for help is referred to as the novice, and the person who provides the help
is referred to as the expert. The expert can assist the novice while continuing a chat conversa-
tion. The novice must first issue an invitation to the expert and then must give the expert per-
mission to take control of the computer. Once a novice has given the expert permission to take
control, the expert can upload files, download files, and make configuration changes necessary
to repair the computer. If you are the expert, then your knowledge of all of the topics discussed
previously will be a key to assisting the user.

Exam Essentials

Know IP address configuration and how to troubleshoot it. You should know how to
determine the IP addresses of a client and whether it was manually assigned or automatically
configured by DHCP or APIPA. You should also know how to manually configure an IP
address on a client and how to force DHCP to release an address and configure a new one.
Finally, you should be able to use the ping and pathping tools to troubleshoot connectivity
between computers.
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Understand the various methods of name resolution. You should understand that computers
recognize one another by their MAC addresses and that ARP is used to convert an IP address
to a MAC address. You should also understand that NetBIOS names and hostnames are user-
friendly names created because people would rather remember them than IP addresses. In addi-
tion, you should know the names of the files and services that are used for name resolution, both
NetBIOS and hostname. Finally, you should know the appropriate tools to use to troubleshoot
each type of name resolution.

Know the types of remote connections. You should know that there are two types of remote
connections, dial-up and VPN, and that you can configure both of these connections using the
New Connections Wizard. You should also know that VPN connections use the Internet and an
ISP to make a connection to an organization’s server. In addition, you should know that VPNs
are being used more often now because they eliminate long-distance charges and provide greater
security than do dial-up connections. Finally, you should know how to troubleshoot the client
side by checking the configuration and testing the modem.

Be able to configure Internet Explorer for users. You should know that Internet Explorer has
become the most popular browser partly because of its tremendous flexibility. You should also
know that most of the client configuration settings for Internet Explorer are located in the Inter-
net Options section of the Tools menu. In addition, you should know that users, by default,
have the permissions to make changes to these settings. Finally, you should know where each
setting is located and what it does so that you can fix errant configurations for users.

Know how to use the remote connectivity tools. You should know that there are two main
remote connectivity tools: Remote Desktop and Remote Assistance. You should also know that
Remote Desktop is available only on Windows XP Professional. In addition, you should know
that Remote Assistance is available on Windows XP Professional and Windows XP Home Edi-
tion. Finally, you should understand how to install and configure both of these remote connec-
tivity tools and how to use them to troubleshoot a user’s computer.
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Review Questions

You are the desktop support technician for your organization. A client complains that she can-
not connect to the network servers. You direct her to a command line and ask her to type the

ipconfig command. She says that the IP address reads 169.254.11.15. Which of the following
should you do next?

A. Immediately escalate the issue to the network administrator.

B. Tell her to type ipconfig /renew.

C. Tell her to restart her computer immediately.

D. Stop and restart the DNS server.

You are the desktop support technician for a large company. A user complains that when he uses
his laptop at home to connect to the company’s server over his VPN connection, he can no

longer browse the Internet. As soon as he closes the VPN connection, he can browse the Internet
again. Which of the following should you do next?

A. Reconfigure the VPN connection to use the default gateway of the server.
B. Change the IP address on the server to an IP address that has Internet connectivity.

C. Reconfigure the VPN connection to use the local default gateway instead of the remote
default gateway.

D. Tell the user to use a dial-up connection for Internet connectivity while he is using the
VPN connection at the server.

You are the desktop support technician for a large organization. A user complains that some of
his applications are not working properly through the network. You suspect that name resolu-
tion is at fault. You ping the application’s server by its FQDN, APP1.sybex.com, and receive a
reply that the host cannot be found. You now want to confirm that you have connectivity to the
server. Which of the following should you do next?

A. Disconnect and reconnect the client computer’s network cable.

B. Ping the server by its NetBIOS name, APP1.

C. Type nslookup appl.sybex.com.

D. Ping the IP address of the server.

You are the desktop support technician for a large company. Some users are having problems
with a legacy application. The errors that the application reports seem to indicate that NetBIOS

name resolution is at fault. You suspect that an old file may be the problem. Which of the fol-
lowing should you do?

A. Ask the administrator to examine the Hosts files on the servers for errors.
B. Ask the administrator to restart all of the DNS servers.

C. Ask the administrator to restart all of the WINS servers.
D

. Ask the administrator to examine the Lmhosts files in the network for errors.
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You are the desktop support technician for a large company. A user in your building tells you
that he can get access to the Internet through the proxy server just fine but he cannot access the
sites on your intranet. Which of the following should you do?

A. Create a new connection on the client computer that is specifically for intranet access.

B. Change the LAN settings in Internet Explorer to allow bypassing the proxy for local
addresses.

C. Change the default gateway on the client computer.

D. Change the client’s IP address to the address of the servers in the intranet.

You are the desktop support technician for a company with many mobile users. You currently
use modems on the users’ laptops to connect to a stack of modems in the server closet. Users are
dialing in from all over the country, so long-distance costs are very high. Management has asked

you for suggestions as to how to lower costs without sacrificing security. What should you tell
management? (Choose two.)

A. You could use VPNs instead of the dial-up connections. This would decrease costs and
increase security.

B. You could lower costs by changing from dial-up to VPN, but the trade-off would be an
increased security risk.

C. If most of the cost comes from long-distance charges, there is no way to avoid those
besides negotiating a better contract with the communications carrier.

D. Using VPNs could eliminate the use of the modems in the network closet.
You are the desktop support technician for a company with many Internet users. One of your
users calls you complaining that the page that automatically comes up when he starts Internet

Explorer has been changed. You want to help the user fix the problem, but you are not in front
of a computer. Which tab in Internet Options contains the Home Page setting?

A. Content

B. Programs

C. Advanced

D. General

You are the desktop support technician for a company with many Internet users. A user calls you
complaining that she cannot download files or run special applications on a web page. You want

to walk her through adding the page as a trusted site, but you are not in front of a computer.
Which tab in Internet Options contains the appropriate setting?

A. General
B. Advanced
C. Security
D

Privacy
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9. You are the desktop support technician for a company that has many users in many different
locations. All users are using Windows XP Professional client software. You want to set up a
program whereby you will train certain users who will then be able to assist other users over the
network. You want the novice users to have to invite the expert users before the expert users can
help. Which remote connectivity tool should you use?

A. Remote Desktop
B. Dynamic Host Configuration Protocol
C. Remote Assistance
D. WINS
10. You are the desktop support technician for a large company with many users. You are consid-

ering using Remote Desktop to remotely manage clients in your network. Which of the follow-
ing are true? (Choose two.)

A. You can manage any client from a Windows XP Professional computer with Remote
Desktop enabled.

B. You can manage a Windows XP Professional client computer, with Remote Desktop
enabled, from any client computer with the Remote Desktop client installed and enabled.

C. You can manage a Windows XP Home Edition client from a Windows XP Professional
client as long as Remote Desktop is enabled.

D. You can only have one active session, local or remote.
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Answers to Review Questions

1.

B. You should tell her to type ipconfig /renew. Apparently the DHCP server was not available
when the computer was last started, but it might be available now. If her computer still does not
obtain an IP address, then she should restart her computer just to give it one more chance. If it still
does not obtain an IP address, then the problem should be escalated to the network administrator.
Stopping and restarting the DNS server should not be done and will not fix this problem.

C. You should reconfigure the advanced network settings of the connection. You should remove
the check mark from Use Default Gateway On Remote Network check box. Changing the IP
address of the server would not solve this problem. The user would need to have two modems
in his laptop and two available telephone lines to use a dial-up connection at the same time he
is using the VPN connection; therefore, this is not a viable solution.

D. To confirm that you have connectivity, you should ping the IP address of the server. If you
get a reply, then you know that you have connectivity and that name resolution is the issue. You
should not disconnect and reconnect the client computer’s network cable. Pinging the computer
by the NetBIOS name will not eliminate all of the name resolution issues. Using nslookup might
assist you in determining whether the DNS servers are working properly, but it won’t help you
establish connectivity between the client computer and the server.

D. You should ask the administrator to examine the Lmhosts files for errors. Since the issue
relates to NetBIOS name resolution, the Hosts file and the DNS servers are not part of the
problem. The WINS database is dynamic and self-checking, so it is unlikely that the old record
is still in the WINS database. If there is an error in the Lmhosts file, it will cause this problem
because the Lmhosts file is read before WINS.

B. You should change the LAN settings in Internet Explorer. You should check the Bypass The
Proxy Servers For Local Addresses check box under Proxy Settings. It is not necessary to create
a new connection on or change the default gateway of the client computer. Each address in a
network should be unique, so you certainly wouldn’t want to change the client’s IP address to
that of the servers.

A, D. You should recommend using virtual private networks (VPNs) instead of dial-up connec-
tions. VPNs will eliminate the long-distance costs and the need for modems on the server side.
VPN will also increase, not decrease, security versus that of dial-up connections.

D. You should direct the user to the General tab in the Internet Options dialog of the Tools
menu. The Home Page is the first option on the General tab. The other options do not contain
the Home Page setting.

C. You should direct the user to the Security tab of the Internet Options dialog of the Tools
menu. You should then walk her through configuring the site as trusted. (This is assuming that
the user has the permissions to make the configuration change.)
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9. C. Youshould use the Remote Assistance tool built into every Windows XP client. Novice users
can invite expert users to help them. Remote Desktop is primarily used by administrators and
support personnel and does not have the invitation capability. Dynamic Host Configuration
Protocol (DHCP) is a service used to automatically assign IP addresses to hosts, not a remote
connectivity tool. WINS is a service that converts NetBIOS names to IP addresses and not a
remote connectivity tool.

10. B, D. Only Windows XP Professional supports remote control from Remote Desktop, not Win-
dows XP Home Edition or any other client prior to Windows XP Professional. You can manage
a Windows XP Professional client computer from any client computer with the Remote Desktop
client installed and enabled. You can only have one active session, local or remote.
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Although any of the information in this book could be very useful
on both the MS 70-271 and MS 70-272 exams, most of what we
have covered so far has been focused on the MS 70-271 exam. We
are now moving into information that is more likely to be useful for the MS 70-272 exam. The
information in the remaining chapters of this book is more specific to applications and the rela-
tionship of applications to the Windows XP operating system.

As user friendly as Windows XP is, most people still don’t start up a computer and log on
to it just to gaze at the operating system. Most of the time, they want to use an application that
is installed on the operating system. There are many different types of applications from which
a user can choose. Some of these are produced by Microsoft and others are produced by many
other third-party companies. In this chapter, we will focus first on some of the applications that
are produced by Microsoft to run on the Windows operating system. As a desktop support tech-
nician, you should be able to install, configure, and troubleshoot the most common Microsoft
Windows applications. After we have discussed Microsoft applications, we will turn our atten-
tion to applications in general, discussing how to configure old and new applications on single-

user computers as well as multiuser computers. The first applications that we will discuss
include Microsoft Office, Internet Explorer, and Outlook Express.

Microsoft Office Microsoft Office is a family of products that are designed to assist users in
completing common business tasks. These products are available individually and in suites,
which are groups of programs bundled together to address related business requirements. You
should know the members of the Office family and have an understanding of how to install,
activate, configure, and troubleshoot these products for the various Windows operating systems
in your user environment.

Internet Explorer As we discussed in Chapter 5, “Troubleshooting Network Protocols and
Services,” Internet Explorer is the browser of choice for most Internet users. It comes standard
with all Microsoft client operating systems later than Windows 95. You should know how to
configure and troubleshoot all of the client settings for Internet Explorer.

Outlook Express Outlook Express is a messaging tool that is built into Windows operating systems
later than Windows 95. Many people use Outlook Express for e-mail transactions and newsgroup

communications. Using the tools in Outlook Express, more than one person can use the same com-
puter for e-mail and each person can have his own identity in the computer. You should know how
to configure and troubleshoot e-mail settings and newsgroup settings for users of Outlook Express.

Application support Applications and operating systems have evolved over time. Some applica-
tions that were designed to run on older operating systems can now run on Windows XP provided
that it is configured properly. Computers that have multiple users or multiple operating systems
present a special challenge. You should know how to configure and troubleshoot application sup-
port on the most common Windows operating systems in various computer and user configurations.
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Microsoft Office

Since Microsoft Office is the best-selling suite of applications in the world today, many of the
calls that you receive from customers may relate to one or more of the Microsoft Office prod-
ucts. As a desktop support technician, you should be able to provide support for users of
Microsoft Office applications. In this section, we will discuss installing Microsoft Office and the
individual applications within it. In addition, we will examine how you should configure, man-
age, and troubleshoot existing Microsoft Office applications. Finally, we will discuss how to
configure e-mail account settings for Microsoft Outlook users.

Installing Microsoft Office

Microsoft Office has evolved since its first release in 1995. It contains many applications, such as
Word, Excel, PowerPoint, and so on. There are many versions and editions of Office that you
might encounter in your network. It’s essential that you have knowledge of these applications and
their different versions. We will discuss the older versions of the software later in this chapter. In
this section, we will focus on the latest Microsoft Office suite of applications, Office 2003. You
should know how to acquire the software, determine the disk space requirements, select an instal-
lation methodology, perform the installation, and activate the new software. We will discuss each
of these concepts in detail.

Acquiring Microsoft Office 2003

There are many editions of Microsoft Office 2003. Depending on the nature of your organiza-
tion and the edition that you require, you will find the software available from many different
sources. Table 6.1 illustrates the editions that are available for Office 2003. Stand-alone appli-
cations are also available through retail outlets, original equipment manufacturers (OEMs), or
volume licenses.

TABLE 6.1 Editions of Microsoft Office 2003 and Their Availability

Microsoft Office Edition Availability

Office Professional Enterprise Edition Volume License and Academic Volume License
Office Professional Edition Retail, OEM, and Academic Volume License
Office Standard Edition Retail and all Volume Licenses

Office Small Business Edition OEM only

Office Student and Teacher Edition Retail and Academic Volume License
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Determining Disk Space Requirements

How much hard disk space Office requires is largely dependent on the options that you select.
You can choose to install all of the applications, just the most commonly used applications, or
just the applications that you want. Table 6.2 illustrates the approximate space required on the
hard disk for each of the installation options.

TABLE 6.2 Disk Space Requirements for Office 2003

Type of Installation Disk Space Needed Description of Installation

Typical 331 MB Installs the most commonly used com-
ponents of Microsoft Office.

Complete 577 MB Installs all of Microsoft Office on your
computer, including all optional compo-
nents and tools.

Minimal 251 MB Installs Microsoft Office with only the
minimal required components.

Custom Based on selected features  Enables you to select the applications
and features that will be installed on
your computer.

Selecting an Installation Methodology

A methodology is simply a way of doing something. There are three ways to install Microsoft
Office onto Windows 2000 and Windows XP clients:

= Manual installation: This type of installation can be accomplished by using the CD or a net-
work share with the required files. You begin the installation and continue to follow all of
the on-screen prompts until the installation is complete. You can specify files that are
installed and advanced settings.

= Automated installation: This type of installation proceeds according to an installation
script. The script installs the application based on preselected choices. Scripts and other
types of automated software installations can be run using Group Policy in Windows 2000
and Windows Server 2003 networks. You can also use Microsoft Systems Management
Server (SMS) to perform installations on multiple computers in any type of Microsoft net-
work with any Microsoft client later than Windows 95.

= Upgrade installation: This type of installation is performed on a computer with a previ-
ous version of Office installed. The purpose of this type of installation is either to update
the Office version or to install additional components on the current version. This type
of installation can be performed manually or can be automated using Group Policy or
SMS software.



Microsoft Office 193

Performing the Installation

The actual steps involved in the installation will vary depending on your installation method-
ology. In this section, we will focus on the manual installation and upgrade installation meth-
odologies using the Microsoft Office 2003 CD. Automated installations and network share
installations are beyond the scope of this text, since they are not generally performed by a desk-
top support technician.

2 You should make sure that you have closed all other programs and deactivated
ING antivirus software before performing any new installation or upgrade.

Performing a New Installation of Office 2003 from a CD

The number of decisions that you make during the installation will vary depending on whether
you select to perform a Typical installation or a Custom installation. Exercise 6.1 walks you
through the steps to perform a Typical installation of Office 2003.

Performing a Typical Installation of Office 2003 from a CD

1. Insertthe Office CD in the CD-ROM drive to launch the Office Setup program. If Setup does
not run automatically, then you can manually run the Setup.exe program located in the
root folder of the CD.

2. Enterthe product key displayed on the label on the Office CD container in the Product Key
dialog box, and then click Next.

& Microsoft Office 2003 Setup

Microsoft Office Professional Edition 2003

Product Key

In the boxes below, type your 25-character Product Key. You will find this number on
the sticker on the back of the CD case or on your Certificate of Authenticity.

Product Key:  [oonT  |-[vol] [-jwiss— ]-frou EEET

or>_] (oo
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EXERCISE 6.1 (continued)

3.

4. Accept the terms in the License Agreement, and then click Next.

5.

6.

@ Microsoft Office 2003 Setup

Select Typical Install for the installation type, and click Next.

Microsoft Office Professional Edition 2003

Type of Installation

Retomase idox Tistall
() Typical Install

or choose another type

) Complete Tnstall
) Minimial Install

(

() Custom Install

Install Microsoft Office with only the most
commonly used components. Additional
features may be installed on first use, or
added later through Add/Remave Programs in
the Caontrol Fanel.

Hote: InfoFath requires Microsoft Internet
Explorer 6.0 or |ater. For more information,
dick the Help button.

Install to: |C:\.Pragrnrr. Files\Microsoft Office)

Browsa...

Enter your User Name, Initials, and Organization information, and then click Next.

s %

< Back H Next = l ’ Cancel

l

Setup will display a list of applications that will be installed. Click Install to complete
the installation.

If you select Custom Install for the installation type, then you will have the option to choose
which programs will be installed and how they will be run on your computer. You should
understand the following options in the Custom Setup box:

Run From My Computer: The component will be installed so that it can be run directly
from the hard drive without the use of the CD. Other underlying components and options
may not be installed, to save hard disk space.
Run All From My Computer: The component and all of the underlying components and
options will be installed on the hard drive so that they can all be run from the hard drive
without the use of the CD. This option consumes the most hard disk space.

Installed On First Use: Office will prompt the user to install the component the first time
she attempts to use it. The user will have to have access to a CD or to a network share to
perform the installation.

Not Available: The system will not install the component or any of the underlying compo-
nents or options.
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) If you have a previous version of acomponent on your computer, then you can
TE select whether to uninstall the previous version or leave it in place.

Performing an Upgrade Installation of Office 2003 with a CD

The term upgrading refers to the process of installing a more recent version of a software com-
ponent that currently exists on your computer. Upgrading Office 2003 is very similar to install-
ing it for the first time. Exercise 6.2 walks you through the steps to perform an Upgrade
installation of Office 2003.

Upgrading to Office 2003 from a CD

1. Insertthe Office CD in the CD-ROM drive to launch the Office Setup program. If Setup does
not run automatically, then you can manually run the Setup.exe program in the root folder
of the Office CD.

2. Complete the first three Setup dialog boxes and enter the product key displayed on the
label of the Office CD container in the Product Key dialog box.

3. Select Upgrade as the installation type.

4. Setup will examine your computer for currently installed Office 2003 components and then
display a list of applications that will be installed. Click Install to complete the installation.

Activating Office 2003

Activation is the newest form of protection from piracy of software. It is designed as a counter-
measure to the most prevalent form of copyright infringement, casual copying. It works by asso-
ciating hardware components of a computer with a specific installation of software. After the
software has been associated with a specific set of components, it cannot be activated on another
computer that does not have the same specific set of components. Exceptions are made for volume
license versions of software that is purchased by large organizations.

After you install or upgrade Office 2003, you are required to activate it. This can be accom-
plished using the Activation Wizard and an Internet connection. The Activation Wizard will
appear the first time that you run an Office Application. You can activate the software easily
through the Internet. If you do not have an Internet connection, then the wizard can give you
the correct telephone number to dial to activate the software. You will either speak with a
Microsoft representative or use an automated system, depending on your region. After you have
given the Product Key information to Microsoft, they will give you an activation code to acti-
vate the software.
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Configuring, Managing, and Troubleshooting
Microsoft Office Applications

Simply knowing how to install Office 2003 will not get you very far as a desktop support tech-
nician. To be effective you must also know how to troubleshoot the installation and maintain
the installation for the user. In addition you should know how to apply updates, add and
remove components, reinstall and repair components, and assist the user to recover data when-
ever possible. In this section, we will discuss each of these concepts in detail.

Troubleshooting an Installation of Office 2003

Because of the evolution of the Office software itself and the manner in which it operates with
other applications on your computer, there a number of problems that can occur when install-
ing or upgrading Office 2003. If you are performing an upgrade installation with an Upgrade
CD, then you should make sure that you have a previous version of the software that you are
trying to upgrade currently installed on the computer; otherwise, you will receive a “No Qual-
ifying Product” error.

The other errors that could occur during an installation depend on the hardware and
software installed on a computer and are too numerous to mention here. Often, the best
method is to simply uninstall the software, restart the computer, and then reinstall the soft-
ware. If this still does not eliminate the problem, you should examine the following files
created during the installation:

= Office Professional Edition 2003 Setup(000x).txt

= Office Professional Edition 2003 Setup (000x)_Task(000x).txt
=  MSI*.log

= Offclnll.Tog—If you have uninstalled Microsoft Office 2003 previously

Applying Updates to Office 2003

The Microsoft Office website is the online extension of Office that assists you in keeping your
applications up-to-date. Microsoft adds new content to the site on a regular basis, so you can
always get the most recent updates and fixes to protect a user’s computer and keep it running
efficiently. You can access the Office Update website at http://office.microsoft.com/
officeupdate/default.aspx. Office Update scans your computer and then provides a list of
critical updates and optional updates. Critical updates are considered essential for the operation
and/or security of your computer. Optional updates could be new features and/or functionality.
As a desktop support technician, you should scan for updates regularly or advise your clients to
scan for them on a regular basis. Exercise 6.3 walks you through the steps to scan for updates
on the Microsoft Update website.
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You can also access Windows Update from the Help menu of most Office 2003
P applications.

Adding and Removing Office Components

Over time, a user’s needs are bound to change. He might need Office components that he didn’t
need before. By the same token, he might have components installed on his computer that he
never uses and that are just taking up hard drive space that could be used for something else.
You should know how to assist the user in making these adjustments to his Office software
without affecting any other components in the system. Exercise 6.4 walks you through the steps
to add or remove Office components:

Scanning for Updates

1. On your browser, type http://office.microsoft.com/officeupdate/default.aspx.

|E] Microsoft Office Downloads Home Page - Microsoft Internet Explorer - EE
Fie Edit View Favortes Took Help a
@Back » © - @ @ @ P Search “rFavortes @Meda € (v L EHIE 3

Address | &] http://office.microsoft.com/officeupdate/default. aspx |»| EdGo ﬁl
United States

Dn Microsof -

L2 Office Online

Downloads

Home Downloads =

Assistance «i'hj

Training -

enitiae Office Update New updates 5

Clip Art and Media Check for free updates that improve Office XP SP3 y

alikaiin Office's stability and security. Excel 2003
Office Marketplace &) Check for Updates Access 2002
Product Information Office 2003 Editions
Popular Office downloads = Share ‘,'Dulr Word documents About Office 2003
3 Outlook 2003 to Notes Use the Word 97/2000 Editions
Things To Do Connector Viewer to share Reasons to upgrade
£ _— | documents with people
Check fi dates ot et} %
eck for updates -T—I\.D Talblc- Reports 101 "B, | vho don't have Word Order a trial CD

Suggest a download utoria installad. o by

e Fublisher 2000 Resume oMLY

Give us feedback Wizard Quick finks

See Office demos
i BROWSE DOWNLOADS
Woruwide Protect your PC il

&] Done & Internet
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EXERCISE 6.3 (continued)

2. Click Check For Updates. The system will scan your computer and generate a list of rec-
ommended updates. The updates that are considered critical will already be selected. You
can read information about each of the updates on the links provided and make your own
decisions in regard to which updates you want to install.

|¢:] Microsoft Office Update - Microsoft Internet Explorer g@ﬁ
Fie Edt View Favorites Took Help i
QBack ~ © - @ @ @ | P search “rFavorites @ Meda € v 2 B L E 3

Ez-http:ﬂoﬁ”nce.microsoft,camfofﬁceupdatefmaincatabg.aspx?CTr:QS

Inited States Microsoft.com Home | Site Map )

3 B#fice Online

1 Downloads z |

Home Microsoft Office Update Help

Assistance

Training Your Office products require the critical updates listed below. The updates have already been

Templates selected for installation. If you do not want to install an update, deselect the check box next to it.

Clip Art and Media

Downloads +" Selected Updates: 8

_ P Updates for Office 2003 products

Office Marketplace Il Download Size: 5862 KB

Product Information @ Download Time: < 1 min Outlook 2003 Junk E-mail Filter Update:
KB835235

Things To Do Start Installation 13 =

Show already \\ld") ) I . ) .

installed Office This optional update provides the Junk E-mail Filter in

updates Microsoft Office Outlook 2003 with @ more current

Sign up to find out definition of which e-mail messages should be

about new updates considered junk. By installing it, you help the filter

Give us feedback provide a higher level of protection against junk e- 1
mzil_Thic nindata wae ralaacad in March 2004 st

&] Done & Internet

3. Whenyou have selected all of the updates that you want, click Start Installation and accept
any user license agreements provided. Some updates may require that you restart your
computer to complete the installation.

Adding or Removing Office Components

1. On the Windows XP desktop, click Start, choose Control Panel, and then choose Add Or
Remove programs.

2. Select the Microsoft Office program from the program list, and then click Change.
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EXERCISE 6.4 (continued)

3. Inthe Maintenance Mode Options dialog box, click Add Or Remove Features, and then
choose Next. Setup will display the same installation options displayed at the original Setup.

_@ Microsoft Office 2003 Setup

Microsoft Office Professional Edition 2003

Maintenance Mode Options

(3 Add or Remove Features
= Change which features are installed or remove specific features.

@a (~yReinstall or Repair

' Reinstall or Repair Microsoft Office 2003 to its original state.

~, Uninstall
" Uninstall Microsoft Office 2003 from this computer.

o

Next > l I Cancel

4. Change only the features that you want to change; the rest of the installation will not
be affected.

5. When you have finished making your choices, click Install. The system will make the
changes to create the installation that you chose. You may have to restart the computer to
complete the installation.

Repairing Office Components

Microsoft Office 2003 uses the Microsoft Windows Installer to enable self-repairing features.
The Microsoft Windows Installer is a special tool that is designed to streamline the process of install-
ing and configuring products and applications. If a resource that is required to start a program
is missing or corrupt, such as a Registry key, then Windows Installer will detect that the resource is
missing and repair the program. You can read more information about Windows Installer on the
Microsoft Developers Network (MSDN) library at http://msdn.microsoft.com.

If you or your customers are having problems with an Office component, you can attempt
to reinstall and repair it yourself or let the system detect and repair the problem. Exercise 6.5
walks you through the steps to attempt to reinstall and repair a problem in Office.
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Reinstalling and Repairing Office

1. Onthe Windows XP desktop, click Start, choose Control Panel, and then choose Add Or
Remove Programs.

2. Select the Microsoft Office program from the program list, and then click Change.

3. Inthe Maintenance Mode Options dialog box, click Reinstall Or Repair, and then click Next.
In the Reinstall or Repair Office Installation dialog box, select one of the following options:

.ﬁmcmso& Office 2003 Setup Q |
Microsoft Office Professional Edition 2003 E o]
Liad

Maintenance Mode Options

Oag
ijflo (Add or Remove Features
~ Change which features are installed or remove specific features.

@3 rv‘;)._geinstall or Repair

' Reinstall or Repair Microsoft Office 2003 to its original state.é

~, Uninstall

- O

~ Uninstall Microsoft Office 2003 from this computer.

I HNext > l | Cancel

Reinstall Office: This option instructs Setup to reinstall all Office files and reset all
Registry settings, whether or not they appear to be defective.

Detect And Repair Errors In My Office Installation: This option instructs Setup to detect
defective files or settings and make just the repairs that are necessary. You should
check the Restore My Start Menu Shortcuts check box if you have changed or deleted
any of the default shortcuts and you want them restored.

< In Office 2003, you can also choose the Detect And Repair option from the Help
P menu in any Office 2003 application.
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Recovering Office Application Files

Microsoft Office 2003 has built-in features to prevent users from losing data. There are new
tools that you can use manually as well as new services that run in the background automati-
cally. In this section, we will discuss the three main tools and services that you and your users
can use to recover Office application files: Microsoft Office Application Recovery, AutoRe-
cover, and Shadow Copy.

Microsoft Office Application Recovery Tool

The Microsoft Office Application Recovery tool provides a way to keep from losing data when
an application crashes or hangs. Instead of using the old familiar End Task button in Task Man-
ager, a user now has another option that may allow her to restart the application and recover
the documents. Exercise 6.6 walks you through the steps to use the Microsoft Office Applica-
tion Recovery tool.

Using the Microsoft Office Application Recovery Tool

1. Onthe Windows XP desktop, click Start and then choose All Programs » Microsoft Office >
Microsoft Office Tools » Microsoft Office Application Recovery.

2. Select the name of the application that you want to recover, and then click Recover Appli-
cation. This will terminate the application and cause it to attempt to save any unsaved
changes before terminating.

V.3 Microsoft Office Application Recovery @

Use Microsoft Office Application Recovery to ext an application which is not responding. You will
be given the options to report the error to Microsoft and, if available, to recover your work.

. Application Status
| | W|Micrasoft Ofice Waord Running
| [2] Microsoft Office Outlook Running
EEMicmsoﬁOfﬁceExcel Running

| Recover Application... I I End Application...

ING ery tool will cause the specified application to terminate without attempting to

ﬁl‘ Selecting the End Application option in the Microsoft Office Application Recov-
save your data.
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AutoRecover

AutoRecover is a feature included in Office 2003 and Office XP that recovers data in Office appli-
cations in the event of a loss or corruption of data. It is especially useful in the event of a power outage
on a desktop or laptop. The service works by automatically saving files at a specified interval. If you
suddenly lose power, the only data that you will lose will be anything that has changed since the last
AutoRecover save. Exercise 6.7 walks you through the steps to recover files using AutoRecover.

Recovering Files Using AutoRecover

1. Open the Office application that you were using when the power outage occurred.

%" Document1 - Microsoft Word = JAEd

! Fle Edit View Insert Format Tools Table Window Help Adobe PDF  Acrobat Comments Type a question for help X

D (AR P o] 5 5 Read & | hormal » Tames liew Roman z12 B I U|W

P75 T R 2] S Attadh SybexSD o

Document Recovery [l -'-'1--------'8---:---} [T SERN I TR SRR .
I

‘Word has recovered the following files. Save the
S you wish to keep.

Available files ) 3
-
] pocumentl [Recoverad] j Z
Last saved with AutoRecover -
7:32 PM Tuesday, May 04, 2004 Z
o
] ImportantFile [Criginal] .
Last saved by user I
2:55 PM Tuesday, May 04, 2004 w
o
-
i
@
j : -
+
L L]
&4 Which file do Twant to save? 3
: *
Close =
=3 @3>0 4 | | » !
Page 1 Sec 1 11 At 1" lnl Coll REC TRK EXT OVR

2. Scan the files listed in the Document Recovery task pane and decide which file you want
to keep. Files that have the word Recovered in the title are usually the newest files.

3. Selectthe file in the Document Recovery task pane, click the arrow next to the file’s name,
and then do one of the following:

To work with the file, click Open.

To save the file, click Save As and name the file. The newly named file will be saved in
the same folder as the original file. If you type the same name as the original file, then the
original file will be overwritten with the recovered file.
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Shadow Copy

Shadow Copy is a new technology included with Windows Server 2003 that tracks the history of all
documents stored in a particular volume on a server. Shadow Copy allows users to roll back changes
made to documents or restore them on the file server if they were accidentally deleted. Client com-
puters must be Windows XP or Windows 2000 Professional and must have the Shadow Copy client
software, ShadowCopyClient.ms1, installed on them to use this feature. You can obtain this soft-
ware from Microsoft’s downloads site athttp: //microsoft.com/downloads. The client software
will create a new tab in the file and folder properties called Previous Versions. You can use this tool
to recover accidentally deleted files and folders or to recover a file that was accidentally overwritten.

Exercise 6.8 walks you through the steps to recover a deleted file.

EXERCISE 6.8

Recovering a Deleted File with Shadow Copy

1. Navigate to the folder in which the deleted file had been stored.

2. Position your cursor over a blank space in the folder.

3. Right-click, select Properties, and then choose the Previous Versions tab.
4

On the Previous Versions tab of the folder’s Properties dialog, select the version of the
folder that contained the file before it was deleted, and then click View.

View the folder and select the file that will be recovered.

o

6. Drag and drop or cut and paste a copy of the file to the user’s local computer.

Exercise 6.9 walks you through the steps to recover a deleted folder:

Recovering a Deleted Folder with Shadow Copy

1. Position the cursor in a blank space in the folder that contained the folder that will
be recovered.

2. Right-click and select Properties, and then choose the Previous Versions tab.

3. Select Restore to recover everything that was in the folder or Copy to copy the older ver-
sion to another location.

Exercise 6.10 walks you through the steps to use Shadow Copy to recover an overwritten or
corrupt file.



204 Chapter 6 = Configuring and Troubleshooting Applications

Using Shadow Copy to Recover an Overwritten or Corrupt File
1. Right-click the overwritten or corrupt file and then click Properties.
2. Select the Previous Versions tab.

3. Toview an older version of the file, choose the version and then click View. To replace the
current version with the older version, click Restore. To copy the older version to another
location, click Copy.

The Real Value of Shadow Copy

Suppose that you are normal user working on a PowerPoint presentation that contains over
300 slides. You are preparing the presentation for a meeting that will take place this afternoon.
You've been working hard on it for about two months and you are just putting on the finishing
touches. There is only one copy of the presentation, which is located on the file server. You feel
safe with this because the file server is backed up on a nightly basis.

There is only one thing about the presentation that bothers you—the style of the slides. You're
not sure whether you have chosen a look that is professional enough. You decide to get a sec-
ond opinion, so you call a colleague to ask her to review a shorter version of the presentation
for style only. She agrees and asks you to send her just 10 or 12 slides.

This is where the problem starts. You decide to select the slides that you don’t want to send her
and cut them out of the current presentation. You select about 290 slides and delete them from
the current presentation. You then intend to save the presentation with a different filename, but
you become distracted and you make a rather large error. You save the file with the same name
that it had before and overwrite the 300-slide presentation with the 10-slide presentation. You
have effectively lost 290 slides!

The fact that you should have just created a new file and then copied the slides into it is no
longer relevant at this point. What is relevant is that the only copy that is left of that presenta-
tion is the one that is on the backup tape of the file server. How well do you know the network
administrator? Will he understand the significance of this emergency and restore your file
before the meeting? What else does the network administrator have to do today besides fix
your mistake? The network administrator might be able to bail you out this time, but suppose
it happens again; would you even have the courage to ask for another favor? Maybe you should
talk to the desktop support technician instead!




Microsoft Office 205

Now suppose you are the same user and you are working on the same file, but you know about
Shadow Copy. You accidentally press Save instead of Save As and realize that you have just
copied over your original presentation. You simply right-click on the file that you still have and
select a previous version of it. Depending on how often the shadow copies are made (as
defined by the network administrator), you may have to redo the finishing touches that you
added today. That's it!

The real value of Shadow Copy is that it lets people be people. We all make mistakes at times and
do things that we can’t believe we actually did. This example, or something like it, probably has
happened to you or someone you know. If your organization uses Shadow Copy, you should

educate your people about its use so that their mistakes don’t have to become your emergencies.

Configuring and Troubleshooting Outlook E-mail
Accounts for Clients

Microsoft Office includes a program called Outlook. This program provides an integrated solu-
tion for managing and organizing e-mail messages, schedules, notes, contacts, tasks, and other
information. You should know how to configure Outlook for your user environment. You
should also know how to troubleshoot Outlook for clients.

Outlook can be configured for general Internet access or for a specialized server that stores
an organization’s messages, called Exchange Server. In this section we will discuss how to con-
figure Outlook for each of these options and how to troubleshoot common user problems for
each of them. A detailed discussion of Exchange Server is beyond the scope of this book.

Configuring Outlook for Internet E-mail and Exchange

Configuring Outlook is a two-step process. First, you create a profile that identifies the user and
stores his messages. Then, you configure a mailbox in which to receive the messages. In this sec-
tion, we will discuss both of these steps in detail.

Creating an Outlook Profile

A profile is a group of e-mail accounts, address books, and personal folders. A user can create
any number of profiles for different uses. In addition, multiple profiles can be very useful when
more than one person uses the same computer. Exercise 6.11 walks you through the steps to cre-
ate a new Outlook profile.

Creating an Outlook Profile

1. On the Windows XP desktop, click Start and then choose Control Panel.

2. Onthe Control Panel, choose Switch To Classic View, and then double-click Mail.
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EXERCISE 6.11 (continued)

3. Inthe Mail Setup dialog box, click the Show Profiles button.

Mail Setup - Microsoft Outlook Internet Settings X
E-mail Accounts —

k‘j‘ Setup e-mail accounts and directories. T

Data Files
# Change settings for the files Outlook uses to
‘y;ﬁ store e-mail messages and documents. Rag ety
Profiles

Setup multiple profiles of e-mail accounts and
data files, Typically, you only need one. Shov Frefliesss,

4. Onthe Generaltab, selectthe Prompt For A Profile To Be Used check box, and then click Add.

5. Inthe Profile Name field, type a name for the new profile. The name should describe the
user or the type of accounts that will be contained in the profile.

6. Inthe E-mail Accounts dialog box, click the Add A New E-mail Account button, and then
click Next.

E-mail Accounts m

This wizard will allow you to change the e-mail accounts
and directories that Outlook uses.

E-mail

(@) Add a new e-mail account
() view or change existing e-mail accounts
Directory

C)Add a new directory or address book
(C) View or change existing directories or address books

Next > |[ Close J
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EXERCISE 6.11 (continued)

7. Select the appropriate server type for your new e-mail account, and click Next.

E-mail Accounts E'z%

Server Type
You can choose the type of server your new e-mall acount will work with.

(") Microsoft Exchange Server

Connect to an Exchange server to read e-mail, access public folders, and share
documents.

() popP3
Connect to a POP3 e-mail server to download your e-mail.
() map

Connect to an IMAF e-mail server to download e-mail and synchronize mailbox
folders.

() HTTR

Connect to an HTTF e-mail server such as Hotmail to download e-mail and
synchronize mailbox folders.

() Additional Server Types

Connect to another workgroup or 3rd-party mail server.

Cme ) o | [om]

8. Fillin the information as prompted, and then click Next and Finish as needed.

9. Click OK.

Configuring Mailboxes

Before users can receive e-mail in Outlook, they need to have a mailbox that is properly config-
ured. There are many different types of mailboxes that you can configure for a user. Which type
of mailbox you configure will depend upon how you are using Outlook in your organization. In
this section we will discuss the configuration of Outlook mailboxes for Internet E-mail (POP3),
Internet Message Access Protocol (IMAP), Hypertext Transfer Protocol (HTTP), and Exchange.

CONFIGURING MAILBOXES FOR INTERNET E-MAIL (POP3)

Before a user can receive e-mail through the Internet, he must have a mailbox that is correctly
configured with his Post Office Protocol, version 3 (POP3) account, provided by his ISP. Exer-
cise 6.12 walks you through the steps to configure a POP3 mailbox for a user.

This is the only configuration necessary if a user is using only one computer to check his
e-mail. If the user is using more than one computer, then you may want to configure the mailbox
to leave a copy of the messages on the server; otherwise, once you have downloaded messages
onto one computer, you will not be able to access them from the server again for the other com-
puter. Exercise 6.13 walks you through the steps to configure the user’s mailbox to leave a copy
of messages on the server.
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Configuring a Mailbox for POP3 Delivery

1. In Microsoft Outlook, choose the Tools menu and then choose E-mail Accounts.

2. Inthe E-mail Accounts dialog box, choose Add A New E-mail Account, and then click Next.
3. Inthe Server Type dialog box, choose POP3, and then click Next.
4

In the E-mail Accounts dialog box, enter the user name, e-mail address, and logon infor-
mation, and then fill in the POP3 and SMTP server addresses as provided by the ISP. The
POP3 address is for incoming mail, while the SMTP address is for outgoing mail.

5. Ifthe outgoing server requires authentication, choose the More Settings button, and then
choose the Outgoing Server tab. Select the My outgoing server (SMTP) requires authen-
tication box.

6. Configure the username and password for your outgoing server or, if the outgoing server
will use the same credentials as the incoming server, then you can simply select the Use
same settings as my incoming mail server option.

E-mail Accounts @

Internet E-mail Settings (POP3)
Each of these settings are required to get your e-mail account working.

User Information Server Information

Your Name: Bill Ferguson Incoming mail server (POP3): | mail.charter.net

E-mail Address: | billferguson@charter.net | Outgoing mail server (SMTF): | smtp.charter.net

Logon Information Test Settings

User Name: billferguson After filling out the information on this screen, we
recommend you test your account by clicking the

Password: *EFE button below. (Requires network connection)

[¥]Remember password
Test Account Settings ...

[]Log on using Secure Password

Authentication (SPA)

I < Back Jl Next > |l Cancel ‘

7. Click Test Account Settings to test the POP3 and SMTP addresses that you entered. The sys-
tem will send out and receive a message that proves that the accounts are working properly.

8. Click Next, and then click Finish.
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Configuring a Mailbox to Leave Messages on the Server

1.
2.

6.

In Microsoft Outlook, click the Tools menu, and then choose E-mail Accounts.

In the E-mail Accounts dialog box, click View Or Change Existing E-mail Accounts, and
then click Next.

Select your POP3 e-mail account and then click Change.
Click More Settings.

On the Advanced tab, select Leave A Copy Of Messages On The Server, and then click OK.

Internet E-mail Settings %\g

| General | Outgoing Server Cunnecﬁon_i Advanced

Server Port Numbers

Incoming server (POP3): | 110 Use Defaults

[ This server requires an encrypted connection (SSL)
Outgoing server (SMTF): |25
DThiS server requires an encrypted connection (S5L)
Server Timeouts

Short - Long 1 minute
Delivery
Leave a copy of messages on the server

[ Remove from server after days

D Remove from server when deleted from 'Deleted tems'

OK | [ Cancel

Click Next, and then click Finish.

CONFIGURING MAILBOXES FOR IMAP

IMAP is a method for e-mail programs to access e-mail and bulletin board messages that are
stored on a mail server. IMAP allow the user to view the headings and the senders of e-mail and
then decide whether to download the entire message. Unlike POP3, a user can search for a spe-
cific message without downloading all of her e-mail. Because all e-mail messages are maintained
on the server, the user can access the messages from more than one computer. Exercise 6.14
walks you through the steps to configure a mailbox for IMAP e-mail service.
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Configuring a Mailbox for IVMIAP

1. In Microsoft Outlook, click the Tools menu, and then choose E-mail Accounts.

2. Inthe E-mail Accounts dialog box, choose Add A New E-mail Account, and then click Next.
3. Inthe Server Type dialog box, choose IMAP, and then click Next.

4. In the E-mail Accounts dialog box, enter the required User and Logon Information.

5

Enter the name of the IMAP server for incoming mail and the name of the SMTP server
(provided by the ISP) for outgoing mail.

6. Click Next, and then click Finish.

CONFIGURING MAILBOXES FOR HTTP MAIL ACCOUNTS

Some e-mail accounts are based on the Web, such as Hotmail accounts. You can configure a user’s
Outlook software to create a mailbox for messages received in web-based accounts. Exercise 6.15
walks you through the steps to configure mailboxes for web-based accounts.

Configuring a Mailbox for an HTTP Mail Account

1. In Microsoft Outlook, click the Tools menu, and then choose E-mail Accounts.

2. Inthe E-mail Accounts dialog box, choose Add A New E-mail Account, and then click Next.
3. Inthe Server Type dialog box, choose HTTP, and then click Next.
4

In the E-mail Accounts dialog box, enter the required User and Logon Information.

E-mail Accounts E‘:\Q

Internet E-mail Settings (HTTP)
Each of these setings are requirad to get your -mail account warking.

user Information Server Information
Your Name: Eill Fergusan HTTP Mail Service Frovider: | other >
E-mail Address: [pilferquson@other,com  SEMVer URL:

Logon Tnformation

User Kame: billfergusangather.com

Fassword: )

V] Remember password

[ ]Leg on vsing Secure Password
Authentication (SFA}

= Back Cancel
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EXERCISE 6.15 (continued)

5. Enter the Server Information. If your server is not available, choose Other from the drop-
down list and enter the URL of the server.

6. Click Next, and then click Finish.

CONFIGURING MAILBOXES FOR EXCHANGE

Configuring Outlook mailboxes for Exchange is relatively simple. When Outlook is first started
after installation, a wizard guides the user through the entire process. You can also add an Exchange
mailbox to a user’s account. Exercise 6.16 walks you through the steps to add an Exchange mailbox
to an existing profile.

Adding an Exchange Mailbox to an Existing Account

1. (Ensure that Microsoft Outlook is closed.) In Windows XP, click Start and then choose
Control Panel.

2. In Control Panel, choose Switch To Classic View, and then double-click Mail.
3. Inthe Mail Setup dialog box, choose Show Profiles.

4. On the General Tab, choose the profile that you want to use, and then select Properties.

Mail X

General

s
\;@ The following profiles are set up on this computer:

[Microsoft Outiook Internet Settings

Add... H Remaove H Froperties H Copy... |

When starting Microsoft Office Outlock, use this profile:
() Prompt for a profile to be used
(@) Always use this profile

Microsoft Outlock Internet Settings v|

| OK [ [ Cancel

5. Inthe Mail Setup dialog box, choose E-mail Accounts.

6. Inthe E-mail Accounts dialog box, select Add A New E-mail Account, and then click Next.
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EXERCISE 6.16 (continued)

7. Inthe box labeled Server Type, select Microsoft Exchange Server.

8. Inthe box labeled Exchange Server Settings, enter the required information, including the
name of the Exchange server and the User Name.

9. Select Check Name to make sure that the server recognizes the name.
10. Click Next and then click Finish.

11. In the Mail Setup dialog box, click Close and then click OK.

TROUBLESHOOTING MAILBOX CONFIGURATION

Asyou can see, there are many settings involved in mailbox configuration. Since users by default have
the permissions to create their own mailboxes, you may be asked to troubleshoot what a user has
attempted to configure. Table 6.3 lists the most common configuration errors and their solutions.

TABLE 6.3 Common Mailbox Configuration Errors and Their Solutions

Error Solution
Incorrect user name or Remember that the password and user name may be case sen-
password sitive depending on the ISP. Check your settings in the E-mail

Accounts dialog box.
Server timeout Increase the setting in the E-mail Accounts dialog box.

Order of account processing  For users with multiple accounts, you can change the order in
which the accounts are processed. The account that is used
most often should be processed first.

Deleted messages remain If you do not want this to occur, then you can change the settings
on the server in the E-mail Accounts dialog box by selecting More Settings.
Copies of messages are Make sure that the settings on the computer with which you are
not stored on the server accessing the server are configured to leave the messages on

the server. Make sure that you have not set the messages to be
deleted after a set number of days and that the ISP does not
have a policy of deleting messages after a period of time.

ISP requires Secure Password Configure this setting in the E-mail Accounts dialog box by

Authentication selecting the check box.
Outgoing e-mail server Configure the required authentication in the E-mail Accounts
requires authentication dialog box under the More Settings option on the Outgoing

Server tab.
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Internet Explorer

As we discussed in Chapter 5, “Troubleshooting Network Protocols and Services,” Internet

Explorer has become the browser of choice for most people who use the Internet. Users can eas-
ily connect to resources across the street or across the world without even knowing the actual
location of the server that contains the information. In Chapter 5, we focused on the Connec-
tions, General, and Security tabs as they related to using Internet Explorer as a connectivity tool.
In this chapter, we will focus on the Programs, Content, Privacy, and Advanced tabs and discuss
the settings that we can apply to Internet Explorer to enhance its performance as an application.

Programs

You can configure the default program that Internet Explorer will use for each of six Internet-
related tasks, such as writing an e-mail message or editing an HTML document. Figure 6.1
shows the Programs tab of the Internet Options dialog box. You can click the drop-down
arrows to the right of each of the six tasks to choose the application that the computer will use.
The list of available programs that displays in the drop-down will depend on which specific
applications are installed on the computer. If Internet Explorer does not find an applicable pro-
gram, then the list will be blank. If you want the computer to recognize an older application that
it cannot locate, then you can manually edit the Registry.

FIGURE 6.1 The Programs tab of Internet Options

..lnternet Options @E

| General | Securily | Privacy | Content| Connections | Programs |Advanced |

Internet programs

g\ You can specify which program Windows automatically uses for
= each Intemet service.

HTML editor.  Microsoft ErontPage ::\j
E-mail. Microsoft Office Outlook [v]
Mewsgroups:
Intemet call NetMesting :Ll
Calendar: Microsoft Office Outioak !Ll
Contactlist Microsoft Office Outlook ;Ll

ResetWeb Sefings.. é You can reset Intemet Explorer to the default home
and search pages.

Internet Explorer should check to see whether itis the default browser

OK I [ Cancel
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For information about manually adding program choices to the
P Windows XP Registry, go to the Microsoft Library at the following

address: msdn.microsoft.com/Tibrary.

Content

The Internet is an extremely diverse environment that provides access to a wide variety of informa-
tion. Some information may not be suitable for all viewers, to put it mildly! You can use the Content
Advisor within the Content tab to help control the types of content that a user can access on the
Internet. The Content tab also contains tools to control the behavior of digital certificates on

the computer. Certificates can be used to protect a user as well as the computer itself. Finally, the
Content tab contains the Personal information section, which includes tools that will complete web
addresses for a user if he has typed the address before and other tools that allow a user to create a
profile that can be used to automatically supply information for a website. In this section, we will
discuss each of these concepts in greater detail.

Content Advisor

The purpose of the Content Advisor is to keep users from accessing websites that contain mate-
rial that could be considered offensive. Content Advisor works by a system of ratings that judge
content based on four areas: Language, Nudity, Sex, and Violence, as shown in Figure 6.2. You
must be logged in with an account that has Administrative rights to activate the Content Advi-
sor. You can enable the Content Advisor by setting a password that only you know. You will
then need this password to change the settings in the future. Any settings that you apply in the
Content Advisor will apply to all users of the computer.

When you first enable the Content Advisor, the settings that are least likely to allow a user to
access offensive content are in effect by default. You can then adjust these settings to meet your
own preferences. You can also use ratings bureaus to identify and block objectionable content.
Unfortunately, not all Internet content is rated and the content on the Internet changes on a daily
basis, so maintaining an effective ratings system is a full-time job. You can also set exceptions for
sites that can always be viewed or sites that can never be viewed, regardless of any rating.

Certificates

Digital certificates can be used to verify the identity of a person or the security of a website. Cer-
tificates are “electronic keys” that identify a user or a computer and are signed by a Certificate
Authority (CA). A Certificate Authority is generally a widely trusted third-party that is relied

upon to verify that the identity of an individual or a company. It’s not necessary that you be an
expert in regard to public key cryptography, but you should be able to recognize and locate the
various kinds of certificates to assist the network administrator in troubleshooting an Internet
Explorer issue regarding certificates.
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FIGURE 6.2 Content Advisor in Internet Options

..Conte'nt Advisor '

Ratings IA_pproven:! S_'rtes_ General _i_A(_ivanced

Select a category to view the rating levels:
ki) RSACi
| e-{anguagel

&= Nudity

&= Sex

&= Violence

Adjust the slider to specify what users are allowed to see:

—]._ —_— = 4 e

Level 0: Inoffensive slang
Description

Inoffensive slang; no profanity.

To view the Intarnet page for this rating service, click
Mare Info. =

[ ok ][ cenca |

There are four kinds of digital certificates that are used on the Internet:

Personal certificates Personal certificates identify individuals. They are used with e-mail and
other specialized applications, such as banking software, to prove the identity of the user. Once
personal certificates are installed, they work transparently for the user. On the Content tab,
choose Certificates and then choose the Personal tab to view the list of personal certificates
installed on a computer.

Server certificates Server certificates identify servers that participate in secure communica-
tions with other computers using communication protocols such as Secure Sockets Layer (SSL).
Servers use these certificates to prove their identity to their clients. Server certificates follow the
X.509 certificate format that is defined by the Public-Key Cryptography Standards (PKCS).

Software publisher certificates Software publisher certificates inform the user whether or not
the software publisher is participating in the infrastructure of trusted publishers and CAs. Using
only software from a certified publisher decreases the risk of downloading and installing soft-
ware that might damage your computer or your data. To view a list of the trusted software pub-
lishers, choose Publishers on the Content page.

Certificate Authority certificates Certificate Authority certificates are divided into two catego-
ries: Root CAs and Intermediate CAs. Root CAs are self-signed; in other words, a company is in
essence verifying itself. Root CAs can assign certificates to Intermediate CAs, which then issue per-
sonal, server, and publisher certificates or even certificates for other Intermediate CAs. This is
referred to as a certificate hierarchy. You can view all of the trusted Root CAs and Intermediate
CAs that are recognized by your computer by choosing Certificates from the Content tab.
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Personal Information

The Personal information section of the Content tab contains two main tools: AutoComplete and
Profile Assistant. Both of these tools can be used to increase the speed and ease of use of Internet
Explorer. In the section, we will discuss the configuration of each of these time-saving options.

AutoComplete

You can configure AutoComplete to remember what a user has done in the past and then make
suggestions as the user types. If the suggestions are correct, the user can simply press the Enter key
to accept the suggestion. You can specify whether you want AutoComplete to remember web
addresses, form information, user names and passwords on forms, or all of the above. Figure 6.3
shows the AutoComplete Settings dialog box within the Content tab.

Profile Assistant

The Profile Assistant stores a user’s personal information, such as her name, address, telephone
number, e-mail address, and so on. When the user accesses a website that requests this infor-
mation, the Profile Assistant can enter the information for the user. You or the user should
choose the My Profile button on the Content tab and then complete all of the information that
you want the Profile Assistant to automatically enter in future transactions. After the informa-
tion is entered, the Profile Assistant will automatically complete the matching required infor-
mation on website forms. This can be a great time-saver for the user.

P remove an item from the list of suggested items by clicking the item and then

g/ When typing information in web forms and when typing passwords, you can
pressing the Delete key.

FIGURE 6.3 The AutoComplete Settings dialog box

AutoComplete Settings

AutoComplete lists possible matches from entries you've
typed before.

Use AutoComplete for
[“]web addresses
[¥]Forms

User names and passwords on forms
O Prompt me to save passwords

Clear AutoComplete history

[ Clear Forms J [ Clear Passwords J

To clear Web address entries, on the General tab in
Internet Options, click Clear History.

OK |I Cancel ]




Internet Explorer 217

Privacy

When you access a website on the Internet, the website also accesses you! As you browse
the content on the website, it can download files, called cookies, into your computer and
read the cookies that are already there. This can work to your advantage, if it helps you to
browse the websites more quickly in future. It also helps the vendor on the website make
suggestions about what you might be interested in based on what you’ve done before.
Some people consider cookies to be harmless and maybe even a little helpful at times. Other
people consider cookies to be a blatant invasion of privacy!

How you feel about cookies will probably be determined by how your organization regulates
their use. You can adjust the settings that affect a computer’s use of cookies on the Privacy tab
of Internet Options, shown in Figure 6.4. You can adjust the slider control on a continuum
between Block All Cookies and Accept All Cookies. You can also override the default settings
on a per-site basis.

< For more information about the Privacy settings in Internet Explorer, see
P Microsoft Knowledge Base article 283185.

FIGURE 6.4 Privacy settings in Internet Explorer

Internet Options @ w

General | Security | Privacy | Content | Connections | Programs | Advanced|

Settings

o Move the slider to select a privacy setting for the Internetzone.
-~

Medium

- Blocks third-party cookies that do nothave a compact privacy

policy

- Blocks third-party cookies that use personally identifiable
L information without your implicit consent

- Restricts first-party cookies that use personally identifiable

information without implicit consent

Import... ] 1 Advanced...
Web Sites
To overide cookie handling for individual Web sites, click
the Edit button,

[ oc ][ cance ]
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Advanced

You can use the Advanced tab to customize many aspects of Internet Explorer. The settings on
the Advanced tab fall into eight categories, as follows:

= Accessibility: Settings for configuring accessibility options for users with physical disabilities
= Browsing: Settings for configuring how web pages are viewed

= HTTP 1.1: Settings that specify how the Hypertext Transfer Protocol (HTTP) is used by
the browser

= Microsoft VM: Settings for configuring Java operations on Internet Explorer (if Java
is installed)

= Multimedia: Settings for configuring support for sound, a joystick, and so on
= Printing: Settings that control background print operations
= Search: Settings that control the default search options

= Security: Settings for configuring the use of certificates, Secure Sockets Layer (SSL), and
other security options

) You can choose Restore Defaults on the Advanced tab to reset all settings to
TE their original installation state.

Outlook Express

Outlook Express is a simple messaging tool that comes bundled with the Windows operating
system. It does not come bundled with Microsoft Office software. Most organizations prefer
to use Outlook because of the additional functionality and security that it provides. Some
organizations may use Outlook Express to avoid purchasing additional messaging software.
In addition, users may use Outlook Express on their home computers to receive work-related
e-mail or newsgroups. For these reasons, you should know how to configure Outlook Express
for your users. In this section, we will discuss configuring and troubleshooting Outlook
Express for e-mail accounts and for newsgroups.

Configuring and Troubleshooting Outlook Express
for E-mail Accounts

You can configure POP3, IMAP, and HTTP accounts in Outlook Express using the same

tool. Since users also have access to this tool, they might ask you to help them fix a config-
uration that they have attempted. You should be able to recognize the most common con-
figuration errors and provide the appropriate solutions. In this section, we will discuss both
of these concepts in detail.



Outlook Express 219

Configuring Outlook Express E-mail Accounts

Accounts in Outlook Express can be POP3, HTTP, or IMAP-based. You can use the same tool
to create all three types of accounts. Exercise 6.17 walks you through the steps to create a POP3
account. The other types of accounts are very similar to create, and the wizard guides you
through the steps.

EXERCISE 6.17

Creating a POP3 Account in Outlook Express

1. On Microsoft Outlook Express, choose Tools and then choose Accounts.
In the Internet Accounts dialog box, select Add.

Choose Mail to open the Internet Connection Wizard.

2

3

4. Enter the User Name and then click Next.

5. Enter the E-mail Address of the user and then click Next.
6

Select POP3 from the drop-down list.

Internet Connection Wizard @

E-mail Server Names

My incoming mail serverisa  |POP3 v ! SErver.

Incaming mail (POP3. IMAP or HTTP) server

mail.charernat

An SMTP server is the server thatis used for your outgoing e-mail
Outgoing mail (SMTP) server

smip.charter.nef

[ < Back " Mext > | | Cancel |

7. Inthe Incoming Mail Server field, enter the POP3 address assigned by the ISP.

8. In the Outgoing Mail Server field, enter the SMTP address assigned by the ISP, and
then click Next.

9. Enter the user’s password for the account, and then click Next.

10. Click Finish.
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Troubleshooting Outlook Express E-mail Accounts

Troubleshooting Outlook Express can be a challenge because there are so many configuration
options to consider. You should remember that the key to troubleshooting is isolating the prob-
lem. In Outlook Express, there are really only two problems that a user can have: Either he can-
not send e-mail or he cannot receive e-mail.

If a user can receive e-mail but cannot send e-mail, the problem is most likely based in the
SMTP settings for his accounts. By the same token, if he can send e-mail but cannot receive
e-mail, then the problem is most likely based in the POP3, IMAP, or HTTP settings of his
accounts. If he can do none of the above, then he may not be online or may have a general con-
nectivity problem. If you examine all of the settings and cannot pinpoint the problem, then you
may want to create a new account for the user.

Configuring and Troubleshooting Outlook Express
for Newsgroups

A newsgroup is a forum on the Internet that is used for threaded discussions on a specified topic
or range of topics. You can find newsgroups on everything from business ethics to fly fishing.
A newsgroup consists of articles and follow-up postings. Each newsgroup has a name that con-
sists of a series of words separated by periods. The words become more specific as you read
from left to right, such as rec.fishing.flyfishing. You can configure Outlook Express to locate
newsgroups as long as your ISP offers links to one or more news servers called network news
transfer protocol (NNTP) servers. Users can subscribe to their favorite newsgroups to make
them easier to access. Some newsgroups are public while others are private, requiring an
account name and password to connect.

In this section, we will discuss how to make Outlook Express the default newsgroup reader.
We will also discuss how to create a newsgroup account and how to subscribe to a newsgroup.
Finally, we will discuss how to troubleshoot common problems associated with newsgroups.

Creating and Subscribing to a Newsgroup Account

In order for a user to be able to read newsgroups messages, a newsgroup account must be properly
configured for the user. To create the newsgroup account, you will need to know the following:

= The name of the NNTP server to which you want to connect
*  Your account name and password if one is required

Exercise 6.18 walks you through the steps to create a newsgroup account.

EXERCISE 6.18

Creating a Newsgroup Account

1. In Microsoft Outlook Express, choose Tools and then choose Accounts.

2. Inthe Internet Accounts dialog box, click Add, and then select News to open the Internet
Connection Wizard.
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EXERCISE 6.18 (continued)

3. Provide a Display Name for the new account (any name will suffice).
4. Provide your e-mail address, and then click Next.

5. Type the name of the NNTP server. If this is a private newsgroup, then select My News
Server Requires Me To Log On, click Next, and enter your credentials.

Internet Connection Wizard

Internet News Server Name

Type the name of the Internet news (NNTP) server your Internet service provider has given
you

News (NNTP) server

nntp.something.com

Ifyour Internet service provider has informed you that you mustlog on to your news (NNTP)
server and has provided you with an NNTP accountname and password. then selectthe
check box below.

[ My news server requires me to log on

< Back H Mext = l [ Cancel

6. Click Finish.

Making Outlook Express the Default Newsgroup Reader

After you have created a newsgroup account, then you can configure Outlook Express to be the
default newsgroup reader for a user. This simplifies using newsgroups for the user by opening
Outlook Express any time they choose a newsgroup link on a web page or a newsreader com-
mand on a browser. Exercise 6.19 walks you through the steps to configure Outlook Express
as the default newsgroup reader.

Configuring Outlook Express as the Default Newsgroup Reader

1. In Microsoft Outlook Express, choose Tools and then choose Options.
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EXERCISE 6.19 (continued)

2. Onthe General tab, in the Default Messaging Programs area, next to This Application Is
NOT The Default News Handler, click Make Default.

2 Options
General | Read Receipts Send Compose || Signatures

Security Connection Maintenance

General

L Z‘ When starting, go directly to my 'Inbox’ folder
[¥] Notify me ifthere are any new newsgroups
-Z|Aulomancally display folders with unread messages
J Automatically log on to Windows Messenger

Send /Receive Messages
[¥]Play sound when new messages arive
3 Send and receive messages al stanup

[]Check for new messages every minute(s)

If my computer is not connected at this time:

Default Messaging Programs

;_A o This application is NOT the default Mail handler Make Default
=N

This application is the default News handler

OK ] [ Cancel I

3. Click OK.

Troubleshooting Newsgroups

Troubleshooting newsgroups is similar to troubleshooting e-mail accounts; it’s all based on isolating
the issue that is causing the problem. If the user cannot connect to any NNTP servers but can connect
to the ISP, then you should review the settings on the newsgroup account. If the user can connect to
some NNTP servers but not others, then the problem may be at the news server or may be one
involving authentication. In this case, you should review the credential settings for any accounts that
require authentication. You can also adjust the search time-out in the Advanced settings for the con-
nection to give the news server more time to respond to the request for a connection.

Application Support

If you are old enough to remember when DOS first hit the market, then you will recall that we
only had the DOS prompt with which to work. There were no windows to open and no mouse
to click. Only one user could be logged on to a computer at a time, and only one application
could be running at a time. Software has come a long way over the last 20 years!
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As application software and operating system software evolved over time, Microsoft decided
to make much of each new operating system backward compatible to the old applications. This
meant that you could continue to use the software to which you had become accustomed, even
if you upgraded to the latest operating system. This backward compatibility came in many dif-
ferent forms over the last 20 years, depending on the operating system and the type of applica-
tions that were to be supported. While backward compatibility is a convenience for the user, it
can be a troubleshooting issue for a desktop support technician. Another troubleshooting chal-
lenge occurs when more than one person uses the same computer. In this section, we will discuss
each of these concepts in greater detail.

Backward Compatibility

Backward compatibility in regard to operating systems is the capability of an operating system
to create an environment that supports an older application. In other words, it’s the capability
of a computer to simulate the environment that the older application is expecting. For example,
programs designed for DOS can be run in the newer operating systems using a special applica-
tion environment called a Windows NT Virtual DOS Machine (NTVDM). Also, programs that
were designed for 16-bit operating systems such as Windows 3.1 and the original Windows 95
can be run in a 32-bit environment using a program called Win16 on Win32 (WOW), which
operates in the context of an NTVDM. Windows XP takes backward compatibility to a new
level, with tools such as Application Compatibility Mode, which can simulate the correct envi-
ronment for an application, and the Program Compatibility Wizard, which can help trouble-
shoot application compatibility issues. In this section, we will discuss each of these concepts in
greater depth.

NTVDM

Many 16-bit applications that were developed during the late 1980s and early 1990s are still in
use today. While these applications don’t have the intense graphics or extreme power of 32-bit
applications, some of them are still perfect for their intended use and have no successor. Since
businesses continue to use these applications, you should know how to install them on a com-
puter that runs one of the newer operating systems, such as Windows XP.

In order for a 16-bit application to run on a 32-bit operating system, the 32-bit operating system
must simulate a 16-bit operating system like the one for which the application was designed. You
can use a computer running Windows XP to simulate one or many “mini operating systems” for
16-bit applications. These mini operating systems are referred to as NTVDMs. These special oper-
ating system environments enable you to run DOS applications as well as 16-bit Windows applica-
tions in a Win32 environment such as Windows XP.

When you launch a DOS-based application in Windows XP, the operating system automatically
creates an NTVDM. Each additional DOS-based application that you launch will be assigned its
own NTVDM. This is because DOS can run only one application at a time. When you launch
16-bit applications, all 16-bit applications will be launched into the same NTVDM by default. This
simulates a Windows 3.1 environment. You can also decide to launch each 16-bit application in its
own NTVDM. You can customize the NTVDMs for 16-bit applications by changing the settings in
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their program information file (PIF). PIFs are used by the operating system to start the 16-bit appli-
cation. They specify the simulated environment that will be created. To change the PIF on an
installed 16-bit application, you should right-click the application and then choose Properties. Each
application will vary in regard to what can be configured, but you can generally configure the
amount of memory that the application will use and whether the application will run in a window
or in full-screen mode.

sl You should be aware that if one 16-bit application crashes inside an NTVDM, it
ING could cause all the other applications inside the same NTVDM to crash as well.

WOw

Win16 on Win32 (WOW) is a program that runs inside an NTVDM, enabling applications that
were written for 16-bit Windows to run in a 32-bit Windows environment. WOW translates the
16-bit calls from applications into 32-bit calls. This process is referred to as “thunking.” You
can determine whether 16-bit applications are currently running on a computer by examining
the Processes tab in Task Manager for an executable named ntvdm. exe, as shown in Figure 6.5.
You will also see the wowexec . exe and the executable name of each 16-bit program that is run-
ning in the WOW virtual machine.

FIGURE 6.5 Task Manager with 16-bit applications running

- | L
| Applications | Processes | performance | Metworking | Users |
: —
Image Name User Name C...| Mem U.., i
| Fullshotog.exa  Bill Ferguson 02 1,032 K
svchost.exe SYSTEM 0z 21,424 K
wowexec.exe  Bill Ferguson 00
spindl6.exe Bill Ferguson 00
ntvdm.exe Bill Ferguson 0o 5,216 K
| swchost.exe SYSTEM 0o 5312 K
| SAVSCAN.EXE SYSTEM oo 180 K
| lsass.exe SYSTEM 0o 1,616 K
| services.exe SYSTEM oo 3,996 K
| winlogon.exe SYSTEM oo 660 K
| csrss.exe SYSTEM oo 3,720 K
| smss.exe SYSTEM oo 472 K
pull.exe Bill Ferguson 00 4,592 K =
| acrotray.exe Bill Ferguson 00 2,456 K
| ctfmon.exe Bill Ferguson 00 2,960 K
| msnmsgr.exe Bill Ferguson 0o 5,196 K
| CCAPP.EXE Bill Ferguson oo 12,120 K
| gttask.exe Bill Ferguson 00 6,016 K
| System SYSTEM ] 216 K (o
I P ey i e |
Dshow processes from all users
Processes: 34  CPU Usage: 2% Commit Charge: 186M
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Application Compatibility Mode

Application Compatibility Mode is a special environment within the Windows XP operating
system that closely simulates the behavior of the Windows NT and Windows 9x operating sys-
tems. Application Compatibility Mode resolves most of the issues that have prevented older
programs from working correctly on the Windows 2000 Professional client. You can configure
a program to run as if it were running in the previous operating system. You can even choose
the resolution and color depth that the application will use. Exercise 6.20 walks you through the
steps to configure programs to run in Application Compatibility Mode.

Configuring Programs in Application Compatibility Mode

1. In Windows XP, right-click the shortcut of the program that you want to configure, and
then choose Properties.

2. On the Compatibility tab, check Run This Program In Compatibility Mode For, and then
select the operating system in which you want to run the program.

Note Pad Properties 283

| General | Shorteut| Compatibility | Security |

If you have problems with this program and itworked comectly on an
earlier version of Windows, select the compatibility mode that matches
that earliar version

Compatibility mode

Run this program in compatibility mode for:

| Windows 95 v
Windows 95
Windows 98 [ Windows Me
D|Windows NT 4.0 (Service Pack 5)
Windows 2000
Run in 256 colors

[] Run in 640 x 480 screen resolution

[[] Disable visual themes

Input settings

[ Tum off advanced text services for this program

Leam more about program compalibility

| OK l | Cancel | | Apply |

3. Inthe Display Settings area, select the display mode that the application requires, and
click Apply.

4. Click OK to close the dialog and save the settings.
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Program Compatibility Wizard

Windows XP includes a program called the Program Compatibility Wizard, which allows you to
test an application in different modes or with different settings. You can set the application and
the computer to run as if they were running on a previous version of the operating system. The
main difference between the Program Compatibility Wizard and Application Compatibility Mode
is that the Program Compatibility Wizard actually changes the settings and drivers in the com-
puter to accommodate the application, so you should use caution when testing applications with
the Program Compatibility Wizard. The Program Compatibility Wizard, shown in Figure 6.6, is
located by default in the Accessories menu of Windows XP.

) The Compeatibility tab used for Application Compatibility Mode is available only
TE after programs are installed on the hard drive. In contrast, you can use the Pro-
gram Compatibility Wizard to test programs that are on a CD/DVD, but the set-

tings will not remain in effect when you close the program.

FIGURE 6.6 The Program Compatibility Wizard

) Help and Support Center u@ﬁ:g

PE > J\J U Index ' Favorites {*')Histur}: @mpport _,'] Options

Search [IINNIENEGEGE =) @ Help and Support Center

Set search options Windows XF Professional

Program Compatibility Wizard
Welcome to the Program Compatibility Wizard
T you are experiencing problems with a program that worked correctly on an earlier version of Windows, this wizard helps you

select and test compatibility settings that may fix those problems,

Caution: Tt is recommended that you do not use this wizard for older virus detection, backup, or system programs.

LE

To continue, dick Next.

Next> | [ Cancel
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Multiuser and Multi-boot Configuration

Network administrators can use Group Policy and IntelliMirror technology to create a mul-
tiuser computer with managed desktops. The computer settings of the multiuser computer
allow users to configure some parts of their own desktop but not others. You should be aware
of how managed desktops can affect your ability to configure a computer for a user and your
need to escalate the issue to network administrator.

A multiuser computer configuration works best when the computer is in a public environment,
such as a library, laboratory, or public computing center. Since the multiuser desktop experiences
high traffic, it is protected so as to be reliable for all users. It is also somewhat flexible so that users
can customize it to some degree. You should understand what you have permissions to change on
a computer that is a multiuser managed desktop and what you will have to escalate.

With the multiuser desktop configuration, users can do the following:

= Modify Internet Explorer settings
=  Run applications that are assigned or published through Group Policy
= Configure some Control Panel options that relate to appearance
With the multiuser desktop configuration, users can be prevented from doing the following;:
= Using the Run command in the Start menu or at a command prompt
*  Adding, removing, or modifying hardware devices

As we discussed in Chapter 1, you and users can install multiple operating systems on the same
computer. If you choose to perform a multi-boot installation, you should install each operating
system in its own separate partition. You should be aware that each operating system will have
its own registry, which records the installation of applications and manages their use. For this rea-
son, each operating system will require a separate installation of most application software.

You can share data files across operating systems, as long the operating system that is being
used to retrieve the files can use the file system that stored them. For example, Windows 98 can
only use the FAT and FAT32 file systems; therefore it cannot be used to retrieve files that have
been stored in NTFS volumes. For this reason, when you multi-boot computers and share data
files with multiple installations, you should format the partition that will store the files with a file
system that is compatible with all of the operating systems on the computer.

Summary

It’s not enough that you understand the Windows operating system; you must also understand the
most common applications that users are running on the operating system, such as Microsoft
Office, Outlook Express, and Internet Explorer. In addition, as a desktop support technician, you
must understand how the newer operating systems, such as Windows XP, can simulate the envi-
ronment that older applications were designed to work within, making it possible for organiza-
tions to continue to use older applications on the latest operating systems. Finally, you should
understand the additional issues and challenges that you may encounter when you have more than
one user or more than one operating system on the same computer.
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Microsoft Office has become the leading suite of business applications in the world today.
The newest release, Office 2003, comes in many editions, which include program bundles
designed for a specific environment, such as a business enterprise or an academic environment.
Programs include Word, Excel, PowerPoint, Outlook, and so on, each having its own specific
business use. You can purchase these programs over the retail counter or through special chan-
nels, depending on your type of business. You can install Office 2003 using the CD, through the
network, or by using an automated method such as SMS. Office 2003 includes new features that
protect your data, including the Application Recovery Tool and AutoRecover.

Outlook, one of the programs included in Microsoft Office, is an e-mail and scheduling program
that is designed to increase worker productivity. Outlook helps users manage e-mail messages,
notes, contacts, tasks, and other information. It can be configured for general Internet access or for
a specialized server that stores an organization’s messages, referred to as Exchange Server. Config-
uring a user for Outlook e-mail is a two-step process: First you create a profile for the user, and then
you configure the mailbox or mailboxes that user will utilize. Troubleshooting Outlook is usually a
process of examining the configuration settings that were attempted by a user.

Internet Explorer is the browser that most people use to access the Internet. It has many con-
figuration options to accommodate the user and make browsing the Internet as safe and pleas-
ant as possible. You can configure Internet Explorer to automatically call on other programs
installed on your computer from within the browser when they are required for specific tasks,
such as e-mail or HTML editing. In addition, you can adjust the settings in the Privacy tab to
control how the computer allows special personal information files called cookies to be used by
websites. You can fine-tune eight categories related to Internet Explorer on the Advanced tab
in Internet Options.

Outlook Express is a simple messaging tool that comes bundled with the Windows operating
system, but it does not come with Microsoft Office. Organizations may use Outlook Express to
avoid purchasing other e-mail software. Users may use Outlook Express at home for e-mail as well
as newsgroups. You can configure POP3, HTTP, and IMAP e-mail accounts and NNTP news-
group accounts using the same set of tools and the Internet Connection Wizard. Troubleshooting
these accounts is a process of isolating the problem and checking the appropriate configurations.

Windows XP can, of course, run all of the latest software, but it can also run most of the old
software that was designed for earlier operating systems, such as Windows 95, Windows 98,
and Windows NT Workstation. This backward compatibility is accomplished using NTVDMs,
WOW, and Application Compatibility Mode. An NTVDM is a virtual machine that is created
automatically when a 16-bit application is launched in Windows XP. With Application Com-
patibility Mode, you can run programs that were designed for older 32-bit operating systems in
Windows XP as if you were running them in the operating system for which they were designed.
The Program Compatibility Wizard lets you experiment with an application and the computer
settings both before you install the application and after, but you should use the program with
caution because it changes settings that might affect other programs.

Special challenges can result when you troubleshoot computers that are configured as mul-
tiuser by the network administrator. Users do not have the ability to change many of the con-
figuration settings of the computer, such as the hardware settings or network connection
settings. This may cause a need to escalate the issue to the network administrator, even when
you might know the solution to the problem.
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Client computers can also be configured with multiple operating systems. This is referred to
as a multi-boot configuration. Each operating system should be installed in its own partition.
Each operating system will have a separate registry, and will require its own installation of
applications. You can share data across operating systems, provided that the operating system
that is retrieving the data supports the file system in which the data is stored. You should know
how to assist users with these multi-boot application issues.

Exam Essentials

Know how to install and repair Microsoft Office 2003. You should know how to install,
configure, and troubleshoot Microsoft Office 2003. You should also know how to activate the
software over the Internet and over the telephone. In addition, you should know how to scan
for updates on the Office Update website. Finally, you should know how to add and remove
components and repair Office installations when needed.

Know how Microsoft Office 2003 AutoRecover works. You should know that AutoRecover
automatically saves versions of files so that you can use them in an emergency. In addition, you
should know that AutoRecover works best when the emergency is a power interruption on a
desktop or even a laptop. Finally, you should know that AutoRecover works automatically
when the application is restarted.

Understand when to use Shadow Copy. You should understand that Shadow Copy is a service
that the network administrator can run on a file server to protect data for users. In addition, you
should know that the Shadow Copy service stores versions of files sorted by time for an entire
volume of files. Finally, you should know that users can utilize this service only if they have the
software client installed on their computer.

Be able to configure Microsoft Outlook. You should know how to configure Outlook for
Internet e-mail and for Exchange e-mail. Specifically, you should know how to create an Out-
look profile and then configure mailboxes for POP3, IMAP, HTTP, and Exchange accounts.
You should also know how to troubleshoot common issues with mailbox configurations.

Be able to configure Internet Explorer. You should know how to configure the Programs,
Content, Privacy, and Advanced tabs of Internet Explorer. You should become familiar with all
of the options on each of these tabs and how they can affect the user. You should also know how
to troubleshoot errant configurations set by users.

Know how to configure Outlook Express. You should know how to configure Outlook
Express for e-mail accounts and newsgroups. Specifically, you should be able to configure POP3,
IMAP, HTTP, and NNTP accounts for Outlook Express. You should also know how to trouble-
shoot the most common issues regarding Outlook Express.

Know how to support older applications in Windows XP. You should know that Windows XP
can support many different types of applications, even those designed for much older operating
systems. Specifically, you should know how NTVDMs are used by the operating system to create
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a simulated environment for 16-bit applications. In addition, you should know how Windows
XP’s Application Compatibility Mode can run older 32-bit applications as if they were running
in the older operating system. Finally, you should know how to use the Program Compatibility
Wizard to test an application on a computer using various settings.

Be able to troubleshoot multiuser issues. You should know the specific troubleshooting issues
regarding application support on computers configured as managed multiuser computers. Specifi-
cally, you should know that since users cannot configure the hardware or the network connection
settings on these computers, you probably can’t configure them either. You should know that users
cannot use the Run command in the Start menu or on the taskbar. Finally, you should be aware that
these limitations may cause you to escalate the issue to the network administrator, even though you
might know the solution to the problem.

Be able to troubleshoot Multi-boot computers  You should know that computers that have
more than one operating system installed will need to have a separate instance of most applications
installed for each operating system. In addition, you should know that each operating system will
have a separate record of each application in its registry. You should also know that each operating
system should be installed on its own partition. Finally, you should know that these computers can
share data across the operating systems as long as the data is formatted in a file system that all of the
operating systems can use.
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Review Questions

1. You are the desktop support technician for your organization. You are performing a manual
installation of Microsoft Office 2003. You wish to install only the Microsoft Word program,
but you do not want to install all underlying optional components. Which of the following
should you do?

A. Choose Typical Install, and then select Word.

B. Choose Custom Install, and then choose Run All From My Computer for Word and Do
Not Install for all other components.

C. Choose Typical Install, and then choose Run From My Computer for Word and Not
Available for all other components.

D. Choose Custom Install, and then choose Run From My Computer for Word and Not
Available for all other components.

2. You are the desktop support technician for your company. You want to upgrade a user’s appli-
cations from Office 2000 to Office 2003. You insert the CD into the drive and close it, but the
program does not automatically run as expected. You want to start the program manually.
Which of the following should you do?

A. Access the Office folder on the CD and double-click the autorun file.
B. Access the root folder of the CD and double-click the setup.exe file.
C. Access the Office folder on the CD and double-click the setup.exe file.
D. Access the Office 2003 folder on the CD and double-click the setup.exe file.
3.  Youare the desktop support technician for a large organization. All users are directed to store their
important files on a centrally located file server, rather than on their own hard drives. The data is

backed up on a nightly basis. You want to recommend a method of further protecting the user data
on the file servers. Which of the following should you recommend?

A. AutoRecover
B. Application Recovery Tool
C. Shadow Copy
D. Microsoft Windows Installer
4. Youare the desktop support technician for a large company with many e-mail users. You receive
a call from a user who has attempted to set up a mailbox to his ISP, but he is receiving an error

indicating that the ISP requires a Secure Password Authentication. You do not have immediate
access to a computer. Which dialog box contains the setting that the user needs to change?

A. The Global Security Settings dialog box for Outlook

B. The Security settings for the mailbox

C. The E-mail Accounts dialog box for that specific account
D. The Global E-mail Accounts dialog box
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5. You are the desktop support technician for a large company with many users. A user asks you
if there is any way to automatically fill in the information on websites that ask for name, address,
telephone number, e-mail address, and so on. There are no security restrictions in your organi-
zation that prevent this action. Which of the following features should you show the user?

A. AutoComplete
B. AutoRecover
C. Public Key Cryptography
D. Profile Assistant

6. You are the desktop support technician for a large company. Many of your users work from
home, using Microsoft Outlook Express to send and receive e-mail. You receive a call from a
user who says that he thinks that one of his friends tampered with his e-mail settings and now

he can receive e-mail normally but nobody seems to be receiving his e-mail, and he keeps getting
errors. Which of the following settings should you direct the user to examine?

A. SMTP address
B. IMAP address
C. NNTP address
D. POP3 address
7. Youare the desktop support technician for your company. Users in the Research department make
extensive use of newsgroups to get the latest information and industry trends. A user calls you

complaining that she cannot connect to some newsgroup servers but she can connect to others.
Which options might allow the user to connect to all newsgroup servers. (Choose all that apply.)

A. Check the network connection settings on the computer.
B. Check the search time-out setting on the NNTP connection.

C. Check the authentication settings on the connections for the NNTP servers with which
she cannot connect.

D. Check the SMTP settings for all connections.

8. You are the desktop support technician for a large company with many users. All users have
desktop computers running Windows XP Professional. Some users still utilize 16-bit applica-
tions that were designed for DOS or the Windows 3.1 operating system. You want to determine
whether there are any applications currently running on user’s computer that were designed for
DOS or Windows 3.1. Which of the following should you do?

A. Open Task Manager and search the Applications tab for the presence of the
NTVDM application.

B. Open Task Manager and search the Performance tab for the presence of the ntvdm. exe file.

C. Open Task Manager and search the Performance tab for the presence of the ntvdm. exe
application.

D. Open Task Manager and search the Processes tab for the presence of the ntvdm.exe
executable file.
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You are the desktop support technician for a large company. All users have computers that run

Windows 2000 Professional. Some users need to utilize applications that were designed for Win-
dows 98. Some of these applications do not run well on Windows 2000. Your management team
is considering upgrading the client computers to Windows XP Professional. Which feature(s) can
you use for the Windows 98 applications after the upgrade is complete? (Choose all that apply.)

A. NTVDM

B. WOW

C. Application Compatibility Mode

D. Program Compatibility Wizard

You are the desktop support technician for a large company. You receive a call from a user who
says that his Windows XP computer is not connecting to the network. He says that it’s a com-
puter that he shares with other users, and they can’t connect either. You tell the user to click Start

and then choose Run. The user tells you that there is no Run line in his Start menu. Which of
the following could be causing this to happen?

A. The network administrator has applied Group Policies to the computer and is manag-
ing it as a multiuser managed desktop.

B. Windows XP is improperly installed.

o

The user has accidentally deleted the Run line from the Start menu.

D. Windows XP does not have a Run line in the Start menu.
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Answers to Review Questions

1.

D. You should choose Custom Install first to make the other options available. Then you should
choose Run From My Computer for Word to install the program without installing all of the other
underlying optional components. Finally, you should choose Not Available for all other Microsoft
Office components to prevent them from being installed.

B. You should access the root folder of the CD and then double-click the setup.exe file. The
setup.exe file is not contained in the Office folder or the Office 2003 folder. The autorun file
is not contained in the Office folder.

C. You should recommend that the network administrators use Shadow Copy on the file
servers. You should install the Shadow Copy client in each user’s computer and train the users
to use the Previous Versions tab. AutoRecover and the Application Recovery Tool are com-
ponents on the client, not on the file server. Microsoft Windows Installer is a service that
ensures that an application can start and run, but it does not protect data.

C. You should direct the user through the Tools menu to the E-mail Accounts dialog box for that
specific account. You should then tell him to place a check mark on the box labeled Log On
Using Secure Password Authentication (SPA). The Global Security settings for Outlook do not
contain the SPA setting.

D. You should show the user the Profile Assistant on the Content tab of Internet Options in
Internet Explorer. The Profile Assistant can automatically fill in personal information on web-
sites. AutoComplete makes suggestions as you type based on websites that you have visited
before. AutoRecover makes version copies of files and stores them on the local computer’s hard
drive in case of a power failure. Public Key Cryptography is used for security within a network
or through the Internet.

A. Since the user can receive e-mail but cannot send e-mail, you should direct the user to the Simple
Mail Transfer Protocol (SMTP) settings for his account. The IMAP and POP3 address could affect
receiving e-mail but not sending it. The NNTP address will affect only newsgroups, not e-mail.

B, C. You should direct the user to check the settings for authentication and search time-out for
the NNTP servers’ connections that will not connect. It is not necessary to check the network con-
nections for the computer since some of the NNTP servers are connecting. The SMTP settings
would affect a user’s ability to send e-mail, not to connect to NNTP servers.

D. You should open Task Manager and search the Processes tab for the presence of the
ntvdm.exe executable file. The presence of this file in Processes indicates that at least one
16-bit application is currently running on the computer.

C, D. After the upgrade to Windows XP Professional is complete, you can use Application Com-
patibility Mode and the Program Compatibility Wizard to test and run the applications in an
environment that closely simulates the Windows 98 operating system environment. NT virtual
DOS machines (NTVDM) are used to run 16-bit applications on a 32-bit operating system.
Win16 on Win32 (WOW) is used to convert 16-bit Windows calls to 32-bit Windows calls and
vice versa.
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10. A. Windows XP does normally have a Run line on the Start menu. The reason that the Run line
does not appear for the users is that the network administrator has configured the computer as
a managed multiuser desktop. You will have to escalate the issue to the network administrator.
The users do not have the permissions to use the Run line or to change the hardware and/or con-
nection settings on the computer. An improper installation will not cause the Run line to be inac-
cessible. The user cannot accidentally delete the Run line from the Start menu.
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Unfortunately, in the real world, applications don’t always function
without any problems. Well, maybe I should say “fortunately,” since
that’s part of what keeps you and me in business. At any rate, you
should know how to configure the most commonly used software components to ensure continued
usability for clients. You should also know how to interpret the error messages that you might
encounter with each of these software components. In this chapter we will discuss configuring and
troubleshooting these software components to resolve issues related to usability.

The four components that are most commonly used on Microsoft networks are as follows:

Microsoft Office  You can reduce the risk of having problems related to Microsoft Office by
installing only the components that a user requires. We will discuss how to customize an instal-
lation for a user’s needs. Unfortunately, no matter how well you configure the installation, you
may still have problems. These problems will often tell you about themselves with an error mes-
sage. We will discuss the tools that you can use to interpret error messages and troubleshoot
problems associated with Microsoft Office.

Internet Explorer There are many settings in Internet Explorer that can affect a user’s experi-
ence. We will discuss how to configure the settings to make Internet Explorer more user-friendly.
In addition, we will discuss how to use the Help menu built into Internet Explorer. Finally, we will
discuss how to interpret error messages and troubleshoot the issues.

Outlook Express  Efficient use of Microsoft Outlook Express requires more than just the ability to
set up a mailbox. There are many features that can enhance the usability of the software for each user
or even for multiple users on the same computer. We will discuss the additional tools located within
the File, Edit, View, Tools, and Message menus of Outlook Express. In addition, we will discuss
using the Help menu and other tools to interpret and troubleshoot the error messages.

Operating system features You can enhance the usability of the computer and the applica-
tions that it contains by understanding the configuration of the operating system itself. There
are many features and options you can use to configure the computer for each user. We will
focus on the Desktop of the latest operating system, Windows XP Professional, and discuss
some of the options that you can configure to enhance the usability of the computer, including
Start Menu properties, Taskbar properties, and shortcuts. In addition, we will discuss interpret-
ing and troubleshooting error messages related to the operating system.

Microsoft Office

Microsoft Office is one of the most commonly used components on the network, partly because of
all of the components that it contains. Users can utilize software for word processing, spreadsheets,
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presentations, and more. In fact, there are so many tools contained in the Typical installation of
Microsoft Office that it is unlikely that most users will need to use all of them. You can make your
job a little easier by installing only the components that a user needs, so there is less chance for pro-
grams to interfere with one another. Of course, no matter how well you install the software, there
will be some problems. As a desktop support technician, you should know how to interpret error
messages associated with Microsoft Office. In this section, we will discuss each of these concepts in
greater detail.

Microsoft Office Customization

The best way to troubleshoot a problem is to do all that you can to keep it from occurring in
the first place. The more software that a user has on his computer, the greater chance there is
for a problem to develop. As a desktop support technician, you should ensure that users have
the software required to perform their jobs. You should also ensure that they do not have soft-
ware that is not required, especially if that software might cause problems. You can accomplish
this goal in relation to Microsoft Office by customizing the installation whenever possible. You
should ask the user about his roles and make a decision about the software that he will need
based on what he does. You should not ask the user what software he wants installed, because
most users won’t know and some users will just tell you to install “everything that you’ve got.”

In Chapter 6, “Configuring and Troubleshooting Applications,” we illustrated how to per-
form a Typical installation of Office 2003. While this type of installation generally provides the
tools that the user requires, it also might install applications that he will never use. For example,
a user might never need to use Excel because his job does not require the use of spreadsheets.
These unnecessary tools not only take up space on the hard drive, they also create a potential
source for future problems. To give the user only what he requires, you should know how to
customize an installation of Office 2003. Exercise 7.1 walks you through the steps to perform
a customized installation of Office 2003.

Interpreting Microsoft Office Error Messages

As someone once said, “I’ve got some good news and some bad news; which do you want first?”
The bad news? Well, the bad news is that no matter how well you install and maintain a user’s
computer, problems will still occur within and between applications. Now, the good news is
that the problems will often tell you about themselves if you know how to listen to and interpret
what they are telling you.

There are two general categories of problems that you can encounter in regard to Microsoft
Office: those caused at installation and those that occurred after installation. Depending on
when the problem occurred, you can use specific tools to find out more information about it.
While the details of each potential problem with each application in Microsoft Office cannot be
listed in this chapter, or even in this book for that matter, the tools that you can use to find out
more information are the same for many problems. In this section, we will discuss the tools that
you can use to interpret error messages in Office 2003.

The two main tools that you can use to troubleshoot Microsoft Office problems are the log
files and the Microsoft Knowledge Base. Let’s look at each in detail.
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Performing a Customized Installation of Office 2003

1. Insertthe Office CD in the CD-ROM drive to launch the Office Setup program. If Setup does
not run automatically, then you can manually run the Setup.exe program located in the
root folder of the CD.

@ Microsoft Office 2003 Setup g

Microsoft Office Professional Edition 2003

Product Key

In the boxes below, type your 25-character Product Key. You will find this number on
the sticker on the back of the CD case or on your Certificate of Authenticity.

Product Key:  [you S L S L L [-[recel |

rr— | ——

2. Enterthe product key displayed on the label of the Office CD container in the Product Key
dialog box, and then click Next.

3 Microsoft Office 2003 Setup =JOEd
Microsoft Office Professional Edition 2003 n n |

User Information

User name: |‘[:l_|ﬁ?erguson
Initials:
Organization: |Bi|l Ferguson Enterprises

Microsoft cares about your privacy. For information about how Microsoft helps protect the
privacy and security of your data, please click the Help button.

pr— p—

3. Enter your User Name, Initials, and Organization information, and then click Next.
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Microsoft Office

4. Accept the terms in the License Agreement, and then click Next.

5.

@ Microsoft Office 2003 Setup M= X]

Microsoft Office Professional Edition 2003

End-User License Agreement

To continue with Office installation, you must accept the terms of the End-User License
Agreement. To accept the agreement, click the check box below.

[END-USER LICENSE AGREEMENT FOR MICROSOFT SOFTWARE ~
IMPORTANT—READ CAREFULLY: This End-User License Agreement ("EULA™) Is a legal il
agreement between you (gither an individual or a single entity) and Microsoft
(Corporation for the Microzoft software that accompanies this EULA, which includes
zssociated media and Microsoft Internet-based services ("Software™). An amendment
or addendum to this EULA may accompany the Software. YOU AGREE TO BE BOUND BY
THE TERMS OF THIS EULA BY TNSTALLIMG, COPYING, OR USING THE SOFTWARE. TF
YOU DO NOT AGREE, DD MOT INSTALL, COFY, OR USE THE SOFTWARE; YOU MAY
RETURN IT TO YOUR FLACE OF PURCHASE FOR A FULL REFUND, IF AFPLICABLE.
GRANT OF LICENSE. Microsoft grants you the following rights provided that
you comply with all terms and conditlons of this EULA:
% | Installation and use. You may:

(a) install and use a copy of the Software on one personal computer or other
device; and

(b) install an additonal copy of the Software on a second, portable device for
the exclusive use of the primary user of the first copy of the Software.
1.2 Alternative Rights for Storage/Network Use. As an alternative to Section 1.1

I accept the terms in the License Agreement

e e ] (o ]

Select Custom Install for the installation type, and then click Next.

& Microsoft Office 2003 Setup

Microsoft Office Professional Edition 2003

Type of Installation

Recommended Install Description
() Typical Install c your Office installati
choosing which features to install on your
or choose another type computer. Recommended for advanced
users.
(O complete Install

() Minimal Tnstall
() custom Install

Hote: InfoPath requires Microsoft Internet
Explorer 6.0 or |ater. For more information,
dick the Help butzon,

Install to: |C:‘.Pragrnrr. Files\Microsoft Office’, Browse.
(|
T | e
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EXERCISE 7.1 (continued)

6. Choose the specific applications for the user based on his use of the computer, select
Choose Advanced Customization Of Applications, and then click Next.

& Microsoft Office 2003 Setup

Microsoft Office Professional Edition 2003

Custom Setup

Select the Microsoft Office 2003 applications you would ke to install:

Word [ Publisher
[+] Excal [Access
B [~]Powerpaint [[infoPath
E |:| Outlook

InfoFath requires Microsoft Internet Explarer version 6.0 or later.

E| Choose advanced customization of applicabons.

Space Required on C:163 MB
Space Available on C:1058 MB

I < Back I Next > | [ Cancel ‘

7. Examine the list of applications that will be installed, and ensure that only the appropriate
applications are selected.

& Microsoft Office 2003 Setup

Microsoft Office Professional Edition 2003

Advanced Customization

Choose installation options for applications and tools.

= 3] Microsoft Office
& _X -] Microsoft Office Access
X% ~| Microsoft Office Outiook
- [=dw] Microsoft Office FowerPoint
& _X_| Microsoft Office Publisher
® - =4] Microsaft Office Word
@ _% =] Microsaft Office InfoPath
(¥ =h=] Office Shared Features
- =] Office Tools

Description
Micro=oft Office Excel will be Installed with the
selected options,

Space Required on C:163 MB
Space Available on C:1068 MB

P —
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EXERCISE 7.1 (continued)

8. Click on each selected application to fine-tune its installation, and then click Next. (Refer to

Chapter 6 for the advanced installation options.)

& Microsoft Office 2003 Setup

Microsoft Office Professional Edition 2003

Advanced Customization

Choose installation options for applications and tools.

= ==| Microsoft Office
[ | soft Off

[l Wicrosoft Ofice Bxcal |

* = Run from My Computer
; =8 Run all from My Computer
3

= Installed on First Use

¥ % Not Available
i |

Description
Microsoft Office Excel will be installed with the
selected opbions.

Space Required on C:163 MB
Space Avallable on C:1068 MB

T

) o=

9. Reviewthe Summary page to ensure that only the applications that you selected are listed
and that the advanced options that you selected are listed. Click Back to make any changes
or Install to begin the installation. (You can also click Cancel to cancel the entire installation

at this point.)

&' Microsoft Office 2003 Setup

-

Microsoft Office Professional Edition 2003

Summary

Setup is ready to begin installing and will perform the following tasks:

- Install the following Microsoft Office 2003 applications

= Word (Run from My Computer)
= Excel (Run from My Computer)
=3 PowerPoint (Run from My Computer)
3 Outlook (Nat Available)
X Publisher (Not Availabla}
¥ Access (Mot Available)
x InfoFath (Mot Available)

Space Required on C:163 MB
Space Available on C:1068 M8

]

< Back | [ Install

| —




244 Chapter 7 - Resolving Usability Issues

EXERCISE 7.1 (continued)

10. The system will begin the installation process and continue through each of the steps until

the software is completely installed on the computer. When the installation is finished, the
Setup Completed box will appear.

& Microsoft Office 2003 Setup

Microsoft Office Professional Edition 2003

Now Installing Office

Installation Frogress:

Current Action:
Copying new files

Copying file: NFOFFICE.DLL

Cancel

11. Select the Check The Web For Updates And Additional Downloads option to get the latest
updates for the software that you have installed. This will automatically connect the com-
puter to the Windows Update website provided that a connection to the Internet is estab-
lished. You will also need to activate the software over the Web or by telephone. (Refer to
Chapter 6 for details on activating software.) Click Finish to complete the installation.

@ Microsoft Office 2003 Setup g |

Microsoft Office Professional Edition 2003

Setup Completed

Microsoft Office 2003 Setup has completed successfully,

There may be additional components or security updates available online. Check the box
below to visit the Office site in your browser after Setup is finished.

Check the Web for updates and additional downloads
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Log Files

During installation, Office 2003 automatically creates log files in your /temp folder. These
files contain information about the specific tasks that were accomplished during installation
and any errors that occurred during that task. Typically an error will also be reported to you
in an error message during installation, but not always. Sometimes the error that occurred
prevents the error message from being created. Therefore, you should know how to locate
and examine the log files created during installation. Table 7.1 lists the log files that are
created. You should examine these log files only for errors that pertain to the issue that you
are experiencing.

sl Many log files contain errors that can be ignored because the issue corrected
ING itself later in the setup. You should examine the log file only for entries that per-
tain to the issue that concerns you at this time.

TABLE 7.1 Office 2003 Log Files Created at Setup

Log File For: Log Filename:

Setup.exe Microsoft Office 2003 Setup(####).txt
Windows Installer (System Files Update)  Microsoft Office 2003 Setup(####)_Task(0001).txt

Windows Installer (Office Installation) Microsoft Office 2003 Setup(####)_Task(0002).txt

The #### characters in the log filenames are numbers that start with 0001. They increment by one each time that
you run Setup. Therefore, the log file that has the highest number is the log file for the most recent time that you
ran Setup.

The Microsoft Knowledge Base

As you may have realized by now, chances are very good that you will receive error messages
or read errors in a log file that you do not understand. This is quite normal. There is no way
that anyone can know everything there is to know about troubleshooting all Office applica-
tions and their relation to the operating system. To make matters worse, some error messages
ask you for permission to proceed or not! For this reason, Microsoft has developed the
Knowledge Base.

Actually, Microsoft Office is just a small portion of the Microsoft Knowledge Base. You can
use the Microsoft Knowledge Base to interpret error messages and gain more information about
Microsoft operating systems and applications. It has been developed over time by other admin-
istrators and network technicians who have experienced the same issues and found solutions.
You can access the Microsoft Knowledge Base through the Microsoft Help and Support page,
as illustrated in Figure 7.1.
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FIGURE 7.1 The Microsoft Help and Support page
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Exercise 7.2 walks you through the steps to troubleshoot an error message using the
Microsoft Knowledge Base. In this case, the error message reads as follows:

“You have not entered a valid product key. Please check the number located on the sticker
on the back of your CD case or on your Certificate of Authenticity.”

You can also use the Microsoft Knowledge Base to find a specific article when
P you are referred to it from another publication and therefore you already know
the number of the article, such as a reference to KB 836178.

EXERCISE 7.2

Using the Microsoft Knowledge Base

1. On the browser, type support.microsoft.comto access Microsoft's Help and Support
website, which contains the Microsoft Knowledge Base.
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EXERCISE 7.2 (continued)

2. Choose Search The Knowledge Base to access the Microsoft Knowledge Base home page.
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File Edit View Favorites Tools Help
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3. Click the drop-down arrow next to Select A Microsoft Product, and choose Office 2003
from the drop-down list.
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Chapter 7 - Resolving Usability Issues

EXERCISE 7.2 (continued)

5.

Enter as much information as possible about the error message or text in the log file. You
can even copy and paste parts of a message or the entire error message. You can also
select to use all of the words, any of the words, or only an exact phrase on the drop-down

list next to Using. The trick here is to type the key information to narrow the search as
much as possible.

|E:1 Search the Knowledge Base - Microsoft Internet Explorer

Fie Edit View Favorites Took Help

O Back -

ERER

- search

Favorites & Media

= .-".#.:

Address

(] http://support.microsoft.com/default.aspx ?scid =fh;EN-US;KBHOWTO

Search the Knowledge Base

Advanced Search and Help

.S:arch the Knowledge Base

Select a Microsoft Product
Search for...

Using

Results Limit

Search Type

Date Range
Scope for your Search

[ otfice 2003

invalid product key

United States

=

| &1 of the words entered

The exact phraze enlered
Boolean (text contans ANDJ/OR)

Allpfthe words entered
Any of the words enfered

(O Tithe Oy
O Artide D

| anytime

| %

‘f& [“linclude Community Solutions Content More details ..

HMost Popular Knowle:

Base Articles

@ + Identi Hi
Brotect Yourself from
Deceptive (Spoofed) ¥
Stes

Most Popular Suppori

Centers

* Exchange

* Windows 2000
¢ Office

# Qutlock Express
* Windows 98

# Windows Me

* Windows Media Plnv:rl'_'_-
>

& Internet

If you wish to narrow your search even further, you can select the Search Type, Date
Range, and Scope for your search.

6. When you have finished entering information and making selections, click Go.
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EXERCISE 7.2 (continued)

7. Examine the selections that the search engine finds to determine whether any of them con-
tain the error that you are experiencing.

|E:] Search the Knowledge Base - Microsoft Internet Explorer - ﬂ Eﬂ
Fle Edt View Favorites Took Help i
QBack ~ © - @ @ @ | P Search “rFavorites @ Meda € v BLUE 3

Address €] http://support. microsoft.com/search/default.aspx ZINCC_hdn=trueaCatalog=LCID%301033%26 v | E 6o @)

United States

Support and Troubleshooting

Product Name :  Office 2003

Search for... [invalid product key Advanced Search and Hel

(& support and Troubleshaoting O a1 of Microsoft.com

Search results: 25 articles

Need More
Help?
"Invald product key" error message when you start an Office 2003 program after you instal {‘? Contact a Support
» Difice Professional Edition 2003 ) Q Professional by E-
(836178) - Describes a problem where you receive an "Invalid product key" error message @‘pw
when you try to start an Office 2003 program after you install Office Professional Edition =

2003.

» How to Obtain a New Product Key for Office Program Setup m

(823570 - This article describes how to obtain a new product key for your Microsoft Office Prutect PC
program setup if your product key labelis damaged or & missing. act your

3 steps to help ensure
» How to Obtain a Volume License Key for Enterprise Editions of Office 2003 your PC is protected.

e Security Support Center |
<] i &)

& Internet

8. If you find an article that matches your issue, then read the article and follow its instruc-
tions. If you do not find an article that matches your issue, then you may want to widen or
narrow your search so as to use the search engine in a different manner.

Internet Explorer

There is more to Internet Explorer than meets the eye, and more than just the Internet Options
in the Tools menu. As a desktop support technician, you should be familiar with all of the tools
that can enhance the usability of Internet Explorer. You should also know how to use the Help
menu and the Microsoft Knowledge Base and Support Center to interpret error messages
related to Internet Explorer. In this section we will discuss each of these concepts in detail.



250 Chapter 7 - Resolving Usability Issues

You Don’t Have to Know Everything!

A user called me and said thaticons were disappearing from his Desktop and then reappearing!
At first, | thought he was either crazy or someone was playing a joke on him. After talking with
him for a little while longer, | realized that this was no joke.

The computer that he was using was at his home and it was not subject to any Group Policies or
network administration of any kind. He was also using a firewall to prevent access from intruders.
He seemed to know how to protect his computer, yet the icons continued to disappear.

Next, | considered that he might have a virus of some kind. | researched my information on the lat-
est viruses and did not find any that just caused icons to disappear. Now, | was totally perplexed!

As my “one last shot,” which should have been my first shot, | decided to check the Microsoft
Knowledge Base to see if they knew anything about disappearing icons. Well, boy, do they
ever! As it turns out, there are many combinations of features that can make icons disappear
for no apparent reason. In some cases, Microsoft doesn’t even try to explain why they disap-
peared; they just tell you how to get them back! Check for yourself on KB articles 307077,
321213, 822721, and 324250. You can also just select Windows XP in the Knowledge Base and
then type disappearing icons; that’'s what | did.

My point is that | should have checked the Microsoft Knowledge Base first instead of last. What
I did is try to solve the problem with only my own intellect. | figured that | must know the answer
to this problem. In other words, | let my ego get in my way.

The moral of this story is that you don’t have to know everything in order to be an effective
desktop support technician; sometimes you just have to know where to find the information.
The Microsoft Knowledge Base is compiled by hundreds of experts who have likely experi-
enced the same problems that you are experiencing. Don’t use it as a last resort. Use the Knowl-
edge Base as your first resource, and you will solve many problems faster than you ever
thought possible!

Internet Explorer Settings

It may seem as if we discussed every possible option involving Internet Explorer in Chapter 6.
In reality, we only scratched the surface in regard to its usability because we focused our entire
discussion on one dialog box, Internet Options. In this section we will discuss all of the other
settings contained in the File, Edit, View, Favorites, Tools, and Help menus.

The File Menu

The File menu contains tools to create new windows, messages, and other communications.
You can also configure settings for printing and saving web pages. In addition, you can import
and export your favorites and cookies files to and from other applications on your computer.
Figure 7.2 shows the options contained in the File menu. In this section, we will discuss each of
these options in greater detail.
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FIGURE 7.2 The File menu

New -
Open... Ctrl+0

Save As...

Page Setup...
Print... Ctrl+P
Print Preview...

Send 4
Import and Export...

Properties
Work Offline
Close

New You can choose New in the File menu to create a new window for the currently displayed
page. You can also use New to connect to other applications installed on the computer to create
a new e-mail message, newsgroup post, contact record, or Internet call.

Open You can select Open and then type the uniform resource locator (URL) of the
resource that you want to open. You can also simply type this information in the address
line on the browser.

Edit and Save These options are generally not available when you are working online, but you
can use them when you are working with documents through your browser offline.

Save As You can choose Save As to save a web page for later viewing. You should use this
option when you feel that the information may not continue to be available online.

Page Setup, Print Preview, and Print You can choose the Page Setup option to configure the
manner in which web pages will be printed. You can use the Print Preview option to view an
example of the document in its printed form on the screen, before you print. You can choose the
Print option to select the printer on your computer to which you will send the page.

Send You can choose Send to send a copy of a web page or a link to the web page through your
default e-mail program. You can also create a shortcut to a web page on your Desktop with this tool.

Import and Export You can choose Import and Export to copy favorites and cookies to
and from other applications on your computer or computers connected to your computer
in your network.

Properties You can select Properties to view general information about a page, such as the
page type and the URL.

Work Offline/Work Online You can use the Work Offline/Work Online tool to control the
use of the browser as a tool to access resources on the Internet or your intranet—or just to access
resources on the computer itself.

Close You can choose this option to close Internet Explorer. You can also close it by clicking
on the X at the top right corner of the program.
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The Edit Menu

The Edit menu contains the tools to cut, copy, and paste portions of the page or the entire page.
In addition, you can use the Edit menu to search for text on a web page. Figure 7.3 shows the
Edit menu, which contains the following options:

Cut, Copy, Paste These are functions that enable you to move or copy text from a website on
your browser to another application. These options are also available by right-clicking the
mouse when it is positioned over the web page.

Select All  This option can be used to quickly select the entire web page to prepare for a print-
ing or copying operation.

Find (On This Page) This option enables you to search for specific words within the web page.

FIGURE 7.3 TheEdit menu

Select All Ctrl+A

Find (on This Page)... Ctrl+F

The View Menu

The View menu enables you to decide which tools will be visible during a user’s normal utili-
zation of the browser. You can also use the View menu to refresh a page or to go to a specific
web page. In addition the View menu enables you to the view the source information for a web-
site and its encoding type. Finally, the View menu allows you to control the size of the text and
the Full Screen mode of the browser. Figure 7.4 shows the View menu, which contains the fol-
lowing settings:

Toolbars, Status Bar, and Explorer Bar These settings control the toolbars that will be dis-
played for the user. The toolbars include Standard Buttons, Address Bar, Links, Favorites,
Media, and others, depending on what other software is installed on the computer. You should
select only the toolbars that the user will utilize.

Go To, Stop, and Refresh These settings are used to navigate to websites. Go To enables you
to go directly to the Home page or to move forward or backward from your current location.
Stop causes the current navigation attempt to cease and returns the previous web page to the
screen. Refresh retrieves the latest copy of the web page that you are currently viewing.

Text Size This setting enables you to adjust the text size of most web pages to a larger or
smaller size relative to the current size of the font. Some fonts on some web pages do not
respond to this setting.

Encoding This setting enables you to adjust the way that the browser will display the infor-
mation contained on the website. You should usually leave the encoding set to the default.
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FIGURE 7.4 The View menu
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Source Choosing the Source option enables you to view the metadata that composes the web
page. The metadata for the page will be displayed in Notepad when you select the Source option.

Privacy Report This setting allows you to view and change settings related to how your com-
puter will handle the cookies from a specific website. The report will indicate the websites that
have contributed content to the current page. You can adjust your Privacy settings from this
page, provided that you have Administrative rights to the computer.

Script Debugger This setting will open the default script debugger installed in your computer.
If you do not have a script debugger installed, then this setting will not be visible.

Full Screen  This setting will open the current page in Full Screen mode for the maximum view-
ing area. Your standard icons will still appear at the top of screen. You can also press the F11
key to toggle between Full Screen and Normal view.

The Favorites Menu

The Favorites menu contains the links to the web pages that a user has marked. You can add
as many favorites as you need, organize them in folders, and sort the sites and folders to make
them easier to find. Figure 7.5 shows the Favorites menu, which contains the following options:

FIGURE 7.5 The Favorites menu
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Add To Favorites You can choose Add To Favorites to add the current website to the Favor-
ites menu. You can give the website a name of your choice that will help you remember why you
saved this particular site. If you have created folders, then you can add the site to a specific
folder within Favorites to make it easier to find.

Organize Favorites You can choose Organize Favorites to create, rename, move, and delete
folders that contain websites.

Lists of Favorites You can click any of the favorites in your list to instantly navigate to that
web page. You can sort the list by right-clicking the list and then choosing Sort By Name. You
can also store a copy of a user’s favorite web page on the computer by right-clicking the favorite
of your choice and then choosing Make Available Offline.

The Tools Menu

As you may remember, we discussed the Internet Options dialog box in the Tools menu in great
detail in Chapter 6. The Tools menu also contains other options that you can configure for a
user. You can use the Tools menu to synchronize a user’s offline web pages with the online web
page from which they originated. In addition, you can use the Tools menu to connect to the
Windows Update site at Microsoft. Finally, you can also use the Tools menu to navigate directly
to your default e-mail and newsgroup applications. Figure 7.6 shows the Tools menu, which
contains the following options:

Mail And News You can choose the Mail And News option to automatically open your
default e-mail and newsgroups applications.

Synchronize When a user stores web pages offline, they are very likely to change online. You
can use the Synchronize option to configure the computer to automatically synchronize these
web pages when the user logs on or logs off or on a set schedule. Simply click the Setup button
to configure these settings.

Windows Update This setting opens the Microsoft Windows Update website at its most cur-
rent location. You can update your operating system and the Microsoft applications that it con-
tains from this site.

Messenger This setting opens the Microsoft Messenger program. You can add contacts so that
you can send instant messages, files, and photos to other users who are online with Messenger.

Show Related Links This setting shows other websites that appear to the search engines to be
related to the current website.

FIGURE 7.6 The Tools menu
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The Help Menu

The Help menu contains information about the browser that you are currently using. It also
contains links to a tremendous amount of information that may be very useful for configuring
and troubleshooting Internet Explorer. Figure 7.7 shows the Help menu, which contains the fol-
lowing settings options:

Contents And Index The Contents And Index tool provides information related to configuring
and troubleshooting Internet Explorer. We will discuss this tool in greater detail later in this chapter.

Tip Of The Day You can choose the Tip Of The Day option to display a helpful tip at the bot-
tom of the screen. The tips change on a daily basis.

For Netscape Users This is specific Help designed to assist users who are currently using
Netscape Navigator to use the similar features of Internet Explorer.

Online Support Choose this option to be automatically connected to Microsoft’s Help and
Support Home page. You can get the latest updates on viruses, downloads, and other informa-
tion. You can also search the Knowledge Base or contact Product Support Centers from this site.

Send Feedback Choose this option to be instantly connected to the Microsoft Internet
Explorer Contact Us page. You can use this page to reach the Product Support, Product Sug-
gestion, Frequently Asked Questions, and Microsoft Internet Explorer website Feedback pages.

About Internet Explorer Choose this option to view the version and product number infor-
mation for the browser that you are using. You may need this information for troubleshooting
purposes to determine whether you have the latest version of the browser. Click OK to close the
dialog box and remove it from view.

FIGURE 7.7 The Help menu
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Interpreting Error Messages in Internet Explorer

There are two main categories of errors that a user might encounter when using Internet Explorer:
those that keep her from accessing a specific page and those that keep her from browsing at all.
Depending on the type of error and whether Internet access is available from another computer,
you have a few tools from which to choose to interpret the error message and troubleshoot the
problem. If you do not have an Internet connection, then you should check the configuration set-
tings that we discussed in Chapter 6 and the general connectivity of your computer. The tools that
you can use to troubleshoot Internet Explorer errors include the following:

The Help menu Many errors are caused by improper configuration. Even if you cannot
obtain an Internet connection, you can find a tremendous amount of information regarding the
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proper configuration and use of Internet Explorer in the Help menu within the Contents And
Index section. You can browse the Contents or search the Index for the configuration informa-
tion that you need.

The Microsoft Knowledge Base If you have an Internet connection, then you can navigate to
the Microsoft Knowledge Base through the Support Tools at support.microsoft.com. You
can choose the browser that you are using (for example, Internet Explorer 6) from the Select A
Microsoft Product drop-down list and then type the key information regarding the error in
question to obtain the latest articles and other support information.

The Microsoft Product Support Centers If you have an Internet connection, then you can nav-
igate to the Product Support Centers through support.microsoft.com. You can choose Internet
Explorer from the products listed and view the latest support information and frequently asked

questions about the product. You can also enter key information in the Search line of Product And
Support Centers to be redirected to a search of the Microsoft Knowledge Base.

TE might assist a user may emerge on the Internet on a daily basis. You can use
the normal search engines such as MSN or Google to find more information
about error messages.

%)’ This is by no means an exhaustive list, since new articles and websites that

Outlook Express

Creating a user-friendly e-mail and newsgroup management tool involves much more than just
setting up a mailbox. You can enhance the user’s experience with Outlook Express if you know
all of the features and options that are available. As with other applications, users will some-
times have problems with the software. As a desktop support technician, you should know how
to interpret the error messages regarding Outlook Express and troubleshoot the problems. In
this section, we will discuss each of these concepts in detail.

Outlook Express Settings

There are many menus in Outlook Express that contain settings to enhance the usability of
the program for the user. All of the tools are located by default at the top-left corner of the
screen. You should be familiar with these tool menus so that you can enhance the settings
for users as well as troubleshoot any settings that they have “adjusted.” In this section, we
will discuss the File, Edit, View, Tools, Message, and Help menus and the settings and
options that they contain.
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The File Menu

The File menu contains tools that enable a user to organize the mailbox, open new messages,
import and export address books and messages, and print messages. A user can also manage

multiple identities from the File menu. This is useful when more than one person is using the

computer or when one user has more than one account. Figure 7.8 shows the File menu, which
contains the following settings:

New You can use the New option to open a new e-mail message, news message, instant mes-
sage, folder, or contact. You can also use the icons on the Outlook Express toolbar to perform
these actions.

Open You can choose the Open option to open a selected e-mail or news message. You can
also simply double-click the message to open it.

Save As  You can use the Save As option to make a copy of a message and store it in a folder
on the computer or on another computer in your network.

Save Attachments You can use the Save Attachments option to copy attachments from the
temporary folder where they are stored by default to a folder of your choice on your computer
or another computer in your network. You can also use Save Attachments by right-clicking the
attachment itself.

Save As Stationery When a user receives an e-mail on digital stationery that he likes, he can
add that stationery to his options by choosing Save As Stationery.

Folder You can use this option to create new folders for messages and to move, rename, man-
age, compact, and delete folders.

FIGURE 7.8 The File menu
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Import/Export You can use this option to quickly move messages and e-mail address books
from one computer to another. This is especially useful when a user changes computers.

Print You can choose the option to be directed to the printer tools, where you can choose a
printer and other advanced options and preferences before printing.

Switch Identity/Identities/Exit And Log Off Identity When more than one person is using the
same computer, this option enables each user to create his own personal message management
system. We will discuss this in greater detail in Chapter 8, “Resolving Application Customiza-
tion Issues.”

Properties This option enables you to view details related to the selected message. These
include General properties, such as the time that the message was sent and received, as well as
Details, such as the addresses of all of the other recipients of a message.

Work Offline This option allows a user to compose e-mail messages offline to be sent when
he is back online. This is especially useful when you are working with a dial-up connection that
you don’t want to stay on because it is shared or because the connection has long-distance
charges associated with it.

Exit You can choose this option to close Outlook Express. You can also close it by clicking
on the X at the top right corner of the program.

The Edit Menu

The Edit menu contains options to organize messages and mark them as Read or Unread. In
addition, you can use the Edit menu to control the use of the folders that you created with the
File menu. You can also use the Edit menu to find a specific message based on information
about the message itself. Finally, you can delete messages using the Edit menu. Figure 7.9 shows
the Edit menu, which contains the following options:

Copy/Select All  You can use the Copy and Select All tools to select messages in preparation
for moving them or printing them. You can also hold down the Ctrl key and select each message
or hold down the Shift key and select a range of messages.

FIGURE 7.9 TheEdit menu
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Find You can use the Find option to locate a message based on information about the mes-
sage. You can enter parameters on which to search, including whom the message was to or from
and the subject and date of the message. You can also use the Find option to locate specified text
within a message. Finally, you can use the Find key to locate people in your address book or
through Internet services.

Move To Folder/Copy To Folder You can use these options to move or copy selected mes-
sages from one folder to another or from the Inbox to a specified folder.

Delete Choosing the Delete option will place the selected message(s) in the Deleted Items
folder. You can then control how often the messages in the Deleted Items folder are actually
deleted. This is a precaution to prevent users from deleting messages by mistake.

Empty ‘Deleted Items’ Folder Choosing this option will override the normal schedule to
delete items in the Deleted Items folder and delete the items immediately. When you choose this
option, Outlook Express will ask you if you are sure that you want to permanently delete the
items. If you choose Yes, then the items will be deleted. If you choose No, then you will cancel
the deletion of the items.

Mark As Read/Mark As Unread/Mark Conversation As Read/Mark All Read The Mark
options enable you to keep track of which messages you have read and which messages you have
yet to read. Messages that are unread will appear in bold text by default. You can also configure
Outlook to automatically mark a message as read after you have viewed it for a set amount of
time, for example, 5 seconds. We will discuss this customization option in Chapter 8.

The View Menu

The View menu enables a user to control the messages that are displayed and how they are
sorted. She can also control the text size in the message and the message encoding. In addition,
the View menu contains tools that enable a user to navigate to and from messages and folders.
Figure 7.10 shows the View menu, which contains the following options:

FIGURE 7.10 The View menu
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Current View The Current View option enables a user to display all messages or to hide the
messages that she has already read or has decided to ignore. She can also create customized
views. In addition, she can use the Current View menu to group messages by conversation. This
sometimes makes a conversation string easier to follow.

Sort By You can use the Sort By option to control the order in which the messages will be dis-
played. For example, messages can be displayed by date, subject, priority, and so on. You can
also simply click on the column heading to sort the messages by the parameter of that column.

Columns You can choose the Columns option to select the column heading that will be shown
for the messages. Keep in mind that you are limited by your screen area, unless you want to
scroll over to see information. You can change the font and the resolution to bring more col-
umns into Normal view.

Layout The Layout option allows a user to further customize the look of Outlook Express and
the tools that she has available. We will discuss the Layout option in greater detail in Chapter 8.

Text Size  You can choose this option to increase or decrease the size of the text used in the
messages.

Encoding You can use this option to change the manner in which Outlook Express interprets
and displays the message information. In most cases, you should leave this setting at its default.

Previous Message/Next/Go To Folder/Expand/Collapse You can use these tools to navigate
messages and folders. This is especially useful when you have many messages and folders
through which to navigate.

Stop You can use the Stop option to cancel a previous command. For example, if the system
is having trouble locating a message but is continuing to try, then you can cancel that command
using the Stop option and then try to locate the message by another parameter.

Refresh This option repaints the screen with the latest information and messages.

The Tools Menu

The Tools menu contains many options that control the sending and receiving of e-mail and the
receiving of newsgroups. You can also create and control user accounts through the Tools
menu. Most of the Tools menu relates directly to customizing Outlook Express for a user. For
this reason, we will discuss the Tools menu in depth in Chapter 8.

The Message Menu

The Message menu relates directly to creating and replying to messages. Users can also use the
Message menu to block messages from specified senders and to flag messages so they stand out.
In addition, users can set the options to watch a specific conversation or ignore a conversation
of messages that they have previously received. A conversation includes the original e-mail and
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all of the replies. Figure 7.11 shows the Message menu in Outlook Express, which includes the
following options:

New Message/New Message Using Both of these options create a new message. New Mes-
sage creates the message with no stationery. New Message Using enables the user to select the
stationery that she will use to create the message.

Reply To Sender/Reply To All/Reply To Group All of the options send a reply to a mes-
sage. Reply To Sender sends the reply only to the person who originated the message. Reply
To All sends a copy of the reply to all of the users who were copied on the message when it
was sent. Reply To Group enables a user to select to whom to send her reply out of the entire
list of recipients to this message.

Forward/Forward As Attachment Both of these options send a copy of the message to another
recipient as specified by the user. Forward sends the message just as it was received, although the
user can add text within the message to introduce the message or make comments. Forward As
Attachment converts the message into an attachment and provides a new e-mail message box for
the user to introduce the message attachment or make comments about the message.

Create Rule From Message Users can automatically forward a message, place it in a folder,
highlight it, flag it, and even delete it, based on the information about the message. This is one
of the customization options that we will discuss in detail in Chapter 8.

Block Sender You can use this option to create a quick rule that will block any further mes-
sages from the sender of the currently selected e-mail. The sender will be added to the blocked
senders list. The system will also ask you if you want to remove, from the current folder, all mes-
sages from the selected sender.

Flag Message/Watch Conversation/Ignore Conversation These options enable a user to cus-
tomize her use of Outlook Express. She can identify messages and conversations that she wants
to pay close attention to and those that she wants to ignore completely. We will discuss these
options in greater detail in Chapter 8.

FIGURE 7.11 The Message menu
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Combine And Decode Sometimes a very large message that contains pictures, audio files, or
other large attachments must be broken down into multiple messages to be sent. You can use
Combine And Decode to put the messages back together into one message. You should first
select the messages that you want to combine and then choose Combine And Decode. The tool
will enable you to put the messages in the right order, regardless of the order in which you
received them.

The Help Menu

The Help menu is a great source of information for troubleshooting. You can use the Contents
And Index tool offline or a host of tools online. As a desktop support technician, you should be
familiar with Help menu, and you should make users familiar with it as well. Figure 7.12 shows
the Help menu, which includes the following options:

Contents And Index You can use the Contents And Index option to connect to a tremendous
source of configuration and troubleshooting information on your computer. You can use this
tool even if you do not have a connection to the Internet.

Read Me This option doesn’t do much except tell you that the Read Me information is in
Readme . doc file at the root of the Windows CD.

Microsoft On The Web  This option enables you to quickly connect to many websites such as
the Windows Update, Product News, Frequently Asked Questions, and Online Support sites.
You can also send feedback to Microsoft through this option and connect to Hotmail and the
MSN Home page.

About Microsoft Outlook Express This option shows the current product information, ver-
sion information, and specific files used by the program. You may need to view this information
for troubleshooting to make sure that you have the latest software available.

FIGURE 7.12 The Help menu

Contents and Index F1
Read Me

Microsoft on the Web 4

About Microsoft Outlook Express

Interpreting Outlook Express Error Messages

Since Outlook Express has many features and settings, it can also generate many types of error
messages. As with Internet Explorer, we can group these error messages into two categories:
those that are related to general connectivity issues and those that are related to Outlook
Express configuration issues. If the user cannot connect to the Internet with any application,
then she might just have a general connectivity issue so you should check all of the general con-
nectivity settings first. On the other hand, if she has connectivity to the Internet but she is still
having a problem sending and/or receiving e-mail, then you can be fairly sure that the problem
is related to the configuration settings of Outlook Express.
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Depending on the type of error encountered and on your access to the Internet, you can use
a few tools to assist you in interpreting Outlook Express error messages and troubleshooting the
problem. The tools that you can use include the following:

The Help menu  As with Internet Explorer, many errors are caused by improper configura-
tion. The Help Menu within the Contents And Index section is a great source of information
about proper configuration of Outlook Express. You can browse the Contents or search in the
Index for the configuration information that you need.

The Microsoft Knowledge Base Assuming that you have an Internet connection, you
can navigate to the Microsoft Knowledge Base through Microsoft Help and Support at
support.microsoft.com. Choose Outlook Express from the Select A Microsoft Product
drop-down list and type the key information regarding the error in question to obtain the
latest articles and other support information.

The Microsoft Product Support Centers Also, if you have an Internet connection, then you
can navigate to the Product Support Centers through support.microsoft.com. Choose
Outlook Express from the products listed and view the latest support information and fre-
quently asked questions about the product. Enter key information in the Search line of Prod-
uct And Support Centers to be redirected to a search of the Microsoft Knowledge Base. The
Product Support Center will often contain the latest updates and patches to enhance the per-
formance of the program.

Operating System Features

Regardless of the application(s) that the user is utilizing, you can enhance the usability of the
computer by configuring components of the operating system to meet the user’s needs. While
there are many components of the operating system that you can configure, the most prominent
components are the Start menu, the Taskbar, and shortcuts on the Desktop. Since users will
sometimes have problems with the operating system, you should know how to interpret and
troubleshoot error messages related to the operating system. In this section, we will discuss both
of these concepts in detail.

Configuring Operating System Features

Most users use the operating system only as a platform to gain access to applications. For this
reason, the Start menu, Taskbar, and Desktop shortcuts are the most important configuration
options in the operating system since they are the tools that enable the user to gain access to
applications. As a desktop support technician, you should know how to configure and trouble-
shoot these important tools for the user. In this section we will discuss configuring each of these
tools to enhance their usability.
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The Start Menu

The Start menu is usually the first navigational tool that the person uses when he logs on to a
computer to access applications. You can configure the Start menu in Windows XP so that it
contains repeatedly used applications, making them readily available for the user. When you or
a user adds an application to the operating system, it is automatically added to the All Programs
menu in the Start menu. As a desktop support technician, you should know how to configure
the Start menu properties for a user.

There is only one main configuration option for the Start menu: Start menu or Classic Start
menu. The rest is all customization. In this section we will discuss only the main configuration
option for the Start menu. We will discuss customizing the Start menu in Chapter 8.

Start Menu for Windows XP

The default Start menu option for Windows XP is simply called Start Menu. You can view this
setting by right-clicking the Taskbar, choosing Properties, and then choosing the Start Menu
tab. Figure 7.13 shows the Start menu properties settings. The Start menu settings allow easier
access to the most commonly used programs and remember the programs that you use, mak-
ing them easier to access next time. They also contain the user’s name and the picture that the
user has chosen for the account. Figure 7.14 shows an example of a Start menu with the
default Windows XP settings.

FIGURE 7.13 Start Menu Properties
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FIGURE 7.14 Windows XP default Start menu
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Classic Start Menu

If users are accustomed to the Start menu in Windows 95, Windows 98, and Windows 2000
Professional and refuse to learn something new, then you can configure their computers with
the Classic Start menu. This configuration does not contain the sections for previously used pro-
grams and does not remember programs that users have previously used. It also does not con-
tain the user’s name or picture. Figure 7.15 shows the Classic Start menu in Windows XP.

P from the bottom and running toward the top of the menu. This started with

g/ All Classic Start menus contain the name of the operating system written
Windows 95 and continues through Windows XP.

The Taskbar

The Taskbar contains information in regard to applications and services that are running. You
can also configure the Taskbar with miniature icons called Quick Launch icons. The Taskbar
is located at the bottom of the screen by default. There are many options for customizing the
Taskbar, which we will discuss in Chapter 8.

In this section will we focus on Taskbar properties, as shown Figure 7.16.
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FIGURE 7.15 The Classic Start menu
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There are two main groups of settings in the Taskbar properties: Taskbar Appearance and
the Notification Area. In this section we will discuss each of those groups of settings in detail.

Taskbar Appearance
The Taskbar Appearance properties control the general appearance of the Taskbar during nor-
mal use of the computer. There are five options that relate to the Taskbar’s appearance. You
should be familiar with these options so you can adjust them for a user or troubleshoot a prob-
lem related to their use.

The five Taskbar appearance settings are as follows:

*  Lock The Taskbar: You can use this setting to prevent the user from accidentally changing
settings on the Taskbar. While the Taskbar is locked, most other changes are disabled.
Administrators can use a Group Policy to prevent the user from unlocking the Taskbar.
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Auto-hide The Taskbar: This setting causes the Taskbar to disappear from the screen when
it is not being used. This frees up space on the screen and reduces clutter. When you return
the mouse pointer to the area where the Taskbar is located, the Taskbar will appear again.

Keep The Taskbar On Top Of Other Windows: This setting is checked by default. If you
remove the check mark, the Taskbar will disappear when you begin to use another appli-
cation. You can switch to the Desktop to regain the use of the Taskbar.

Group Similar Taskbar Buttons: This setting is an enhancement to Windows XP that auto-
matically puts similar programs into groups in the Taskbar. For example, if you have several
Microsoft Word documents open at the same time, then Windows will group the documents
in the Taskbar and indicate how many are in the group. You can click on the group to view
the items that it contains and manage each item separately. Groups are indicated with a tri-
angle pointing downward. Figure 7.17 shows a Taskbar with groups.

Show Quick Launch: You can use this setting to create miniature icons for the most com-
monly used applications in the Taskbar. The initial Quick Launch icons include Internet
Explorer, Outlook Express, and the Desktop toggle icon. You can add more icons by drag-
ging icons from the Desktop to the Taskbar.

FIGURE 7.16 Taskbar properties
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FIGURE 7.17 A Taskbar with groups
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Notification Area

The Notification Area is located by default on the right side of the Taskbar. This area was
referred to as the system tray in previous versions of Windows. The Notification Area shows the
services that are running on your computer to support applications, such as Microsoft Messen-
ger. It can also contain the date and time. When you install new hardware and software in your
computer, it can indicate their presence in the Notification Area. You can control which icons
are displayed and when they are displayed.

The Notification Area contains the following settings:

=  Show The Clock: You can use this setting to display or not display the time and date.

=  Hide Inactive Icons: You can use this setting to reduce the clutter in the Notification Area
by not displaying icons that are inactive. You can further customize the display of these
icons by choosing Customize and then selecting when to hide or show each icon.

Desktop Shortcuts

The more quickly users can find their applications, the more productive they can be. Many
applications ask whether to add a shortcut on the Desktop during their installation. If the appli-
cation does not ask, or if the question was answered with “no,” there are still many ways to add
a shortcut to the Desktop for that application. In this section, we will discuss two methods of
adding shortcuts to a Desktop: from the All Programs menu and from the Desktop using the
Create Shortcut Wizard.

From the All Programs Menu

If the application is installed in Windows XP, then it is most likely in the All Programs menu
of the Start menu. If it is, then you can simply navigate to the application in the Start menu,
right-click the application name, choose Send To, and then choose Desktop (Create Shortcut).
Figure 7.18 shows the steps to create a Desktop shortcut for Microsoft Office Excel 2003 from
the All Programs menu.

From the Desktop Using the Create Shortcut Wizard

If the application is not listed in the All Programs menu, such as an older application or an appli-
cation that has been deleted from the All Programs menu, then you can create the shortcut from
the Desktop by using the Create Shortcut Wizard. Exercise 7.3 walks you through the steps to
create a Desktop shortcut using the Create Shortcut Wizard.
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Creating a Desktop shortcut from the All Programs menu in Windows XP

EXERCISE 7.3

Creating an Application Shortcut with the Create Shortcut Wizard

1. Onthe Windows XP desktop, right-click in an open area and then choose New.

2. Onthe expanded list from New, choose Shortcut. This will start the Create Shortcut Wizard.

Create Shortcut

This wizard helps you to create shortcuts to local or
network programs, files, folders, computers, or Internet
addresses.

Typa the location of the itam:

i

Click Next to continue.
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EXERCISE 7.3 (continued)

3. Typethe location of the executable file for the application for which you creating the short-
cut, or click Browse to search for the file. In this example we will use Solitaire (sol.exe).
Browse For Folder 2
Select the target of the shortcut below:
s
=) sortkey.nls
) sorttbls.nls
= sound.drv
& spider.exe
1 spiisupd.exe
2] spmsg.dil
ﬂ_ spnike.dll |v
< | | 12
[ Make New Folder ‘ I oK l ’ Cancel ‘
4.

After the wizard enters the location of the executable file, choose Next to continue.

Create Shortcut @

This wizard helps you to create shortcuts to local or
network programs, files, folders, computers, or Internet
addresses.

Type the location of the item:

C:\WINDOWS\system32\sol.exe|

Click Next to continue.

Next > [| Cancel
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EXERCISE 7.3 (continued)

5. Type the name that you want to use for the shortcut.

‘Select a Title for the Program @

Type a name for this shortcut:
Solitaire

Click Finish to create the shortcut.

I < Back " Finish || Cancel

6. Click Finish to add the shortcut to the Desktop.

Interpreting Error Messages Related to
the Operating System

Just as applications will sometimes have “issues,” so will the operating system. You should
know how to interpret error messages that are related to the operating system and trouble-
shoot the problem for the user. As with applications, the main tools that you should use are
Help menus and the Microsoft Knowledge Base on the Internet. With Windows XP, however,
the Help menu is greatly enhanced to provide a tremendous amount of information that you
can use for configuration and troubleshooting. In this section we will discuss the tools that
you can use to troubleshoot the operating system: the Help and Support Center, the Microsoft
Knowledge Base, and the Microsoft Product Support Centers.

The Help and Support Center

The Help and Support Center contains tools that can be used online as well as tools that can be used
offline. The tools are arranged in categories to make it easier to find the one that you need. Many
of the offline tools provide links to online tools. Figure 7.19 shows the Help and Support Center.
You can access the Help and Support Center through the Start menu or by pressing the F1 key.

The Microsoft Knowledge Base

If you have an Internet connection, then you can navigate to the Microsoft Knowledge Base
through the Support Tools at support.microsoft.com. Just choose Windows XP from the
Select A Microsoft Product drop-down list and type the key information regarding the error in
question to obtain the latest articles and other support information.
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FIGURE 7.19 The Help and Support Center
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The Microsoft Product Support Centers

If you have an Internet connection, then you can navigate to the Product Support Centers
through support.microsoft.com. Simply choose Windows XP from the products listed and
view the latest support information and frequently asked questions about the product. You can
also enter key information in the Search line of the Product and Support Centers to be redirected
to a search of the Microsoft Knowledge Base. The Product Support Center will often contain
highlights and important issues regarding the operating system. Figure 7.20 shows the
Microsoft Product Support Center for Windows XP.

FIGURE 7.20 The Microsoft Product Support Center for Windows XP
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Summary

As a desktop support technician, you are responsible for configuring a user’s operating system
and applications so as to prevent as many problems as possible. It’s impossible to prevent all
problems, but correct configuration of the operating system and the most common applications
is a large step in the right direction. You should know how to configure the most common appli-
cations and the operating system to maximize usability for the user. You should also know how
to interpret error messages that relate to the operating system and the most common applica-
tions, such as Microsoft Office, Internet Explorer, and Outlook Express.

When you install Microsoft Office for a user, you can prevent many issues by installing only
the components that the user will use. You should ask the user about her job roles and deter-
mine which components she needs. You should then perform a Custom installation, which
installs only the components that she will use. While this will prevent many problems from
occurring, it will not prevent them all. You should know how to use the Setup log files and the
Microsoft Knowledge Base to troubleshoot a problem regarding Microsoft for a user.

One of the most commonly used applications other than Microsoft Office components is the
Microsoft browser, Internet Explorer. There are many configuration options within Internet
Explorer that can enhance its usability and make the product more user-friendly. You should
know how to configure the options in Internet Explorer to allow for safe, efficient browsing.
You should also know how to use the Help menu and the Microsoft Knowledge Base and Prod-
uct Support Centers to interpret and troubleshoot error messages.

Outlook Express will be the e-mail program of choice for many of your users, especially at
home. You need to know the options that are available in Outlook Express so that you can con-
figure them for the user and teach the user to configure them himself. These options control the
manner in which messages are displayed, read, sent, stored, and so on. You should also know
how to use the Help menu and the Microsoft Knowledge Base and Product Support Centers to
interpret and troubleshoot error messages.

Users will be more productive if their applications are organized so that they can easily find
the applications they need. Windows XP has the most user-friendly interface of any Microsoft
client. You can configure the Start menu, Taskbar, and Desktop shortcuts so that applications
are easy to locate and use. You should also know how to use the Help and Support Center, the
Microsoft Knowledge Base, and the Product Support Centers. A knowledge of these tools will
assist you in interpreting error messages and troubleshooting the operating system and the
Microsoft applications that run on it.

Exam Essentials

Know how to perform a Custom installation of Office 2003. You should know how to per-
form a Custom installation of Office 2003. This includes selecting only the components that the
user requires and configuring the components to provide maximum usability.
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Be able to use the Microsoft Knowledge Base. You should know how to access the Microsoft
Knowledge Base on the Internet and use it to interpret error messages. You should know that
the Microsoft Knowledge Base can assist you in troubleshooting Windows operating systems
and most Microsoft applications.

Know how to configure Internet Explorer. You should know how to configure all of the
menus of Internet Explorer so that you can assist a user with his configuration. In addition, you
should know how to troubleshoot errant configurations by users. Finally, you should know
how to use the Help menu and the various online resources to interpret error messages and trou-
bleshoot Internet Explorer.

Know how to configure Outlook Express. You should know how to configure all of the
menus of Outlook Express to create a usable e-mail and newsgroup tool for the user. You
should know the menus so well that you can assist the user over the phone without looking at
the software yourself. In addition, you should know how to use the Help menu and the various
online resources to interpret error messages and troubleshoot Outlook Express.

Know how to configure the Windows XP Desktop. You should know how to configure
the Start menu, Taskbar, and Desktop shortcuts on the Windows XP Desktop to make
applications easily available to users. In addition, you should know how to troubleshoot
users’ errant configurations.

Be able to troubleshoot Windows XP. You should know how to use the offline and online
tools of Help and Support Center to troubleshoot Windows XP. In addition, you should know
how to use the Microsoft Knowledge Base and Product Support Center to interpret error mes-
sages and troubleshoot problems.
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Review Questions

1. You are the desktop support technician for your company. A user calls you to request that
Microsoft Word be added to her computer so that she can read e-mail attachments. She has
never needed any Microsoft Office products in the past. Which should you do?

A. Perform a Typical installation of Microsoft Office.
B. Perform a Custom installation, selecting only Word.

C. Ask the user what other e-mail attachments she has received and what types of tasks she
needs to perform, and then install only the software that you think she will require in
the near future.

D. Ask the user what applications she needs to have installed on her computer along
with Word.

2.  You are the desktop support technician for your company. You have recently installed
Microsoft Office on a user’s computer, but you are experiencing errors. Which of the following
resources can you use to interpret the error messages? (Choose two.)

A. The Microsoft Knowledge Base
B. The Computer Management Console
C. The Setup log files
D. Device Manager
3.  Youare the desktop support technician for your company. A user calls you complaining that the
font on some web pages is very small and that he can’t read it. He does not want to make any

changes that will affect the size of any icons or the text of any other applications. You are not
in front of a computer at this time. To which Internet Explorer menu should you direct the user?

A. Tools

B. View
C. Edit
D. Options

4. You are the desktop support technician for a large company. A user calls you from a remote
location and tells you that he cannot gain access to the Internet through Internet Explorer. He
can send and receive e-mail. Which of the following should you do?

A. Ask the user for all of his network connection information, IP address, default gateway,
and so on.

B. Ask the user if he is receiving an error message and then use the Microsoft Knowledge
Base to interpret the error message.

C. Tell him to restart his computer.

D. Walk him through uninstalling and reinstalling Internet Explorer.
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5.  You are the desktop support technician for your company. A user calls you to say that she is
upgrading to a new computer at home but she is worried because all of her Outlook Express
e-mail messages and address books are on the old one. She is afraid that she will have to start
over. What should you tell her?

A. She should make sure to move the old hard drive over to her new computer to keep all
of the e-mail messages and address books intact.

B. She will have to start all over, but everything will be better when she gets it all in
there again.

C. She can simply find the folders where all of the messages and address are contained and
then move them over to the My Documents folder on her new computer.

D. She can export the e-mail messages and address books from her computer and then
import them into the new computer.

6. Youare the desktop support technician for your company. A user is experiencing problems with
Outlook Express and is receiving some very odd error messages that you have never seen before.
Which resource should you use first to attempt to interpret the error messages?

A. Google
B. The Microsoft Product Support Center
C. The Help menu in Outlook Express
D. The Microsoft Knowledge Base

7. You are the desktop support technician for your company. A user who is working from home
calls you with a question. She has received an e-mail on stationery that she really likes and she
would like to add that stationery to her stationery options on Outlook Express. You are not in

front of a computer with Outlook Express installed. To which menu should you direct her to
find Save As Stationery?

A. Edit
B. View
C. Tools
D. File
8. Youare the desktop support technician for a large company. A user who is working from home
calls you with a question. He has received an e-mail and he would like to see detailed informa-

tion about it, including all of the e-mail addresses to which it was sent. To which Outlook
Express menu should you direct the user?

A. File

B. Edit

C. Tools
D. Message
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You are the desktop support technician for a large company with many Windows XP computers.
Some users complain that they liked the old Start menu that was provided by previous Windows
operating systems much better than the one they have now. What should you do?

A.
B.

Tell them that there are no other options unless you reinstall the operating system.

Direct the users to reinstall the operating system and choose the Classic installation
this time.

Direct the users to right-click on an empty area of the Desktop, and then choose
Properties » Start Menu » Classic Start Menu.

Direct the users to right-click on an empty area of the Taskbar, and then choose
Properties » Start Menu » Classic Start Menu.

You are the desktop support technician for a large company with many Windows XP computers.
A user calls you to say that he is experiencing a problem when he uses many of the applications
on his Windows XP computer. He does not have Internet access, but you do. Which of the fol-
lowing should you do? (Choose two. Each answer is part of the solution.)

A

B.
C.
D.

Direct the user to the offline Help and Support Center tools on his computer.
Direct the user to the Microsoft Knowledge Base.
Tell the user to read the error message to you over the phone.

Research the Microsoft Knowledge Base through your computer for information about
the error on his computer.
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Answers to Review Questions

1.

C. You should ask the user about how she will be using the computer and then make your deci-
sion in regard to what software to install on her computer. A Typical installation might install
many programs that she will not use but that could cause problems in the future. Installing only
Word is a short-range solution to the problem. You should not ask the user what she needs
because most users will not know what they need.

A, C. You should use the Microsoft Knowledge Base and the Setup log files to determine more
information about error messages that you receive after installing Microsoft Office. The Com-
puter Management Console and Device Manager will not help you interpret error messages
related to Microsoft Office.

B. You should direct the user to the View menu and then to Text Size to change the size of the
text in Internet Explorer only. The Tools and Edit menus do not have the required option. There
is no Options menu in Internet Explorer.

B. You should ask the user if he is receiving an error message and then use your Internet connection
and the Microsoft Knowledge Base to interpret the error message for him. You do not need his net-
work information since he obviously has connectivity. (He can send and receive e-mail.) Stopping
and restarting the computer probably won’t fix the problem. You should not recommend unin-
stalling and reinstalling Internet Explorer until you have checked the error messages.

D. You should tell her to use the Import/Export tools under the File menu in Outlook Express
to export the e-mail messages and address books from her old computer and import them into
the new computer. She does not have to move the hard drive from the old computer to the new
computer. She does not have to start over. She should not just copy the files.

D. You should look first at the Microsoft Knowledge Base to interpret the error messages.
The Microsoft Knowledge Base has been compiled by experts who have probably experi-
enced the same problems that your user is experiencing. Google, the Microsoft Product Sup-
port Center, and the Help menu in Outlook Express would all be good alternatives for
information, but they should not be your first choice.

D. You should tell the user to select the e-mail with the stationery that she wants and then
choose Save As Stationery from the File menu of Outlook Express. Then she can name the sta-
tionery so it will be made available to her when she composes e-mail. The Edit, View, and Tools
menus do not contain the Save As Stationery option.

A. You should direct the user to the File menu, and then to Properties, and finally to the
Details tab to see the details of the message. You could also direct the user to right-click on
the e-mail and choose Properties. The Edit, Tools, and Message menus do not contain the
required information.

D. You should direct the users to change to a Classic Start menu by right-clicking an empty
area on the Taskbar and then navigating to the Start menu’s properties. You do not have to
reinstall the operating system to change the Start menu’s properties. You should direct them
to right-click an empty area on the Taskbar, not the Desktop.
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10. C, D. You should assist the user by asking him to read the error message to you and then
researching the error message on the Microsoft Knowledge Base with your Internet connection.
You should not direct the user to his own offline Help and Support Center tools. The user will
not be able to access the Microsoft Knowledge Base without Internet access.
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As a desktop support technician, your main job is to make sure
that a user’s computer and applications continue to function well
so that the user can remain productive for your organization. You
should understand that every user utilizes his operating system and applications in a unique
manner; therefore, you can increase the user’s productivity by customizing them for the user or
teaching him to customize them on his own.

The four main components that you can customize are as follows:

Office applications After you have installed the applications that a user needs to do his job,
you can make them easier to learn and easier to use by customizing them. We will discuss cus-
tomizing toolbars to make them easier to use. In addition, we will discuss tools that can enhance
productivity when users are working with multiple languages, such as proofing tools for mul-
tiple languages. We will also discuss how to safely import data to and export data from
Microsoft Outlook and how to repair corrupted data. Finally, we will discuss how to use the
features of Microsoft Office to create a personalized workspace for a user.

Internet Explorer Perhaps one of the most customized applications is a user’s browser. Inter-
net Explorer provides a variety of customization options that let you create a browsing envi-
ronment that fits a user’s needs. We will discuss using and organizing the Favorites tool to make
returning to a website as easy as clicking the mouse. In addition, we will discuss password cach-
ing to enable the browser to automatically enter a previously entered password. Finally, we will
discuss customizing the toolbars in Internet Explorer to create the most efficient browsing envi-
ronment for each user.

Outlook Express When you support users who share a computer, you can personalize the Out-
look Express mailbox, contacts, and personal settings for each user by creating an identity for
each user. We will discuss how to create, modify, and delete identities in Outlook Express. In addi-
tion, we will discuss how to import a user’s e-mail messages and address books into Outlook
Express from another computer and how to export them to another computer. Finally, we will
discuss how to customize the toolbar for each user based on her needs.

The operating system Just as we can customize applications for a user, we can also customize
the operating system so that she can gain access to and use the applications more efficiently. We
will discuss how to customize the Start menu and the Taskbar to meet a specific user’s needs.
In addition, we will discuss how to customize the regional settings for a user based on her loca-
tion. We will also talk about how to customize fonts within the operating system to create a
more comfortable and user-friendly environment for each user. Finally, we will discuss how to
customize folder settings based on the types of files that are stored in the folder and their
intended use.
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Customizing Office Applications

Different users utilize applications in different ways. The way a user utilizes an application may

be due to her role in the organization, her location in world, or many other factors. As a desktop

support technician, you should be able to assist a user to customize her own applications to make

them easier to use. Microsoft Office 2003 contains features that enable you to customize the tool-
bars and personalize the Office environment. You can also install additional proofing tools and

language programs that enable a user to work efficiently with documents in multiple languages.

In addition, you can safely manage Microsoft Outlook data using the tools provided by the appli-
cation in Office 2003. These tools enable you to configure data, import data from other applica-
tions, and export data from Outlook to other applications. You can also use tools to fix Outlook
data if it becomes corrupt. Finally, you can use the extensive Options menu to personalize the soft-
ware for each user. In this section, we will discuss each of these concepts in detail.

Customizing Toolbars

One of the benefits of using Microsoft applications is that there is some standardization in regard
to their control. In other words, the Cut, Copy, Paste, Save, and many other tools are about the
same for Word as they are for Excel or PowerPoint. Although the tools themselves are standard-
ized, the way that we use the tools can be customized.

The method that we can use to customize toolbars varies only slightly across the applications
in Office 2003. We will use Microsoft Word to illustrate this concept, but you should know that
the other applications, such as Excel and PowerPoint, function in very much the same manner.
Figure 8.1 shows Microsoft Word with a blank document and a standard set of toolbars.

FIGURE 8.1 Microsoft Word 2003 with standard toolbars
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You can add toolbars to Microsoft applications to put the tools that the user needs to do her
job in an obvious location on the screen. The types of toolbars that you can add will depend on
the software that you are using and on the other software that is installed on the computer. Even
some non-Microsoft software can produce toolbars in Office 2003 applications. Exercise 8.1
walks you through the steps to add and organize toolbars in Word 2003.

Adding and Organizing Toolbars in Word 2003

1. In Microsoft Word 2003, choose View from the menus at the top of the screen, and then
choose Toolbars. (You can also simply right-click any existing toolbar.)
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EXERCISE 8.1 (continued)

Select the toolbar(s) that you want to add by positioning the mouse pointer on it and click-
ing. The toolbar will be added to the screen in its default location. In this case we will add

the Picture toolbar.
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EXERCISE 8.1 (continued)

3. Ifthe toolbar is floating in the screen, then you can move it to the top, bottom, left side, or
right side to anchor it on its own or with other toolbars.
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If the toolbar is already anchored, then you can click and hold the handle on the left side

of the toolbar and drag the toolbar to any area of the screen. Note that the mouse pointer
changes when the mouse cursor is over the handle.

5. You can also resize the toolbar by clicking and holding it on the right side and “pushing”
toward the left.
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EXERCISE 8.1 (continued)

6.

You can add as many toolbars as a user needs in this manner. This example shows 10
added toolbars. Note that this is an extreme example and you probably would not use this
many toolbars. (You can also add multiple toolbars by choosing Tools » Customize and

then selecting the toolbars.)
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EXERCISE 8.1 (continued)

7. Toremove any toolbar, choose View > Toolbars and then click on the toolbar that you want

Chapter 8 - Resolving Application Customization Issues

to remove. (You can also right-click on any toolbar to see a selection list of all toolbars.)
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If the default selection of toolbars is still not sufficient for a user, then he can create fully custom-
ized toolbars. For example, if a user needs some of the tools from many of the toolbars, but does not
want the clutter of having all of the toolbars on the screen, then he can create his own toolbar that
has only the tools that he needs. Exercise 8.2 outlines the steps to create a custom toolbar.

Creating a Custom Toolbar

1. In Microsoft Word 2003, choose Tools from the menus at the top of the screen, and then
choose Customize.
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EXERCISE 8.2 (continued)

2. Inthe Customize dialog box, choose New and type a name for your new toolbar; then use
the drop-down arrow to choose whether the toolbar will be available only on this docu-
ment or whether it will be added to the normal.dot template to make it available on all
future documents created with this template. Then, click OK to continue. Note that a small
toolbar will appear next to the Customize dialog box when you click OK.
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3. Inthe Customize dialog box, choose the Commands tab and then choose the first category
from which you will gather tools for your new toolbar.
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4. Click, hold, and drag to your new toolbar each tool that you want from the first category,
and then move on to each additional category and do the same. You can scroll through the
categories on the left and through the tools on the right and choose any of the tools in any
category. When you have finished building your toolbar, click Close to remove the Cus-
tomize dialog box. The new toolbar is automatically saved.

=] ampledoc.doc - Microsoft Word L
! Fle Edit View Insert Format Tools Table Window Help Adobe PDF  Acobat Comments Type a question for help X
N EHR G VE SRS -8 3 OEEE S G s * © | QiRead o
- e e —]
I_“_e......y.!...2...,..3......4..,...5...,..'2....,...7. ‘|
_ Customize 283 Ll
Toolhars — Commands | Options ]
To add a command to a toslbar: select a category and drag the command out of
this dizleg bax to & toalbar,
Categories: Commands:
Tools ol
ahic :! &3 veawing
Web ki | Select Objects
(Window end Help iy
Drawing Sy Select Multiple ObjerTs
funshapes &8 Create Test Box Link
Barders ;.
Mail Merge ':.? Ereak Forward Link
Farms
Contral Toolbox LI :.J Nest Text Bax _ﬂ 0
Modify Selection ¥|  Resrrangs Commands... | "
Seva in: (eampledec. doc ﬂ Keyboard... |
-
+
@
*

EBEIB[:LIJ

Sec 1 1 ol REC T
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EXERCISE 8.2 (continued)

5. You can now anchor the new toolbar and manage it in the same manner as all of the other
toolbars.

|-d"-i exampledoc.doc - Microsoft Word

l=J2ES

: Flle Edit View Insert Format Tools Table Window Help Adobe PDF Acrobat Comments

D EHER G0V R T AR e Nes R W IR R R

Type a question for help L

bt w&eddi

G2

<
Ej

Lo

i
Standard
Formatting
AutoText
Control Toolbox
Database
Drawing

E-mall

Forms

Frames

Mail Merge
Outlining

Picture

Reviewing

Tables and Borders
Task Pane

Visual Basic

Weh

Web Tools

Word Count
WordArt
AttachSybexSD
Custom Toolbar
PDFMaker 6.0

| Customize...

B R

Col 1

—

. Y|

L CE G
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Configuring Proofing Tools

If your organization does business in more than one language, then you might want to consider
purchasing the Office 2003 Proofing Tools software, which can be added to Office 2003. These
tools offer a collection of editing technologies that enable a user to proofread and correct doc-
uments in multiple languages. They include spelling and grammar checkers, AutoCorrect lists,
and options. Administrators can choose from a list of languages when installing Proofing Tools,

as shown in Figure 8.2.

If your organization uses only the English language, then all of the proofing tools that you
need are included with the English version of Office 2003. In this section, we will focus on con-
figuring the proofing tools for the English version of Office 2003.
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FIGURE 8.2 A custom installation of Microsoft Proofing Tools for Office 2003

1 Microsoft Office 2003 Proofing Tools Setup |- | [

Microsoft Office 2002 Proofing Tools n
Hr |
4
o
Advanced Customization el mﬁfJ

Choose installation options for applications and tools.

E3

=2 -] Basque 3
=2 -| Bulgarian

_gh_l_d Catalan

57| chinese (Simplified)

9% chinese (Traditional)

63 -] Croatian

3+ Czech

3~ Danish |~

= [=2=|iProofing Tools Kit!

=
i
=
o
=
=

B S I e S S

Description
Proofing tools for use with Microsoft Office.

Space Required on C:6749 KB
Space Available on C:834 MB

| < Back “ Install ] [ Cancel

Spelling and Grammar Checkers

Let’s face it, we are all human and we all make mistakes in spelling and grammar from time to
time—that means you, too! For this reason, the more help that we can get from the application
in regard to spelling and grammar, the better—at least usually. The reason that I say “usually”
is that there are some instances when we know what we want to say or how we want to spell
a word (or an acronym), but the application has not yet been trained to accept our input.
Because of this, spelling and grammar checkers can irritate users who do not know how to con-
figure them properly. The trick is to configure the tool to be flexible to the way that the user
expresses himself, while at the same time maintaining as much accuracy as possible.

In this section, we will discuss how to configure the spelling and grammar checkers for
Microsoft Word 2003. These tools are very similar in the other applications within Office 2003.
You can configure spelling and grammar checking from the Tools menu of Word 2003. Click
the Tools menu at the top of the screen, choose Options, and finally choose the Spelling &
Grammar tab. Figure 8.3 shows the Spelling & Grammar tab in the Options dialog box, which
includes the following settings.
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FIGURE 8.3 The Spelling & Grammar tab of the Options dialog box

Options 2k

Compatibility | File Locations |
View | General ] Edit | Print ] Save | Security |
Spelling & Grammar I Track Changes l User Information |

Spelling

[ Hide spelling errors in this document
[v Always suggest corrections

[~ Suggest from main dictionary only
[ Ignore words in UPPERCASE

[ Ignore words with numbers

[¢ Ignore Internet and file addresses

Custom Dictionaries...

Grammar

[ check grammar as you type Writing style:

[¥  Hids 2 Grammar Qnly -
[ Check grammar with spelling
ST Settings...

-
Check Document

Proofing Tools

||

= Check Spelling As You Type: This setting automatically checks the spelling of each word
that you type against the dictionary or dictionaries that you choose and install. It will indi-
cate a word that is not in the dictionary by placing a wavy red line underneath the word.

= Hide Spelling Errors In This Document: You can use this setting in conjunction with the
Check Spelling As You Type setting to leave the default setting for documents set so that
spelling is checked and the wavy red line is shown, while at the same time hiding the wavy
red line in only the document in which you apply the setting. If Check Spelling As You Type
is not selected, then this setting will be enabled by default.

= Always Suggest Corrections: You can use this setting in conjunction with the Suggest From
Main Dictionary Only setting. If this option is checked, then the system will make recom-
mendations from the dictionary or dictionaries to correct your misspelling.

Suggest From Main Dictionary Only: If you are using multiple dictionaries for reference,
then you can use this setting to limit the recommendations to only your main dictionary.

Ignore Words In UPPERCASE: Often, words that are written in all uppercase letters are

actually acronyms or company names that may not be found in a dictionary. You should
use this setting when the user tends to type many of these kinds of words. This setting is

selected by default when Word 2003 is installed.
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Ignore Words With Numbers: Words with numbers are usually being utilized for a special
purpose and may not be found in a dictionary. You should use this setting when the user
tends to use many words with numbers. This setting is selected by default when Word 2003
is installed.

Ignore Internet And File Addresses: These types of addresses are often used in business but
may not be found in a dictionary. You should select this setting when a user utilizes these
types of addresses. This setting is selected by default when Word 2003 is installed.

Custom Dictionaries: You should click the Custom Dictionaries button to add a new dic-
tionary that you have obtained from the Internet or from a third-party source.

Check Grammar As You Type: When you enable this setting, the application will examine
the words that you type and the context in which you type them against the standard rules
for grammar. When the application does not agree that what you have typed is grammat-
ically correct, it will indicate this by placing a wavy green line underneath the area with
which it has an issue. You can right-click the entry to get suggestions as to how to fix the
grammatical error.

Hide Grammatical Errors In This Document: You can use this setting in conjunction with
the Check Grammar As You Type setting to leave the default setting for documents set so
that grammar is checked and the wavy green line is shown, while at the same time hiding
the wavy green line in only the document in which you apply the setting. If Check Grammar
As You Type is not selected, then this setting will be enabled by default.

Check Grammar With Spelling: You should use this setting when you want the applica-
tion to also check the grammar whenever you specifically select to check the spelling in
a document.

Show Readability Statistics: When you enable this option, the application will automati-
cally display information about the reading level of the document as soon as it finishes a
spelling or grammar check. If you are using multiple languages in a document and multiple
dictionaries, then you should select the text on which you want to perform a spelling or
grammar check. The application can then recognize the language.

Writing Style and Settings: You can use these options to further customize what will be con-
sidered acceptable grammar by the application. You should balance what a user needs to
do his job against the need to maintain the highest level of accuracy in regard to grammar.

Check Document / Recheck Document: If a user has not previously answered “Ignore” on
any spelling and grammar suggestions, then this button will read Check Document. If the
user has answered “Ignore” on even one suggestion, then the button will read “Recheck
Document.” Users can utilize this option to recheck potential errors on which they have
previously answered “Ignore.”
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AutoCorrect Lists and Options

If you are using AutoCorrect, then you may not be as good a typist as you think! The application
might just be changing your misspellings before you ever get a chance to see them. AutoCorrect
is a feature included in Microsoft Word that automatically corrects the most common types of
spelling errors. You can also use AutoCorrect to replace a typed entry with another typed entry.
This is especially useful for users who tend to use the same long phrase or terminology repeatedly.
They can type a much smaller entry and then let AutoCorrect do the rest of the work. Users can
utilize plain text or formatted text to express themselves in their documents. The AutoCorrect set-
tings are located within the Tools menu of Word 2003. Figure 8.4 shows the AutoCorrect dialog
box. Most of the settings are self-explanatory, but you can add in any text and the text with which
you want to replace it. You can choose the Exceptions button to list specific instances when you
don’t want the application to work for you. For example, most of the time it’s handy that the
application will automatically capitalize the next letter after you type a period, but not if you just
typed a word such as appt. within a sentence. Users can use exceptions to “train” and customize
AutoCorrect so that it works better for them.

FIGURE 8.4 The AutoCorrect dialog box

AutoCorrect: English (U.S.) X

AutoCorrect ] AutoFormat As You Type | AutoText | AutoFormat | SmartTags |

[~ Show AutoCorrect Options buttons

[+ Correct TWo Mitial CApitals Exceptions...

[v Capitalize first letter of sentences

[ capitalize first letter of table cells

[¢ Capitalize names of days

[v¥ Correct accidental usage of cAPS LOCK key

[ -Replace ext as you type

Replace: with: (% ]

()
(r)

(tm)

® 1@
L [I»]

[ Automatically use suggestions from the spelling checkar
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This is by no means a complete list of all of the automatic features of Microsoft

P Word 2003 or other Microsoft Office 2003 applications, but only the features
that pertain to proofing the document. To learn more about Word, you should
take a good class on the software or read a good book that walks you through
all of its features. It will be well worth your time.

Managing Outlook Data

When your users utilize Outlook on a daily basis, they may send and receive e-mail using multiple

accounts. This activity will create many contacts, notes, appointments, and so on. This information
is vital to the productivity of the users in your organization. Outlook provides many tools that assist
you in managing this data for users. You can use personal folders to store user information in a cen-
tral location. In addition, you can create Junk E-mail filters to block a user’s receipt of unsolicited

e-mail. You can also configure automatic features that manage and organize messages and archive

data for a user, clearing out the old items in his mailbox. Finally, you can import data into Outlook
from other applications and export data to other applications using the tools built into Outlook. In
this section, we will discuss each of these concepts in detail.

Personal Folders

A personal folder is a data file with a . pst extension that stores information such as messages,
appointments, tasks, and journal entries. The storage limit on these files is set to 20 GB by
default but can be increased to as much as 1 terabyte! Exercise 8.3 shows you how to create a
personal folder in Microsoft Outlook 2003.

Junk E-mail Filters

Unfortunately, many users receive unsolicited advertisements and other unwanted e-mail, called
junk e-mail. Outlook 2003 includes tools that can automatically move junk e-mail to a user’s
Deleted Items folder, Junk E-mail folder, or any folder that you specify. Users can also have
unwanted e-mail delivered to their Inbox but color coded so it’s easy to recognize. Finally, users
can specify that all messages from a particular sender be moved to another folder or deleted. In
this section, we will discuss each of these options in detail.

Setting Junk E-mail Options in Outlook

Outlook 2003 includes a new feature called the Junk E-Mail filter. This tool enables you to
quickly configure a user’s junk e-mail settings and make changes to them whenever necessary.
You can access this tool through the Tools » Options menu of Outlook 2003. The Junk E-mail
Options dialog box includes the following tabs and settings.
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Creating a Personal Folder in Outlook 2003
1. In Microsoft Outlook, choose File > New » Outlook Data File.
2. Inthe New Outlook Data File dialog box, click OK.

"New Outlook Data File X

Types of storage:

Description

Provides more storage capacity for items and folders.
Supports multilingual Unicode data. Not compatible with
Outlook 57, 98, 2000, and 2002.

I 0K ll Cancel |

3. Inthe File Name field, type a name for the file, and then click OK. In this case we used the
username Bob Jones.

Create or Open Outlook Data File @
Saveln: | (2 Outlook ] @ @@ X Cy & - Tools~
=) 2 archive.pst
£y 2 outiook.pst
Desktop

My Decuments

5

My Computer

<

My Netwo...

File name:  [Bob Jones ﬂ _
Save aslype: | personal Folders Files (*.pst) v | m
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EXERCISE 8.3 (continued)

4. In the Create Microsoft Personal Folders dialog box, type the display name for the folder
and the password required to access it, and then click OK.

Create Microsoft Personal Folders E'Zg

File: C:\Documents and Settings\Bill Ferguson.X
Name:  personal Folders - Bob Jones

Format: | Personal Folders File
Encryption Setting

() No Encryption
(8) Compressible Encryption
() High Encryption

Password
Password:
Verify

|:| Save this password in your password list

The new folder will be displayed in Outlook 2003 and can be accessed by the user with the
password. (You can also specify the type of encryption required by your organization.)

All Mail Folders

[ Microsoft
L outbox
L9 Sent Items
8 LY Search Folders
& =9 Archive Folders
= 3§ Personal Folders - Bob Jones
5] Deleted ltems
LY Search Folders

OPTIONS

The Options tab contains the overall settings for filtering junk e-mail. You should configure the
settings based on the amount of junk e-mail that a user is receiving. Remember that a setting
that is too strict might cause the user to miss an e-mail that he actually needs to see. This is
because a user will not always remember to check the Junk E-mail folder. Figure 8.5 shows the
Options tab of the Junk E-mail Options dialog box, which includes the following settings:

*  No Automatic Filtering: Use this tab to have all mail sent to the user’s Inbox.

= Low: Use this setting to move only the most obvious junk e-mail to the Junk E-mail folder.
All other mail will be filtered and then sent to the user’s Inbox.
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= High: Use this setting to detect most junk e-mail. Users should understand that some reg-
ular e-mail also might be accidentally sent to the Junk E-mail folder. Users should check
their Junk E-mail folder regularly when using this setting.

= Safe Lists Only: Use this setting to establish that only e-mail from senders that are listed in
the Safe Senders or Safe Recipients Lists will be sent to the mailbox. All other mail will be
considered as junk e-mail. Users should check their Junk E-mail folder regularly after con-
figuring this setting.

*  Permanently Delete Suspected Junk E-Mail Instead Of Moving It To The Junk E-mail
Folder: You should use this setting only after you have established a reliable system to iden-
tify and manage junk e-mail.

SAFE SENDERS

The Safe Senders tab enables you add users or domains that will never be treated as junk e-mail.
You should add the individuals or domains with which you commonly associate to this list. This
will prevent these users or domains from being accidentally filtered by the Junk E-mail filter.

Figure 8.6 shows the Safe Senders tab. You can use the Import From File and Export To File

options to copy Safe Senders Lists to and from Outlook. The Always Trust E-mail From My

Contacts check box allows all recognized e-mail to be sent to the user’s Inbox. This option is
enabled by default, but you can clear the check box to disable it.

FIGURE 8.5 The Options tab of Junk E-mail Options

Junk E-mail Options 'S?

Options | Safe Senders | safe Recipients | Blocked Senders

L_'_'. Outlook can move messages that appear to be junk e-mail into a special
< Junk E-mail folder.

Choose the level of junk e-mail protection you want:

ONo Automatic Filtering. Mail from blocked senders is still moved
to the Junk E-mail folder.

(&) Low: Move the most obvious junk e-mail to the Junk E-mail folder.

(") High: Most junk e-mail is caught, but some regular mail may be
caught as well. Check your Junk E-mail folder often.

O Safe Lists Only: Only mail from people or domains on your Safe

Senders List or Safe Reciplents List will be delivered to your
Inbox.

[[]Permanently delete suspected junk e-mail instead of moving it to
~ the Junk E-mail folder

OK I [ Cancel
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FIGURE 8.6 The Safe Senders tab of Junk E-mail Options

Junk E-mail Options

Options | Safe Senders Sale Recipients | Blocked Senders

g; E-mail from addresses ar domaln names on your Safe Senders List will
=l naever be treated as junk e-mail.

Speccam

import from File....
Export to File...

[#] Also trust e-mail from my Contacts

274 ] | cancel Apply

SAFE RECIPIENTS

The Safe Recipients tab enables you to add users or domains that will not be considered junk e-mail
if users have sent them an e-mail message and they receive a reply to that message. You should add
the individuals or domains with which you commonly associate to this list. This will prevent these
users or domains from being accidentally filtered by the Junk E-mail filter. Figure 8.7 shows the Safe
Recipients tab. You can use the Import From File and Export To File options to copy Safe Recipients
Lists to and from Outlook.

FIGURE 8.7 The Safe Recipients tab of Junk E-mail Options

Junk E-matl Options X

ﬁ' E-mail sent to addresses or domain names on your Safe Recipients List
= will naver be treated as junk e-mail,

Imgort from File...

ok || cancel || gmy
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BLOCKED SENDERS

The Blocked Senders tab enables you to add individual names or domains that will always be
treated as junk e-mail. You should add names and domains that have been recognized in the
past as junk e-mail senders. Figure 8.8 shows the Blocked Senders tab. You can use the Import
From File and Export To File options to copy Blocked Senders Lists to and from Outlook.

User can quickly add a sender or domain name to these lists by right-clicking
P the message, pointing to Junk E-mail, and then choosing the appropriate list.

Microsoft Outlook Rules

A Microsoft Outlook rule is a set of conditions, actions, and exceptions to use in processing and
organizing messages. Rules help by performing actions automatically based on the conditions of
the rule. For example, a rule could be used to automatically move all messages from a specific

e-mail address into a folder created for only that address. Rules fall into two categories, as follows:

= Organization rules: This type of rule performs one or more actions on a message. You can
create rules that automatically move, forward, and/or highlight messages based on whom
the message is from and what it contains.

=  Notification rules: This type of rule alerts a user when he receives a message with particular
characteristics. Users can utilize these rules to have a message sent to their cellular phone
or pager when they receive an important e-mail.

FIGURE 8.8 The Blocked Senders tab of Junk E-mail Options

Junk E-mail Options Eﬁ

| Options = Safe Senders | Safe Recipiemsi Blocked Senders

& E-mail from addresses or domain names on your Blocked Senders List
&e will always be treated as junk e-mail.

@junk.com
junk@junk.com

Import from File...
Export to File...

OK H Cancel H Apply
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Once you create a rule, it will run automatically. In addition, you can run the rule manually
to selectively apply it to messages that are already in a user’s Inbox or another folder when you
create the rule. If you do not want Outlook to apply your rule all of the time, you can create a
list of exceptions to the rule.

Exercise 8.4 walks you through the steps to create a rule in Outlook.

EXERCISE 8.4

Creating Rules in Outlook 2003

1. In Microsoft Outlook, choose Tools > Rules And Alerts.

2. If the user has more than one e-mail account, choose the Inbox that you want; if the user
has only one account, proceed to Step 3.

3. Click New Rule to open the Rules Wizard.

4. In the Rules Wizard, you can choose to create a rule from a template or start with a blank
rule. Either way, the wizard will guide you through the rest of the process to create your
new rule, by assisting you in selecting a template, editing a rule description, and applying
special conditions if necessary.

5. For example, to automatically move messages from a specific sender to a folder, under
Stay Organized choose Move messages from someone to a folder.

PRules Wizard @

(@)istart creating a rule from a template

(") start from a blank rule

Step 1: Select a template
Stay Organized ||
<i Move messages from someone to a folder
{3 Move messages with specific words in the subject to a folder
5 Move messages sent to a distribution list to a folder
X Delete a canversation
¥ Flag messages from someane with & colored flag
Stay Up to Date
%+ Display mail from someone in the New Item Alert Window
{  Flay a sound when I get messages from someone v
n E

Step 2: Edit the rule description (click an underlined value)
Apply this rule after the message arrives
from people i
move it to the =

Example: Move mail from my manager to my High Importance folder

) [




Customizing Office Applications 303

EXERCISE 8.4 (continued)

6.

Select people or distribution list, then select the user(s) on which you want the rule to
apply, and choose OK.

Select specified folder, and then choose the folder to which you wish to send the mes-
sages, or select New to create a new folder, and choose OK.

Rules and Alerts

Choose a folder:

i Calendar
85| Contacts
# (5] Deleted Items
7| Drafts
_J Fun
= [ ) Inbox
ot T

=]
ﬁ Jour!
" gl Junk E-mail [1]
1 Microsoft
o | Notes
LU Outbox

=] t‘;ii._ﬁersonal Folders [~

U= Sent Items |

8. Apply any specific conditions that are necessary, and then choose Next.

Rules Wizard

5

Which condition(s) do you want to check?
Step 1: Select condition(s)

! from
1 with in the subject
_| through the account

1 sent only to me

1 where my name is In the To box

C] marked as

C] marked as

"1 flagged for

] where my name is in the Cc box

] where my name is in the To or Cc box
] where my name is not in the To box
] sent to

Step 2: Edit the rule deseription (dlick an underlined value)

Apply this rule after the message arrives

from Ar art (Arnold Farr]
and on this machine only
move it to the Arnold folder

i

concel | [ <sack || met> | [ Fnisn
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EXERCISE 8.4 (continued)

9. Selected any additional actions that you want to perform on the e-mail, such as printing it,
for example, and then choose Next.

Rules Wizard ﬁ

What do you want to do with the message?
Step 1: Select a.ction(s)

[ assign it to the category

[ delete it

[7] permanently delete it

maove a copy to the folder =
forward it to

forward it to as an attachment

reply using

flag message for

flag message with

dear the Messzge Flag

mark it as

print it oot

ogoooooodd

Step 2: Edit the rule description (dick an underlined value)
Apply this rule aﬁer the message arrives
from Amold Far
and an this machine uwly
move it to the Amo'd folder

[ concel | [ <ock || med> | [ Finish

10. Configure any exceptions to the rule that apply, and then choose Next.

Rules Wizard @

Are there any exceptions?

Step 1: Select exgeption(s) (if necessary)

D lexcept i from people or distribution list =]
- [ except if the subject contains I
[ except through the acocount

[7] except if sent only to me

| axcept where my name Is in the To box

except if it is marked as

except if it Is marked as

except if it is flagged for

except where my name Is in the Cc box

except if my name is in the To or Cc box

|| except where my name is not in the To box

except if sent to

|| except if the body contains |

oOoooooot

Step 2: Edit the rule description (click an underdined value}
Apply this rule after the message arrives

from Amold Farr {Arnold Farr)
and on this machine only
move it to the Amold folder

[ Cancel ]| < Back ][ Hext > | Finish
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EXERCISE 8.4 (continued)

11. Select Finish to complete the configuration of the new rule and turn the rule on. You can
also select to Run the rule for the messages that are already in the Inbox.

Rules Wizard Eﬂ

Finish rule setup.

Step 1: Specify a name for this rule
Armold Farr (Arnold Farr)

Step 2: Setup rule options

D Run this rule now on messages already in "Inbox™

[+] Turn on this rule

Step 3: Review rule description (click an underlined value to edit)
Apply this rule after the message arrives

from Arnold Farr {Armnold Farr)
and on this machine only
move it to the Arnold folder

Cancel ][ < Back t Finish I

Exercise 8.5 details the steps needed to run an existing rule in Outlook.

Running an Existing Rule in Outlook 2003

1. In Microsoft Outlook, choose Tools > Rules And Alerts.

2. Choose Run Rules Now.
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EXERCISE 8.5 (continued)

3. Inthe Run Rules Now dialog box, select the rules that you want to run.

Run Rules Now @

Select rules to

1
D Sprint Forwarding

Rule Description
Apply to message
forward It to "billfergusonv@hotmail.com"

Run in Folder: | Inbox

[include subfolders

Apply rules to: | Al Messages lise

4. Click Browse to select the folders that contain the messages on which you want to run the
rules. You can also indicate whether you want to include the subfolders within the folders.

5. Click the drop-down arrow to configure the application to run the rule on All Messages,
Unread Messages, or Read Messages.

6. Choose Run Now to run the rules that you have selected.

Archiving Data

Microsoft Outlook 2003 includes a tool called AutoArchive that allows users to archive their data
at specific intervals. AutoArchive is on by default and runs automatically to clear out old and
expired items from folders. You can configure AutoArchive in regard to which folders it clears out
and how often it clears them out. You can configure an overall setting for AutoArchive that
applies to all folders. To locate these settings choose Tools » Options » Other » AutoArchive.
In addition, you can override this setting by applying the AutoArchive settings directly to a folder.
Figure 8.9 shows the AutoArchive dialog box, which includes the following settings:
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FIGURE 8.9 The AutoArchive dialog box

AutoArchive X
gy o
[ Prompt before AutoArchive runs
During AutoArchive:
[] Delete expired items (e-mail folders only)
[] Archive or delete old itams

Show archive folder in folder list
Default folder settings for archiving

14 = days

-

Clean out items older than & <1 [Months _v]
(3) Move old items to:

C:\Documents and Settings\Bill Ferguson.XF

(") Permanently delete old items

[ Apply these settings to all folders now I

To speafy different archive settings for any folder, right-click
on the folder and choose Properties, then go to the
AutoArchive tab.

Retention policy

1,

e i The network administrator has not set retention policies.

I OK II Cancal l

=  Run AutoArchive Every __ Days: This setting configures the interval in days for the auto-
matic running of AutoArchive.

= Prompt Before AutoArchive Runs: When this setting is enabled, the user is prompted that
AutoArchive is about to run.

*  During AutoArchive: This is the main configuration menu that controls which items will be
deleted and which items will be moved. You can also specify the location to which the old
items will be moved.

= Apply These Settings To All Folders Now: Clicking this button automatically applies the
new AutoArchive settings to all folders except those that have their own specific settings.
You can specify settings for a single folder by right-clicking the folder, choosing Properties,
and then choosing the AutoArchive tab.

=  Retention Policy: The network administrator can enter a retention policy that will override
the settings of a user to be certain that information is retained for the length of time
required by the organization.

Importing and Exporting Outlook Data

When a user changes computers or software, you can easily move the important data to and
from Outlook using the built-in Import and Export Wizard. This wizard enables you to safely
import data without damaging or duplicating it in the process.
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Exercise 8.6 walks you through the steps to import data using the Outlook Import and
Export Wizard.

EXERCISE 8.6

Importing Data Using the Import and Export Wizard

1.  In Microsoft Outlook, choose File » Import And Export.

2.

In the Import and Export Wizard, choose Import From Another Program Or File, and then
click Next.

.Irnport and Export Wizard

Choose an action to perform:

Export to a file

Import @ VCARD file (vef)

Impart an iCalendar or vCalendar file (.vcs)
Impaort from anather program or file
Impart Internet Mail Account Settings
Import Internet Mail and Addresses

Description

Import data from other programs or files,
including ACT!, Lotus Organizer, Personal Folders

(.PST), Schedule+, database files, text files, and
others.

| Mext > |l Cancel ]

3. Select the type of file that you want to import, and then click Next.

.lrnport a File

Select file type to import from:

ACT! 3.x, 4., 2000 Contact Manager for Windows |
Comma Separated Values (DOS) [l
Comma Separated Values (Windows) =

Lotus Organizer 4.x 2

Lotus Organizer 5.x il
Microsoft Access |
Microsoft Excel i
| Personal Address Book |2 |

< Back ]I Next > I[ Cancel
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EXERCISE 8.6 (continued)

4. Click Browse, select the file that you want to import from, and then choose one of the
following:

Replace Duplicates With Items Imported: This setting will cause existing duplicate data
to be overwritten by the data that is being imported.

Allow Duplicates To Be Created: This setting will allow duplicate data to be added to the
Outlook folder.

Do Not Import Duplicate Items: This setting will prevent duplicate data from being cop-
ied into the folder during import. The existing data will be retained.

Import a File

File to import:

Options

Q Replace duplicates with items Imported
(3) Allow duplicates to be created

(") Do not import duplicate items

< Back axt Cancel

5. Click Next, and then select the folder into which you want to import the data.

6. If necessary, map the fields from the file that you are importing to the Outlook fields, and
then click Next.

7. Click OK to import the data.

Exercise 8.7 explains how to export data using the Outlook Import and Export Wizard.

EXERCISE 8.7

Exporting Data Using the Import and Export Wizard
1. In Microsoft Outlook, choose File > Import And Export.

2. Inthe Import and Export Wizard, choose Export To A File, and then click Next.
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EXERCISE 8.7 (continued)

3. Select the type of file that you want to export to, and then click Next.

Export to a File

Create a file of type:

Comma Separated Values (00S) d
Comma Separated Values (Windows)

Microsoft Access

Microsoft Excel

Personal Folder File (.pst)

Tab Separated Values (DOS)

Tab Separated Values (Windows)

[ < Back " Mext = |[ Cancel ‘

4. Follow the remaining instructions of the wizard; these will vary based on the type of file
that you choose.

Repairing Corrupt Data

Office 2003 has a tool called the Inbox Repair Tool that you can use to repair corrupted .pst
files. The Inbox Repair Tool, also called Scanpst. exe, is installed automatically during setup.
You can typically find the Scanpst.exe file at the following location:

C:\Program Files\Common Files\System\MSMAPI\1033\Scanpst.exe.

The Inbox Repair Tool scans . pst files to verify that the file structure is intact. When it dis-
covers problems, it attempts to repair the corrupt items. Exercise 8.8 shows you how to scan a
.pst file with the Inbox Repair Tool.

EXERCISE 8.8

Using the Inbox Repair Tool

1. Click Start and then choose Run.

2. OntheRunline, type C:\program files\common files\system\msmapi\1l033\scanpst.exe
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EXERCISE 8.8 (continued)

3. Inthe Inbox Repair Tool dialog box, enter the name of the .pst file that you want to scan.
44 Inbox Repair Tool L:J ] E_:%
Enter the name of the file you want to scan:

| Browse...

Close [ Options... |

4. Choose Options to specify scan log options, or just click Start.

5. If errors are found during the scan, then you will be prompted to start the repair process. If
so, click Repair.

Customizing Internet Explorer

Each user utilizes her Internet Explorer browser in a slightly different manner. You can assist
the user in customizing her browser so it fits her own needs. This might include using timesaving
features such as saving a password for a site so she doesn’t have to remember it or organizing
links to her favorite websites so that they are easier to find. You can also customize the toolbar
in Internet Explorer to create a user-friendly workspace for the user. In this section, we will dis-
cuss each of these concepts in detail.

Saving a Password for a Website

When a user attempts to access a website that requires secure access, she has to type her pass-
word. You can enable the system to remember the password so she doesn’t have to type it again
when she uses the same computer. This password caching is on by default and can be controlled
in the AutoComplete settings on the Content tab of Internet Options, as shown in Figure 8.10.

ING caching. You can disable password caching, but it requires using the Registry

ﬁl‘ Some organizations may have security policies that do not allow password
Editor or the Internet Explorer Administration Kit (IEAK).
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FIGURE 8.10 The password caching option in AutoComplete

AutoComplete Settings ? @
AutoComplete lists possible matches from entries you've
typed before.

Use AutoComplete for
Web addresses
Forms

[¥]User names and passwords on forms
O Prompt me to save passwords

Clear AutoComplete history

[ Clear Forms: J [ Clear Passwords J

To clear Web address entries, on the General tab in
Internet Options, click Clear History.

oK | ’ Cancel

Organizing Favorites

Favorites are simply Internet shortcuts that point to websites that the user wants to access fre-
quently and quickly. You can assist the user in organizing her favorites in order to put the tools
that she uses on a daily basis at her fingertips. To organize favorites in Internet Explorer, you
should choose Favorites » Organize Favorites. Figure 8.11 shows the Organize Favorites dialog
box, which includes the following buttons:

= Create Folder: This button creates a new folder. You should give each folder a unique name
based on the shortcuts that are in the folder.

= Move To Folder: You should select the shortcuts that you want to move and then click this
button. You can then select the folder to which to move the shortcuts. You can also drag
and drop the shortcuts.

= Rename: You should use this button to rename a shortcut or a folder.

= Delete: You should use this button only if you want to permanently delete a folder or a link
from Favorites. The system will ask you for confirmation and, if you answer “Yes,” the
item will be moved to the Recycle Bin.

TE Most operations can be performed by right-clicking the item that you want

% You can also organize favorites within the Internet Explorer Favorites menu.
to manage.



Customizing Internet Explorer 313

FIGURE 8.11 The Organize Favorites dialog box

&) Organize Favorites

To create a new folder. click on the Create

Folder button. To rename or delete an D Business *
item, selectthe tem and click Rename or =i Links
bk (= Personal
l Create Folder | l Bename | I Sybex
[ Move to Foider.. | Delete ] [=© Microsoft

&) 323380 - HOW TO Configure D.
Unfiled

&l American Express Bil
&] AubumTigers.com - Schedule

Favarites Folder

Modified: &) AubumTigers.com - The Offici...
3/6/2003 12:58 PM =
&l Beyond Contacts - Quick Tips
E] Bible Gateway

&] Cisco - Simulation Demo

&) Cisco Connection Documentati,,| %

Close

Customizing the Internet Explorer Toolbar

Different users utilize different tools in Internet Explorer. Some users may never use some of the
tools that are included in the Standard toolbar. In that case, they are just getting in the user’s
way. Other users may perform an action for which there is no tool in the Standard toolbar,
thereby doing it the hard way. You can assist the user in customizing his toolbar to fit his own
needs. To customize the toolbar in Internet Explorer, right-click the Standard toolbar and then
choose Customize. Figure 8.12 shows the Customize Toolbar dialog box, which includes the
following settings and options:

Available Toolbar Buttons: This is a list of all of the buttons that are available for use in
Internet Explorer.

Current Toolbar Buttons: This is a list of all of the tools that are currently installed and the
order in which they are displayed, including separators.

Add/Remove: These buttons enable you to add and remove tools to create a custom
toolbar.

Reset: This button restores the default set of tools that were installed.

Move Up/Move Down: These buttons enable you to reorganize the order in which the tools
will be displayed.

Text Options: This setting controls the display of text shown with the tool icon.

Icon Options: This setting controls the size of the icons for the tools. There are only two
sizes: large and small.
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FIGURE 8.12

Customize Toolbar
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The Customize Toolbar dialog box

()
X

Available toolbar buttons:

Curment toolbar buttons:

Separator ~ Separator B
¥ Map Drive I Mail
¥ Disconnect < Print
Folders = EEdit
& Full Screen Discuss |
A Size <- Remove R h |
% Cut 4 Messenger 3
o | v
Th Paste £ (ool (MoveDowp
Text options: ESeIectjve text on right L!
Icon options: Small icons q

Customizing Outlook Express

When more than one person uses a computer for e-mail messages, you can create an identity for
each user so his messages will go into his own Inbox. In addition, when a user changes com-
puters, you can easily and safely import his messages and address books to another computer
using the tools built into Outlook Express. You can also assist each user in creating a custom-
ized look and feel in Outlook Express by modifying the standard toolbar. In this section, we will
discuss each of these topics in detail.

Outlook Express Identities

You can create an identity for each user who utilizes Outlook Express e-mail on a computer.
Once the identity is created, a user can build his own hierarchy of folders that he will be able
to see and use each time he logs on to the computer. Each identity can also have its own per-
sonal settings such as tools, fonts, and so on. You can also manage the identities on the com-
puter for each user and delete identities when they are no longer required. In this section, we
will discuss each of these subjects in detail.

Creating an Identity

Usually, you will create identities from inside Outlook Express. You should create a new
identity for each user of the same computer. Exercise 8.9 walks you through the steps to cre-
ate an identity.
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EXERCISE 8.9

Creating an Identity
1. In Microsoft Outlook Express, choose the File > Identities » Add New Identity.

2. Type the name of the new user. In this case, Sam Spade.

‘New Identity @
]den?'rty

%a Type your name:  Sam Spade

Password

f% You can require a password for this identity. This provides a
E moderate level of sacurity. However, other users may still be able to
see your data. For information about security, dick Help,

|| require a password

3. If you want to require a password for this identity, select Require A Password and then
enter and confirm the password.

Enter Password E]

HNew LTI

Confirm New sessanee
rovides a

— lay still be able to
Fielp.

IE Require a password

Halp
o)

4. Click OK. The system will ask you if you want to switch to the new identity that you
created. You can answer “Yes” to switch to the new identity or “No” to remain on the
identity that you used to create the new identity.

Managing and Deleting Identities

Outlook Express provides tools to assist you in managing multiple identities. You can find these
tools on the File menu. Choose Identities » Manage Identities. Figure 8.13 shows the Manage
Identities dialog box, which contains the following options and settings:

= Identities: This is a list of all of the identities that are currently in the computer.

= New: You can click this button to create new identities from the Manage Identities dialog box.
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=  Remove: You can click this button to delete an identity that is no longer required. You can-
not delete an identity that is currently being used.

= Use This Identity When Starting A Program: You can click the drop-down arrow and then
select the default identity that will be used when programs that are identity-aware are started.
If you leave this option unchecked, then the user will be prompted to choose the identity.

»  Use This Identity When A Program Cannot Ask You To Choose An Identity: You can click
the drop-down arrow and then select the default identity that will be used when a program
is not identity-aware.

FIGURE 8.13 The Manage Identities dialog box

"Manage Identities ﬁ

To add a new identity, dick New. To modify an identity,
select it, and then click Properties. To delete an identity,
select it, and then click Remove

Identities:

Bill Ferguson Slas

Bill Gates

Sam Spade

Use this identity when starting a program

|_BII[ Ferguson e

Use this identity when a program cannot ask you to choose an
identity

Bill Ferguson | % I

Import and Export Tools

When a user changes computers or changes software, the last thing that she wants to have to do
is start all over again in regard to messages, address books, and settings in Outlook Express.
You can assist a user in safely exporting the data from the old system and importing the data
to the new system. Table 8.1 lists the types of data and settings that you can import into Out-
look Express. You can also export address books and messages from Outlook Express to other
e-mail programs. You should use the Import and Export Wizard located on the File menu of
Outlook Express. The wizard will guide you through the process of importing and exporting all
types of data and settings.
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sl You should know that using a password provides only a minimal level of secu-
ING rity. It keeps users from using your identity, but it does not keep them from
viewing your files.

TABLE 8.1 Dataand Settings That Can Be Imported into Outlook Express

Item Details

Address books from Microsoft and other You can import address book data that uses a
products comma separated value (CSV) format.
Messages from other e-mail programs You can import messages from Microsoft Out-

look and older versions of Outlook Express.

E-mail account settings You can import most, if not all, of the custom-
ization settings such as fonts, mailbox set-
tings, and so on.

Newsgroup account settings You can import your subscription settings
from other Outlook Express programs.

Customizing the Outlook Express Toolbar

As with Internet Explorer, different users will use Outlook Express in very different ways. The
Standard toolbar might contain some tools that a user will never utilize. By the same token, the
user might be performing tasks the hard way because he is not aware of a tool that would help
him perform them faster. You can assist a user in creating a customized toolbar that fits his
needs. You should begin by right-clicking the current toolbar in Outlook Express and then
choosing Customize. Figure 8.14 shows the Customize Toolbar dialog box for Outlook
Express, which contains the following settings and options:

= Available Toolbar Buttons: This is a list of all of the buttons that are available for use in
Outlook Express.

= Current Toolbar Buttons: This is a list of all of the buttons that are currently installed and
the order in which they are displayed, including separators.

= Add/Remove: These buttons enable you to add and remove tools to create a custom toolbar.
= Reset: This button restores the default set of tools that were installed.

=  Move Up/Move Down: These buttons enable you to reorganize the order in which the tools
will be displayed.

= Text Options: This setting controls the display of text that appears with the tool icon.

= Icon Options: This setting controls the size of the icons for the tools. There are only two
sizes: large and small.
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FIGURE 8.14 The Customize Toolbar dialog box in Outlook Express

Customize Toolbar
Available toolbar buttons: Currenttoolbar buttons:
Separatar o [ '}_ Create Mail ! o
Tj’ Cancel & 80‘ Reply |
1) Decode G Reply Al 1
v Contacts +8 Forward
ol <-Remove 8
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,E;, Encading i Print
=l Falder | et & N Nalata |v
TextOptions:  Selective text on right X |
lcon Options: Large lcons T]

Customizing Windows XP Settings

Windows XP has many features that allow you to customize an environment for users. In
Chapter 7, “Resolving Issues Related to Usability,” we discussed basic configuration of the
Start menu and Taskbar. You can also further customize each of these components for a specific
user’s needs. In addition, you can configure and customize regional settings to adapt the com-
puter to users from all over the world. You can also customize the font that the operating system
uses for each user who logs on to a computer. Finally, you can customize folder settings to make
it easier to use the specific types of files that are stored in a folder. In this section, we will discuss
each of these concepts in greater detail.

Customizing the Start Menu and Taskbar

Both the Start menu and the Taskbar in Windows XP have two levels of settings: general and
customized. In Chapter 7 we discussed the general settings for each of these tools. In this chap-
ter, we will discuss how to further customize each of these tools for an individual user.

Customizing the Start Menu

The Start menu in Windows XP is the first tool that most people use to find the programs
that they need. You can customize the look and feel of the Start menu for an individual user.
You should begin to customize the Start menu by right-clicking on an empty area of the
Taskbar and then choosing Properties. You should select the Start Menu tab, as shown in
Figure 8.15.
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The Taskbar and Start Menu Properties dialog box

T T T O

| Taskba | Start Menu |

@8 u
Selectthis menu style for easy access to the
Internet, e‘mail, and your favonte programs.

() Classic Start manu
Select this option to use the menu styls from earlier
wversions of Windows.

o J[

Cancel

To customize the Start menu options, click the Customize button. This will open a new dia-
log box that contains two additional tabs, General and Advanced, as shown in Figure 8.16. In
this section, we will discuss each of these tabs in detail.

FIGURE 8.16 The Customize Start Menu dialog box

| General Advanced|

Selectan icon size for programs

E:‘ (O Large icons 51
Programs
The Start menu contai to the prog
Clearing the list of shortcuts does not delete the programs

MNumber of programs on Start menu:
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Show on Start menu

you use most often.

| Internet Explorer

[ Intemnet

Eai [Microsof Office Outiook

™

OK

[ Cancel
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General

The General tab of the Customize Start Menu dialog box contains settings that control the size
of the icons that the user will see and how many shortcuts will be created and remembered in
the Start menu. You can also select the Internet and E-mail program that will be shown on the
Start menu when there is more than one program of that type in the computer. The General tab
contains the following options:

= Select An Icon Size For Programs: You have two choices: large or small.

= Programs: You should use this setting to determine the number of shortcuts that will be
remembered on the Start menu. The number that you use should balance making programs
available to the user with having less clutter in the Start menu. You can also clear the mem-
ory by clicking the Clear List button.

= Show On Start Menu: You should use the drop-down arrow to indicate which Internet and
E-mail programs you wish to show on the user’s Start menu when the computer has more
than one of these types of programs.

Advanced

The Advanced tab of the Customize Start Menu dialog box contains more detailed settings for
many of the components of the Start menu. You can also configure the system to remember the
documents that users have recently used so that they can return to them faster. Figure 8.17
shows the Advanced tab, which contains the following options and settings:

= Start Menu Settings: These settings include the options to open submenus when the user
pauses on them with the mouse and to highlight newly installed programs for users.

= Start Menu Items: These settings enable you to fine-tune the way that items such as the
Control Panel, My Documents, My Music, and so on are shown in the Start menu.

= Recent Documents: This setting enables users to utilize My Recent Documents from the
Start menu to get faster access to documents that they have recently used and then closed.

FIGURE 8.17 The Advanced tab of the Customize Start Menu dialog box
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Customizing the Taskbar

When configured properly for a user, the Taskbar in Windows XP can be a control and information
center. In Chapter 7, we discussed general configuration of the Taskbar. In this chapter, we will dis-
cuss customization of the Taskbar to show or not show items in the Notification Area. Notification
Area icons can give a user information about hardware and software installed in and running on his
computer. The type of information given by the icon varies based on the type of icon.

To begin to customize the Notification Area of the Taskbar, you should right-click on an
empty area of the Taskbar and then choose Properties. Then choose the Taskbar tab and select
Hide Inactive Icons (at the bottom of the dialog box). When you select this option, the Custom-
ize button will become active, as shown in Figure 8.18. You should then click Customize to
open the Customize Notifications dialog box and begin to configure the Notification Area.

The Customize Notifications dialog box enables you to configure the type of icons that will
be shown in the Notification Area of the Taskbar and under what circumstances they will be
shown. As shown in Figure 8.19, each icon can be configured for the following settings:

=  Hide When Inactive: Use this setting for hardware or software that is rarely used but might
sometimes be needed.

= Always Hide: Use this setting when the presence of the icon in the Notification Area has no
value to the user.

= Always Show: Use this setting for items that show critical information about hardware or
software. For example, a Notification Area icon can show a user that she has a connection
with a universal serial bus (USB) device.

FIGURE 8.18 The Taskbar tab of the Start Menu and Taskbar Properties dialog box

’.Taskbar and Start Menu Properties L?Jm

| Taskbar [S‘f_gr[ Menu

Taskbar appearance

[ Lock the taskbar

[V] Auto-hide the taskbar

[Vl Keep the taskbar on top of other windows
Group similar taskbar buttons

[¥] Show Quick Launch

Notification area

[¥] Showi the clock

You can keep the notification area uncluttered by hiding icons that you have
not clicked recently.

[¥] Hide inactive icons

OK ]I Cancel H Apply ]
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FIGURE 8.19 The Custom Notifications dialog box
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Customizing Regional Settings

In Chapter 4, “Configuring and Troubleshooting the Desktop and User Environments,” we dis-
cussed regional settings and performed an exercise in which we selected additional input lan-
guages. By choosing the region, we chose how the operating system would treat dates, times,
numbers, and so on. You may have noticed that there was also a Customize button on the
Regional Options tab. In this section, we will discuss how to further customize the Regional
Options in Windows XP.

You should begin to customize the Regional Options by opening Regional and Language
Options through the Control Panel. The first tab of the Regional and Language Options dialog
box is Regional Options, as shown in Figure 8.20. It enables you to configure the correct set-
tings for most users in most regions.

Click Customize to begin to customize the options for any selected region. This will open the
Customize Regional Options dialog box, as shown in Figure 8.21. The settings that you can cus-
tomize on the four tabs are as follows:

= Numbers: This tab allows you to customize how positive and negative integers are dis-
played and how digits are separated.

=  Currency: Here you can customize the currency symbols that are used in a specific region.

= Time: You can customize how times are displayed in the operating system and in applica-
tions that get this information from the operating system.

= Date: This tab lets you customize how dates are displayed in the operating system and in
applications that get this information from the operating system.
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FIGURE 8.20 The Regional Options tab of the Regional and Language Options dialog box
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FIGURE 8.21 The Customize Regional Options dialog box
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Customizing Operating System Fonts

It stands to reason that users will generally be more productive if they can read what is on their
screen! In addition, you can increase user satisfaction and productivity by making the fonts that
the operating system uses more pleasing to the user. What is pleasing varies by user, but you can
control three main settings that affect the fonts: Appearance, Advanced Appearance, and DPI.
In this section, we will discuss each of these setting in detail.

Appearance Settings for Fonts

Windows XP makes it simple to change the size of the fonts used by the operating system.
Rather than having to choose the size of each font on each type of menu, you can simply con-
figure the system to use larger fonts, versus the normal font size, on every menu. You can adjust
the size of all fonts by right-clicking the Windows XP Desktop, choosing Properties, and then
choosing the Appearance tab, as shown in Figure 8.22. Then click the Font Size drop-down
arrow to adjust the fonts to normal, large, or extra large.

Advanced Appearance Settings for Fonts

If there are specific items or menus on which users would like to have a larger font or a different
font style, then you should click the Advanced button on the Appearance tab of the Display
Properties dialog box. The Advanced Appearance dialog box enables you to control the size and
type of font for many areas of the Desktop and its associated icons, windows, and menus, as
shown in Figure 8.23. You will generally use this setting to fine-tune the overall settings.

FIGURE 8.22 The Appearance tab of the Display Properties dialog box

tﬁsplay Properties @ﬁ

| Themes | Desktop | Screen Saver | Appearance .Senjngs

.Active Window

[Window Text

Windows and buttons:

|Windows XP style

x|

Color scheme:

E]

I Silver

Font size:

I 0K l ’ Cancal ]

]

| Normal




Customizing Windows XP Settings 325

FIGURE 8.23 The Advanced Appearance dialog box
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DPI

Dots per inch (DPI) is a standard that is used to indicate how crisp and readable a font will
appear. Sometimes a user needs to utilize a very high screen resolution, which makes the

fonts very small, in order to view an entire application on the screen. When this is the case,
you can increase the readability of the fonts by increasing the DPI setting. This setting will
also slightly increase the size of the font. Exercise 8.10 outlines the steps to adjust the DPI
setting for all fonts in Windows XP.

EXERCISE 8.10

Configuring the DPI Setting for Fonts

1. On the Windows XP Desktop, right-click and then choose Properties.

2. Onthe Display Properties dialog box, choose the Settings tab and then choose Advanced.
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EXERCISE 8.10 (continued)

3. Onthe dialog box for your video card, choose the General tab. The name of this box will
vary based on the type of video card on your computer.

NEC MultiSync XV17+ (-2) and NVIDIA GeForce2 MX/MX 400... | 2 .4

| General | Adapter | Monitor | Troubleshoot | Color Management |

|

| Display

lf your screen resolution makes screen items too small to view comfortably,

you can increase the DPlto compensate. To change font sizes only. click
| Cancel and go to the Appearance tab

DPI setting:

| Large size (120 DPI) | %
1l size (36 DPI)

Large size (120DP0
Custom seffing..

Compatibility

Some programs might not operate properly unless you restart the
computer after changing display seftings

After | change display seftings:

() Restartthe computer before applying the new display settings
(@) Apply the new display settings without restarting

| () Ask me before applying the new display settings

Some games and other programs must be run in 256-color mode. Leam
| more about (unning programs in 256-color mode.

I OK ] | Cancel ‘

4. Usethe drop-down arrow to adjust the DPI setting for all screen items including fonts, and
then click OK or Apply. You will be required to restart the computer before all of the set-
tings can take effect.

Customizing Folder Settings

Computer users work with many different types of files in many different ways. Some tools that
are very helpful for some types of files do not apply at all to other types of files. For example,
if you are working with audio or video files, then it might be useful to have an indicator of the
length of time that the audio or video file runs; however, for any other type of file, this infor-
mation would not apply. For this reason, Windows XP enables users to customize a folder so
that it contains the tools that are useful for the files that it contains. Exercise 8.11 explains how
to customize a folder for a user.
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Creating a Customized Folder
1. In Windows XP, right-click the Start button and then choose Explore.
2. Select the folder that you want to customize.

3. Choose the View menu at the top of the screen and then choose Customize This Folder.
(You can also use the View menu in My Documents.)

\View Favorites Tools Help
Toolbars »
Status Bar
Explorer Bar L4

Thumbnails
Tiles

Icons

List

Details

Arrange Icons by L4

Choose Details...
Customize This Folder...

Go To 4
Refresh

4. In the properties of the folder, from the Use This Folder Type As A Template drop-down
list, select the type of folder that will work best with the files that your folder contains.

.My Videos Properties @

General | Sharing | Security | Customize |

What kind offolder do youwani?
Use this folder type as a template:

Documents (for any file type) A
Documents (for any file type)
Piclures (best far many fileg)
Photo Album (best for fewer files)
Music (best for audio files and playlists)
Music Artist (best for works by one arisl)
Music Album (best for racks from one album)
ideos

contents.
[
Choose Picture.
Restore Default

Foldericons

For all views except Thumbnails. you can change the standard
“folder" icon to another icon

Change lcon.. ___,J'

I QK | | Cancel |
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EXERCISE 8.11 (continued)

5. Choose any picture that you have in the computer to represent the folder by browsing for
the picture.

6. Choose any icon to represent the folder and make it stand out within Windows Explorer.

Change Icon for My V... lﬂ@

Look for icons in this file:

yetemRootse\system32\SHELLIZ.d

Select an Icon from the list below:

Ho @B T 2
EE-EL" LTI d IF:
O8e®L 9, G
I-LPne@ s

fal.o 2

l Restore Defaults ‘ [ Ok l I Cancel

Take the Time to Customize Folders

One of the nicest new features of Windows XP is the ability to customize folders. | doubt that
most people take advantage of all that this feature has to offer. Depending on the types of files
that are contained in the folder, you can really add some convenient tools.

I tend to work with lots of pictures, so the options to customize the folder for pictures and even
for a photo album are of great value to me. They give me the tools to view a slide show and man-
age the pictures in a much more organized manner. I've also used the customization option for
music files to have the ability to quickly play and control the files. Customizing for videos gives
me the capability to control the videos in the Windows XP software. I've also found the custom-
ized icons for folders to be a handy way to make folders stand out when needed.

| guess it's one of those things that is not urgent, so most people don’t think it's important
either. That’s probably why a lot of people aren’t taking advantage of it. You could be the one
who shows them the way it's done! Do yourself a favor and take the time to experiment with
customizing folders. I'm sure that you will find new ways to increase your productivity as well
as the productivity of the users whom you serve.
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) You can also customize folders in the same manner using the My Docu-
TE ments tool.

Summary

The productivity of most users can be increased if their tools are customized for the tasks that
they are performing. As a desktop support technician, you should know how to assist a user in
customizing the applications that he uses most often. In particular, you should know how to
customize Office 2003 applications, Internet Explorer, and Outlook Express. In addition, you
should know how to assist the user in customizing the Windows XP operating system so that
he can find and manage applications and data in the most efficient manner.

The most commonly used applications in the world are those in Microsoft Office. Each user
utilizes Office for his own reasons and in a slightly different manner than other users. For this rea-
son, Microsoft Office 2003 has features that allow it to be customized to fit a user’s needs. You
should know how to customize the standard toolbars in Office 2003 applications and how to cre-
ate new custom toolbars for the user. You should also know how to assist a user to configure and
train proofing tools such as spelling and grammar checkers and AutoCorrect. In addition, you
should know how to manage Microsoft Outlook data by creating and managing personal folders.
You should also know how to help the user manage his Outlook e-mail by configuring a Junk
E-mail filter and rules that automatically manage messages. Finally, you should know how to
attempt to repair corrupted Outlook data using the Inbox Repair Tool in Office 2003.

Each user can utilize Internet Explorer in a unique manner. This is because Internet Explorer
has many features that can be customized for each user. You should be able to assist the user
in customizing features that will save her time. In particular, you should be able to configure
password caching for secure sites so that the user does not have to remember and enter pass-
words for sites where she has already been authenticated. You should also be able to assist her
in organizing her Favorites menu so she can easily access websites that she uses frequently.
Finally, you should be able to assist her in customizing her Internet Explorer toolbar so that it
contains all of the tools that she needs and only the tools that she needs.

Outlook Express can be used as the e-mail program for multiple users on the same computer.
Each user can have his own Inbox folder and can create his own folder hierarchy. This is accom-
plished by creating a separate identity for each user. You should know how to create and man-
age identities for users and how to delete identities when they are no longer required. You
should also know how to import messages and address books from other e-mail programs into
Outlook Express and how to export them from Outlook Express to other programs or com-
puters. Finally, you should know how to customize the Outlook Express toolbar so that it con-
tains all of the tools that a user needs and only the tools that he needs.

Windows XP is the most customizable Microsoft operating system to date. You should know
how to customize the Start menu and Taskbar to put the tools that users need right at their fin-
gertips. You should also know how to customize Regional Settings for users to configure the
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operating system and application for use in many different areas of the world. In addition, you
should know how to customize operating system fonts to make the font more legible and pleas-
ing to a user. Finally, you should know how to customize folders based on the types of files that
are contained in them.

Exam Essentials

Know how to customize and manage toolbars and create custom toolbars. You should know
how to customize the toolbars in Windows XP, Internet Explorer, and Outlook Express. You
should also know how to create custom toolbars in Office 2003 applications, such as Word 2003.
Finally, you should know how to manage toolbars on the screen in Office 2003 applications.

Be able to configure proofing tools. You should know how to configure the spelling and
grammar-checking tools in Office 2003 applications. You should also know how to install the
Microsoft proofing tools for Office 2003 and configure them for multiple languages. Finally,
you should know how to configure the AutoCorrect option in Office 2003 applications, such
as Word 2003.

Know how to manage Outlook data. You should know how to create personal folders in
Outlook 2003. In addition, you should be able to configure Junk E-mail filters to protect a user
from unsolicited e-mail but let the regular e-mail get through to his Inbox. You should also
know how to use the Rules Wizard to configure rules that manage messages automatically.
Finally, you should be able to use the Inbox Repair Tool to attempt to repair a corrupt . pst file.

Be able to customize Internet Explorer. You should know to configure Internet Explorer for
password caching to save a user from having to authenticate to a secure website after he has
already authenticated once. You should also know how to organize the Favorites feature to save
a user time when accessing frequently used websites.

Understand how to create and manage identities in Outlook Express. You should know
how to create an Outlook Express identity for each user of a computer. In addition, you should
be able to manage the identities and change properties when necessary. Finally, you should
know how to delete the identities when they are no longer necessary.

Know how to import and export messages and mailboxes in Outlook Express and Outlook.
You should be able to use the Import and Export Wizard in Outlook Express and Outlook to
move messages and mailboxes from one computer to another. You should be able to use the
wizard to move many different types of files.

Know how to customize Windows XP. You should know how to customize the Start menu
and Taskbar in Windows XP. In addition, you should be able to customize Regional Settings for
users around the world. You should also know how to customize fonts in the Windows XP
operating system. Finally, you should understand how to customize folders to work the best
with the files that they contain.
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Review Questions

1. You are the desktop support technician for your company. A user has asked you how to create
a custom toolbar in Microsoft Word with only the tools that he needs. Which of the following
items shows the first two steps to create the new toolbar?

A. Choose Tools » New.
B. Choose Tools » Toolbars.
C. Choose Tools » Customize.
D. Choose Tools » Options.
2.  You are the desktop support technician for your company. A user complains that someone has
opened so many toolbars in Word that she can hardly see the document anymore. You want to

help her remove all of the toolbars except for the Standard toolbar. Which of the following
options is the easiest method of accomplishing this task?

A. Right-click on each toolbar and then choose Close.

B. Choose Tools » Customize, and then remove all of the toolbars except the Standard
toolbar from the list in the Toolbars tab.

C. Right-click on each toolbar and then deselect it from the list of active toolbars.
D. Right-click on any toolbar, hold down the Shift key, and deselect all of the toolbars
except the Standard toolbar.

3.  Youare the desktop support technician for your company. A user complains that he doesn’t like
Word because it thinks it’s smarter than him. You ask him to elaborate, and he says that it’s
always trying to capitalize the next character after a period and a space, so when he types an
abbreviated word such as etc. in the middle of a sentence, he has to fight with Word to keep the
next letter in lowercase. Which of the following options would fix his problem? (Choose two.)

A. Create a custom dictionary.

B. Adjust the spelling and grammar checker options in Word.

C. Remove the check mark from Capitalize First Letter Of Sentences in AutoCorrect.

D. Create an exception in AutoCorrect for each of the words that are creating the problem.
4. You are the desktop support technician for your company. A user complains that she has to use

many acronyms and the spell checker in Word is always bothering her about the acronyms. She

has added some of them to her dictionary, but there are too many of them, and it’s an ongoing
battle. What should you tell her to do that will fix the problem?

A. Create an exception for each acronym that she uses.

B. Replace the Correct Two Initial Capitals check mark that has been removed from the
AutoCorrect options.

C. Turn off grammar checking.

D. Replace the check mark that has been removed from Ignore Words In UPPERCASE in
the Spelling & Grammar options.
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You are the desktop support technician for your company. A user complains that she is receiving
a lot of unsolicited e-mail in Outlook 2003 that just clogs up her mailbox. What should you do
to help the user?

A. Ask the administrator to change her username on the network servers.
B. Install a firewall on her computer to block all unsolicited e-mail.

C. Configure the Junk E-mail filter to send unsolicited e-mail to the Junk E-mail folder
instead of her mailbox.

D. Configure the options on her browser to block all unsolicited communication.
You are the desktop support technician for your company. A user would like to receive a phone

call automatically if he receives an important e-mail from a specific e-mail address. What feature
of Outlook 2003 will enable you to configure this option for the user?

A. Organization rules

B. Personal folders

C. Import and Export Wizard

D. Notification rules

You are the desktop support technician for your company. A user complains that after having

installed a security update, his Outlook does not work at all. You suspect that the .pst file has
become corrupt. Which tool should you use to troubleshoot the problem?

A. The Inbox Repair tool

B. The AutoCorrect tool

C. The AutoArchive tool

D. The scanstate.exe tool

You are the desktop support technician for your company. A user asks you if there is any way

that he can avoid remembering all of the passwords that he has to use for secure sites that he
accesses frequently from his Desktop. Which feature of Internet Explorer will assist the user?

A. Favorites

B. AutoComplete

C. Customized toolbars

D. Registry Editor

You are the desktop support technician for your company. One of your users utilizes Outlook
Express to work from home. He has two children who also use Outlook Express on the same

computer. He wants to have a completely separate Inbox and folder hierarchy from those of his
children. What feature of Outlook Express should you explain to the user?

A. Personal Folders
B. Junk E-mail filtering
C. Identities

D. Customized toolbars
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10. You are the desktop support technician for your company. A Windows XP user asks you why
he does not have an option to open My Recent Documents from his Start menu. Which tab con-
tains the setting that will fix his problem?

A

The Start Menu tab in Taskbar and Start Menu Properties

B. The Taskbar tab in Taskbar and Start Menu Properties
C.
D. The Advanced tab in Customize Start Menu

The General tab in Customize Start Menu
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Answers to Review Questions

1.

10.

C. You should first choose Tools and then choose Customize. The Customize dialog box will
enable you to create the new toolbar. None of the other options have the correct tools.

B. She should choose Tools and then Customize. On the Toolbars tab of the Customize dialog
box, she can deselect all of the toolbars except the Standard toolbar. She could right-click on
each toolbar and then deselect it from the list, but this would not be the fastest option. The other
options are not valid.

C, D. He could remove the check mark from Capitalize First Letter Of Sentences within the
AutoCorrect options. This would fix his problem, but he would not have the convenient tool
that capitalizes the first letter automatically when it’s appropriate. He could also create an
exception for each of the words with which he is having a problem. The other options will not
provide the solution.

D. The option to Ignore Words In UPPERCASE is selected with a default installation, for the
express purpose of ignoring acronyms and company names. Evidently, someone has unchecked
this option. She should replace the check mark in the appropriate box on the Spelling & Grammar
tab of the Tools » Options dialog box. The other choices will not solve the problem.

C. You should configure a Junk E-mail filter that automatically sends unsolicited e-mail to her
Junk E-mail folder. She can review the mail there to make sure that nothing is filtered that should
not be filtered. None of the other options provide a solution to the problem.

D. The Outlook 2003 feature that will automatically make a call based on receiving a specific
e-mail is Notification rules. You can use the Rules Wizard to create this rule, provided that a
modem is set up to make the call. Organization rules automatically manage messages but cannot
be used to make a phone call. Personal folders contain and organize all of the user data. The
Import and Export Wizard can be used to transfer data.

A. The Inbox Repair tool (scanpst.exe) should be used to examine the .pst file and, if cor-
rupt, attempt to repair it. The AutoCorrect tool corrects errors in typing. The AutoArchive tool
cleans up a user’s mailbox by removing old items. The scanstate.exe tool is used to gather

information about the settings on a computer to transfer them to another computer.

B. The AutoComplete feature of Internet Explorer can be used to control password caching.
This feature can remember passwords for a user. The Favorites tools provide shortcuts to web-
sites but do not remember passwords. Customized toolbars are not a solution to this problem.
The Registry Editor can be used to disable the option for password caching but would not be
used to enable the feature.

C. The user can create identities in Outlook Express for himself and for his children. This will
create a completely separate Inbox and folder hierarchy. Personal folders are used in Outlook,
not in Outlook Express. Junk E-mail filtering does not address this problem. Customized tool-
bars do not address this problem.

D. The Recent Documents settings are contained in the Advanced tab of Customize Start Menu.
This is within the Start Menu and Taskbar Properties dialog box. The other options are not the
correct tab.
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v Identify and troubleshoot name resolution problems.
Indications of such problems include application errors.

v Identify and troubleshoot network adapter configuration
problems. Indications of such problems include application
errors.

v Identify and troubleshoot LAN and Routing and Remote
Access configuration problems. Indications of such
problems include application errors.

v Identify and troubleshoot network connectivity problems
caused by the firewall configuration. Indications of such
problems include application errors.

v ldentify and troubleshoot problems with locally attached
devices. Indications of such problems include applications
errors.




Many of the applications that people use in today’s modern net-
works require connectivity to an intranet or to the Internet in
order to function properly. For example, applications such as
Internet Explorer, Outlook, and Outlook Express are relatively useless if the computer upon

which they are installed has no connectivity with other computers. For this reason, connectivity
issues can potentially have a very negative affect on the productivity of your users. As a desktop
support technician, you should be able to quickly identify and troubleshoot connectivity prob-
lems with applications. In order to be able to troubleshoot connectivity problems, you have to
know how the connections and configurations are supposed to look. In other words, you should
be able to configure them yourself.

In this chapter, we will discuss how to configure the essential elements for connectivity with
applications. Once you know how to configure these elements, you will more easily recognize
a problem with one of them. We will also discuss the methods of troubleshooting connectivity
in regard to each of these elements. The five elements that are essential to connectivity in regard
to applications are as follows:

Name resolution In order for computers to communicate on a network, they must each have
a unique address. Actually, computers can have more than one type of address based on the way
they are used in a network and on the protocol that is used. Name resolution is a process of con-
verting the user-friendly addresses that people use into logical and physical addresses that rout-
ers and computers can use. We will discuss the major types of name resolution and how to
troubleshoot name resolution.

Network adapter configuration A network adapter is a device that converts serial communi-
cation from the network cable or a wireless device into parallel communication that can be
interpreted by the computer. Proper configuration of the network adapters in clients and servers
is essential for communication on a network. We will discuss how to configure and trouble-
shoot network adapters for user computers.

LAN and routing and remote access configuration There are generally many devices within
and between networks that must be configured properly for clients to have connectivity to
resources. While you probably don’t have the authority to configure or repair all of these
devices, you should be able to identify them as the source of a problem and then give that infor-
mation to the network administrator. We will discuss the different types of network devices that
you might encounter in a network and how to isolate a problem that exists on a network device.
In addition, we will discuss configuring the client to connect to these devices for LAN commu-
nication as well as remote access configuration.

Firewall configuration Firewalls are filters that allow you to control what goes into and out of
your network. A properly configured firewall is an asset to a network that will keep intruders out
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and increase productivity in an organization. An improperly configured firewall can become a
barrier to legitimate communications and have exactly the opposite effect. While you probably
won’t be able to modify the configuration of your firewalls, you should know about firewall con-
figuration in general so that you can identify connectivity problems that relate to firewall config-
uration. We will discuss the general configuration of network firewalls and the issues that can
occur with applications.

Locally attached device configuration Today’s computers are capable of directly connecting
to many different types of devices, including printers, faxes, and other locally attached devices.
These devices are often configured by Plug and Play, but sometimes problems occur with the
connection or the configuration. You should know how to configure and troubleshoot locally
attached devices on a user’s computer.

Name Resolution

To really comprehend name resolution you have to understand all of the types of names that
a computer can have and the services that can be used to resolve them. As we discussed in
Chapter 5, “Troubleshooting Network Protocols and Services,” computers actually recog-
nize each other by a unique physical address burned into their network interface cards, their
MAC address. In order for packets to be delivered to the correct location, the MAC addresses
must be used. When we build and connect networks, we use logical addresses and names such
as protocol addresses, NetBIOS names, and hostnames to facilitate communication to the cor-
rect networks and the correct computers within the network. Since the computers cannot use
these names and addresses, they must be resolved from logical names and addresses to the
physical address, the MAC address, before communication can take place. Many different
services and protocols can be involved in this process. In this section we will discuss each of
these concepts in greater detail.

Types of Names and Addresses Used by Computers

Depending on how a computer is used in a network, it may be designated by many types of
names or addresses. In order to understand name resolution, you must first understand the
nature of each type of name and address assigned to a computer. In this section we will focus
on the names and addresses that can be assigned to each computer and the methods that you can
use to determine what name or address is assigned to a computer.

MAC Address

A MAC address is a data link layer address that is required for every port or device that connects
to a LAN and uses the Ethernet method of communication. MAC addresses are six bytes long and
are controlled by the IEEE to make sure they are unique. A MAC address is also known as a hard-
ware address, a MAC-layer address, or a physical address. Computers recognize each other by

their MAC address. MAC addresses are expressed in hexadecimal numbers. The first three bytes
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represent the manufacturer of the network adapter and the last three bytes should be unique for
that manufacturer; for example, 00-05-1B-00-4B-F6 is the MAC address for a Belkin USB Ether-
net network adapter. You can view the MAC address of your Windows 98, Windows 2000, Win-
dows NT, or Windows XP computer by typing ipconfig /all on the command line. This will
generate the output shown in Figure 9.1. The address listed next to Physical Address is the MAC
address of the computer.

) On Windows 95 clients, enter winipcfg on the Run line to view the MAC
TE address of the computer.

Protocol Address

A protocol address is a logical address that is used by networks to move packets to the correct
network, often through a series of routers. The most common protocol address is an IP address
that is used by the TCP/IP protocol suite. (Some networks also use IPX addresses, which are pro-
tocol addresses proprietary to Novell NetWare servers and clients.) Each computer in a network
must have a unique protocol address. An example of an IP address is 192.168.1.10. This type
of address is referred to as a 32-bit address that is based in binary. Since computers can work
only with ones and zeros, the computer would read the address above as its binary equivalent,
11000000 10100000 00000001 000001010. The easiest method of viewing the IP address of
a computer is by typing ipconfig on the command line, as shown in Figure 9.2. The output will
display the IP address of each network adapter card in the computer.

FIGURE 9.1 Anipconfig/all output showing the MAC address of a computer

@ C:\WINDOWS\System32\cmd. exe _|of x|
B
Ethernet adapter Firewalled Internet:
Connection-specific DN$ Suffix . : _J
Description . . . . . . . . . . . : Belkin USB Ethernet Adapter
Physical Address. . . . . . . . . : 88-05-1B-80-4B-F6&
Dhcp Enabled. . . . . . . . . . . : Yes
Autoconfiguration Enabled . . . . : Yes
IPAddress. . . . . . . . . . . . : B6B8.190.17.158
Subnet Mask . . . . . . . . . . . : 255.255.255.90
Default Gateway . . . . . . . . . : BB.190.17.1
DHCP Server . . . . . . . . . . . : B68.114.39.2
DNS Servers . . . . . . . . . . . : 24.196.17.8
67.97.48.9
Lease Obtained. . . . . . . . . . : Tuesday, May 25, 2004 7:50:52 AM
Lease Expires . . . . . . . . . . : Tuesday, May 25, 2004 3:50:52 PM
C:\Documents and Settings\Bill Ferguson.XP1>_
~]
q Br
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FIGURE 9.2 Anipconfig output showing the IP address of a computer

B C:\WINDOWS\System32\cmd. exe _|=| x|
Microsoft Windows XP [Uersion 5.1.26080] =
(C) Copyright 1985-2001 Microsoft Corp.

C:\Documents and Settings\Bill Ferguson.XP1>ipconfig

Windows IP Configuration

Ethernet adapter Private Network :
Connection-specific DNS Suffix
IPAddress. . . . . . . . . . . . :192.168.1.10
Subnet Mask . . . . . . . . . . . : 255.255.255.0
Default Gateway . :

Ethernet adapter Firewalled Internet:

Connection-specific DNS Suffix

IPAddress. . . . . . . . . . . . : 68.190.17.158
Subnet Mask . . . . . . . . . . . : 255.255.255.8
Default Gateway . . . . . . . . . : 68.190.17.1

C:\Documents and Settings\Bill Ferguson.XP1>

4] | ¥

NetBIOS Name

A NetBIOS name is a unique computer name assigned to every computer in a Microsoft network.
NetBIOS names exist in a “flat name space,” which means that they must be completely unique.
They are sometimes referred to as the computer name. NetBIOS names can be up to 15 characters
in length. A computer can have many NetBIOS names because the operating system adds a 16th
character to create multiple NetBIOS names for the same computer. These names designate ser-
vices that the computer can perform for the network. Some legacy applications rely on these
names. You can view the list of NetBIOS names for a computer by typing nbtstat -n on a com-
mand line. This will generate the output shown in Figure 9.3.

Hostname

A host is any computer that is on a TCP/IP network. A hostname is a unique designation for a
computer on a TCP/IP network or internetwork. Hostnames exist in a hierarchy and must be
unique only in their level of the hierarchy. For example, bobj.msft.com is a totally different
hostname than bobj.sybex.com, even though they are both bobj. Computers are assigned only
one hostname, which can be up to 255 characters in length. Most of the applications used today
rely on hostnames to identify computers on the network. Some applications can use both host-
names and NetBIOS names. The simplest method of viewing just the hostname of a computer
is by typing hostname on a command line, as shown in Figure 9.4.
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FIGURE 9.3 An nbtstat -n output showing the NetBIOS names of a computer

B C:\WINDOWS\System32\cmd. exe _|=| x|
Name Type Status 4]
XP1 <80> UNIQUE Registered _J
WORKGROUP <B0> GROUP Registered
xP1 <03> UNIQUE Registered
XP1 <20> UNIQUE Registered
WORKGROUP <1E> GROUP Registered
BILL FERGUSON <@83> UNIQUE Registered

Firewalled Internet:
Node IpAddress: [68.190.17.158] Scope Id: []

NetBIOS Local Name Table

Name Type Status

®P1 <00> UNIQUE Registered

WORKGROUP <0e> GROUP Registered

*P1 <03> UNIQUE Registered

AP1 <20> UNIQUE Registered

WORKGROUP <1E> GROUP Registered

WORKGROUP <1D> UNIQUE Registered

..__MSBROWSE__.<©1> GROUP Registered

BILL FERGUSON <83> UNIQUE Registered
Cf\nocumente and Settings\Bill Ferguson.XP1> | ||
4 »

FIGURE 9.4 A hosthame command output showing just the hostname of a computer

B C:\WINDOWS\System32\cmd.exe

C:\Documents and Settings\Bill Ferguson.XP1>hostname
xp1

C:\Documents and Settings\Bill Ferguson.XP1>

Types of Services and Files That Are Used to Resolve Names

Since computers use only MAC addresses, all of the other types of addresses are really just for
people and for network design. The addresses that people use have to be resolved back to a

MAC address before a physical address of a computer can be determined so that the packets can
be delivered to the correct location. Often, more than one name resolution method is involved
in this process. For example, a hostname may be resolved to an IP address so that the IP address
can then be resolved to a MAC address. Many types of files and services are used to provide this
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name resolution, including ARP, the hosts file, the Imhosts file, WINS, and DNS. In this section,
we will discuss each of these files and services in detail.

ARP

The Address Resolution Protocol (ARP), as previously discussed in Chapter 3, is the protocol that
TCP/IP uses to resolve an IP address to a MAC address. ARP is actually used by computers and by
routers. When ARP resolves an address, it caches the information for about 10 minutes so that the
address can possibly be resolved faster the next time. ARP works by a two-step process. First, it
checks the cache to see if it has resolved that address in the last 10 minutes and then, if it hasn’t,
it broadcasts to resolve the address. In other words, it basically yells out into the network to ask the
computer that is assigned that IP address to please tell ARP its MAC address. These broadcasts are
typically limited to one subnet of one network, since routers generally stop broadcasts. Network
administrators are responsible for designing the logical network so that by the time ARP is used, the
computer that ARP is looking for is in the subnet. You can view the ARP cache on a computer by
typing arp -a on the command line, as shown in Figure 9.5.

< While you don’t have to be an expert at ARP, you can obtain more information
P about it by typing arp /? on a command line.
Lmhosts

The Imhosts file is a static file that the computer uses to resolve NetBIOS names to IP
addresses. The Im stands for LAN Manager, which was one of the original network oper-
ating systems developed by Microsoft. The Imhosts file can also be used to preload impor-
tant network addresses, such as those of domain controllers, into a NetBIOS name cache on
the local computer for faster name resolution. You can locate the sample Imhosts file on a
Windows XP or Windows 2000 Professional client at %systemroot%/system32/drivers/
etc. A sample Imhosts file is shown in Figure 9.6.

FIGURE 9.5 The ARP cache

B Command Prompt

C:\Documents and Settings\Bill Ferguson.XP1>arp -a

Interface: 192.168.1.10 --- Ox10003
Internet Address Physical Address Type
192.168.1.1085 00-02-a5-6e-72-65 dynamic
Interface: 68.190.17.158 --- ©x10004
Internet Address Physical Address Type
68.190.17.1 00-30-Th-f8-94-54 dynamic

C:\Documents and Settings\Bill Ferguson.XP1>
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FIGURE 9.6 The sample Imhosts file in Windows XP

|_:_|‘l Imhosts.sam - Notepad m@ﬁa
Fle Edt Format View Help

# Copyright (c) 1993-1999 Microsoft Corp. ~
#

# This is a sample LMHOSTS file used by the Microsoft TCP/IP for Windows.
#

|# This file contains the mappings of IP addresses to computernames

# (NetBIOS) names. Each entry should be kept on an individual line.

# The IP address should be placed in the first column followed by the

# corresponding computername. The address and the computername

# should be separated by at least one space or tab. The "#" character

# is generally used to denote the start of a comment (see the exceptions

# below).

#
# This file is compatible with Microsoft LAN Manager 2.x TCP/IP Imhosts
# files and offers the following extensions:

#PRE

#DOM: <domain>

#INCLUDE <filename>
#BEGIN_ALTERNATE
#END_ALTERNATE

\Oxnn (non-printing character support)

HuHHHHHRY

|# Following any entry in the file with the characters "#PRE" will cause
|# the entry to be preloaded into the name cache. By default, entries are
|# not preloaded, but are parsed only after dynamic name resolution fails.
#

# Following an entry with the "#DOM:<domain>" tag will associate the
# entry with the domain specified by <domain=>. This affects how the

o While it is not necessary that you be an Imhosts file expert, you can obtain
ITE more information about the Imhosts file by reading the information in the
sample file.

Hosts

The hosts file is a static file that the computer uses to convert hostnames to IP addresses. The
hosts file is rarely used in today’s networks because it has been replaced by DNS. You can
view a sample of a hosts file on a Windows XP or Windows 2000 Professional client at
%systemroot%/system32/drivers/etc. A sample hosts file is shown in Figure 9.7.
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FIGURE 9.7 The sample hosts file in Windows XP

|_;l hosts - Notepad M@JE’\E

Fle Edit Format View Help
|# Copyright (c) 1993-1999 Microsoft Corp.
#

# This is a sample HOSTS file used by Microsoft TCP/IP for Windows.

#

# This file contains the mappings of IP addresses to host names. Each

# entry should be kept on an individual line. The IP address should

|# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.

#

# Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a '#' symbol.

#

# For example:

#

# 102.54.94,97 rhino.acme.com # source server
#  38.25.63.10 x.acme.com # x client host

127.0.0.1 localhost

WINS

Windows Internet Name Service (WINS) is a dynamic service that registers the NetBIOS names
of computers on a network and then resolves the NetBIOS names to IP addresses. Some small
networks may get by without using a WINS server, but, in general, any network that has clients
and/or applications that use NetBIOS name resolution should use a WINS server. Since the net-
work administrator is responsible for the WINS server, you do not have to be a WINS expert,
but you should know how to determine whether a client is configured to use a WINS server.
One method of determining whether a client is configured to use a WINS server is to check the
network connection of the client. Exercise 9.1 walks you through the steps to check the network
connections of a client to determine whether the client is configured to use a WINS server and
change the server address if necessary.

Using Network Connections for WINS Configuration in Windows XP

1. On the Windows XP Desktop, click Start and then choose Control Panel.

2. On the Control Panel, choose Network Connections and then choose the network connec-
tion that you want to examine. (In this case, we want to look at the Private Network Con-
nection properties.)
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EXERCISE 9.1 (continued)

3. On the Status dialog box of the connection that you want to examine, click the Properties
button.

.. Private Network Status 2F4

General Support|

Connection
Status: Connected
Duration: 125717
Speed 100.0 Mbps

Signal Strength

Actvity -

Sent — ",ﬂ ——  Received
Packets: 33724 | 28.880
Properiies ‘ ’ Disable !

Close

4. On the Properties dialog box for the connection, double-click Internet Protocol TCP/IP.

=L Private Network Properties L?_,‘E"i

| General | Authentication | Advanced

| Connectusing:

H3 Siemens SpeedStream USB 10/100 Ethemet Adapter

|

This connection uses the following items:

| @ B clientfor Microsoft Neworks
¥ @ File and Printer Sharing for Microsoft Networks
| | ¢ HQOS Packet Scheduler

¥ = Internet Promc_gt (TCP/IP) |

N T (e

| ~Description

| Transmission Control Protocolfintermnet Protocol. The default wide
area network protocol that provides communication across
| diverse interconnected networks.

I [] Show icon in notification area when connected

OK l [ Cancel
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EXERCISE 9.1 (continued)

5. On the Internet Protocol (TCP/IP) Properties dialog box for the connection, click the
Advanced button.

Internet Protocol (TCP/IP) Properties 2F3

| General
You can get IP settings assigned automatically if your netwark supports this

capability, Otherwise. you need to ask your network administrator for the
appropriate IP setings.

(") Obtain an |P address automatically

(@) Use the foliowing IP address:
IF address m
Subnet mask: 285 . 255 . 255 o

Default gateway

{ .; Use the followang DMS server addresses:

Prefered DNS server 24 1% . 17 8
Alternate DNS server: 24 189 . 17 . 9
Advanced,
1 0K | I Cancel ]

6. On the Advanced TCP/IP Settings dialog box, choose the WINS tab.

Advanced TCP/IP Settings 2Bd
IP Setings DNS || WINS | Oplions |

IP addresses

IP zddress Subnet mask
192.168.1.10 255255 255 0
[ agd. J[ Edi. ][ Remove

Drefault gateways:

Galaway Metric

V] Autamalic metric

ok | [ cancel
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EXERCISE 9.1 (continued)

7. Onthe WINS tab, read the addresses in the box labeled WINS Addresses, In Order Of Use.
You can add or remove WINS servers or change the order of their use. You should consult
with a network administrator before altering these settings on a client.

'vaanced TCP/IP Settings t?_]?ﬁ

| [P Settings | DNS

WINS | Options

WINS addresses, in order of use:
192.168.1.15 &
101012

Add. | [ Edt. ][ Remove |

FLMHOSTS lookup is enabled, it applies to all connections for which TCPAIP is
enabled.

Enable LMHOSTS lookup [ imporiimHosTs.. |

MNetBIOS setbng
() Default
Use NetBIOS setting from the DHCP server. If static |P address is

used orthe DHCP server does not provide NetBIOS setting, enable
NetBIOS over TCPJIP.

(_) Enable NetBIOS over TCP/IP
() Disable NetBIOS over TCP/IP

[ ok J[ cancal |

8. Click OK twice and then click Close to close the network connections properties and save

any new settings.

&

DNS

If you only want to view the addresses and do not need to change them, you
can also view the WINS addresses of the client in the Ipconfig /all output
or in the Details section of the Support tab in the Status dialog box of the net-
work connection.

Domain Name System (DNS) is a dynamic database that resolves hostnames to IP addresses.

DNS can be used to resolve the hostnames of your clients and servers as well as the hostnames
of computers across the world, using the Internet. In fact, DNS is the primary service that makes
the Internet possible. The DNS database encompasses all of the computers that are connected
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to the Internet, but the database is divided into thousands of servers that communicate with one
another to make the name resolution possible. Network administrators are responsible for mak-
ing sure that the DNS infrastructure is in place to provide the name resolution for clients and
servers, but you should know how to examine the DNS configuration of a client and make
changes when necessary. Exercise 9.2 walks you through the steps to examine and configure the
DN settings on a client.

Using Network Connections for DNS Configuration in Windows XP

1. On the Windows XP Desktop, click Start and then choose Control Panel.

2. Onthe Control Panel, choose Network Connections and then choose the network connec-
tion that you want to examine. (In this case, we want to look at the Private Network Con-
nections properties.)

3. Onthe Status dialog box of the connection that you want to examine, click the Properties
button.

4. On the Properties dialog box for the connection, double-click Internet Protocol TCP/IP.

5. On the Internet Protocol (TCP/IP) Properties dialog box, examine the DNS settings. If
Obtain DNS Server Address Automatically is selected, then you will have to type the
ipconfig /a1l command atthe command prompt to determine the address that the DHCP
server has assigned to the client. If Use The Following DNS Server Addresses is selected,
then you can view the configured Preferred DNS Server address and Alternate DNS Server
address. You can also change the DNS server addresses in this dialog box.

Internet Protocol (TCP/IP) Properties 2k43

| General

‘You can get IP settings assigned automatically if your network supports this
capability. Otherwise. you need to ask your network administrator for the
appropriate IP setings

() Obtain an P address automatically

(@) Use the following IP address:
IP address: 192188 . 1 . 10 |
Subnet mask 255 . 285 255 1]

Default gateway

(@) Use the followang DNS server addresses
Preferred DNS server 24 1% 17 8

Alternate DNS server T4 . 189 . 17 . 9

l Advanced.,

I OK ] | Cancel
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EXERCISE 9.2 (continued)

6. Click the Advanced button and then choose the DNS tab. If the client is assigned more
than two DNS servers, you can view the configured DNS server addresses and their
order of use. You can also add or remove server addresses or change the order of their
use. You should consult with the network administrator before changing the DNS con-
figuration of a client.

Advanced TCP/IP Settings

| IP Settings | DNS | WINS || Options |

DNS server addresses. in order of use:

24196178
24169.17.9

|-

Add.. l [ Edit. I Remove ]

The following three setiings are applied to all connections with TCE/IP
enabled. For resolution of ungualified names:

@ Append primary and connection specific DNS suffixes
Append parent suffixes of the primary DNS suffix
\’:_] Append these DNS suffixes (in order):

DNS suffix for this connection:

Register this connection's addresses in DNS
[[J Use this connection's DNS suffix in DNS registration

[ OK ] ’ Cancel ]

7. Click OK twice and then click Close to close the network connections properties and save
any new settings.

- If you only want to view the addresses and do not need to change them, you

ITE can also view the DNS addresses of the client in the ipconfig /all output
or in the Details section of the Support tab in the Status dialog box of the
network connection.
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Network Adapter Configuration

A network adapter card is like a little computer within the computer. Since it is a computer, it
must be “programmed” correctly to function properly. Programming a network card includes
installing the card and the drivers (as we discussed in Chapter 3, “Configuring and Trouble-
shooting Hardware Devices and Drivers”) and correctly configuring the IP address, subnet
mask, and default gateway on the connection. If these are not configured properly, the com-
puter will be unable to connect to the servers and resources that the user’s applications require.
You do not need to be a network connection expert, but you should be able to recognize the
most common configuration errors in regard to network connections. These include an incor-
rect IP address, subnet mask, or default gateway. Since users can by default make changes to
these settings, you should know how to examine the settings and make comparisons that you
can use to troubleshoot the network card’s configuration. In this section, we will discuss each
of these settings in greater detail. You can view all three of these configuration addresses by
typing ipconfig on the command line of a Windows XP, Windows 2000 Professional,
Windows 98, or Windows NT Workstation client, as shown in Figure 9.8.

IP Address

Networks in large organizations are generally divided into subnets to control and optimize net-
work flow. Network designers and network administrators go to great lengths to make sure that
host addresses are unique within each subnet. A proper IP address configuration is essential to
allow applications such as Internet Explorer and Microsoft Outlook to provide a resource for the
user. Most network administrators use a DHCP server to configure addresses automatically for
clients. While you do not have to be an expert at network design, you should be able to recognize
the addresses that belong in your network. You can compare the IP address of a client with the IP
addresses of other clients in the same subnet to see if it is similar. If it is similar, but it is still not
working, then you should check the subnet mask and default gateway as well. You may need to
consult with the network administrator for the details on your IP addressing structure.

FIGURE 9.8 Sample output of an ipconfig command

Bl C:\WINDOWS\System32\cmd.exe

Microsoft Windows XP [Uersion 5.1.2600]
(C) Copyright 1985-2081 Microsoft Corp.

C:\Documents and Settings\Bill Ferguson.XP1>ipconfig

Windows IP Configuration

Ethernet adapter Firewalled Internet:

Connection-specific DNS Suffix . :

IP Address. . . . . . . . . . . . : 68.190.17.158
Subnet Mask . . . . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . . . . : 68.190.17.1




350 Chapter 9 - Configuring and Troubleshooting Connectivity for Applications

) You should use the winipcfg command on a Run line to view this information
TE on a Windows 95 client.

Subnet Mask

The subnet mask of an IP address provides two functions. First, it divides the IP address into the
network ID and the host ID. Second, it allows computers and routers to determine the network
ID and host ID of an address. It does this by a binary process called anding. The IP address is
anded to the subnet mask to determine the network ID and the host ID of a host on a TCP/IP
network. As a desktop support technician, you do not need to be an expert at binary numbers
or the anding process. You should know that the subnet mask is a very important part of the
IP address and that it must be configured correctly in order for communication to take place.

Default Gateway

The default gateway is the address of the interface that is configured to allow a client to com-
municate outside its own subnet. This is generally a router interface, but it could be the interface
of a server or sometimes even a client with more than one network interface card. If the 1P
address and subnet mask are configured properly, but the default gateway is not, then the client
will be able to communicate within its own subnet but will not be able to communicate with
hosts outside its subnet. You can test the connection to the default gateway by simply pinging
the default gateway from the client. As you may remember, we discussed using the ping com-
mand in Chapter 5.

LAN and Routing and Remote
Access Configuration

In today’s business world, people might work from just about anywhere! Some users will uti-
lize only a desktop computer that is connected directly to the Internet or connected through
a proxy server. Others might use a laptop from a remote location by dialing into the network
with a modem. Both types of users ultimately just want to connect an application such as
Internet Explorer to a server that contains the resources they need. As a desktop support tech-
nician, you should understand what is involved in each type of communication. You should
also know how to configure the settings on Internet Explorer to provide access to a client
through the LAN and through a remote access server. In this section we will discuss each of
these concepts in greater detail.
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LAN Configuration

The local area network (LAN) of an organization is usually considered to be the collection of com-
puters, servers, and other network devices that are connected with high-speed links, which the orga-
nization owns. Typically, clients are connected with cables or wireless connections to some type of
hub or switch. Creating and maintaining this connectivity is essential so that the user can utilize an
application such as Internet Explorer or Microsoft Outlook. Clients that use Internet Explorer may
be directed to a proxy server to enhance the control of their Internet use. The Internet Explorer appli-
cation provides a tool to configure LAN settings and proxy server settings for a client when needed.
In this section, we will discuss each of these concepts in greater detail.

LAN Settings for the Client

The LAN settings for the client are primarily the settings that we have already discussed in
this chapter and in Chapter 5. They are the configuration settings that allow the client to
obtain an address, communicate on the network, and resolve names when necessary. As we
discussed before, many network administrators use a DHCP server to configure these set-
tings. If the client is unable to communicate on the network, you should check the following
configuration settings:

= The IP address of the client or the setting to obtain an IP address automatically

= The subnet mask (if not configured by the DHCP server)

*  The default gateway (if not configured by the DHCP server)

= The address of the WINS server or servers (if not configured by the DHCP server)
*  The address of the DNS server or servers (if not configured by the DHCP server)

LAN Settings for Internet Explorer

Internet Explorer can be configured to connect directly to the Internet through an Internet
Service Provider or to use the organization’s proxy server to facilitate the connection. Some
organizations use a proxy server to tightly control who is allowed access to what sites on the
Internet and when they are allowed to access them. A proxy server also can be used to cache
address requests to improve performance for users. The network administrator is responsible
for configuring the proxy server, but you should know how to configure the clients to connect
to the server. The two main tools that you can use to configure these settings are the Internet
Options dialog box and the New Connection Wizard. In this section, we will discuss each of
these tools in greater detail.

The Internet Options Dialog Box

Here we are, back to the Internet Options dialog box again! I’ll bet you thought that we had
done just about everything that we could do with this box in Chapter 6, “Configuring and
Troubleshooting Applications,” and Chapter 7, “Resolving Issues Related to Usability.”
Actually, we only briefly discussed the options available on the Connections tab, as shown in
Figure 9.9. To configure a client to use a proxy server for Internet Explorer and the applica-
tions that it controls, you should click the LAN Settings button. This will open the Local Area
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Network (LAN) Settings dialog box, as shown in Figure 9.10, which contains the following
settings related to the proxy server.

Automatically Detect Settings: This setting can be used with a proxy server that can be con-
figured for automatic detection without the use of a script, such as Microsoft Proxy Server.

Use Automatic Configuration Script: This setting should be used when automatic detection
of the proxy server requires a script. Your network administrator will provide the location of
the script.

Use A Proxy Server For Your LAN: This is a manual setting that configures the client to
always use a proxy server at a specific location and port.

Advanced: You should click the Advanced button only if you are directed by the network
administrator to specify ports for an application or specify exceptions to the rules.

Bypass Proxy Server For Local Addresses: This setting allows Internet Explorer to browse
your organization’s intranet as well. Without having this setting checked, the application
will try to go out to the Internet through the proxy server to find locations that are in its
own intranet.

ﬁ" You should disable the Automatic Configuration settings when you manually

ING set the configuration; otherwise, the Automatic Configuration settings may
override the manual settings.

FIGURE 9.9 The Connections tab of the Internet Options dialog box.

lntemet Options @ﬁ

General | Security | Privacy Ccmtenti'30ﬂ|'185‘j0|'l5 Programs | Advanced

Q% To set up an Internet connection, click Setup.
Dialup and Virtual Private Network setings

Choose Settings if you need to configure a proxy server
for a connection.

Local Area Network (LAN) settings

LAN Settings do not apply to dial-up connections. Choose | | AN Seftings... |
Settings above for dial-up settings. d

ok | [ Gancsl
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FIGURE 9.10 The LAN Settings dialog box

Local Area Network (LAN) Settings L?_]%

Automatic configuration

Automatic configuration may override manual settings. To ensure
the use of manual settings, disable automatic configuration.

[J Automatically detect settings

[Juse automatic configuration script

Proxy server

Use & proxy server for your LAN (These settings will not apply to
dial-up or VPN connections).

oK | [ Cancel

The New Connection Wizard

Some of your users may make connections directly to an ISP, while others will connect to other cli-
ents or servers that are connected to an ISP. The New Connection Wizard can assist you in creating
the correct configuration. This is the same tool that we discussed in Chapter 5. You can access this
tool through Network Connections in the Control Panel, or you can simply click the Setup button
on the Connections tab of the Internet Options dialog box in Internet Explorer. You should click
Next when the New Connection Wizard opens. This will open the New Connection Type dialog
box. You should choose the first option, Connect To The Internet, as shown in Figure 9.11, and then
click Next. This will open the Getting Ready dialog box, as shown in Figure 9.12, which contains
the following options in regard to LAN settings:
= Choose From A List Of Internet Service Providers (ISPs): You should choose this option if you
want to select from the list of ISPs that were installed with the Internet Explorer software.
= Set Up My Connection Manually: If you choose this option, then you will need to know
the address of the connection and you will need a valid username and password.
= Use The CD I Got From An ISP: You should use this option if you have obtained a CD from
an ISP. You should place the CD into the CD-ROM drive on your computer. The computer

should automatically detect the presence of the CD. Follow the directions on the CD to
complete the installation.

4 The New Connection Wizard can also be used for dialup and VPN connections.
TE We will discuss these options later in this chapter.
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FIGURE 9.11 The New Connection Type dialog box in the New Connections Wizard

‘New Connection Wizard

Network Connection Type
What do youwant to do?

@c

Connectto the Internet 5o you can browse the Web and read email.

(") Connect to the network at my workplace

Connectto a business network (using dial-up or VPN) so you can work from home. a field
office, or another location.

{_) Set up a home or small office network
Connectto an existing home or small office network or set up a new one.

CJ Selup an advanced conneclion

Connect directly to another computer using your serial, parallel, or infrared port. or setup
this computer so that other computars can connectto it

<Back || MNew> | [ cancel

FIGURE 9.12 The Getting Ready dialog box in the New Connections Wizard

‘New Connection Wizard

Getting Ready @
The wizard is preparing to setup your Internet connection .

How do you wantto connectto the Internet?

(@) iCh from a list of Internet service providers (ISPs)

O Setup my connection manually

For a dial-up connection, you will need your account name. password, and a phone
number for your ISP. For a broadband account. you won't need a phone number.

(_) Use the CD | got from an ISP

[ < Back |[ Next> |[ Cancel
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Remote Access Server Configuration for Clients

Since many users now work from their homes or from a laptop “on the road,” businesses have
had to adapt to the changes by allowing the users access to the organization’s servers from
remote locations. This began in the early 1990s with the installation of modems on both the
user’s computer and in the server rooms. This is referred to as dial-up remote access, in which
one modem calls another modem using nothing but a regular telephone connection. This
method soon presented two major drawbacks. First, the server rooms had to be equipped with
multiple modems or special equipment that simulated multiple modems to handle the traffic
from the users. Second, if the users were not in the same vicinity, then long-distance charges
were added to each call.

With the growth of the Internet, businesses soon found that they could use the connections
through the Internet to connect a client to their servers. The clients still used a modem to connect
to the Internet through an ISP, but then they were “tunneled” straight to the servers in the orga-
nization. This offered a solution that could provide greater security and eliminate long-distance
charges, provided that a local ISP was available to the user. The only remaining disadvantage of
a VPN connection using a modem was that the modem was very slow when compared to a LAN
connection. With the evolution of technology, broadband connections such as cable modems and
digital subscriber line (DSL) make the connections from home almost as fast as those in the office.
Many hotels now offer broadband connections at no charge or for a small fee.

The newest servers from Microsoft (Windows 2000 Server and Windows Server 2003)
include a tool called Routing and Remote Access Server that enables a network administrator
to configure dial-up connections and VPN connections for clients. Since the network admin-
istrator is responsible for configuring the connections on the server side, you do not need to
know how to configure them. However, you should understand the advantages and disad-
vantages of each type of connection and know how to configure the connections on the client
computer. In this section, we will discuss the configuration of each of these types of connec-
tions in greater detail.

Configuring Dial-up Connections

As we mentioned before, dial-up connections are comparatively slow and should be used as
a last resort, for example, on a laptop from a hotel where no other faster method is available.
You may also see dial-up connections used in very small businesses that do not have the
resources for faster options. You should know how to use the tools built into Internet
Explorer to configure dial-up connections for a client. Exercise 9.3 walks you through the
steps to create a dial-up connection from within Internet Explorer. You may notice a marked
similarity to the method that we used in Chapter 5 (from the Network Connections tool in
Control Panel).
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Configuring Dial-up Connections from the Connections Tab
of Internet Explorer

1. InInternet Explorer, choose the Connections tab and then choose Add under the Dial-up
and Virtual Private Network settings.

2. Choose Dial-up To Private Network and then click Next.

-

New Connection Wizard

Type of Connection
Select the type ofthe connection

) Dial-up to private network.
Connect using my phone line (modem or ISDN).

) Connect to a private network through the Internet.
Create a Virual Private Network (VPN) connection or unnel through the internet.

O Connect directly to another compuler.
Connect using my senal, parallel, or infrared port.

) Connect to the network via broadband
Connect through my broadband connection.

I Next > |f Cancel J

3. Type the phone number to dial, including any additional characters such as 1 for long dis-
tance or 9 to get a local line at a hotel. Click Next.

7
New Connection Wizard @,ﬁ
Phone Number to Dial Et::l
Whatis the phone number you will use to make this connection?

-

Type the phone number below.

Ehone number:
12055551212

Youmight need to include 2 "1° orthe area code, or both. If you are not sure you
need the extra numbers, dial the phone number on your telephane. [f you heara
modem sound. the number dialed is comect

< Back ” Mext = | [ Cancel




LAN and Routing and Remote Access Configuration

357

EXERCISE 9.3 (continued)

4. Type a name for your connection (any name will suffice) and then click Finish.

5.

New Connection Wizard

Finished
The wizard is ready to create your connection

Type a name you want for this connection:
Diallup Sybex

Click Finish to save itin the Network Connections folder

To edit this connection later, selectit. click the File menu. and
then click Properies.

’ < Back

[ Finish ] [

Cancel

l

Dial-up Sybex Settings

2ES

Automatic configuration

Dgutumaﬁcally detect settings

[use automatic configuration script

Proxy server

" apply to other connections).

Dial-up settings

User name: billyjones
Password: [eesaee
Domain: sybex.com

Automatic configuration may override manual settings. To ensure
the use of manual settings, disable automatic configuration.

; Use & proxy server for this connection (These settings will not

0K

H Cancel ]

Clicking Finish creates the connection and exits the wizard. This will open the Settings dia-
log box for the connection.
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EXERCISE 9.3 (continued)

6. Configure the Proxy Server and Dial-up Settings for the connection based on information
from the network administrator and the ISP.

7. Click the Properties button to configure all of the settings of the connection just as you
would configure them from the New Connections tool.

‘L. Dial-up Sybex Properties [:?_J%

General | Options | Security | Networking | Advanced

Connect using:
& Modem - Dell Data Fax Modem (COM3)

Phone number

Phone number

12055551212 | Alternates

[1Use dialing rules

[# Show icon in notification area when connected |

ok [ cancel ]

8. Click Advanced to change the default connection attempts, wait times, and idle time
disconnects.

Advanced Dial-Up ?]@
Tryto connect |10 |5 times
Wait 5 2 seconds between attempts
[] isconnect If idle for minutes

[[] isconnect when connection may no longer be needed
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EXERCISE 9.3 (continued)

9.

Click OK three times to exit the settings and close Internet Options. You can view and
manage the new connection in Network Connections within the Control Panel.

|e.a Network Connections

Fie Edit View

T search

Address !0_, Metwork Connections

[5] Create a new connection

9 Set up a home or small
office network

See Also &

) Network Troubleshoater

other Places k3

D- Control Panel
g My Network Places
f_] My Documents
j My Computer

»

Details

Network Connections
System Folder

Favorites Took Advanced Help

Folders [«

|~] Name Type
Dial-up

i Diakup Sybex Digkup

LAN or High-Speed Internet

LAN or High-Speed Internet
L Private Network LAN or High-Speed Internet

[v]<] i

B
Status Dy
Disconnected ol

Enabled, Shared, Firewaled Bel
Enabled Siel

3 objects

Configuring VPN Connections

VPN connections are not necessarily any faster than dial-up connections, because you can
establish a VPN connection using a regular modem and regular telephone lines to connect to an
ISP. This will most likely be the case on laptops connecting from hotels, although many hotels

are now installing broadband connections. Users who work from home and have a cable

modem or DSL connection can establish a VPN connection that is almost as fast as their con-
nection at the office (or at least it will feel that way). You should know how to use the tools built
into Internet Explorer to create a new VPN connection for a client. Exercise 9.4 walks you

through the steps to create a new VPN connection from Internet Explorer.



360 Chapter 9 - Configuring and Troubleshooting Connectivity for Applications

Configuring VPN Connections from the Internet Options Tab
of Internet Explorer

1. InInternet Explorer, choose the Connections tab and then choose Add under the Dial-up
and Virtual Private Network settings.

2. Choose Connect To A Private Network Through The Internet and click Next.

-

Hew Connection Wizard E.j
Type of Connechon ‘_'I
Salectthe type of the connachion. &—-—

) Dial-up to private network.
Connectusing my phona line (modem or ISON).

©{Connect to a private network
Create a Virual Pnvate Metwork (WVPMN) connection or tunnel through the internet
) Connect directly to another computer.
Connectusing my seral. parallel. orinfrared port

() Connect to the network via broadband
Connect through my broadband connechon

Mext > | Cancel ]

3. Type the hostname or IP address of the computer to which you are connecting, and then
click Next.

Mew Connection Wizard

VPN Server Seleclion
What is the name or address of the VPN sarvar?

Type the host name or Internat Protocol (IP) address of the computer to which you are
connecling.
Hogtname or IP address (for example, microsoft com or 157.54.0.1);

sybexco n'{

[ <Bsck [ Mewz | [ cencel |

4. Type aname for your connection (any name will suffice) and then click Finish to create the
connection. This will open the Settings dialog box for the connection.

New Connection Wizard @

Finished -
The wizard 1= ready fo create your connechon g.-—

Type 3 nama you want for this connaction
Sybex VPN

Click Finigh to save it in the Network Connections folder

Ta adi this connection later, select it click the Fils menu, 2nd
then click Properias.

<Back |[ Finish |[ Cancal
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EXERCISE 9.4 (continued)

5. Configure the proxy settings and dial-up settings for the connection based on information
from the network administrator and the ISP.

6. Click the Properties button to configure all of the settings of the connection just as you
would configure them from the New Connections tool.

7. Click Advanced to change the default connection attempts, wait times, and idle time
disconnects.

8. Click OK three times to exit the settings and close Internet Options. You can view and man-
age the new connection in Network Connections within the Control Panel.
@ Network Connections l___llﬂ}\a

fle Edt View Favortss Took Advanced Help i
T search | Folders | Ew

& Network Connections ~|@Eco
| Name Type Status
| LAN or High-Speed Internet

Network Tasks =]

[ create & new connection

L} LAN or Hoh-Speed Internet  Enabled, Shared, Frewaled

2 setup LAN or High-Speed Tnternst Enabled
office ni
Virtual Private Network
See Also & | Sybex VPN irtual Private Network Disconnectzd

& Network Troubleshooter

Other Places &

@ control Panet
Sd My Network Flacas
(3 My Documents
9 My Computer

Details L3

Hetwork Connections
System Folder
w e | | >

3 objects

Firewall Configuration

Organizations often use corporate firewalls to filter traffic between two networks or between
their private network and the Internet. Firewalls consist of a software program and/or a hard-
ware device that is used to identify and “flag™ different types of traffic. Traffic that is flagged
by the firewall may not be allowed into the network at all, or it may be allowed in but with
restrictions on where it can go in the network. Network administrators are responsible for
configuring the corporate firewalls. Some firewall configurations can be very complex and
can filter traffic by many different characteristics and even by combinations of characteristics.
You should know that some user applications may fail to connect because they are inadvert-
ently blocked by firewall settings when they meet the characteristics that the firewall is
designed to block.
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The following are examples of application or connection characteristics that a firewall may
inadvertently filter or block:

= IP addresses: The firewall can block traffic from specific addresses, lists of addresses, spe-
cific network IDs, or even ranges of addresses.

*  Domain names: The firewall can block access to specific domain names or even block
access to all domains except for a specific domain name.

= Protocols: The firewall can be set to block traffic that is using a specific protocol or proto-
cols, such as File Transfer Protocol (FTP) or User Datagram Protocol (UDP).

= DPorts: Ports are specific logical addresses to which applications are assigned in a computer.
Using ports, a computer can handle and process many types of data traffic at once. The fire-
wall can be programmed to filter traffic that uses specific ports or even to permit only traffic
that uses specific ports.

= Specific words or phrases: Some of the latest firewalls can fully examine, or “sniff,” each
packet to determine whether it can enter the network.

As you can see, a properly configured firewall can provide a tremendous barrier of security
for an organization. You might also see that an improperly configured firewall can cause an
interruption of communications. Since many firewalls do not send any type of message back
to the user, the only real indicator that there is a problem is that the application has failed to
connect. If a user can connect to other computers on a network or on the Internet using some
applications but cannot connect using others, then you should suspect a firewall filter. You
should, of course, contact your network administrator to confirm your suspicion and get the
problem corrected.

ING wall settings, as we discussed in Chapter 5, to make sure the client computer is

ﬁ" You should also check the configuration of the client’s Internet Connection Fire-
not creating its own problem.

Locally Attached Devices

Modern computers can have many devices attached to them to perform functions related to the
user’s utilization of applications. Examples include printers, faxes, and scanners. Windows XP
provides tools to install and configure these devices. Actually, most of the configuration these
days happens through Plug and Play or through wizards built into the software, but you should
know how to use the tools built into Windows XP to configure and troubleshoot devices when
the automatic configuration did not work or has been changed. There are two main tools in the
Control Panel that you can use to configure these devices: Printers and Faxes, and Scanners and
Cameras. You should know how to use these tools to establish connectivity to the device so that
the user can utilize the application associated with the device. In this section we will discuss
these two tools in greater detail.
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An Unintended Consequence

A colleague of mine told me an interesting story about a company with which he worked. They
had just installed a corporate firewall with all of the latest filters. The network administrator
went to great lengths to configure the firewall to block any dangerous or offensive content,
including recognizing keywords within a document.

Shortly after the installation of the firewall, the Human Resource department began complain-
ing that users could not get some of the forms from the FTP servers. They had been able to
retrieve the forms with no problems before the installation. They said, “The forms are mostly
just basic employee information and shouldn’t contain anything offensive!”

The network administrator began by checking all of the IP address and port settings on these
servers that contained the forms. When he found them to be configured correctly, the problem
became even more curious. “Why would certain forms transfer properly while others would

not transfer it at all?”

He continued to examine the firewall settings and found that the firewall was indicating that

some of the forms that users had attempted to download from the HR department contained
offensive content. As you may have guessed, the “offensive content” was discovered to be the
word sex, which appeared on many forms to inquire of a person’s gender. Changing the word
sex to gender on the forms corrected the problem.

The moral of this story is that even the best intentions can sometimes have unintended conse-
quences. Your network administrator will configure the corporate firewall to protect the orga-
nization and its users. It's your responsibility to make sure that the users can still use their
applications normally after the firewall is configured.

Printers and Faxes

The Printers and Faxes tool allows you to manage the printers on a computer. Printers, contrary
to popular belief, are actually software and not hardware. A printer is the software package,
including the drivers, that controls the print device that actually creates the print job. The Print-
ers and Faxes tool, as shown in Figure 9.13, enables you and the users to manage the currently
installed printers and to install an additional printer when necessary. In this section, we will dis-
cuss each of these concepts in greater detail.

Managing Printers

You can simply right-click on any of the printers and then choose Properties to manage that
printer. Figure 9.14 shows the properties of a printer used for an HP Color Laser]et print device.
Most printers enable you to print a test page from the printer itself. If you can print the test page
using the printer software, but you cannot print from the application, then you have isolated the
problem to the application. The other tools and settings for printers will vary by printer man-
ufacturer and type of printer.
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FIGURE 9.13 The Printers and Faxes tool in Windows XP

Fle Edit View Favortes Took Hep i
OBack ~ © - (7|2 seach [ Foders | [~

Address | Printers and Faxes

" Printer Tasks

= e | 0
18] Add = printer | ZaAuto Adobe POF on XPCLIENT 0 Ready
. 0 Ready
2 Setup faxing o Ready

0

i Microsoft Office Document Image Wiiter

See Also (2]

[‘ﬂ Troubleshoot printing
©) Get help with printing

Other Places

B control Panel
'S Scanners and Cameras
@ My Documents

IZ3 My Pictures
§ My Computer

i i
5 objects |

FIGURE 9.14 Properties for an HP Color LaserJet printer

ColorManagement ] Security | Device Setlings
General Shari | Pots |  Advanced
D FeCorasesl |
Location: | |
Comment ‘ ‘

Model: HP Colar LaserJet
Color Yes Paper available:
Double-sided: No Lettar e
Staple: No
Speed: Unknown
Maximum resolution: 300 dpi Il gt
[ PrntingPrsferences.. | [ PrniTastPage |
. OK I | Cancel I | Apply |
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Adding a Local Printer

You can use the Printers and Faxes tool to add many types of printers, including local print-
ers, network printers, and printers that just send output to other software, such as an Adobe
Acrobat printer. In this section we will focus on adding a local printer to a computer. You
should know that a local printer is a printer that is software that is installed on a computer
to which the associated print device is actually attached. Exercise 9.5 walks you through the
steps to add a local printer to a user’s computer.

Adding a Local Printer

1. On the Windows XP Desktop, click Start and then choose Control Panel.

2. On the Control Panel, choose Printer and Faxes.

3. Onthe Printers and Faxes tool, choose Add A Printer to open the Add Printer Wizard.
4,

On the Welcome screen of the Add Printer Wizard, click Next.

Add Printer Wizard

Welcome to the Add Printer
Wizard

This wizard helps you install a printer or make printer
connections.

i If you have a Plug and Play printer that connects

m) through a USE port (or any other hot pluggable port,
such as |[EEE 1394, infrared. and so on), you do not
need to use this wizard. Click Cancel to close the
wizard, and then plug the printer's cable into your
computer or pointthe printer toward your computer's
infrared port, and turn the printer on. Windows will
automatically install the printer for you

To continue, click Next

[ Mex > ;[ Cancel
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EXERCISE 9.5 (continued)

5.

6.

Select Local Printer Attached To This Computer. You can also select the Automatically

Detect And Install My Plug And Play Printer check box and then click Next to detect and
install a printer that has been physically attached to the computer. If you choose not to
automatically detect and install the printer, then proceed to Step 6.

Add Printer Wizard

Local or Network Printer
The wizard needs to know which type of printer to setup

Selectthe option that describes the printer you want to use:

(@) Local printer attached to this computer

[“]iAutomatically detect and install my Plug and Islay prinle'ﬁ

f:i A ngtwork printer, or a printer attached to another computer

To setup a network printer that is not attached to a print server,
\) use the "Local printer” option

[ < Back [ Mext > I I Cancel

Click Next to open the Select a Printer Port dialog box.

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports

Selectthe port you want your printer to use. Ifthe portis notlisted, you can create a new port

(@) Use the following port

Note: Most computers use the LPT1: portto communicate with a local printer. The
connector for this port should look something like this:
S

&= =

(") Create a new port

[ < Back Mext > Il Cancel ]
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EXERCISE 9.5 (continued)

7. Inthe Selecta Printer Port dialog box, choose Use The Following Port or Create A New Port
and then use the drop-down arrow to select the port that you wish to use or create. Click
Next to continue.

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports

Selectthe port you want your printer to use. Ifthe portis not listed, you can create a new port.

(8) Use the following port LPT1: (Recommended Printer Part) |~
LPT1: (Recommended Prnter Port)

Note: Most computers usqLPT2: (Printar Port)
connector for this port sho|LPT3: (Printer Port)
COM1: (Senal Port)
COM2: (Serial Port)
COM3: (Senal Port)
COM¢4: (Senial Port)
COMSE: (Serial Port)
COME: (Senal Port)
COM?. (Senial Port)
(C) Create a new port FILE: (Print to File)

e of port WPCLIENT\Printer (Local Port)
Desktop\* pdf (Adobe PDF Port)
Microsoft Documentimaging Writer Port: (Local Port)
My Documents\”.pdf (Adobe PDOF Port)

TSI1{TSI Print Redirectar)
[ <pack | Nexi> Il ancel

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports

Selectthe port you want your printer to use. Ifthe portis notlisted, you can create a new port

() Use the following port

3 \:«:
(®) Create a new port
Type of port | Adobe PDF Port 'V|
Adobe PDF Po
Local Port

Microsoft Document Imaging Writer Monitar

Standard TCP/IP Port ancel
TSI Print Monitor

8. In the Install Printer Software dialog box, choose the printer manufacturer and specific
printer model to obtain the drivers from the Windows XP driver cache, and then click Next.
You can also choose Have Disk to install the drivers that came with the print device or Win-
dows Update to search the Windows Update website for printer drivers.
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EXERCISE 9.5 (continued)

9. Inthe Name Your Printer box, type a name for your printer in the box below Printer Name
or accept the default name for the printer, and then click Next. You can also choose
whether you want the new printer to be the default printer for the user’s computer.

Add Printer Wizard
Name Your Printer
You must assign a name to this printer.

Type a name for this printer. Because some programs do not support printer and server
name combinations of more than 31 characters, itis bestto keep the name as shortas
possible.

Printer name:
HP LaserJet4l

Do youwantto use this printer as the default printer?

(O ¥es
(@) No

[ < Back |[ Next > Il Cancel ‘

10. Inthe Printer Sharing dialog box, choose Do Not Share This Printer or choose Share Name
and the type the share name for the printer. Click Next.

-

Add Printer Wizard

Printer Sharing
You can share this printer with other network users

Ifyou want to share this printer. you must provide a share name. You can use the suggested
name or type a new one. The share name will be visible to other network users.

{_) Do not share this printar

HPLaserJ

< Back “ Next > I | cancel
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EXERCISE 9.5 (continued)

11. In the Location and Comment dialog box, enter the printer location and comments about
the printer if you wish, and then click Next. Note: This is not a required step.

Add Printer Wizard

Location and Comment
You have the option of supplying a location and description of this printer

You can describe the location and capabilities of this printer. This information may be helpful
to users.

Location:  bham/corporate/2ndFloor

Comment  Large Document Printed

[ < Back “ Mext > |[ Cancel ]

12. In the Print Test Page dialog box, select Yes if you want to print a test page now or No if
you do not want to print a test page. If the print device is actually attached to the computer,
then it is recommended that you print a test page. Click Next to continue.

Add Printer Wizard

Print Test Page
To confirm that the printer is installed properly, you can print 2 test page

Do youwantto print a test page?

< Back ” Mext = ] ’ Cancel
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EXERCISE 9.5 (continued)

13. In the Completing the Add Printer Wizard dialog box, review your settings and then click
Finish to create the printer and close the wizard.

Add Printer Wizard

Completing the Add Printer
Wizard

You have successfully completed the Add Printer Wizard,
‘You specified the following printer setbngs:

MName: HF LaserJet4l

Share name.  HPLazer)

Port: LPTY:

Model: HF Laseret4l

Default Na

Testpage Yes

Location: pham/corporate/2ndFioor
Comment Large Document Printer

To close this wizard, click Finish

< Back " Finish i Cancel

Scanners and Cameras

Users utilize a computer in many ways, including viewing and managing images that are pro-
duced by scanners, cameras, and other imaging devices. Windows XP has built-in tools to assist
you and the user in managing these imaging devices that are connected to the computer. You
can use the Scanners and Cameras tool, shown in Figure 9.15, to manage currently installed
imaging devices and to install additional imaging devices. In this section we will discuss each of
these concepts in greater detail.

Managing Imaging Devices

You can install multiple imaging devices on a single Windows XP computer and manage
them using the Scanners and Cameras and tool located in the Control Panel. As a desktop
support technician, you should be familiar with the use of this tool so that you can assist
users with managing their imaging devices. To manage a currently installed device, you
should right-click on the device and then choose Properties. The properties that you can
manage will vary by the device, but most devices include a diagnostic tool, such as the
device shown in Figure 9.16.

Adding an Imaging Device

You can also use the Scanners and Cameras tool to quickly add new imaging devices to a user’s
computer. The tool includes wizards to assist you in adding the devices. Exercise 9.6 walks you
through the steps to add a new imaging device to a user’s computer.
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FIGURE 9.15 The Scanners and Cameras tool

Fle Edt View Favorites Took Hep
QBack + © - (7| P search = Follers | [v

| Type
i Image scanner

Imaging Tasks
El Add an imaging device

Other Places

B control Panel
fa My Documents
@ Shared Documents
%3 My Netwark Flaces

FIGURE 9.16 Animaging device with a diagnostic tool

General | Color Ma ent)
a Visioneer 87XX/89%X USB Scanner
Manufactured by~ Visi Hardware
-5 Status

Status. Device Ready OnPort Wilsbscanl

Optical resclution:  300x300 DPI

Diagnostics

OK | | Cancel | | Appl‘,r_l




372 Chapter 9 - Configuring and Troubleshooting Connectivity for Applications

Adding an Imaging Device Using the Scanners and Cameras Wizard
1. On the Windows XP Desktop, click Start and then choose Control Panel.

2. On the Control Panel, choose Scanners and Cameras.

3. Onthe Scanners and Cameras tool, ensure that you do not have a device selected, and then
select Add An Imaging Device to open the Scanner and Camera Installation Wizard. Click
Next to close the Welcome screen of the Scanner and Camera Installation Wizard.

Scanner and Camera Installation Wizard

Welcome to the Scanner and
Camera Installation Wizard

This wizard helps you to install a digital camera, scannar or
other image device that Windows did not automatically detect

To conbnue, click Next

| Mext = | | Cancel

4. Choose the manufacturer and specific model of your imaging device. If you have software
that was included with the device, you can click Have Disk and insert the CD/DVD in the
appropriate drive. Click Next to continue.

Scanner and Camera Installation Wizard m
Which scanner or camera do you want to install? &}
. E:;
= --a Select the manufacturer and model of your device. If you have an installation disk, click Have
o Disk
Manufacturer i Il| Madel
Agfa | _ | | E=kagta ePhoto 1280 Digital Camera
E"‘f"" ¥ Agfa ePhota 1680 Digital Camera
pson e
FLJiIFII M [}Agfa ePhoto 780 Digital Camera
Hewlett Packard i
@‘ Thiz driver s digitally signed.

<Back |[ Next> | Cancel |
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EXERCISE 9.6 (continued)

5. Select Automatic Port Detection or choose the port to which you want to install the device,
and then click Next.

Scanner and Camera Installation Wizard

Connect your device to your computer.

Plug your device into 3 port on your computer, and then
selectthe port below.

Available ports:

Automatic port detection

Communications Part (COMT)

SAMSUNG USB-to-Serial Comm Pont (COM7)

I < Back ” Next > [| Cancel ‘

6. Accept the default name for the device or type the name that you wish to use, and then

click Next.
Scanner and Camera Installation Wizard b4

What is the name of your device? @

Type a name for your device or use the one provided below.

. bt
Agfa ePhoto 1280 Digital Camera

< Back JI MNext > ] I Cancel
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EXERCISE 9.6 (continued)

7. Click Finish to complete the installation. Some devices may require that you restart your
computer before using the device.

Scanner and Camera Installation Wizard @

Completing the Scanner and
Camera Installation Wizard

To close this wizard and complete the installation of your device. click
Finish. To change your installation preferences. click Back

i

Summary

There are many settings of a computer that must be configured correctly to provide connectivity for
a user’s applications. As a desktop support technician, you should be familiar with these options,
including their configuration and troubleshooting methods when a configuration is not correct. The
settings that you should be familiar with include name resolution, network adapter configuration,
LAN configuration, firewall configuration, and configuration of locally attached devices.

Computers actually use only one address to identify one another and facilitate communication:
their MAC address. This address is burned into the network interface card installed on each com-
puter in a network. People, on the other hand, use many names and addresses to manage com-
puters and to design computer networks. The process of converting the names that people use to
the MAC address that a computer can use is called name resolution. There are two basic types of
name resolution: NetBIOS name resolution and hostname resolution. NetBIOS name resolution
is accomplished using an Imhosts file, a WINS server, or broadcasts if neither is available. Host-
name resolution is accomplished using a hosts file or, more commonly, DNS servers. In both cases,
the name is resolved to an IP address, which is then resolved to a MAC address. Most newer appli-
cations use hostname resolution, but some of the older legacy applications still use NetBIOS name
resolution. As a desktop support technician, it is important that you understand these concepts so
you can assist the user with name resolution problems related to applications.
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The network adapter card on a user’s computer is like a little computer. Correct “program-
ming” of the network adapter card requires a basic understanding of the TCP/IP protocol. It is
essential that each computer’s network adapter card be configured with a valid IP address, sub-
net mask, and default gateway. Since users can, by default, make changes to this configuration,
a desktop support technician should be able to recognize and correct errant configurations for
the user. The ipconfig command and the Network Connections tool in Control Panel are the
tools most commonly used to analyze and correct these configurations.

Today’s users are just as likely to be connecting to your network from a remote location as they
are to be connecting from their own desktop computer. Many applications that the users utilize,
such as Internet Explorer and Microsoft Outlook, require connectivity to the Internet. You can
provide this connectivity with a direct connection to an ISP or require users to go through a proxy
server to enhance the security of the network. The New Connection Wizard in Microsoft Internet
Explorer has built-in tools to assist you in both types of LAN configuration. You can also con-
figure and control remote access connections including dial-up and VPN connections.

Today’s networks often incorporate corporate firewalls for the purpose of filtering traffic into
and out of the network. These firewalls can either be your best friend or your worst enemy. They
do protect the network from intruders who would harm it, but they might also inadvertently block
regular application traffic and disrupt a user’s communications. While it is unlikely that you will
be able to manage the configuration of your corporate firewall, you should be familiar with the
filters that the network administrator might have applied so that you can recognize a problem that
is associated with the firewall. The types of filters that most firewalls use include IP addresses,
domain names, protocols, ports, and sometimes even specific words or phrases. If most applica-
tions are working correctly but some applications cannot make a connection to a required
resource, then you should suspect firewall configuration as a possible problem.

Most of today’s computers offer the ability to add locally attached devices for specific uses,
such as printers, faxes, scanners, and cameras. These devices often work along with an application
that assists the user in some aspect of her job. Windows XP includes tools to manage currently
installed devices and to install additional devices when necessary. The two main tools that you can
use to manage locally attached devices are the Printers and Faxes tool and the Scanners and Cam-
eras tool. Most of the installation of these types of devices is accomplished through Plug and Play
or through wizards included with the software that came with the device. You should be familiar
with these tools so that you can assist the user in managing and installing these devices when the
automatic installation does not work or when troubleshooting is required.

Exam Essentials

Know the name resolution methods. You should understand the two main types of name res-
olution. You should know that most new applications use hostname resolution, but that some
older applications still use NetBIOS name resolution. You should understand that computers
actually use only the MAC address and that all other names are to help people manage com-
puters and design networks. You should also know the files and services that each type of name
resolution uses. Finally, you should be able to recognize and correct application problems that
are associated with name resolution.
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Be able to configure network adapter cards. You should know and understand the three
main configurations on a network adapter card: the IP address, subnet mask, and default gate-
way. You should know how to examine the configuration of a user’s network adapter card with
the Ipconfig tool on a command line. Finally, you should be able to use the Network Connec-
tions tool to further analyze and correct network adapter card configurations.

Understand LAN configuration. You should know how to configure the essential LAN
settings for a user’s applications in the Windows XP operating system as well as in Internet
Explorer. In addition, you should know how to configure proxy settings for client computers
that are required to use a proxy. Finally, you should be able to configure the connection to
bypass the proxy for addresses that are within your own intranet.

Be able to configure remote access. You should know how to configure clients for remote
access including dial-up and VPN connections. In addition, you should understand the differ-
ences between dial-up and VPN connections. Finally, you should be able to use the Network
Connections tool in the Control Panel and the tools built into Internet Explorer to configure
both types of connections.

Be aware of how firewalls might affect applications. You should know how firewalls can be
used to protect the network. In addition, you should remember that firewalls can impede net-
work communications and disrupt application traffic. Finally, you should know the various fac-
tors by which network administrators might filter traffic through a firewall so that you can
recognize problems related to firewall configuration.

Know how to install and manage locally attached devices. You should know how to man-
age locally attached devices using the tools provided by the Windows XP software. In addi-
tion, you should be able to use the tools in the Windows XP Control Panel to install additional
devices. Finally, you should know how to locate the diagnostic tools in the properties of
locally attached devices.
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Review Questions

1. You are the network desktop support technician of your organization. Some users are utilizing
legacy applications that use NetBIOS name resolution. Which of the following types of files and
services might affect name resolution for these legacy applications? (Choose two.)

A. WINS

B. DNS
C. Lmbhosts
D. Hosts

2. Youare the desktop support technician for a large organization. The network administrator has
configured a server to automatically assign an IP address as well as the addresses of the servers
that provide name resolution to each client computer when the computer is started on the net-
work. Which type of server has the network administrator configured for this purpose?

A. DNS

B. WINS
C. RRAS
D. DHCP

3.  Youare the desktop support technician for a large organization. Some users complain that they
can communicate within their own subnet but not outside their subnet. Which part of the IP con-
figuration should you examine first?

A. IP address
B. Subnet mask
C. Default gateway
D. DNS server address
4. You are the desktop support technician for a large organization. A user has a connectivity issue
with an application. You want to examine all of the IP settings of the user’s network adapter

from a command line, including the addresses of the name resolution servers for which it is con-
figured. Which of the following commands should you type on the command line?

A. Ipconfig

B. Nbtstat -a
C. Arp -a

D. Ipconfig /all
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5.  You are the desktop support technician for a large organization. You have recently configured
a client to use a proxy server. The user now complains that although she can access resources on
the Internet, she can no longer access resources on her own intranet from her browser. Which
of the following settings should you suspect first?

A. Proxy server address
B. Proxy server port
C. Bypass proxy setting
D. DNS server address

6. You are the desktop support technician for a large organization with many locations. You also
have many users who utilize their laptops from hotels in remote locations. Since management
is concerned about long-distance charges, you want to employ a technology that will reduce

or eliminate long-distance charges for these users. Which of the following technologies should
you employ?

A. Dial-up

B. Cable modems
C. DSL

D. VPN

7. Youare the desktop support technician for a large organization. The network administrator has
recently installed a corporate firewall. Now some of your users’ applications will not function,
while others function normally. The users still have general connectivity to all of the resources
that they use. Which types of firewall filters should you suspect first? (Choose two.)

A. IP addresses
B. Domain names
C. Protocols
D. Ports
8. You are the desktop support technician for a large organization. You have recently installed
a client computer onto the network. The computer can access some applications, but cannot
access other applications through the network. You suspect that the corporate firewall is causing
the problem. You speak to the network administrator, but she insists that the corporate firewall

could not be causing the problem because other clients in the same subnet as that client computer
can access all applications properly. What configuration option should you suspect next?

A. DNS
B. WINS
C. ICF

D. DHCP
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You are the desktop support technician for a graphics company. A user has obtained a new
imaging device and attempted to install it on her Windows XP computer, but the automatic
installation failed. Which Control Panel tool can you use to assist the user in completing and
troubleshooting the installation?

A. Printers and Faxes

B. Sounds and Audio Devices

C. System

D. Scanners and Cameras

You are the desktop support technician for a large organization. Some users have personal printers
directly attached to their client computers. A user complains that her personal printer will not print
from one specific application. It seems to work fine with other applications, and she can print a test

page from the Windows XP client software. Which of the following should you suspect first as the
cause of this problem?

A. Printer drivers

B. The application

C. The operating system
D. The print device
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Answers to Review Questions

10.

A, C. NetBIOS name resolution can be accomplished using an Imhosts file or a Windows Inter-
net Name Server (WINS). Domain Name System (DNS) and the hosts file are used to perform
hostname resolution.

D. The network administrator can configure the Dynamic Host Configuration Protocol (DHCP)
server to automatically assign an IP address, the addresses of the name resolution servers, and
other configuration information to a client. The DNS server is used for hostname resolution.
WINS is used for NetBIOS name resolution. RRAS is used for routing and remote access.

C. If the default gateway is not correctly configured, then users will not be able to communicate
outside their own subnet. If the IP address and subnet mask were not configured properly, the
users would not be able to communicate within their own subnet. The DNS server address is not
a valid concern in this case.

D. The ipconfig /a1l command will display all of the IP settings related to each network adapter
installed in a client. The ipconfig command will display only the IP address, subnet mask, and
default gateway addresses assigned to the card. The nbtstat -a command will display the Net-
BIOS names assigned to a client. The arp -a command will display the ARP cache of a client.

C. You should suspect that the Bypass Proxy Server For Local Addresses setting is not selected.
Selecting this setting will let the client gain access to local resources without using the proxy. The
proxy server address and port address must be correct or the user would not be able to access
the Internet. The DNS server address is not the issue in this case.

D. Virtual Private Network (VPN) connections will enable the user to dial their ISP’s local number
wherever one is available. Once the user is connected to the ISP, he can be tunneled through the Inter-
net to your organization’s servers. Dial-up connections will not eliminate long-distance charges.
Cable modems and DSL might be used from the users’ homes but cannot be relied upon at hotels.

C, D. Since some applications are functioning while others are not, you should suspect that the
filter is specific to an application. The only two choices here that are specific to an application
are protocols and ports. Since the users have general connectivity to their resources, you should
not suspect IP address or domain name filtering to be the source of the problem.

C. The issue is probably related to a firewall but, in this case, it’s not the corporate firewall but
instead the Internet Connection Firewall (ICF) that is part of the Windows XP client software.
You should access the advanced settings on the client’s connection and examine the ICF config-
uration. The DNS, WINS, and DHCP servers are not part of this problem; otherwise, the client
would not have access to any applications through the network.

D. The Scanners and Cameras tool in Windows XP enables you to manage currently installed
imaging devices and install additional devices. The Printer and Faxes tool enables you to manage
and install printers and faxes. The Sounds and Audio Devices and System tools are not appro-
priate in this scenario.

B. In this case, the specific application must be at fault. If there were a problem with the printer
drivers, the operating system, or the print device, then none of the applications would work cor-
rectly with the printer and a test page would not print.
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Security on a computer or a network should be virtually transpar-
ent to a user who is just doing his job. In other words, if the user
wants access only to resources that he has been allowed to use,
then he should be able to access those resources with his normal user logon and without pro-
viding additional credentials. On the other hand, security should become very apparent to a user
who attempts to use a resource for which he does not have permissions. In addition, your net-
work and the computers that it contains should be continually updated to protect against
attacks from intruders and viruses. Some applications provide tools and settings to enhance
their own security.

As a desktop support technician, you should understand the elements of security that relate
to a user’s applications. In this chapter, we discuss security with a special focus on application
security. The security of the user’s applications relies on understanding and controlling the fol-
lowing three elements:

Problems related to permissions Permissions either allow a user to utilize a resource or deny
him its use. There are many types of permissions that you can use to control access to a resource.
The type of permission that you use will depend upon the type of resource and its location. The
key is to make sure that the user can utilize the resource transparently, while at the same time
blocking access to intruders. While the network administrator typically controls this, you
should understand the problems that can result when permissions on the network and the com-
puters that it contains are not controlled properly. You should also be able to recognize security
issues related to applications so that you can bring them to the attention of the network admin-
istrator. Finally, you should be able to troubleshoot user permissions and rights to assure that
users can remain productive.

Security incidents Security incidents are not inherently the fault of the network administrator
or the desktop support technician, but their success in causing a disruption could indicate a
weakness in the security of a computer or a network. You should be able to quickly identify and
troubleshoot a problem caused by a virus. In addition, you should ensure that you have installed
the latest critical updates for your users’ operating systems and applications. This should not be
considered a one-time fix but rather a habit or ongoing procedure.

Application security settings Some applications provide their own tools to enhance security
for users and their documents. You should understand that these security measures are gener-
ally a trade-off for application flexibility and functionality. For example, when you enable
macro security you might limit the functionality of an application. We will discuss security set-
tings that are built into the applications within Microsoft Office 2003. You should be familiar
with these settings so that you can enhance a user’s application security and troubleshoot issues
related to these settings.
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Problems Related to Permissions

In Chapter 2, “Managing and Troubleshooting Access to Resources,” we discussed file and
folder permissions that you can use to control a user’s access to the documents that are created
by applications. You should know that you can also control a user’s access to the application
that creates the documents. For example, only the users who have access to the executable files
for each application will be able to utilize the application. The network administrator will con-
trol most of this security, but you should be able to recognize security issues that are related to
permissions and to rights to use applications.

While it is possible to assign a user permissions to an application directly, this is not the rec-
ommended method. Users are typically allowed to use an application based on their member-
ship in a group. On a computer that is a member of a workgroup, this is generally the Users
group or another group with specified access to the application. You can examine the member-
ship of local groups using the Local Users and Groups tool within the Computer Management
console. Exercise 10.1 walks you through the process of examining group membership.

Examining Local Group Membership in Windows XP

1.  On the Windows XP desktop, right-click My Computer and then choose Manage.
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EXERCISE 10.1 (continued)

2. Inthe Computer Management console, expand Local Users And Groups.
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3. Inthe console pane (on the left) choose Groups.
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EXERCISE 10.1 (continued)

4. Inthe details pane (on the right), right-click the group that you want to examine and then

choose Properties.
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5. Examine the box beneath members to determine who is a member of this group.
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EXERCISE 10.1 (continued)

6. Toaddamemberto the group, click on the Add button and then type the name of the new
member. (You can also use the Advanced button to browse a list of users.)

7. When you have entered the name of the new member, click OK to close.

On a computer that is a member of a domain, the Domain Users group or another specialized
group may be used for this purpose. These groups will be maintained by the network adminis-
trator using the Active Directory Users and Computers tool. You will generally not be allowed
to make changes to these groups, so you will need to forward your requests to the network
administrator.

At this point, you may be wondering why it is so important to control a user’s access to appli-
cations. After all, it’s just an application right? Well, applications are also doors into the oper-
ating system of the computer. An attacker can use these doors to exploit the memory of a
computer and in some cases, even to gain access to the registry. You should be familiar with the
security issues related to improper access to applications.

The following is a partial list of security issues that can affect a user’s productivity when
accessing an application locally as well as through the network:

Buffer overruns A buffer is a special area of memory that is set aside to speed the execution
of an application. Buffers are meant to improve productivity, but they can also become a poten-
tial security issue if permissions are not correctly configured. You should ensure that only the
appropriate users have permissions for the executable files of applications and that the latest
service packs are installed to reduce the possibility of an attacker’s exploiting a buffer in a buffer
overrun attack. You can refer to Microsoft Knowledge Base (KB) article 308035 for more infor-
mation on buffer overrun attacks.

Registry access The time during an installation or a restart after an installation is an especially
vulnerable period for the application from a security standpoint. This is because the application
and the Local System account have been given access to the Registry. If an attacker has access
at this point or if a worm has been hidden in the computer, then security could be breached at
this time. For this reason, you should make sure that you know what software is being installed
on the computers within your network.

Macros Macros are designed to improve user productivity by allowing users and program-
mers to create command sets that automatically run a series of steps within the computer. You
should know that an attacker can exploit macros and that the very resource that was designed
to improve productivity can also be used to threaten security. We will discuss macro security in
greater depth later in this chapter.

Viruses Virus attacks threaten the security of computers and networks in all organizations.
The only real way to protect your computers and networks from viruses is to install and main-
tain an antivirus program. We will discuss viruses and virus prevention in much greater depth
later in this chapter. You can also refer to Microsoft KB article 129972 for more information
on virus prevention.
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Security Incidents

As a desktop support technician, you should understand the security procedures and policies of
your organization. Most organizations use some type of antivirus software to protect the com-
puters in their network from the harmful effects of viruses. This software prevents many viruses,
but some might still slip through. You should be able to recognize the symptoms of a virus on
a user’s computer. In addition, most organizations require that computers be kept up-to-date
with the latest critical patches. Although you may not be responsible for maintaining the secu-
rity of the entire network, you are responsible for understanding the impact of these security
policies on the individual computers in your network. In addition, you are responsible for
understanding the methods that the network administrators might choose to deploy these
updates. In this section, we discuss each of these topics in greater detail.

Viruses

Viruses are executable files that are designed to replicate themselves, thereby causing a disrup-
tion of service for the computer user. They’re also designed to avoid detection by disguising
themselves as legitimate programs. There are over 60,000 known viruses at the date of this writ-
ing! In addition, even more viruses are being created on a daily basis. Most organizations use
antivirus software on their networks and on the individual computers in their networks to com-
bat the problem of viruses. You should recommend that your organization make use of an anti-
virus program that has an automatic update feature.

As the desktop support technician, you should be aware of how viruses might affect the com-
puter. You should be able to recognize the effects of a virus such as a worm or a Trojan horse.
In addition, you should know what steps to take to begin to recover the computer from a virus
attack. Finally, you should be aware of procedures that can reduce the likelihood that another
virus attack will succeed. In this section, we will discuss each of these concepts in greater detail.

The Effects of a Virus

The effects of a virus will vary depending on the type of virus. Some viruses are just a minor nui-
sance, but others have been known to cause a considerable amount of damage to the user’s data
and to essential operating system files. You should be able to recognize problems that are most
likely caused by a virus so that you can quickly troubleshoot a user’s computer when it is
infected. It’s also important to quickly troubleshoot viruses because you want to make sure that
you don’t give them a chance to spread to other computers.

The following is a list of symptoms that might be caused by a computer virus:

= The infected file makes copies of itself and ends up using much of the free space on a user’s
computer.

= The infected file is automatically sent to all or some of the addresses on the user’s e-mail
address list.

= The user’s hard drive is partially or completely formatted without any action from the user.
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Much of the user’s hard drive is consumed, but the files and folders that contain the data
are not recognizable or are not even visible.

Security settings on the computer or the network are automatically changed without any
action from the user or any other party.

A user tells you that his computer hasn’t been working well since he last checked his e-mail
and opened some attachments.

There are double extensions (such as jpg.vbs) on attachments that have been recently
opened by users.

The antivirus program on a computer is unexpectedly disabled and cannot be restarted.
A new antivirus program cannot be installed on a computer or will not run properly.

Messages or dialog boxes suddenly appear on the user’s screen without any action from the
user.

A user tells you that she is receiving unusual e-mail with attachments from people with
whom she rarely has contact.

Icons suddenly appear on a user’s desktop that the user did not create and that are not asso-
ciated with any application installed on the user’s computer.

Unexpected sounds are heard from the audio system of the computer.

Programs that were previously installed and running on the computer have disappeared
without any action from the user or any other party.

Recovering from a Virus Attack

While it would be nice to just prevent all virus attacks from affecting (and infecting) your users’
computers, it’s probably not a realistic goal. Chances are good that some viruses will sneak
through onto some computers in your network. For this reason, you should know the steps to
recover from a virus attack. While the details of each step will vary based on the virus, there is
a method that will generally assist you in eradicating a virus from a user’s computer.

To recover from a virus you should take the following five steps in the order that they

are listed:

1.

Check the website of your antivirus vendor to get the latest information about eradicating
the virus. Follow any directions that are listed on the website. Often, there will be detailed
instructions that you can use to eradicate the virus while protecting most, if not all, of the
user’s data.

If your antivirus program is still working properly, then make sure that you have the latest
updates from your antivirus vendor. When you are sure that you have the latest updates,
scan the computer with the updated antivirus program.

If your antivirus program is damaged or is not working properly, then reinstall the antivirus
program with the latest updates. After the antivirus program is reinstalled, scan the entire
computer to eradicate the virus.

After the virus has been eradicated according to the antivirus software, scan the entire com-
puter once more to make sure that it is completely free of viruses.
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In some cases, you may have to completely reformat the hard drive and reinstall the oper-
ating system and all of the applications. If the antivirus software states that it cannot erad-
icate the virus, then the virus may have hidden itself in the master boot record or another
operating system file. If the antivirus software will not clear the virus and the vendor’s web-
site does not have an adequate solution, then you will have to reformat the user’s hard drive

to remove the virus. If possible, you should back up the user’s data and configuration
before reformatting her computer.

Be Careful about the Computers That You Connect to Your Network

A few years ago, a company with which | was associated brought a computer into their network
from a user’s home to install the latest security updates and antivirus programs. Shortly after they
attached the computer to the network, they realized that they had made a mistake. Other computers
that had the latest antivirus software began reporting the presence of the W32.FunLove.4099 virus.
The FunLove virus has a cute name, but it is not a friendly virus. In fact the FunLove virus has the
ability to infiltrate the Windows NT security subsystem and cause degradation in performance and
system instability on the computers that it infects. Unfortunately, before they could stop it, the virus
had located network shares and replicated itself into the network and onto many computers. This
was just the beginning of their FunLove problems.

They began by updating the antivirus software on the client computers and servers and install-
ing antivirus software on any computers that did not currently have it. They ensured that all of
the computers were aware of the FunLove virus signature. They then used the antivirus soft-
ware and instructions from the vendor’s website to quarantine and clean the FunLove virus
from the network and its computers.

This process took approximately one week, but every time they thought they had seen the last
of the virus, it managed to pop up in a few places again. By this time, most of the computers
were protected against the effects of the virus, but it was still perplexing as to where the virus
was hiding. They checked all of the drives of the computers where it seemed to have surfaced
again and found nothing.

Finally, when the virus appeared once more after over two weeks of absence, they determined
where the virus had been hiding. Apparently, a user who did not know that his computer was
infected had made a backup to a CD-R very early in the process. Whenever he decided to use
the files that were on the CD-R, he unknowingly relaunched the virus onto his computer and
into the network.

The moral of this story is “Be careful about connecting a computer to your network when you
are not sure what it contains.” Do not allow users to bring computers from home and connect
them to your network. It may be tough to enforce strict rules at times, but it is much harder to
track down a virus and eradicate it once it is released into an active network.
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Preventing a Virus Attack

While it may be impossible to prevent every virus attack from succeeding, there are steps that
you can take to protect the security of your computers in regard to viruses. Since you are respon-
sible for the productivity of the users on your network, you should be familiar with the guide-
lines to prevent virus attacks from succeeding. Your ability to implement these measures will
vary based on the policies of your organization. You should know that the more of these guide-
lines that are implemented, the safer the network and the computers that it contains will be.

The guidelines that are recommended by Microsoft to prevent virus attacks from succeeding
are as follows:

= Install an antivirus program that includes an automatic update feature.
=  Configure your antivirus program to automatically update virus signatures on a daily basis.
=  Configure your antivirus program to automatically scan computers on at least a weekly basis.

= Install the latest security patches from the Microsoft Windows Update website at
windowsupdate.microsoft.com.

= Configure Windows to download and install all critical updates. See Microsoft KB
article 294871.

= Make sure the latest updates are installed for all e-mail programs utilized by users.
= Disable Active Scripting in Outlook and Outlook Express.

=  Enable and configure the Internet Connection Firewall (ICF) on users’ computers or install
a third-party personal firewall.

Security Updates and Patches

A security update is generally a new piece of software that is released by the software vendor to
combat a known security weakness. Today’s software vendors typically create and distribute
security updates as soon as a weakness or flaw in an application’s security is discovered.
Microsoft’s Windows Update website can help you keep a user’s computer up-to-date with the
latest security patches for the operating system. You should understand how to use the Win-
dows Update website to enhance the security of applications on a user’s computer by enhancing
the security of the operating system. In addition, you should know how to use the Office Update
website to check for any updates specific to Office applications. You should also know how net-
work administrators might deploy security updates to a large group of computers using Group
Policy and/or Systems Management Server (SMS). Finally, you should know the difference
between critical updates and optional updates. In this section, we will discuss each of these con-
cepts in greater detail.

The Windows Update Website

In Chapter 1, “Installing a Windows Desktop Operating System,” we discussed the Windows
Update feature of Windows XP and the Windows Update website as they apply to the operating
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system. You should know that the Windows Update website can also help you keep your com-
puters up-to-date with the latest security patches for applications. When you access the Win-
dows Update website, the site scans your computer and provides you with the selection of
updates that apply only to the operating system and the applications on your computer that
came with the operating system, such as Internet Explorer and Outlook Express. New content
is added to the site on a regular basis, so you can always get the most recent updates to protect
your computer and maintain the user’s productivity. You should encourage users to access the
Windows Update website on a regular basis. Exercise 10.2 illustrates how to access the Win-
dows Update website and scan a user’s computer for the latest updates.

Accessing the Windows Update Website

1. Onvyour browser, type windowsupdate.microsoft.com. The system will convert the
address to the latest Windows Update website. (At the time of this writing the site was
v4.windowsupdate.microsoft.com/en/default.asp.)
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2. Wait for the site to obtain the latest Windows Update software. (Depending on the speed
of your connection, this might take a minute or two.)
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EXERCISE 10.2 (continued)

3. When the Welcome to Windows Update page is displayed, choose Scan For Updates.

2] Microsoft Windows Update - Microsoft Internet Explorer =X
Bl Edt Vew Favortes Tooks Help &
QBack ~ © - @ & @0 P search rFavortes @ Meda €@ Or S B - OB 3

Address &) hitp:ffvd.wndowsupdate.microsoft.com/en/default.asp

P Windows Update

Home | Windows Catalog | Windows Family | Office Update | Windows Update Worldwide

Windows Update is looking for available
updates... 66% complete

] Windows Update

[ Welcome
[ Pick updates to nstal ...

O Windows XP (18)

[ Review and mstal
updates

Other Options
[ View installation history

& 2004 Miroseft Corporation. Al nohts resereed.  Tamms of use.  Accessibity.

] Done et

4. The system will scan your computer and then list the Critical Updates and other types of
updates that are recommended for your computer and the applications installed on it.

5. When the Pick Updates To Install page is displayed, choose Review And Install Updates.

2] Microsoft Windows Update - Microsoft Internet Explorer =X
Fle EdR View Favorites Tooks Help &
@Back - © - @ & @0 P search FFavortes @ Meda € Or S B - B 3

yBe &

Address &) hitp:ffvd.wndowsupdate.microsoft.com/en/default.asp

¥ Windows Update

Home | Windows Catalog | Windows Family | Office Update | Windows Update Worldwide

| Windows Update Pick updates to install

& Welcome
& Pick updates to nstal

O Critical Updates and
Service Packs (2)

O Windows XP (18)
[ Driver Updates (3)

0 Review and install
updates (2)

Windows Update has found 2 criical updates for your computer.

El review and nstal updates

Windows Update has ako found other updates for your computer. To browse
through these updates and select the ones you want to instal, dick a category tite
i the st

Other Options
[ View installation history

& 2004 Moroseft Corporation. Al nghts resereed.  Tamms of use.  Accessibity.

&) o ntemet
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EXERCISE 10.2 (continued)

6.

7

Read the information about each critical update and service pack first to determine
whether to install it. (You should probably install all critical updates.) If you want to install
the update, then simply leave it on the list. These updates are selected by default. If you do
not want to install the update, then choose Remove to delete that update from the list of
updates that will be installed.

|¢J Microsoft Windows Uplflh‘- Microsoft Inhrmt!xﬁbn'r ‘m
Fie Edt Vew Favortes Tools Help 'ﬂ’
QBsck + O B @ @ | Fsearch “rFavoites Meds € v B -0 83

Address ié] hitp:/fvd windowsupdate micrasoft.com/en/defaui.asp

"7 Windows Update

Home | Windows Catalog | Windows Family | Office Update | Windows Update Worldwide

| Windows Update Critical Updates and Service Packs

Critical updates are already selected for you Lo install
Review the Ist of crica! updates below, You can remove any ftem you don't want.

O Welome
B Pick updates to instal

O Critical Updates and

Service Packs (2) El Review and install updates Total kems selected: (2)
£l DA XEASH) Update Rollup 1 for Microsoft Windows XP (KB826939) i)
O Driver Updates (3) [ i

1 282 KB, < 1 minute
faushy

[ Review and install
updates (2)

ur computer. Read more...
This item has been selected. At Remove
Security Update for Microsoft Windows (819696)

: T lad <7p: 048 KA < 1 minute
& 2004 Microsaft Corporaton, Al nghts raserved.  Tzmms of use,  Accesshify,

&) | &b Internet

other Optons

O View instalation history

Next, read the information about the other updates. If you want to install any of them, then you
will need to click Add to put them on the install list. These updates are not selected by default.

|¢J Microsoft Windows Update - Microsoft Internet Explorer ‘m
Fle Edit Vew Favortes Tooks Help i
QBsck + O B @ | Fsearch “rFavoites dMeds € Db B-C 83
Address !é] hitp:/fvd windowsupdate microsoft.com/en/defaui.asp ﬂ Go %

Al Products | Support | Search | microsoft.com Guide

Microsoft

" ‘"Windows Update
Home | Windows Catalog | Windows Family | Office Update | Windows Update Worldwide

| Windows update Windows XP Updates Y Windows®

T the Windows XP Web ite
Bick from Windows XP updates Wisk the Windows XP Web site

The following updates are avalable for your computer. To select an update you
want to instal, cick Add, and then cick Review and install updates.

0 Welcome
B Pick updates to instal

O Critical Updates and
Service Packs (2)

O Windows XP (18)

E_},I Review and install updates Toksl kems selected: (2)

[ Driver Updates (3) Update for Windows XP Shop for Music Onfine Link (KB833998)
O Review and Install Dovmbad sze; 282 KB, < 1 minute
updates (2} This update changes the behavior of the Shap for musc onine fnk in the My

Music falder. Previoushy, dicking this ink would launch Internet Explorer. After
nstaling this update, cicking this ink wil Bunch the defaull brovses. After you
install this ke, you may have to restart your computer. Read mos

bbb Frs i dmsse WE LSl A B AT £k T £ T U W

Temms of use,  Accesshifty,

oOther Options

O View instalation history

& 2004 Microsaft Corporation. Al nghts reserved.
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EXERCISE 10.2 (continued)

8. When you have finished selecting the updates to install, click Install Now to begin the
installation of all selected updates.

9. The Windows Update dialog box will appear, indicating both the Download progress and
Install progress of your selected updates. Some updates may require that you restart your
computer before they are effective.

ﬁ;] Microso Microsoft Interne - ._——|| 4
Fie Edt View Favortes Took Help i
@Back -+ © - A @ @ S Search “Favortes @ Meda € | (dv & B - [ & 3
Address [ €] http://v4.windowsupdate.microsoft.com/en/default.asp v|Beo &

| Al Products | Support | Search | micre com Guide
Microsoft
Home | Windows Catalog | Wind) . e = g ™
= ] L ety @ Windows Update -- Web Page Di... ﬁ
Windows Update i downloading the
Wiadaws ntare updates to be installed on your computer.
e Please wait.
& Welcome [ Update Rolup 1 for Microsoft Windows XP T 0 —
[ Pick updates to instal ‘ (KBBZ::SQ) B
Download ress: 160 KB/1.2 MB ’
[ Critical Updates and T Eeg 2
Servi @k 2 = 1.2 MB, < 1 minute
ePacks(2) | | pounioad tme remaning: < 1 minute
& Windows XP (18) | Lot Hire P (KB826939) |~
[ Driver Updates (3) ‘ [
view and insta ral and security updates, for -
o 5epdatesa?1) 8 L Cancel pe. Instaling this item provides
R - updates. After you instal this
B i item, you may have to restart your computer. Read more...
Other Options [ _
Remove
O View installation history i = =
'ﬂ" Security Update for Microsoft Windows (819696) —

Dowrlnad si7e: 448 KB. < 1 minute

& 2004 Microsoft Corporation. Al rights reserved. Terms of use. Accessibility.
] Done & Internet
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EXERCISE 10.2 (continued)

10. When you see the Installation Complete page, you have successfully installed your updates.
(Restart the computer to make sure that all updates become effective immediately.)

8] Microsoft Windows Update - Microsoft Internet Explorar
Ale Edit View Favortes Took

O - DB | search <7 Favortes @ Meda @ v B - U@ 3
Address | &) hip:f/v4.windowsupdate. microsoft.com/en/default.asp EI Go ﬁl

O Back ~

Al Products | Support | Search | mic e

# Windows Update Microsoft

Home | Windows Catalog | Windows Family | Office Update | Windows Update Worldwide

| Windows Update l| () Installation Complete

[ Welcome
Bl Pick updates to install

[3 Critical Updates and
Service Packs (0)

0 Windows XP (18)
[ Driver Updates (3)

[2] Review and Instal
updates

The folowing updates have been successfully instalied:

Update Rollup 1 for Microsoft Windows XP (KB826939)
Security Update for Microsoft Windows (819696)

View Installation history

Other Options
[0 View instalation history

B 2004 Micro: orooravion. Al nghts reserved,  Temms of use.  Accessibiity,

iig] Done (— . i) Intemet

%] Microsoft Windows Update - Microsoft Internet Explorer
Fle Edit View Favorites Took He

@Back + ) - M [@ | search 7 Favortes ¥ Media & (o 5 EY -

Address |i] http:/fv4.windowsupdate. microsoft.com/en/default.asp

4 Windows Update
Home | Windows Catalog | Windows Family | Office Update | Windows Update Worldwide
\:.:) You must restart your computer to complete the nstzlation.

If you want to restart later, or close other programs fist, cick
‘Cancel, and then restart your computer manualy.

| Windows Update

O Welcome
B Pick updates to install

[3 Crivcal Updates and
Service Packs (0)

3 Windows XP (18)
[ Driver Updates (3)

[ Review and install
updates

DO you want to restart now?

ok [ conce

Other Options
[ View instaliation history.

Accessibilty.
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EXERCISE 10.2 (continued)

11. Toview yourinstallation history of this and other Windows Update software, choose View
Installation History on the Installation Complete page.

|E}_ Microsoft Windows Update - Microsoft Internet Explorer o - "ES
Fie Edit View Favorites Took Help ar
QBack »~ © - @@ @ Psearch rFavortes @ Meda @ v L B - [UE 3

Address |ﬁ http://v4.windowsupdate.microsoft.com/en/default.asp

Al Producte | Supoo
*Microsoft Al Products | Support |

¥ Windows Update

Home | Windows Catalog | Windows Family | Office Update | Windows Update Worldwide

Windows Update | Installation History
] = i | Keep track of what you've Instaled from Windows Update. To sort by status,
C3 Driver Updates (3) date, description, or source, clck the coumn headers,

[ Review and nstal
updates

Note The items listed on this page reflect only the actions you've performed on
Windows Update. If you have subsequently restored your computer, or E
reinstalled or uninstalled programs, some items isted here might no longer be [,

e oo s |8

Other Options
[ View installation history
[ Personaize Windows

Successful Tuesday, June 15, Security Update for Web
Hpdate = 2004 Microsoft Windows site
[ Get help and support (819696)
See Also successful Tuesday, June 15, Update Rollup 1 for Web
2004 Microsoft Windows XP site
[ About Windows Update (KB826939)

& 2004 Microsoft Corporation. Al rights reserved. Terms of use.  Accessibiity.

&] 8 Internet

The Office Update Website

The Office Update website contains information and tools for Office XP and Office 2003 appli-
cations. You can use the tools on the Office Update website to scan your computer to detect the
applications that are installed and determine which critical updates, service packs, and other types
of updates might be needed on your computer. You should know how to use this tool so you can
help users and show them how to use the tool as well. Exercise 10.3 walks you through the steps
to scan the applications on your computer using the tools on the Office Update website.
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Accessing the Office Update Website

1. Onyour browser, type of ficeupdate.microsoft.com; or from any Office 2003 application,
choose Help and then choose Check For Updates.

|3" Document1 - Microsoft Word QE
! Fie Edt View Insert Format Took Table Window Documents ToGo | Help | [ype a guestio
7| - - | A § Microsoft Office Word Help  F1

|
f

Show the Office Assistant

NEHRSS RV

Microsoft Office Cnine
-_ Contact Us

WordPerfect Help...
: Check for Updates

—I Detect and Repair...

Activate Product...
Customer Feedback Options...

About Microsoft Office Word

A} Avery Wizard Help...

Emgzm<_ 5

Page 1 Sec 1 1/1 At 1" Ini Col1



398 Chapter 10 = Configuring Application Security

EXERCISE 10.3 (continued)

2. Onthe Office Update web page, choose Check For Updates. The system will examine your
computer and make a list of critical updates, service packs, and other updates that are rec-
ommended specifically for your computer’s Office 2003 applications.

2] Microsoft Office Downloads Home Page - Microsoft Internet Explorer mEX
Fle Edit view Favortes Took Help
QoBack -~ © - [ @ @ | P search 7 Favortes & Meda @ | (v s B &3

v &

Atldress

&1 hqp:ffomce,microgoft.comfomoegpdqte:'derqult.qspx PCTT=6&0rigin=EC010227221033

tecl State: Microsoft.com Home | SttaMap (RSl
Ca ; [
_ 0ffice Online ]
Downloads |
Fome Downloads Hielp | =
fss!st.ance a _ Clip of the Day
Iraining
Tamplates Office Update New updetes
clip Art and Media Check for free updates that improve Office 2003
s Office’s stability and security. Offlce XP =
3 = Access 2002
Office Marketplace ‘¥ Check for Updates coess 200
Praduct Tnfarmation office 2003 Editions
Popular Office downloads ~ Fnterprise release of Office 2003 §
= = Order a trial CD
Business Scorecards Administrators, get the 5 _ ey
Things To Do Accelerator enterprise-specific MmN _tu upgrade
Check for updates sl 2003/ Edd-i setup.exe to deploy About Office 2003
eck for updates Excel 2JUI; 2.00_2 : .drc in for Office 2003 viith Local Editions
Suggest a download SQL Server Analysis Tnstallation Source
Services Hows to buy
Get our nawsletter B . enabled.
Gt Fstibinek Office 2000 Service Pack 3 Quick finks
i . BROWSE DOWNLOADS See Office demaos
L = NLUALS
oridwide Fratect your PC 23
€] o Internet
— A— = — — _ .
|§] Microsoft Office Update - Microsoft Internet Explorer i !@j 4
Fle Edt View Favoites Toos Hep i
GBack - O - [ @ {0 P Search 77 Favortes & Medn @ | (0 i @ &3
e | Pipfofice microsoft com)offieupdate/mainCatalog aspx?CTT=98 | 8c &

O 68fce Online

Downloads ||

s Microsoft Office Update Help
Assistance

Training

g e Please wait. Checking for Office updates you need...

Clip Art and Media
Downloads

Office Marketplace
Product Information

40% complete

Things To Do The detection process can take up to one minuie over a 56.6 Kbps connedion. 1
Show alrandy Mo personally identifiable information is snt to Microsoft during this process.
installed Office

updates

Sign up to find out

about new updates

Give us feedback

i£] Done " & Internet
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EXERCISE 10.3 (continued)

3. When Microsoft Office Update page is displayed, you can browse the list of recom-
mended updates and either select or deselect them based on your own needs. Note that
the critical updates are selected by default and the other updates are not selected by
default. To read more about each update, you can select More Information at the end of
the general information for each update.

|IE:] Microsoft Office Update - Microsoft Internet Explorer g@

Fie Edit View Favorites Took Help "
QBack ~ @ - A [ (| Psearch rFavortes & Meda € (v w @ &3

4}‘j http:ﬂolﬁce.m'ncrgsaﬂ,comfofﬁceupdatefmaincatabg.aspx?CTr:BS

| ey Wizt
On &fice Online

Home Microsoft Office Update Help

Assistance

Training your Office products require the critical updates listed below. The updates have already been

Templates selected for installation. I you do not want to install an update, deselect the check box next to it.

Clip Art and Media

sl ¥/ oeieaza lindnlesi10 Updates for Office 2003 products

Office Marketplace ‘el Download Size: 6540 KB

Product Information ® Download Time: < 1 min Outlook 2003 Junk E-mail Filter Update:
KB835235

Things To Do 1939 KE Time =

Show already

installed Office This optional update provides the Junk E-mail Filter in

updates Micrasoft Office Outlook 2003 with @ more current
Sign up to find out definition of which a-mail messages should be
about new updates considered junk. By installing it, you help the filter
Give us feedback provide & higher level of protection against junk e-
mzil Thig nindata was ralaacad in March 7004 o |
&] Done 8 Internet

4. When you have made your choices, select Start Installation to begin to install the updates
that you have chosen.
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EXERCISE 10.3 (continued)

5. On the End-User License Agreement for Microsoft Software page, click Next (read it first
if you want).

g_'] crocoft Office Update - Microsoft Internet Explore ==
= =3 P
& | Office Update Installation Wizard -- Web Page Dialog
O Back ~ [lny siomer
.2 0ffice Online
Address | €] ht]
- Office Update Installation Wizard
Cg"“ % End-User License Agreement for Microsoft
_— T
Flzass read the following license agreement.
Home You must accept the license agreemeant to proceed with the installation. Help
Assistance
Training NOTE: F you have reason to believe that your Office product was acquired from an en
AL llegal source or has been illzgally madifizd, product updates likely vall not work as 1o it
Temglates designed and may cause unexpecizd failures to your applications. For more %
Clip Art and M| nfarmation an sare piracy, wsit the software pi R
Downloads
Office Markety SUPPLEMENTAL END USER LICENSE AGREEMENT FOR MICROSOFT SOFTWARE
s COMPONENT
Product Infarm)
IMPORTANT: READ CAREFULLY - This Supplemental End User License Agreement
Things To Dol {"Supplemental EULA") governs your rights to the software components that =
Arrnmnany thig Sunnl LEL 2 including anu nnline or elacteonie
Show already e
instalied Offic Filtar in
updates frent
Sign up to fin ]
about ne Itar
g s TR T (TR
Give us feedbdl  printar Friandly Version Nt > Cancel | E-k Lo -
TR AT I W TSI Ty

;E']Dnne

6. On the Please Confirm Your Selection page, click Next.

& | Office Update Installation Wizard -- Web Page Dialog
Q Back - [l sor
- .1 0ffice Online
Address | &] htt
Office Update Installation Wizard Step1of 5
Ca"“ 5 Please confirm your selection

_ I you weant to make changes to your selection, click Cancel. It is recommended that you

exit all running COffice programs befare installing updates. Click Next to continue.

Foame A Download Size: 2484 KB Help
il & Download Time: < 1 min

Training en
Templates SELECTED UPD. to it
Clip Art and M Outlook 2003 Junk E-mail Filter Update: KB835235

Downboads 1939 KB/ < 1 min  Meors information...

Office Markety] Office 2000 Security Patch: KB822035

S45KB [ < 1min More informabon.,
Product Infarn 2KE e

Things To Dof

Show already

Instalied Officy Filtar in
updates frent
Sign up to fin ]

about new up ltar
Give us feadb Naxt > Cancel | nk -
L= g

&l F}r&met
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EXERCISE 10.3 (continued)

7. Depending upon the update, you may need to supply your Office product CD to complete
the installation. Insert the CD and then click Next to begin downloading the updates.
@ 2 gl I ;
= 7
= t_j Office Update Installation Wizard -- Web Page Dialog @ -
QBack ~ 4 [y memr
‘ . 30ffice Online
Office Update Installation Wizard Step 2 of 5
L_’_’] Office! Please have your Office product CD ready
_ T you installed your Cffice products from product COs, you may be asked to insert
these CDs during the installation process. Please have the product CDs ready.
Hame T you installed your Office products from a network location, you may need to have e
sttone access to this netwerk location during the installation process. P
il Click Next If you have access to your Office product CDs or network Instaliation len
Iraining
Templates Iocetionz. to It
Clip Art and
Downloads
Office Marketp f—
Product Tnforn
Things To Doy
Fitter in
fused about which product CDs are required during installation? prent
Sign up to fin to learn more about why this requirement is necessary? F
about 1 llter
Give us fae < Back | | et > Cancel | ke
w
al T #® htemet
| 2 ol
@ Office Update Installation Wizard -- Web Page Dialog ﬂ o
My semar )
__ 30ffice Online
Office Update Installation Wizard Step3of 5

Downloading Updates

Office Update is downloading the selected updates. Pleass wait.
The updates will be installed when the download is complete.

Give us feed

B

&

Home Downloading: Office 2000 Security Patch: KB822035 Help
Assistinice g: Office Security Pakch:
Training en
Temgplates Download Progress: 528 KB [ 2484 KB ok
Clip Art and |
load d time < 1 min
Office Markety
Product Inforn
Things To Dof
Filter in
rent
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EXERCISE 10.3 (continued)

8. When the updates are downloaded and installed, the system will display the Installation
Result page and indicate which updates require rebooting the system.

&] Microsoft Office Update TS =
&) pdate = Zard b P: s "
Q Back -~ [l e i
[ h0ffice Online

Address | &] hit Be &
| Ererrr—— Office Update Installation Wizard Step4 of 5 =
Mo et H E EI |

% Gfficet  Installing Updates ::-! :

_ Office Updatz is instzlling the selected updates. Please wait. II
Go

Installation progress:
Home

Help
Assistance
Training en
Temglates tioit
Clip Artand M
Downboads
Office Marketp —
Product Infarn
Things To Do
Show already N
instalied Gffice Filter in
updates rrent
Sign up to fing ]
about new up filtar
Give us feedbe Cancel | nk e-

RSP o e e v g ik
&l [ T P Fealnet

9. Click Finish to close the Installation Result page, and restart your computer if necessary.

(= = "
& | Office Update Installation Wizard -- Web Page Dialog M -
QO Back ~ [l sterase .
— | a0fficeOnline
Address _‘ﬂ hit|
AT Office Update Installation Wizard StepSof 5

[ messerr =

- T\ Office Installation Result

_ Check below to s=e if updates installed successfully.
Hame + Installation Successful
e Help

Astistance Outlook 2003 Junk E-mail Filter Update: KBE35235

Tralning fen

Templates Atk

Clip Art and M

Downloads

Office Markety

Froduct Infor

Things To Do

Filber in
frent

Sign up ko fin ilbar

about new up nk -

Give us feedd] Finish I

2 -

2] . 8 Internst
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Methods of Deploying Updates

As a desktop support technician, you will probably use only the tools that we’ve discussed thus
far; however, you should know that network administrators might use many other tools to
deploy updates to multiple computers at the same time. While you don’t have to be an expert
on all of these tools, you should be familiar with them and understand how they may have
affected the users’ computers. The more familiarity you have with the tools that the network
administrator might use, the more you can understand the big picture in regard to managing
updates on users’ computers.

The following is a partial list of the most common tools that network administrators use to
deploy updates to users’ computers:

= System Management Server (SMS): SMS is a Microsoft server application that helps network
administrators automate the management of their networks. With SMS, administrators can
install, execute, and access network resources. They can also strengthen network account-
ability and maintainability. Network administrators sometimes use SMS to install security
patches in a mandatory fashion without giving the client computers any choice. At other
times, SMS is used to provide the security patch and make the client computers and the users
aware of its availability; then the users can install the security patch if they so choose.

= Active Directory: Windows 2000 servers and Windows Server 2003 servers employ Active
Directory as a means of identifying and managing all of the objects in all of the domains of
an organization. Active Directory has tremendous power to control objects. With Active
Directory and Group Policies, administrators can install security patches on computers
within their organizations.

= Group Policy: Group Policy consists of groups, or combinations, of policies that are used
to control sites, domains, and organizational units within an Active Directory. Group Pol-
icy provides granular control of all installations of software, including security patches.

=  Executable patch: Sometimes the patches themselves provide an executable file or a wizard
to assist the network administrator or even the user in the installation of the patch.

Application Security

Historically, most of the security of applications has been delegated to the operating system. Due
to increases in technology and the constant need for greater security and more layers of security,
the latest Microsoft applications now have their own built-in security features. These should be
used in addition to, not instead of, operating system—based security methods such as NTFES per-
missions. In this section, we will focus on the application security built into Microsoft Word 2003.
You should know that the same security features are now available on all of the latest applications
in Microsoft Office 2003. Figure 10.1 shows the Security tab within the Tools » Options menu
of Microsoft Word 2003; it contains the following security settings:
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FIGURE 10.1 The Security tab of the Options menu of Word 2003

Options ? 'w
Spelling & Grammar Track Changes User Information
Compatibility File Locations
View Genaral Edit Print Save Security

File encryption options for this document

Fassword to opem: || Advanced...

File sharing options for this document

Password to modify:

] Read-only recommended

[ Digital Signatures... | [ Protect Document...

Privacy options
[] Remove personal information from file properties on save

|: Warn befare printing, saving or sending a file that contains tracked changes or
comments

IZ Store random number to improve merge accuracy
E: Make hidden markup visible when opening or saving
Macro .CE'CIII'I[‘:'
Adjust the security level for opening files that might contain @
macro viruses and specify the names of trusted macro

developers.

—— ———

= File Encryption Options For This Document:

= Password To Open: Users can password-protect individual documents and files to pre-
vent others from seeing or changing them. Users can enter a password in the Password
To Open text box to secure the document. Users should realize that they must remember
this password; otherwise, they will be locked out of their document until they can
remember it. The administrator and desktop support technician cannot override this
security to assist the user.

= Advanced: You should click the Advanced button to apply specific encryption when
your organization requires it.

= File Sharing Options For This Document:

= Password To Modify: This is actually not as much of a security feature as a feature to
prevent a user from unintentionally modifying a document. Users can enter a password
in the Password To Modify text box. This feature can also be used to stop users from
changing the file and saving it with the same name, but it does not stop them from saving
the file with a different name and then modifying that file.

= Read-only Recommended: This is the recommended setting when a password is used.
This will also prevent another user from modifying the document and saving it with the
same name unless they have the Password To Modify credentials. It is not a strong secu-
rity feature.
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= Digital Signatures: Users who have a digital signature from your organization’s certifi-
cate authority or a third-party certificate authority can apply the digital signature to the
document. This may not be considered as a legally binding signature.

= Protect Document: Users should click the Protect Document button to apply granular
restrictions to their documents. These include formatting and editing restrictions.

= Privacy Options:
=  Remove Personal Information From File Properties On Save: This option removes the
Author, Manager, and Company entries from the document properties. The author’s

name is also removed from comments, tracked changes, and macros. This option does
not remove fields in headers and footers that may contain the same information.

= Warn Before Printing, Saving Or Sending A File That Contains Tracked Changes Or
Comments: This option should be used only if the information regarding those who cre-
ated and modified the document is sensitive.
= Store Random Number To Improve Merge Accuracy: This option should be used to get
the best results when merging changes with multiple reviewers. It is selected by default.
= Make Hidden Markup Visible When Opening Or Saving: This option should be used
when the hidden markup in a document is not of a sensitive nature.
= Macro Security: Macros are lists of commands that can be used to control a computer. You
can adjust the degree to which the application will respond to macros to prevent attackers
from using them as part of their attack. Figure 10.2 shows the Security Level options that
are available, which include the following;:
= Low: This option is generally not recommended because it does not protect the user
from unsafe macros. Users should use this option only if they are also using third-party
software that protects them from unsafe macros.

=  Medium: This option allows the user to choose whether to run a potentially unsafe macro.

= High: This option allows only signed macros from trusted sources to run. Unsigned mac-
ros are automatically disabled.

= Very High: This option allows only specific macros installed in trusted locations to run.
All other signed and unsigned macros will automatically be disabled.

= Trusted Publishers: This is a list of the entities that users have specifically added as a
trusted source.

= Trust All Installed Add-ins And Templates: To provide for the greatest security, this box
should not be checked.

= Trust Access To Visual Basic Project: This option should be selected for specific access
to Microsoft Visual Basic.

= Prior Trusted Sources: This is a list of trusted sources that was created by a prior version
of Office. You cannot add new sources to this list.
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FIGURE 10.2 Macro Security Level settings in Word 2003

Security 253

Trusted Publishers | Prior Trusted Sources

-::_':- Very High. Only macros installed in trusted locations will be allowed
to run. All other signed and unsigned macros are disabled.

.;’_;_\ High. Only signed macros from trusted sources will be allowed to
run. Unsigned macros are automatically disabled.

\':::l Medium. You can choose whether or not to run potentizlly unsafe
macros.

() Low (not recommended). You are not protected from potentially
unsafe macros. Use this setting only if you have virus scanning
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Summary

Our constantly changing world creates a continual supply of security challenges for desktop
support technicians and network administrators. Experience tells us that the best type of secu-
rity is a system that includes multiple layers. Because of improvements in technology, we now
have applications that can be used as security tools. In addition, we have security settings built
into the latest Microsoft Office applications. As a desktop support technician, you should be
familiar with the security problems that are related to improperly configured permissions. In
addition, you should know how to recognize and respond to security incidents on your network
and on the computers within your network. Finally, you should know how to configure security
for the latest Microsoft Office applications.

As a general rule, permissions are controlled by the operating systems in a network. These oper-
ating systems include those that are on the clients as well as the servers. The purpose of permissions
is to provide transparent access to resources that a user utilizes. At the same time, permissions should
deny access to users who have no need to use the resource. In addition, permissions should be con-
trolled so as to prevent an attacker from manipulating the operating systems or applications in a net-
work. When permissions are not controlled properly, the result is a weakness in the network or the
computers that it contains. These weaknesses can take the form of buffer overruns, unauthorized
Registry access, installation issues, macros, and viruses. Buffer overruns and unauthorized Registry
access are generally exploitations of the system that an attacker executes after waiting for the oppor-
tune time. Macros and viruses are a more automated type of attack that can be loaded into a system
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to be executed at a later date. You should be familiar with each type of attack so that you can
recognize it and respond accordingly. Your response will most likely include involving the network
administrator.

Security incidents are attacks upon the computers within your network. An attack itself is
not the fault of the network administrator or the desktop support technician; however, its abil-
ity to succeed may well indicate a weakness in your network or the computers that it contains.
Typically, a successful attack indicates that your network does not have either virus protection
or the latest critical updates for operating systems and applications, or both. You should be able
to identify a problem caused by a security incident and take the steps to assure that the network
remains safe in the future. This should include recognizing viruses and understanding the meth-
ods used to deploy critical updates in your organization.

Some of the latest applications developed by Microsoft and other third-party companies
have security features built into them. These include the capability to password-protect individ-
ual documents created by the application. You should know the security settings that are avail-
able in Microsoft Office 2003 applications. In particular, you should know about password
protection, digital signatures, and macro security. You should understand that, while security
is a must in all networks and in the computers that they contain, some of the security features
represent a trade-off in flexibility and functionality of the application.

Exam Essentials

Understand security issues. You should understand the security issues that can result from
improper configuration of permissions. In addition, you should be able to recognize computer
and network problems created by security issues, such as buffer overruns, Registry access,
installation issues, macros, and viruses. Finally, you should understand that tightening security
usually includes a trade-off on functionality and flexibility.

Know how to prevent security incidents. You should understand that security incidents are

caused by an attacker or a virus but can often be prevented by solid network administration. In
addition, you should know how to make the most effective use of antivirus software to protect
your network and the computers that it contains. Finally, you should know the various methods
that your organization might employ to distribute and install critical updates and other updates.

Be able to implement application security. You should understand that application security is
an additional layer of protection that can be used to secure documents. In addition, you should
know that the latest Microsoft Office applications include security features to protect docu-
ments. Finally, you should know how to configure security settings such as password protec-
tion, digital signatures, and macro security.
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Review Questions

1. You are the desktop support technician for your organization. A user complains that her
Microsoft Word application has recently developed a “mind of its own.” It seems to execute
steps that she has not ordered or programmed it to do. Which of the following is probably
configured improperly on her application?

A. Viruses
B. Registry access
C. Macro security
D. Buffers

2. Youare the desktop support technician of your organization. A user complains that her computer
has not worked properly since the last time that she checked her e-mail. You ask her if there were
any unusual messages in her e-mail the last time that she checked it. She responds that there was

one message that had an unusual title and a weird file attached to it, but that she deleted the e-mail
as soon as she saw what was in the attachment. What is the most likely cause of the user’s problem?

A. An unsafe macro
B. A virus
C. A buffer overrun
D. Improperly configured Registry access
3.  You are the desktop support technician for your organization. The user complains that one of
his applications has been performing very slowly as of late. Now, all of the sudden, it’s perform-

ing well again, but he does not have access to some of the files that he needs and it seems as if
permissions have been altered. What type of an attack should you suspect?

A. Buffer overrun
B. Registry access
C. Virus
D. Unsafe macro
4. You are the desktop support technician for your company. A user has recently installed a new

application but now finds that she is having multiple problems with many existing applications.
Which type of attack should you suspect?

A. Virus

B. Unsafe macros
C. Buffer overrun
D

. Unauthorized Registry access
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You are the desktop support technician for your organization. A user’s computer has become
infected with a virus. The virus was able to shut down and disable the antivirus software installed
on the user’s computer. You install the antivirus software with the latest updates from the Web,
but the antivirus software indicates that it cannot eradicate the virus from the user’s computer.
What should you do next?

A. Reinstall the antivirus software and try again.
B. Reinstall the operating system on the user’s computer.

C. Back up the user’s data and configuration, if possible, and reformat the hard drive of
the user’s computer.

D. Ignore the virus as long as it doesn’t affect the user’s productivity.

You are the desktop support technician for your organization. You are assisting a user who uti-
lizes a Windows XP Desktop from her home. She has recently experienced several problems that
seem to be application security—related. As a first step, you want to make sure that she has all

of the latest critical updates for the Windows XP operating system. Which of the following
should you do? (Choose two. Each answer is part of the solution.)

A. Direct the user to the Windows Update website.

B. Direct the user to the Office Update website.

C. Tell her to check for updates and then select all of the suggested updates.

D. Tell her to check for updates and then accept all of the updates that the system selects.
You are the desktop support technician for your company. You are assisting a user with
setting automatic updates on his computer. When you access the Automatic Updates tab, the

settings are configured but they are grayed out and you cannot access them. Which of
the following should you suspect?

A. A virus

B. An unsafe macro

C. A buffer overrun attack

D. Group Policies

You are the desktop support technician for your organization. A user asks you how she can get

the latest updates for her Word 2003 application. Which of the following should you tell her?
(Choose two. Each answer is a complete solution.)

A. On her browser, type www.windowsupdate.microsoft.com, and then choose
Office Updates.

B. On her browser, type www.officeupdate.microsoft.com, and then choose Check
For Updates.

C. On her Word 2003 application, choose Help » Check For Updates, and then choose
Check For Updates again on the web page that opens.

D. On the Windows XP Desktop, choose Help » Check For Updates.
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You are the desktop support technician for your organization. A user has password-protected

an important document using the security features built into Word 2003. Unfortunately, he can-

not remember the password that he used. He did not write it down and did not tell anyone else.

He wants you to override the system so that he can obtain his document. Which of the following

should you tell him?

A. You are not authorized to override the system; he will have to talk to the network
administrator.

B. There is nothing that anyone can do; he will have to either remember the password or
re-create the document.

C. He can override the security simply by creating a document with the same name as the
one that is password-protected.

D. Overriding the security will mean that he will have to change his username and pass-
word on the network as well.

You are the desktop support technician for your organization. Management wants you to make
sure that only signed macros from trusted sources are allowed to run on the Office 2003 appli-
cations installed in client computers. Which Macro Security option should you choose?

A. Very High
B. Medium
C. Low
D. High
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Answers to Review Questions

1.

C. The most likely cause of her problem is improperly configured macro security. The problem
could also be caused by a virus, but the question specifically asks about configuration, and
viruses would not be configured. The problem is not caused by improperly configured Registry
access or improperly configured buffers.

B. The most likely cause of the user’s problem is that her computer has been infected with a
virus. The fact that she opened the attachment is the key to the answer. Closing and deleting the
message does not eradicate the virus after the computer has been infected. Since the symptoms
are affecting the entire computer, they are most likely not caused by an unsafe macro. This
would not be caused by a buffer overrun or improperly configured Registry access.

A. The most probable explanation is a buffer overrun attack. The attacker used the buffers built
into the application to gain access to the application and its properties. He then changed the per-
missions, giving himself permissions to control the application. This is probably not related to
a Registry access attack, since it did not happen during the installation of additional software.
This attack does not have the symptoms of a virus or an unsafe macro.

D. The type of attack that would most likely cause this problem is an unauthorized Registry
access attack. Since the problem occurred immediately after installing additional software, you
should consider this option first and inform the network administrator. Since the user is having
problems with applications but not the operating system, a virus would not be the first suspect.
Since the problem exists on many applications, it is not likely just unsafe macros. Since the prob-
lem happened after installation, and the user did not report a problem with the applications
prior to the new installation, it is probably not related to a buffer overrun.

C. In this case, you will need to reformat the user’s hard drive to completely rid the computer
of the virus. You should attempt to back up as much of the user’s data and configuration as pos-
sible before you reformat his hard drive. Reinstalling the antivirus software will probably have
no effect. Reinstalling the operating system will not eradicate the virus from the computer. You
should never ignore a virus because it can spread to other areas of the computer and to other
computers within your network.

A, D. You should direct the user to the Windows Update website to get the latest critical updates
for Windows XP. The critical updates will be automatically selected for the user when she checks for
updates. She should accept the defaults to obtain only the critical updates that are not already
installed on her computer. The Office Update website does not contain critical updates for
Windows XP operating system software. She does not need to select the suggested updates to obtain
the critical updates because the critical updates are automatically selected by the system.

D. The most likely suspect in this case is Group Policies configured by the network administra-
tor. These can be configured for an organizational unit, a domain, or even a geographical site.
Group Policies will override the local security configuration of a computer. These symptoms do
not indicate the presence of a virus, an unsafe macro, or a buffer overrun attack.
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B, C. She should either use her browser and type www.of ficeupdate.microsoft.com and then
choose Check For Updates on the Office Update Downloads page on the Web or choose Help from
the Word 2003 application, choose Check For Updates from the Help menu, and then choose
Check For Updates from the Office Update Downloads page on the Web. The Windows Update
website does not contain the updates that she needs. She cannot access the correct Help menu from
her Desktop.

B. Unfortunately, in this case, there is nothing that you or the network administrator can do.
If the user cannot remember the password, then he will have to re-create the document. You
should not direct the user to the network administrator because there is nothing that the net-
work administrator can do about the password protection of a local file. He cannot override the
local password protection of the application by creating another file with the same name. Local
password protection at the application level is completely separate from user credentials, such
as username and password, at the network level.

D. You should choose the High setting in Macro Security to allow only signed macros from
trusted sources to run. Unsigned macros will then be automatically disabled. The Very High
option will allow only specific macros installed in trusted locations to run. The Medium setting
will allow the user to choose whether to run the macro or not. The Low setting does not provide
for macro security and should be used only in a situation where other third-party software is
protecting against unsafe macros.
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A

Accessibility Features Tools located in the Accessories menu that can be used to magnify ele-
ments on the screen, read text, and provide other assistance for users with physical disabilities.

Accessibility Options  Settings in the Control Panel that control the keyboard, display, and
sounds that a computer generates when keys are pressed. These can be configured to assist a
user who has a physical disability.

access token A virtual list created for a user at logon based on permissions that are assigned
to the user and to groups of which he is a member. This list is used to gain access to resources
in a computer or a domain.

activate See Windows Product Activation (WPA).

Active Directory A proprietary name given to Microsoft’s X.500-compliant directory struc-
ture hosted by domain controllers. Active Directory is a distributed yet hierarchical database
used to host user, computer, and group accounts as well as domain, application, and object con-
figuration information.

active partition The partition that contains the files that are required to boot a computer and
find the operating system. This partition must always be on the first disk in the computer.

Address Resolution Protocol (ARP) A name resolution protocol that is part of the TCP/IP
protocol suite. ARP resolves an IP address to a MAC address by first checking a cache and then
broadcasting when necessary.

Advanced Configuration Power Interface (ACPI) An open industry specification that defines
a flexible method of controlling power to components on a system board.

anding A binary calculation whereby 1 and 1 equals 1 but anything else equals 0. This process
is used by IP in routers to determine whether a packet’s destination address exists on the local
subnet or on a remote subnet.

answer files Files that contain configuration information that is common to a group of com-
puters that are being installed using an unattended installation. These files can be used to auto-
mate the installation process and answer the questions asked by the installation program.

attended installation A type of software installation that requires a person to monitor the
entire installation and occasionally choose options or enter additional information.

auditing The process of recording a sequence of events on servers, workstations, and other
networking devices. Audited events are recorded in one or more logs.

authentication The process of verifying the identity of a user. For example, a user might be
authenticated by providing the username and password combination.

AutoCorrect A feature of applications in Office software that automatically corrects common
typing errors or replaces text based on configuration by the user.
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Automatic Private IP Address (APIPA) An automatic addressing system that can configure
each client computer with a unique IP address in the 169.254.0.0 subnet. This type of addressing
is typically seen when a DHCP server has failed and a client is configured to obtain an address
automatically.

B

basic disks Disks that follow the rules and standards of the earliest operating systems. Basic
disks can contain a maximum of only four partitions, but they can contain one extended par-
tition that can be divided into multiple logical drives.

basic input/output system (BIOS) A set of software or firmware contained in a computer
that tests the hardware at startup, starts the operating system, and supports data transfer among
the hardware devices within and attached to the computer. The BIOS also keeps track of the
date and the time.

boot partition The partition in a computer that contains the Windows System files that are
required to run the operating system after a successful boot.

boot sequence A component of the basic input/output system (BIOS) configuration on a
computer that determines which drives a computer will address at startup and in what order
they will be addressed.

C

cached credentials Permissions and rights that were used on the last successful logon and
stored in the system for later use. These are sometimes used when a user cannot gain access to
a domain controller due to a network problem.

cathode ray tube (CRT) The earliest method of creating a display from computer-generated
output. Consists of an electron gun that fires a series of electrons through a vacuum tube onto
a phosphorous screen that is very much like a television screen. This is still the most common
type of display used on computers today.

certificate An electronic piece of identification received from a certificate authority. The cer-
tificate contains information about the certificate holder, including the public keys used for sig-
natures and encryption.

certificate authority (CA) A certificate authority is a certificate server that has authority to
issue certificates for security purposes. Some CAs are considered root CAs, while others, called
subordinate servers, derive their authority from a root CA.

computer name A generic term used to describe a computer in a network. This is usually also
the NetBIOS name and the hostname of a computer on a network using TCP/IP.
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Connection Manager Administration Kit (CMAK) A tool used to build a service profile for
remote access. The service profile contains all the files needed to create and install the remote
access software on the remote access client and to configure the settings for the remote access user.

Content Advisor A tool in Internet Explorer that is used to prevent users from accessing web-
sites that contain material that could be considered offensive.

control set A copy of configuration settings stored in the Registry that is used to configure the
drivers and other software to work with the hardware of a computer.

cookies Small files that contain a user’s personal information and can be used to automati-
cally log on to websites and provide information. Cookies can also be abused by other entities
and should be controlled carefully.

Creator Owner The user who originates a document. The Creator Owner has default permis-
sions assigned by the system.

D

data decryption field (DDF) Used in EFS encryption to store the symmetric key used to encrypt
and decrypt a file stored with the encryption attribute enabled. The DDF contains the file encryption
key used to encrypt a file and is encrypted using the user’s public key. Only the user who encrypted
the file can then decrypt the DDF and retrieve the file encryption key and decrypt the file.

data link layer Layer 2 of the Open Systems Interconnect (OSI) model. The data link layer is
responsible for the physical addressing of computer. It contains two sublayers: the logical link
control layer and the media access control layer. The MAC address derives its name from the
second sublayer.

data recovery field (DRF) Used in EFS encryption to store the symmetric key used to encrypt
and decrypt a file stored with the encryption attribute enabled. The DRF contains the file encryp-
tion key used to encrypt a file and is encrypted using the recovery agent’s public key. Only the
recovery agent can then decrypt the DRF and retrieve the file encryption key and decrypt the file.

decryption The process of taking an encrypted file and decoding the encryption so that it can
be read in its original format.

default gateway The interface that can give a computer access outside of its own subnet. This
is usually an interface on a router, but it could also be a network interface card on a server or
another client computer.

Demilitarized Zone (DMZ) Usually existing between (logically) two firewalls, a DMZ is con-
sidered a neutral area that is not part of the local network or part of the Internet. Servers are
placed in the DMZ that should be accessed from the Internet but still need to be managed from
locations on the local network. The DMZ prevents outside users from getting direct access to
a server that has company data on the local network. The term comes from the geographic
buffer zone that was set up between North Korea and South Korea following the United
Nations police action in the early 1950s.
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dial-up A remote connection that is formed using two modems. One modem is used to dial in
to a network, and the other modem answers the first modem.

digital certificate Sece certificate.

digital signature Certificates used to prove the identity of the user or company. Often used
for signing e-mail or for code signing. Provides non-repudiation, which means that a user
cannot later say that he didn’t say something or send something. Digital signatures are some-
times even considered legally binding.

Discretionary Access Control List (DACL) That part of the Access Control List (ACL) that
can be modified using the Security tab in the resource’s Properties dialog box. The DACL lists
user and group SIDs that have access to the resource along with each SID’s level of access.
Each entry is called an Access Control Entry (ACE). The Deny Access permission is also listed
at the top of the DACL. Together with the Security Access Control List (SACL), the DACL
forms the overall ACL.

disk 0 The first physical disk in a computer. This is the disk that must always contain the
active partition.

display device A device that produces visual output that a user can see and interpret.

drivers Software that allows the hardware to communicate with the operating system. Each
driver is designed specially for a hardware device and a specific operating system.

DNS servers Domain Name System (DNS) servers are network-based servers that are used to
provide hostname resolution for clients.

dynamic disks A new type of disk management that allows a disk a tremendous amount of
flexibility over that of a basic disk. Dynamic disks can contain as many volumes as needed.

Dynamic Host Configuration Protocol (DHCP) servers Network-based servers that can
automatically assign and configure an IP address and many other network configuration
parameters onto a client computer when the client computer is started up on the network.

E

Effective Permissions tool A GUI-based tool in the NTFS advanced permissions that assists
administrators in determining the effective NTFS permissions for a resource, especially when a
user is a member of multiple groups.

Encrypting File System (EFS) EFS is unique to Windows products and is a core technology
of Windows. It is used to store files in an encrypted format on an NTES file system.

encryption Encryption is the process of changing data from its native format to a ciphered
format that cannot be read by unauthorized users.

error message Text output from a computer system that indicates that a problem has occurred.
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Ethernet The most common method of putting data onto wires using the Carrier Sense Mul-
tiple Access with Collision Detection (CSMA/CD) method.

extranet An extension of the internal network or intranet that allows access for remote clients
or partner networks. Usually involves connections over the Internet.

F

fast-user switching A new feature in Windows XP that allows more than one user to log
on to a computer at the same time. This enables a user to let another user log on to his com-
puter without having to close all of his applications first. This feature is available only if the
computer is not joined to a domain.

fdisk tool An MS-DOS-based tool that you can use to view partition information about a
disk, partition the disk, and delete partitions from the disk.

File and Settings Transfer Wizard A GUI-based tool included with Windows XP that can be
used to transfer files and settings on computers that are not a member of a domain.

File Signature Verification tool A GUI-based tool in Windows XP and Windows 2000 Pro-
fessional that assists you in determining which drivers in your computer are signed.

file system A set of rules or standards that determines how data is stored and accessed on a
partition. Examples of file systems include FAT, FAT32, and NTFS.

fixed storage device A common term used to describe a hard drive that is permanently
mounted in a computer, although hard drives can be easily removed from most of today’s
computers.

firewall A system with special security configurations used to protect the company network
from untrusted networks such as the Internet. A firewall is used to filter out undesirable net-
work traffic.

flash The process of updating the BIOS of a computer. This was at one time performed with
light, but now it is done electronically.

flat-panel monitor A display device that consists of a liquid crystal display (LCD) or plasma
gas display. The display has many levels, which are used to produce all needed colors. Flat-panel
displays are not as bulky as CRTs and they do not produce heat.

format The process of applying a file system to a partition on a disk. The file system will be
used to control how data will be stored and accessed.

format tool An MS-DOS-based tool that can be used to place a FAT or FAT32 file system on
a partition.
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G

gpresult A command-line tool that you can use to determine the Resultant Set of Policy
(RSoP) of a computer and the currently logged on user.

graphical user interface (GUI) A control system for a computer that hides the commands that
are actually being used, allowing the user to simply point and click with a mouse or another
pointing device.

H

hardware profiles Settings that can be added to a computer to control the devices that are
enabled when the computer is started. The default profile provides for all devices to be enabled
when the computer is started. You can copy the default profile and then create a new hardware
profile that disables some of the devices in the computer as needed.

Help and Support Special tools built into Windows XP that assist the administrator and the
user in ongoing management and maintenance of the computer and the Windows XP operating
system. You can access these tools by pressing F1 while on the Windows XP Desktop.

host A computer that is on a TCP/IP network.

Hosts file A static file that is sometimes used for hostname resolution instead of or as a
backup for DNS.

hostname A hierarchical computer name that can be used within a network or between net-
works. The hostname must be unique within its own hierarchy.

hub A device that works at Layer 1 of the Open Systems Interconnect (OSI) model and con-
nects devices to each other without any intelligence or filtering.

identity A term used with Outlook Express to identify each person when more than one user
utilize the same computer. Each identity can have one or multiple accounts.

IEEE 1394 A standard of very fast data transfer that was developed specifically for use with
digital cameras and other graphics peripherals. Also referred to as FireWire.

IMAP A method of storing and retrieving messages that allows a user to search through mes-
sages on a server and download only the items that she chooses.

input/output (1/0) device Any device that can send and receive data to and from a computer.

infrared (IR) Communication or control using light that people cannot see because it is below
the frequency of red light. Requires line-of-sight to work correctly.
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Internet Connection Firewall A new feature in Windows XP that includes a firewall that
can be configured for each connection. You can configure the firewall in the advanced settings
of the connection.

Internet Control Message Protocol (ICMP) A protocol that works at the Internet layer of the
TCP/IP suite and provides information to higher layer protocols about the status of the network
and the packets that are flowing through it. ICMP responds when an administrator uses the
ping tool.

Internet Service Provider (ISP) An organization that provides connections to the Internet for
its clients.

IP address A unique address assigned to each computer and interface within a network to
allow the routing and delivery of messages throughout the network using the TCP/IP protocol.

ipconfig A command-line tool that can be used to determine the IP address, subnet mask, and
default gateway of a computer’s connection. You can also add switches to this command for
other functions.

issuing CA A certificate authority that issues certificates to users and computers on the network.

J

junk e-mail Unrequested and unwanted e-mail that is sent to a user. This type of e-mail can
be filtered by Outlook 2003.

K

key A parameter used in an answer file for unattended installations. Also can be a string of
numbers used for encryption and decryption.

L

Last Known Good Configuration The control set stored in the Registry that was used the last
time the computer was successfully booted and logged onto. You can revert to this control set
using the tools in the advanced startup options by pressing (F8) at startup.

Lmhosts file A static file that is sometimes used for NetBIOS name resolution instead of or as
a backup to WINS.

loadstate The User State Migration Tool component that is used to configure other com-
puters with the configuration captured using scanstate.
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local printer The software that is used to control a print device that is physically attached to
the computer on which the software is installed.

Localization The language that is displayed by the operating system itself. This includes the
Start menu, Taskbar, and Help screens. There are 24 Localizations of Windows XP, including
the English version.

Local User Accounts and Groups A GUI-based tool within Computer Management that
allows an administrator to create and manage users and groups that are being given access to
the local computer.

Local Security Authority (LSA) A system that operates on a local computer, providing the
logon screen and communicating with the domain controller when necessary.

low-level format The factory formatting of a hard drive that creates the sectors that will later
be used to store data.

log A file that holds records of noteworthy events.

M

Media Access Control (MAC) address A hexadecimal address encoded on most network
devices that consists of an assigned number that identifies the manufacturer and a serial number
assigned by the manufacturer.

Microsoft client Software built into all Microsoft operating systems since Windows 95. This
software provides the method of networking computers using a common client.

Microsoft Office A suite of applications designed to assist users in performing business-
related tasks.

Microsoft Windows Installer A group of programs and services that are used to assist in the
installation of Windows software.

mirrored volume A fault-tolerant disk configuration that duplicates data on two separate
hard disks.

modem A device used to transfer information through regular telephone lines by con-
verting digital information into analog information in the form of sounds. The term stands
for modulator/demodulator.

multiboot installation An operating system software installation that includes two or more
operating systems installed on the same computer within different partitions.

Multilanguage User Interface (MUI) A special version of Windows XP operating system soft-
ware that includes all 24 Localizations of the software.
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N

name resolution The process of converting one type of computer name to another to facili-
tate communication. Some names, such as hostnames and NetBIOS names, are used by people
but not by computers. Name resolution is the process of converting the names that people use
into names and addresses that computers and network devices can use.

nbtstat A command-line tool that you can use to manage NetBIOS name information and dis-
play statistics and details regarding current IP connections.

NetBIOS name A name or names unique to a computer that define the computer and/or ser-
vices that it can provide for the network. NetBIOS names must all be unique within a network.
They can be a maximum of 15 characters in length. The system automatically adds the 16th
character to create additional NetBIOS names associated with services that the computer can
perform for the network.

Network Address Translation (NAT) An Internet standard process that allows the user to use
one set of IP addresses internally for a company and completely different IP addresses for the
perimeter devices exposed to the Internet. All internal addresses are converted to an external

address before any information or requests are sent out of the network.

net A command-line tool that is used primarily to view network settings on a computer.

network printer Software that is used to control a print device that is not attached to the com-
puter on which the software is installed.

nslookup A command-line tool that you can use to test hostname resolution and to verify that
a computer is registered in the DNS server(s) of a network.

)

Office 2003 Proofing tools Tools such as a spelling and grammar checker that are used for
checking documents and that are available in English as well as many other languages.

offline files and folders Local copies of network resources stored on local hard drives.
While offline (off the network), users can open, modify, delete, and create new files that can
then be synchronized with the network resource once the client computer is reconnected to
the network.

original equipment manufacturer (OEM) A vendor of computers that installs software into
the computers as part of the production of their computers.

Outlook Express A simple messaging program tool for e-mail and newsgroups that comes
bundled with the Windows operating system.
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P

packets Communication that is delivered and guaranteed using acknowledgments at the
transport layer of the TCP/IP protocol.

paging The process of moving memory from a hard disk into RAM to be used by an appli-
cation. Memory on the hard disk is referred to as virtual memory.

page file The area of a hard disk that is set aside for virtual memory.

parallel communication The exchanging of information between computers and peripherals
using multiple data bits and control bits simultaneously over parallel wires.

parent folder The folder above another folder in a folder hierarchy. The parent folder is said
to contain the child folder.

parity data Fault-tolerant records that are spread across all of the disks in a RAID configuration.

partition A specific portion of a disk that is set aside from the rest of the disk and can then be
formatted with a file system. You can also treat an entire disk as one partition.

permissions Rules and settings that define a user’s access to files, folders, printers, computers,
and other components in a network. The two most common permissions in Windows-based
networks are share permissions and NTFS file and folder permissions.

power scheme A collection of settings that can be configured in the Power Options proper-
ties of Control Panel. These include the ability to turn off the monitor, hard drives, and other
components after a set period of time. Power schemes are part of Advanced Configuration
Power Interface (ACPI).

Plug and Play The capability of the Windows operating system to recognize a new device and
automatically assign it the resources that it needs to operate within the computer.

POP3 Post Office Protocol, version 3 (POP3) is used to store messages in a user’s mailbox and
to assist the user in retrieving the messages when the user is logged on.

printers Software that is used to control a print device.

print device A hardware peripheral device that attaches to a computer or a network cable for
the purpose of creating a hard copy of documents and graphics, generally on paper.

print job The data that is transferred to the print spool that will be used to create the hard
copy of a document, picture, and so on.

printer driver Software that is specifically designed to allow a printer to communicate with
the operating system.

printer permissions Rules and settings that control a user’s ability to use and manage a
printer and the print device(s) to which it is attached. These include, print, manage documents,
and manage printers.
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private key Half of the public-private key pair issued with most certificates. The private key
is held and protected by the user of the key. It is not published or made available to others.

profile A storage location for many configuration settings for a user account. It contains many
folders and files specifying how the computer desktop should be configured on a client computer.

public key Half of the public-private key pair issued with most certificates. The public key is
made available to everyone to verify the user or computer.

public key cryptography The use of private-public key pairs to provide encryption and

decryption as well as authentication by breaking the key into two pieces that work together. The
public key is published and made available to everyone, while the private key is held and kept
secret. Actions taken with the public key require other actions to be taken with the private key.

Public Key Infrastructure (PKI) Consists of protocols, services, and standards that support
public key cryptography. A PKI consists of applications and services that use public-private key
pairs provided by certificates issued by either public or private certificate authorities.

R

radio frequency (RF) Communication and control using radio waves in a specified frequency.
Does not require line-of-sight.

recovery agent Used to recover EFS-encrypted files when the user is not available to decrypt
the files.

regional settings Configuration in Regional and Language Options that defines the method
of displaying dates, times, currency, and so on, based on a country and region.

Regional and Language Options A setting in Control Panel that allows an administrator to
add new languages that the computer can understand and for which it can be used to create doc-
uments. This might also require a special keyboard or a keyboard overlay.

Remote Assistance A new tool in Windows XP that allows a user to request assistance from
a more experienced user and allows the more experienced user to take control of a less experi-
enced user’s computer remotely to attempt to fix a problem.

Remote Desktop A tool built into Windows XP that enables a user to connect to and control
a remote computer provided that the remote computer is configured to allow the connection
and that the user can log on to the remote computer.

Remote Installation Server (RIS) A network server that is configured by the network admin-
istrator to be used for automated installation of client operating systems and applications.

removable storage devices All types of devices that are used to store data with the exception
of hard drives.

Resulting Set of Policy (RSoP) The combination of Group Policy settings that determines the
effective settings when more than one Group Policy is applied to the same object.



Glossary 425

Roll Back Driver A new feature on Windows XP that allows you to easily return to a previous
driver for a device when a driver upgrade fails.

Routing and Remote Access Services (RRAS) A Windows service that provides access to
LAN resources to remote users through dial-up or VPN connections.

Redundant Array of Inexpensive Disks (RAID-5) volume A special type of stripe configura-
tion that creates fault-tolerance as it stripes the data across all of the disks. With a RAID-5 con-
figuration, you can lose any one of the disks in the configuration and you can still rebuild the
array from the fault-tolerant data spread across the other disks.

remote connections Computer connections into a network from the outside using dial-up or
virtual private networking (VPN).

routers Devices that work at Layer 3 of the Open Systems Interconnect (OSI) model and
transfer packets from one subnet to another.

S

scanstate The User State Migration Tool component that is used to capture the configuration
settings of a computer.

section title A category of settings in an answer file.

Secure Sockets Layer (SSL) Also called Transport Layer Security, SSL is used to encrypt data
at the transport layer when that data flows between a web server and a web client.

serial communication The sequential exchange of information between computers and
peripheral devices one bit at a time over a single channel.

Setup Manager Wizard A tool that administrators can use to create answer files and unique-
ness database files for unattended installations of Windows operating system software.

shared folders Folders on a computer that have been made available to other computers and
users who can access the folders through the computer network.

share permissions Rules and settings on a folder or printer that control a user’s access to that
resource through the network. These settings include Read, Change, and Full Control.

simple file sharing A permission system whereby files are only shared by placing them into
the Shared Files folder. NTFS permissions are not controlled and remain in their default posi-
tion. Simple file sharing is enabled by default in Windows XP Home Edition and can be selected
in Windows XP Professional.

simple volume A single region on a hard disk or multiple regions on the same hard disk that
are linked together. Simple volumes are not fault tolerant.

single sign-on The process of logging on one time and being able to access resources
throughout the network, including resources on different operating systems.
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Software Update Services (SUS) Free software from Microsoft that is designed to down-
load updates and hotfixes from Microsoft and then internally distribute these updates to all
your Windows 2000-based (and later) servers and workstations.

spanned volume A region of disk space that exists on more than one hard disk. The size of
a spanned volume is increased by extending it onto additional dynamic disks.

special permissions NTFS permissions that are not standard but instead are customized. Spe-
cial permissions display as Special in the advanced settings of NTFS permissions.

startup error An error that occurs when a computer is in the processes of booting or accessing
the operating system.

stop error An error that occurs in the text mode of a Windows installation that causes the
computer to stop installing software and to stop responding to all user input.

storage device Any device that is installed on or connected to a computer for the purpose of
storing data.

striped volume Regions of hard disk space that are composed of “stripes” of equal size data
that are written across all of the disks in the volume.

symmetric Processes that utilize a single key. Unlike asymmetric processes that require two
different keys, a symmetric process requires only a single key to encrypt and decrypt a file. Many
symmetric keys are simple passwords.

synchronization The process of ensuring that shared folders and offline copies of the folders
have the same content. This can be accomplished manually or with some automation.

System Access Control List (SACL) That portion of the Access Control List that contains
entries specifying what actions and user, group, or computers accounts will be audited.

system partition The partition in the computer that contains the files that are required to suc-
cessfully boot the computer and locate the operating system.

systemroot The folder on the boot partition in which the Windows System files are stored. On
most client computers this is either the C: \WINNT\SYSTEM32 or C:\Windows\SYSTEM32 folder.

switch A programmable device that works at Layer 2 of the Open Systems Interconnect (OSI)
model and filters traffic based on the MAC addresses of hosts.

-

Take Ownership A special permission that is granted to a user that allows him to control per-
missions on an object and assign other users permissions for the object. The Take Ownership
permission is included by default with Full Control permissions and can be assigned through
special permissions.
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Task Manager A GUI-based tool that can assist a user or administrator in troubleshooting
and managing applications on the computer. You can access this tool by right-clicking an empty
area of the Taskbar and then choosing Task Manager.

text editor A tool such as Notepad or WordPad that an administrator can use to view,
change, and create text-based files.

Transmission Control Protocol/Internet Protocol (TCP/IP) A suite of protocols that repre-
sent the most prevalent communication standard used for network communication on today’s
networks, including the Internet.

U

unattended installation An automatic installation that makes use of answer files and unique-
ness database files to choose options and enter information previously programmed by an
administrator.

Unicode-Enabled Follows a standard of character mapping that is universal in nature and
applies to all Localizations.

Uniform Resource Locator (URL) Address A user-friendly web address that includes the
DNS address of a computer and the complete path to the resource located on the computer.

uniqueness database files Files that contain information that is specific to a computer. These
files can be used to override the settings of an answer file during an unattended installation.

Universal Serial Bus (USB) One of the newest methods of transferring data from a computer
to a peripheral device. Devices can be daisy chained and can be attached and unattached
without shutting down the computer or the peripheral device.

Upgrade Advisor Software built into Windows XP that checks the hardware and soft-
ware of a computer for compatibility with Windows XP and creates a report prior to
installing the software.

upgrade installation A software installation of an operating system or an application that is
performed on a computer that already has a previous version of the same software.

user accounts Security principles that identify a user and allow an administrator to assign
permissions and audit the user activity within a computer or a network. An individual must
have a user account to log on to a computer or a network.

User State Migration Tool Software included on the Windows XP CD that can be used to
capture the configuration settings of a computer and load those settings into other computers.
It consists of two components: scanstate and loadstate.
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Vv

value A configuration setting that corresponds to a key used in an answer file.

virtual private network (VPN) A connection to an existing network from a remote location
through private or public IP networks using encapsulated packets that are encrypted and diffi-
cult to decrypt by unauthorized users. These are often used to improve security and avoid long-
distance charges.

virus A piece of self-replicating code attached to some other piece of code. This code can be
harmless or harmful, depending on what the developer wrote the code to do. The virus searches
a user’s files for an uninfected executable program for which the user has security write privi-
leges. The virus infects the file by putting a piece of code in the selected program file. When a
program that is infected with a virus is executed, the virus immediately takes command, finding
and infecting other programs and files.

virtual DOS machine (NTVDM) A special application environment that a newer operating
system creates to simulate the environment that a DOS application expects.

volume An area of space on one disk or multiple disks that can be used to store data. Volumes
can contain multiple partitions.

W

Windows 9x A term used to refer to the Windows client operating systems of the 1990s and
early 2000 including Windows 95, Windows 98, and Windows Millennium Edition (Me).

Windows Internet Name Server (WINS) Network-based servers that dynamically reg-
ister IP addresses and NetBIOS names of computers on a network and then provide name
resolution to clients.

Windows Performance Tool An administrative tool that consists of two components: System
Monitor and Performance Logs and Alerts. This tool can be used to collect and monitor real-
time data as well as to create logs for later review.

Windows Product Activation (WPA) The process of electronically pairing up a scan of hard-
ware components in a computer with the software license. The result is an activation key, which
allows the software to continue operating. This process is designed to prevent casual copying of
Windows software.

Windows Update A feature included in the Windows XP operating system that allows the
computer to automatically download the latest security updates from Microsoft’s website.
These can also be installed automatically based on a schedule set by the user.

Windows Update website A site that is maintained by Microsoft to provide the latest critical
updates and other security updates for operating systems and built-in applications.
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basic disks, 76-77, 415
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stem), 415
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"blue screen of death,” 79
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23,24
Bootsect.dos file, 10
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cable modems, 355
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report on handling, 253
Copy (IE Edit menu), 252
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Customize Regional Options
dialog box, 322, 323
Customize Start Menu dialog box
Advanced tab, 320, 320
General tab, 319, 320
Customize Toolbar dialog box
in Internet Explorer, 313, 314
in Outlook Express, 317, 318
Cut (IE Edit menu), 252

D

DACL (Discretionary Access
Control List), 417
data decryption field (DDF), 416
data link layer, 337, 416
data management in Outlook,
296-311
archiving data, 306-307
corrupt data repair, 310-311
importing and exporting,
307-310
junk mail filters, 296,
298-301
personal folders, 296,
297-298
data recovery field (DRF), 416
date and time on Taskbar, 268
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DB-25 connector, 91
decryption, 416
default gateway, 350, 380, 416
for VPN, 168
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Outlook Express as,
221-222
default page, for Internet
Explorer, 169
Delete (Outlook Express Edit
menu), 259
deleted files, recovery with
Shadow Copy, 203
deleting. See also removing
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temporary Internet files, 169
Demilitarized Zone (DMZ), 416
Deny permissions, 40—41, 50, 70
for printers, 55
Designed for Windows XP logo, 9
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268-271
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268, 269

with Create Shortcut Wizard,
268,269-271
"Destination host unreachable"
error message, 162
device drivers. See drivers
Device Manager, 90
and ACPI compliance, 90-91
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DHCP (Dynamic Host
Configuration Protocol), 14,
149, 380
servers, 417
dial-up, 417
dial-up connections, 163-165,
172, 355-359
for remote access, 355
troubleshooting, 165-166
digital certificates, 171,
214-215, 415
types, 215
digital signatures, 417
for drivers, 96-99
in Office, 405
DirectX Diagnostic tool, 835,
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DirectX (Microsoft),
troubleshooting, 85
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(DACL), 417
disk 0, 417
Disk Management tool, 77, 77, 80
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message, 80
disk subsystem, 129. See also hard
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troubleshooting system with
no display, 84
types, 82
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Appearance tab, 324, 324
Settings tab, 84
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DNS (Domain Name Service),
346-348
server, 159,417
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installation, 14
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by, 127
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of, 362
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fast user-switching and, 114
and security policy, 116-117
user logon to, 127-128
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drivers, 94-99, 417
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digital signatures, 96-99
loading during startup, 126
for printers, 43
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troubleshooting, 55-57
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updates, 94-96
for attended installation, 9
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Dynamic Host Configuration
Protocol (DHCP), 14,
149, 380
servers, 417

e-mail accounts. See also Outlook
in Outlook Express, 218-220
E-mail Accounts dialog box, 206,
207,234
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importing to Outlook
Express, 317
junk filters in Outlook, 296,
298-301
Outlook rules for processing,
301-306
sending web page or link
in, 251
and viruses, 388
Edit (IE File menu), 251
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Edit menu (Internet Explorer),
252,252
Edit menu (Outlook Express),
258,258-259
effective permissions, 46, 70
when combining shares and
NTES, 48-50
Effective Permissions tool, 38, 39,
39,417
Empty 'Deleted Items' Folder
(Outlook Express Edit
menu), 259
Encoding (IE View menu), 252
Encoding (Outlook Express View
menu), 260
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encrypted folders, 46
Encrypting File Sysem (EFS), 417
encryption, 417
"Error loading operating system"
error message, 79
error messages, 417
about Windows XP, 271-272
in Internet Explorer, 255-256
for Microsoft Office, 239,
245-249,278
logs, 245
Microsoft Knowledge
Base, 245-249
in Outlook Express, 262-263
from ping, 162
at startup, 79
stop error, 80
Ethernet, 337, 418
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211-212
Exit (Outlook Express File
menu), 258
Expand (Outlook Express View
menu), 260
Explorer Bar (IE View menu), 252
exporting data in Outlook,
309-310
extended partitions, 76
extranet, 418

F

FAST. See Files and Settings
Transfer (FAST) Wizard
fast user-switching, 114, 418

FAT file system, 11
FAT32 file system, 11
Favorites menu (Internet
Explorer), 253, 253-254
fdisk tool, 12, 30, 418
File and Settings Transfer
Wizard, 418
File Copy in Windows Setup, 13
File menu (Internet Explorer),
250-251, 251
File menu (Outlook Express), 257,
257-258
file Properties dialog box, General
tab, 46
file recovery in Microsoft Office,
201-205
with AutoRecover, 202, 202
with Microsoft Office
Application Recovery
tool, 201
Shadow Copy, 203-205
File Signature Verification tool,
98-99, 105, 418
file systems, 11, 418
files and folders, 34, 35-46. See
also offline files and folders;
shared folders
caching, 63
NTFS file permissions, 35
Deny permissions, 40-41
inheritance, 38—40
special permissions, 42-44
troubleshooting, 44-46
verifying, 36-38
when copying and moving
files, 41-42
NTFS folder permissions, 36
verifying, 36-38
ownership of, 45
recovery of deleted with
Shadow Copy, 203
Files and Settings Transfer (FAST)
Wizard, 22-23, 23
FilterKeys, 112
Find (on This Page) (IE Edit
menu), 252
Find (Outlook Express Edit
menu), 259
Firewalled Internet Properties
dialog box, Advanced
tab, 148
firewalls, 336-337, 418
configuring, 361-362, 363
exam essentials, 376

Internet Connection Firewall
configuration, 147-148
Remote Assistance
through, 179
FireWire, 92
fixboot command, 80
fixed storage devices, 75,
76-81, 418
troubleshooting, 79-81
fixmbr command, 80
Flag Message (Outlook Express
Message menu), 261
flapping, 154
flash, 418
flat-panel monitor, 82,418
flicker, 83
floating toolbar, 285, 286
floppy disks, and boot
process, 127
Folder Options dialog box,
Offline Files tab, 62
Folder (Outlook Express File
menu), 257
folder Properties dialog box
Customize tab, 327
Security tab, 37, 37
absence of, 70
Sharing tab, 47
folders. See also files and folders
customizing settings in
Windows XP, 326-328
for Favorites, 312
for print spooler, 58
fonts customization in Windows
XP, 324-326
For Netscape Users (IE Help
menu), 255
foreign status for dynamic disk, 80
format, 418
format tool, 12, 418
formatting partitions, 11
Forward As Attachment
(Outlook Express Message
menu), 261
Forward (Outlook Express
Message menu), 261
Found New Hardware Wizard,
for printers, 52
FQDN (fully qualified domain
name), 162
Full Control NTEFS file
permission, 35
Full Control NTES folder
permission, 36



Full Control shared folder
permission, 48

Full Screen (IE View menu), 253

fully qualified domain name
(FQDN), 162

FunLove virus, 389

G

Go To Folder (Outlook Express
View menu), 260
Go To (IE View menu), 252
Gpresult tool, 119, 138, 419
Grammar checker, 292-294
graphical user interface (GUI),
75,419
group accounts, 109, 120,
123-125
troubleshooting, 125
viewing and creating, 124
Group Policy, 118-119, 227,
403, 411
vs. local security policy, 138
grouping Taskbar buttons,
267,268
Guest account, 109, 120
Guests group, 124
GUI (graphical user interface),
75,419
GUI Mode in Windows Setup, 13

hard disk drives, 76-81
minimum requirements
for Microsoft Office, 192
for Windows XP, 6
power options for, 87
preparation for attended
installation, 9-13
tools, 11-12
reformatting, 411
troubleshooting, 79-81
hardware. See also drivers
Advanced Configuration
Power Interface (ACPI),
75, 85-91
power schemes, 86-88
standby vs. hibernate,
88-91
display devices, 75, 81-85
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settings, 82—-84
types, 82
exam essentials, 100-101
input/output devices, 75,
91-94
hardware profiles, 92-93
troubleshooting, 94
types, 91-92
locally attached, 362-374
minimum requirements for
attended installation, 6
and software compatibility,
7-9
storage devices, 75, 76-81
basic disks, 76-77
dynamic disks, 77-79
removable storage
devices, 81
Hardware Abstraction Layer
(HAL), 126
hardware profiles, 92-93,
105, 419
Hardware Profiles dialog box, 93
Hardware Update Wizard, 96, 96
Help and Support, 129-130, 130,
245, 246,271,272, 419
Help menu (Internet Explorer),
255,255
Help menu (Outlook Express),
262,262
Help Services Group, 124
hibernation, 87, 105
vs. standby, 88-91
history of Internet browsing, 169
HKEY_LOCAL_MACHINE
Registry key, 126
home page for Internet
Explorer, 169
host, 419
host-network VPN, 166
hostname command, 339,
340, 419
hostnames, 158-161, 339
resolving to IP addresses,
346-348
hosts file, 342, 343,419
HTTP (Hypertext Transfer
Protocol), 218
HTTP mail accounts, mailbox
configuration, 210-211
hub, 351, 419
Hypertext Transfer Protocol
(HTTP), settings for, 218

1/O. See input/output (I/O) devices
ICMP (Internet Control Message
Protocol), 420
packets, 151
icons
for customizing folders, 328
on Start menu, 320
identities in Outlook Express,
334,419
customization, 314-316
Identities (Outlook Express File
menu), 258
IE. See Internet Explorer
IEEE 1284 standard, 91
IEEE 1394 standard, 92, 419
Ignore Conversation
(Outlook Express Message
menu), 261
imaging devices. See Scanners
and Cameras
IMAP, 419
mailbox configuration,
209-210
Import and Export (IE File
menu), 251
Import and Export tools,
customization in Outlook
Express, 316-317
Import/Export (Outlook Express
File menu), 258, 278
importing data in Outlook,
307-309
Inbox Repair Tool, 310-311, 334
infrared (IR) connection, 92, 419
for printers, 52
Infrared Data Association
(IrDA), 92
inheritance of NTFS permissions,
38-40
input/output (I/O) devices, 75,
91-94, 419
hardware profiles, 92-93
pointing device, settings,
113,114
troubleshooting, 94
types, 91-92
installing
local printer, 51-52
Microsoft Office,
191-195, 234
disk space
requirements, 192
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new from CD, 193-194
selecting
methodology, 192
upgrade installation with
CD, 195
network printer, 53-54
printer driver, 56-57
installing Windows XP, 5-26
attended installation, 6-16
activating Windows XP,
14-16
BIOS preparation, 9
driver updates, 9
hard disk preparation,
9-13
hardware and software
compatibility, 7-9
log files for
troubleshooting, 16
minimum hardware
requirements, 6
network components, 14
setup program, 13
Windows Update, 14
exam essentials, 26
multiboot installation, 23-25
unattended installation, 17-20
answer files, 17, 18
Remote Installation
Services (RIS), 19-20
uniqueness database files,
17-18, 18, 19
upgrade installation, 20-23
with Files and Settings
Transfer (FAST)
Wizard, 22-23
with Upgrade Advisor, 21
with User State Migration
Tool, 21-22
Integrated Services Digital
Network (ISDN), 163
IntelliMirror, 227
Intermediate Certificate
Authorities, 215
Internet, 143
for remote connections, 166.
See also virtual private
network (VPN)
Remote Desktop over,
175-176
Internet Accounts dialog box, 220
Internet Connection Firewall,
380, 390, 420
configuration, 147-148

Internet Connection Wizard, for
newsgroup, 221
Internet Control Message
Protocol (ICMP), 420
packets, 151
Internet e-mail (POP3), mailbox
configuration, 207-208
Internet E-mail Settings dialog
box, Advanced tab, 209
Internet Explorer, 144, 190, 238
configuring, 169-173,
213-218
LAN settings, 351-353
customization, 282, 311-313
organizing Favorites, 312
saving password for
website, 311
toolbar, 313
error messages, 255-256
exam essentials, 229, 330
settings, 249-256
Edit menu, 252, 252
Favorites menu, 253,
253-254
File menu, 250-251, 251
Help menu, 255, 255
Tools menu, 254, 254
View menu, 252-253, 253
Internet Options dialog box
Advanced tab, 173, 218
Connections tab, 172,
172-173, 351, 352
for dial-up connections,
356-357
for VPN connection,
360-361
Content tab, 171,
214-216, 234
General tab, 169, 170, 185
for LAN, 351-352
Privacy tab, 171, 217,217
Programs tab, 173, 213, 213
Security tab, 170-171,
171,185
Internet Protocol (TCP/IP)
Properties dialog box, 145,
145, 146, 146, 345
DNS settings, 347, 347
Internet Service provider
(ISP), 420
intranet, Remote Desktop over,
175,176
"Invalid partition table" error
message, 79
IP address, 143, 338, 420

automatic configuration,
146-147
entering during Windows
installation, 14
firewall blocking of, 362
forcing request for new, 150
manual configuration, 145
for network adapter, 349
for Remote Desktop, 176
resolving hostname to,
346-348
subnet mask, 350
troubleshooting, 149-150
ipconfig tool, 149, 176, 185,
380, 420
to force request for new IP
address, 150
name resolution
troubleshooting
with, 161
sample output, 349
to view IP address, 338,
338,339
IrDA (Infrared Data
Association), 92
ISDN (Integrated Services Digital
Network), 163
issuing CA, 420

J

junk e-mail, 420
Outlook filters for,
298-301, 334
Junk E-mail Options dialog
box, 296
Blocked Senders tab, 301, 301
Options tab, 298-299
Safe Recipients tab, 300, 300
Safe Senders tab, 299, 300

K

kernel initiation phase of
startup, 126
kernel load phase of startup, 126
key, 420
keyboard
accessibility options, 112
On-Screen Keyboard, 113
Knowledge Base. See Microsoft
Knowledge Base



L

languages, 109, 115-116
LAN:Ss (local area networks)
configuring, 351-354
for client, 351
for Internet Explorer,
351-353
exam essentials, 376
settings, 173
laptop computers. See also offline
files and folders
power consumption, 85
risks of standby, real world
scenario, 90
Last Known Good Configuration
(LKG), 126, 420
Layout (Outlook Express View
menu), 260
LCDs (liquid crystal displays), 82
List Folder Contents NTFS folder
permission, 36
Lists of Favorites (IE Favorites
menu), 254
Lmbosts file, 155-157, 185,
341-342, 342, 420
loadstate command, 22, 30, 420
local accounts, 120, 138
Local Area Network (LAN)
Settings dialog box,
352,353
local area networks (LANS). See
LAN:Ss (local area networks)
local intranet zone, 170
local printers, 51-53, 421
adding, 365-370
removing, 52-53
Local Security Authority (LSA),
126,421
local security policy, 117-118
vs. Group Policy, 138
Local User Accounts and Groups,
120, 122-123, 421
Local Users and Groups,
examining membership,
383-386
Localization, 421
localized versions of
Windows XP, 115
locking Taskbar, 266
logical drives, 76
logon process, 110, 126
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logs, 421
for Microsoft Office, 245
Performance Logs and Alerts,
131-132, 139
for troubleshooting attended
installation, 16
loopback test, 152
low-level format, 10, 421

MAC (Media Access Control)
address, 337-338, 421
macros, 411
and security, 386, 406, 412
Magnifier, 113
Mail and News (IE Tools
menu), 254
Mail Setup dialog box, 206
General tab, 211
mailbox configuration in
Outlook, 207-212
for Exchange, 211-212
for HTTP mail accounts,
210-211
for IMAP, 209-210
for Internet e-mail (POP3),
207-208
to leave messages on
server, 209
troubleshooting, 212
Manage Documents printer
permission, 55
Manage Identities dialog box,
315-316, 316
Manage Printers printer
permission, 55
manual caching, 63
manual installation of Office, 192
Mark As Read (Outlook Express
Edit menu), 259
Master Boot Record (MBR), 126
replacing, 80
Media Access Control (MAC)
address, 337-338, 421
memory, 129
minimum requirements for
Windows XP, 6, 30
Message menu (Outlook Express),
260-262, 261
Messenger (IE Tools menu), 254

Microsoft client, 421
Microsoft Developers Network
(MSDN) library, 199
Microsoft DirectX,
troubleshooting, 85
Microsoft Knowledge Base, 105,
263,271,278
article numbers, 246
article on buffer overruns, 386
for error message help, 256
for Microsoft Office, 245-249
searching, 248
Microsoft Office, 190, 191-212,
238-249, 421. See also
Outlook
activating, 195
adding and removing
components, 197-199
customization, 282, 283-311
AutoCorrect lists and
options, 295-296
Proofing Tools,
291-296, 292
of toolbars, 283-291
error messages, 239, 245-249
logs, 245
Microsoft Knowledge
Base, 245-249
exam essentials, 229
file recovery, 201-205
with AutoRecover,
202, 202
with Microsoft Office
Application
Recovery tool, 201
Shadow Copy, 203-205
installing, 191-195, 234
customization, 239,
240-244
disk space
requirements, 192
new from CD, 193-194
selecting
methodology, 192
upgrade installation with
CD, 195
Office Update website,
196-198, 197,
396402, 412
passwords, 404, 412
repairing components,
199-200
troubleshooting, 196
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updates, 196, 197
version 2003 editions, 191
Microsoft Office Application
Recovery tool, 201
Microsoft On The Web (Outlook
Express Help menu), 262
Microsoft Product Support
Centers, 256, 263,272,272
Microsoft Windows Installer, 421
Microsoft Word
standard toolbars, 283
toolbar, 111
mirrored volume, 79, 421
Missing/Offline dynamic disk,
80-81
"Missing operating system" error
message, 79
modem Properties dialog box,
Diagnostics tab, 165
modems, 92, 355, 421
testing, 165-166
Modify NTFS file permission, 35
Modify NTFS folder
permission, 36
monitors. See display devices
mouse
accessibility options, 113
settings, 113, 114
Mouse Properties dialog box, 114
Move To Folder (Outlook
Express Edit menu), 259
moving files and folders, and
permissions, 41-42
multiboot installation, 6,
23-25, 421
boot partition for, 10
configuring, 227
Multilanguage User Interface
(MUI), 115, 138, 421
multimonitor, 82
multiple languages, 115-116
multiuser configuration, 227
My Network Places, 47
My Recent Documents, 320, 334

name resolution, 336, 337-348
exam essentials, 180-181, 375
hostnames, 158-161
NetBIOS names, 155-158

Lmhosts file, 155-157

WINS (Windows Internet
Name Service),
157-158
services and files for, 143,
155-163, 340-348, 422
ARP (Address Resolution
Protocol), 143,
341,414
DNS (Domain Name
Service), 157,
346-348,417
hosts file, 342, 343, 419
Lmbhosts file, 155-157,
185, 341-342,
342,420
WINS (Windows Internet
Name Service),
157-158, 343-346
troubleshooting tools,
161-163
ipconfig tool, 161. See also
ipconfig tool
nbstat command, 163
net command, 162, 422
nslookup tool, 162
ping tool, 151-152,
161-162
types of names and addresses,
337-339
hostnames, 339
MAC address, 337-338
NetBIOS names, 339
protocol address, 338
names, for printers, 368
Narrator, 113
nbstat command, 163
nbtstat command, 339, 340,
380, 422
net command, 162, 422
NetBIOS names, 155-158, 339,
380, 422
Lmbhosts file, 155-157, 185,
341-342, 342,420
WINS (Windows Internet
Name Service),
157-158, 343-346
network. See also connectivity;
name resolution
exam essentials, 180-181
overview in Task
Manager, 130
network adapter, 129
configuring, 336, 349-350
exam essentials, 376

Media Access Control (MAC)
address, 143
Network Address Translation
(NAT), 422
Remote Assistance
through, 179
network components, 129
for attended installation, 14
Network Configuration
Operators group, 124
network connection Properties
dialog box, 344
network interface cards. See
network adapter
network-network VPN, 166
network news transfer protocol
(NNTP), 220
network printers, 53-54, 422
New (IE File menu), 251
New Connection Type dialog
box, 353, 354
New Connection Wizard,
164,164
for dial-up connections,
356-357
for LAN settings, 353, 354
for VPN, 167, 167, 360-361
New Log Settings dialog box, 132
New Message (Outlook Express
Message menu), 261
New Outlook Data File dialog
box, 297
New (Outlook Express File
menu), 257
New User dialog box, 122
newsgroups in Outlook Express
configuring, 220-222
importing settings, 317
troubleshooting, 222
Next (Outlook Express View
menu), 260
NNTP (network news transfer
protocol), 220
“No Qualifying Product”
error, 196
Not Initialized status for dynamic
disk, 81
Notification area of Taskbar, 321
nslookup tool, 162, 422
NT Loader (NTLDR), problems
finding, 80
Ntbootdd.sys file, 10
Ntdetect.com file, 10, 126
NTES file permissions, 35
Deny permissions, 40-41



inheritance, 38-40
special permissions, 42-44
troubleshooting, 44-46
verifying, 36-38
when copying and moving
files, 41-42
NTEFS file system, 11
NTES folder permissions, 36
verifying, 36-38
NTLDR file, 10, 126
"NTLDR is compressed" error
message, 80
"NTLDR is missing" error
message, 80
Nrtoskrnl.exe file, 126
NTVDM (virtual DOS machine),
223-224,428
ntvdm.exe file, 223-224, 234
numbers, customizing for
region, 322

(o)

Office. See Microsoft Office
Office 2003 Proofing tools,
291-296, 292, 422
Office Update website, 196-198,
197, 396-402, 412
offline files and folders, 34,
61-65, 422
client computer configuration
for, 61-62
making available, 62
synchronization, 64
On-Screen Keyboard, 113
Online (errors) status for dynamic
disk, 81
Online Support (IE Help
menu), 255
Open (IE File menu), 251
Open (Outlook Express File
menu), 257
operating systems. See also
Windows
install types, 5-6
obtaining for test
environment, 24
Options dialog box
General tab, 222
Security tab, 404, 404
Spelling & Grammar tab, 293,
293-294
Organize Favorites (IE Favorites
menu), 254, 312
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organizing Favorites,
customization in Internet
Explorer, 312
original equipment manufacturer
(OEM), 422
Outlook
data management, 296-311
archiving data, 306-307
corrupt data repair,
310-311
importing and exporting,
307-310
junk mail filters, 296,
298-301
personal folders, 296,
297-298
exam essentials, 229, 330
mailbox configuration,
207-212
for Exchange, 211-212
for HTTP mail accounts,
210-211
for IMAP, 209-210
for Internet e-mail (POP3),
207-208
troubleshooting, 212
profile creation, 205-207
rules, 301-306, 334
Outlook Express, 190, 218-222,
238,422
configuring for e-mail
accounts, 218-220
customization, 282, 314-317
identities, 314-316
Import and Export tools,
316-317
toolbar, 317
error messages, 262-263
exam essentials, 330
newsgroup configuration,
220-222
setting as default reader,
221-222
settings, 256-262
Edit menu, 258, 258-259
File menu, 257, 257-258
Help menu, 262, 262
Message menu,
260-262, 261
Tools menu, 260
View menu, 259, 259-260
troubleshooting, 220
overwritten files, Shadow Copy to
recover, 204
ownership of files and folders, 45

P

packets, 423
page file, 129, 423
Page Setup (IE File menu), 251
paging, 129, 423
parallel communication, 423
by /O devices, 91
parent folder, 38, 423
parity data, 79, 423
Partition Magic (PowerQuest), 77
partitions, 10, 30, 423
formatting, 11
passwords
for Content Advisor, 214
for identities in Outlook
Express, 315
for mailbox, 212
for Office documents,
404, 412
for website, saving in Internet
Explorer, 311
Paste (IE Edit menu), 252
patches, 390-403
deployment methods, 403
executable file for, 403
Office Update website,
196-198, 197, 396-402
Windows Update, 14,
390-396
pathping tool, 153-154
performance, 110, 128-132
fast user-switching and, 114
monitoring tools, 129-132
Help and Support tools,
129-130, 130
Task Manager, 130, 131
Windows Performance
tool, 131-132, 132
resources for, 128-129
Performance Logs and Alerts,
131,139
permissions, 382, 383-386, 423.
See also NTEFS file
permissions
effective, 46, 70
exam essentials, 65-66
for printers, 54-55
setup, real world scenario, 50
share, 48
personal certificates, 215
personal folders, in Outlook, 296,
297-298
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personal information, for Internet
Explorer, 171, 216
personal profile, for Internet
Explorer, 171
physical disabilities, person with.
See accessibility options
pictures, for customizing
folders, 328
PIFs (program information
files), 224
ping tool, 151-152
error messages, 162
name resolution
troubleshooting with,
161-162
PKI (Public Key
Infrastructure), 424
plasma gas displays, 82
Plug and Play, 9, 423
parallel devices, 91
PNPlog.txt file, 16
pointing device, settings, 113, 114
POP3 (Post Office Protocol,
version 3), 423
mailbox configuration
for Outlook, 207-208
for Outlook Express, 219
ports
firewall blocking of, 362
for imaging device, 373
for printers, 366-367
power. See also Advanced
Configuration Power
Interface (ACPI)
management settings, 105
for USB devices, 81, 92, 105
power meter, displaying, 88
power-on self-test (POST), 126
Power Options Properties dialog
box, 88
Hibernate tab, 88-89, 89
Power Schemes tab, 87, 87
power schemes, 86-88, 423
Power Users group, 124
PowerQuest, Partition Magic, 77
pre-boot phase of startup, 126
Previous Message (Outlook
Express View menu), 260
primary partitions, 76
print devices, 34, 423
Print (IE File menu), 251
print jobs, 51, 423
redirecting, 60
troubleshooting, 55

— Recovery Console

Print (Outlook Express File
menu), 258
Print Preview (IE File menu), 251
Print printer permission, 55
print queue, clearing, 59
print server, 51
Print Server Properties dialog box,
Advanced tab, 58
print spooler, 58-59
restarting service, 59
printer drivers, 423
deleting, 54
installing, 56-57
updating, 57
printer permissions, 54-55, 423
configuring, 55-56
printer Properties dialog box
General tab, 364
Security tab, 56
printers, 34, 51-60, 423
local, 51-53
removing, 52-53
management, 363
adding local, 365-370
network, 53-54
permissions, 54-55, 70
troubleshooting, 55-60
connectivity, 59-60
drivers, 55-57
print spooler, 58-59
redirecting print jobs, 60
test page printing, 60, 369
privacy
cookies and, 217
for Office documents, 405
Privacy Report (IE View
menu), 253
private key, 424
for encrypted files, 46
problem solving. See
troubleshooting
processes, in Task Manager, 130
processor, 128-129
minimum requirements for
Windows XP, 6
product key for Office, 193, 240
product number for Internet
Explorer, determining, 255
profile, 424
Profile Assistant, 216, 234
profiles, creating for Outlook,
205-207
Program Compatibility Wizard,
226,226,234

program information files
(PIFs), 224
program Properties dialog box,
Compatibility tab, 225, 225
Proofing Tools in Microsoft
Office, 291-296, 292, 422
Properties (IE File menu), 251
Properties (Outlook Express File
menu), 258
protocol address, 338. See also
IP address
protocols, firewall blocking
of, 362
proxy server, 351
settings, 352
.pst files, repairing, 310-311
public key, 424
public key cryptography, 424
Public-Key Cryptography
Standards (PKCS), 215
Public Key Infrastructure
(PKI), 424

Q

Quick Launch icons, on Taskbar,
265,267

radio frequency (RF), 92, 424
RAID-5 (Redundant Array of
Inexpensive Disks), 79, 425
RAM, 129
minimum requirements for
Windows XP, 6, 30
Read and Execute NTES file
permission, 35
Read and Execute NTFS folder
permission, 36
Read Me (Outlook Express Help
menu), 262
Read NTEFS file permission, 35
Read NTES folder permission, 36
Read shared folder permission, 48
Readability Statistics, 294
Recent Documents, 320, 334
recovery agent, 46, 424
Recovery Console, for
troubleshooting, 80
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Redundant Array of Inexpensive
Disks (RAID-5) volume,
79,425

Refresh (IE View menu), 252

Refresh (Outlook Express View
menu), 260

refresh rate, 83

Regional and Language
Options, 424

Regional And Language Options
dialog box

Languages tab, 115
Regional Options tab, 116,
322,323
regional settings, 424
customization in Windows
XP, 322

registration, vs. activation, 16

Registry, access to, 386, 411

Remote Assistance, 144, 424

remote connections, 144,
163-168, 173-179, 425

dial-up connections, 163-165

troubleshooting, 165-166
exam essentials, 180-181, 376
Remote Assistance,

176-179, 186
configuring, 178-179
expert console, 177, 178
novice console, 177

Remote Desktop, 144,

173-176, 424
configuring, 174-175
permissions, 174
requirements, 174

server configuration for
clients, 355-361
dial-up connections,
355-359
VPN connections,
359-361
virtual private network

(VPN), 166-168
default gateway, 168
troubleshooting, 166

Remote Desktop Protocol
(RDP), 173

Remote Desktop Users group, 124

Remote Installation Services
(RIS), 19-20, 30, 424

server, 5

removable storage devices, 75,
81,424

removing

network printer, 54

toolbar from Microsoft Office
application, 288
repairing Office components,
199-200
Replicator group, 124
Reply To All (Outlook Express
Message menu), 261
Reply to Group (Outlook Express
Message menu), 261
Reply To Sender (Outlook
Express Message
menu), 261
"Request timed out" error
message, 162
resizing toolbar, 286, 286
resolution of screen display, 83
resource sharing, 34. See also files
and folders; printers
exam essentials, 65-66
resources, baseline for, 128
restricted sites zone, 171
Resultant Set of Policy (RSoP),
119, 424
rights, inheritance from
group, 120
RIS. See Remote Installation
Services (RIS)
RJ-11 jack, 92
Roll Back Driver, 425
rolling back drivers, 96, 97
Root Certificate Authorities, 215
routers, 425
Routing and Remote Access
Services (RRAS), 355, 425

S

SAM (Security Accounts
Manager) database, 127
Save (IE File menu), 251
Save As (IE File menu), 251
Save As (Outlook Express File
menu), 257
Save As Stationery (Outlook
Express File menu),
257,278
Save Attachments (Outlook
Express File menu), 257
saving
with Hibernate, 88
password for website, 311
scanner Properties dialog box,
General tab, 371

Scanners and Cameras, 370-374,
371,380
Scanpst.exe, 310-311
scanstate command, 22, 30, 425
screen resolution, 83, 84
screen saver, 82
Script Debugger (IE View
menu), 253
SCSI (Small Computer System
Interface) drives, 129
section title, 425
Secure Sockets Layer (SSL), 425
security, 109, 116-119, 382,
387-403
for applications, 403-405
exam essentials, 134, 407
Internet Explorer settings,
170-171, 171
local policy, 117-118
network policy settings
recognition, 118-119
policies hierarchy, 119
updates and patches, 390-403
deployment methods, 403
Office Update website,
396-402
Windows Update website,
390-39%6
viruses, 387-390
effects, 387-388
preventing, 390
recovery from attack,
388-389
Security Accounts Manager
(SAM) database, 127
security identifier (SID), 120
Select All (IE Edit menu), 252
Select All (Outlook Express Edit
menu), 258
Select Users or Groups dialog
box, 37
Send (IE File menu), 251
Send Feedback (IE Help
menu), 255
serial communication, 425
by /O devices, 91
server certificates, 215
services.msc, 59, 59
Setup Manager Wizard, 17, 425
setup program, for attended
installation, 13
Setupapi.log file, 16
Setupapt.log file, 16
Setuperr.log file, 16
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Setup.exe for Office, 193,
240-244
log files for error
messages, 245
Setuplog.txt file, 16, 30
Shadow Copy, 203-205, 234
share permissions, 48, 425
combining with NTFS, 48-50
shared folders, 34, 46-50, 425
classic sharing, 46-50
simple file sharing, 46
sharing printers, 368
shortcuts. See also Desktop
shortcuts configuration
to Offline Files Folder, 62
Show Related Links (IE Tools
menu), 254
signed drivers
computer configuration
for, 98
determining, 98-99
sigverif.exe, 98-99
simple file sharing, 46, 425
enabling or disabling, 38
Simple Mail Transfer Protocol
(SMTP), 234
simple volume, 79, 425
single sign-on, 425
Small Computer System Interface
(SCSI) drives, 129
smart displays, 82
SMS (System Management
Server), 403
SMTP (Simple Mail Transfer
Protocol), 234
software publisher
certificates, 215
Software Update Services
(SUS), 426
Sort By (Outlook Express View
menu), 260
sound, accessibility options, 113
Source (IE View menu), 253
spanned volume, 79, 426
special NTES permissions, 42-44
special permissions, 426
Spelling checker, 292-294
AutoCorrect and, 294-295
standby
vs. hibernate, 88-91
risks for laptop, real world
scenario, 90

Start menu
> All Programs > Accessories >
Communications >
Remote Desktop
Connection, 176
creating shortcut from,
268,269
> Connect To, 164
> Run, 235
classic, 265, 266
configuring, 264-265
customization in
Windows XP, 318-320
default for Windows XP, 265
startup. See system startup
startup errors, 79-80, 426
stationery, 257, 278
Status Bar (IE View menu), 252
StickyKeys, 112
stop error, 13, 80, 105, 426
Stop (IE View menu), 252
Stop (Outlook Express View
menu), 260
storage devices, 75, 76-81, 426
basic disks, 76-77
dynamic disks, 77-79
removable storage devices, 81
striped volume, 79, 426
subnet mask, 350
switch, 351, 426
Switch Identity (Outlook Express
File menu), 258
symmetric, 426
synchronization, 426
of offline files and folders, 64
Synchronize (IE Tools menu), 254
System Access Control List
(SACL), 426
System account, 120
System Management Server
(SMS), 403
System Monitor, 131
system partition, 10, 30, 426
system performance. See
performance
System Properties dialog box, 15
Advanced tab, for operating
system selection and
timeout, 24
Automatic Updates tab, 15
Computer Name tab, 159,
159-160

Driver Signing Options
tab, 105
Remote tab, 175,179
system standby, 87
system startup, 110, 125-126
boot sequence phases, 126
user logon
to computer, 126-127
to domain, 127-128
system tray, 268
systemroot, 10, 426

T

tablet PC, 82
Take Ownership permission, 426
Task Manager, 130, 131,
139,427
Processes tab, 234
16-bit applications in,
224,224
Taskbar
configuring, 265-268
appearance, 266-267
Notification area, 268
customization in
Windows XP, 321
Quick Launch icons on, 265
settings, 110-111
Taskbar and Start Menu
Properties dialog box
Start Menu tab, 264, 319
Taskbar tab, 111, 266-267,
267,321
TCP/IP (Transmission Control
Protocol/Internet Protocol),
143, 144-154, 427
automatic IP address
configuration, 146-147
Internet Connection Firewall
configuration, 147-148
manual IP address
configuration, 145
troubleshooting, 147,
149-154
connectivity, 151-154
IP address, 149-150
/temp folder, log files from Office
2003 install, 245
templates for customizing
folders, 327



temporary Internet files, 169
test environment, creating, 24
test page, printing, 60, 369
text editor, 427
Text Mode in Windows Setup, 13
Text Size (IE View menu),
252,278
Text Size (Outlook Express View
menu), 260
themes, for display, 83
thunking, 224
time, customizing display for
region, 322
timeout, for mailbox
configuration, 212
Tip Of The Day (IE Help
menu), 255
ToggleKeys, 112
toolbar
adding, 284-285, 285
creating custom,
288-291, 334
customization
in Internet Explorer, 313
in Office, 283-291
in Outlook Express, 317
exam essentials, 330
in Microsoft Word, 334
standard, 283
settings, 111
Toolbars (IE View menu), 252
Tools menu > Customize,
288-289
Tools menu (Internet Explorer),
254,254
Tools menu (Outlook
Express), 260
Tools menu (Outlook) > Rules
and Alerts, 302
touch-screen monitors, 82
Trojan horse, 387
troubleshooting, 127
Advanced Configuration
Power Interface
(ACPI), 89
DirectX, 85
display devices with VGA
mode, 84
display settings, 83
dynamic disk errors, 80-81
fixed storage devices, 79-81
group accounts, 125
input/output devices, 94
Microsoft Office, 196
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name resolution, 161-163
with ipconfig tool, 161
with nbstat command, 163
with net command, 162
with nslookup tool, 162
with ping tool, 161-162

newsgroups in Outlook

Express, 222
NTFS file permissions, 4446
Outlook mailbox
configuration, 212

printers, 55-60
connectivity, 59-60
drivers, 55-57, 70
print spooler, 58-59
redirecting print jobs, 60

Recovery Console for, 80

remote connections
dial-up connections,

165-166
virtual private network
(VPN), 166
TCP/IP (Transmission Control
Protocol/Internet
Protocol), 147, 149-154
connectivity, 151-154
IP address, 149-150

user accounts, 123

viruses, 387-388

Windows installation, log files

for, 16
trusted publishers, 405
trusted sites zone, 170

U

.udb file extension, 17
unattended installation, 5,
17-20, 427
answer files, 17, 18
Remote Installation Services
(RIS), 19-20
uniqueness database files,
17-18, 18, 19
unattend.udb file, 17, 18, 19
Unicode, 116
Unicode-Enabled, 427
Uniform Resource Locator (URL)
Address, 427
uninstalling. See removing
uniqueness database files, 427
for unattended installation, 5,
17-18, 18,19

Universal Naming Convention
command, 54
Universal Serial Bus (USB).
See USB (Universal Serial
Bus) devices
"Unknown host hostname" error
message, 162
Unreadable status for dynamic
disk, 81
unsigned drivers, determining,
98-99
updates, 390-403
deployment methods, 403
Office Update website,
196-198, 197, 396-402
Windows Update website,
390-396
updating. See also Windows
Update
drivers, 9, 94-96
Microsoft Office, 197
printer drivers, 57
Upgrade Advisor, 21, 427
upgrade installation, 5,
20-23,427
of Office, 192, 195
of Windows XP
with Files and Settings
Transfer (FAST)
Wizard, 22-23
with Upgrade Advisor, 21
with User State Migration
Tool, 21-22
URL (Uniform Resource
Locator), 144
USB (Universal Serial Bus)
devices, 427
for /0O, 92
power for, 81, 92,105
printers as, 52
user accounts, 109, 120-123,427.
See also group accounts
exam essentials, 134
group membership of, 125
troubleshooting, 123
User Accounts tool, 120, 121, 121
user environment, 109, 110-114
accessibility options, 112-113
fast user-switching, 114
pointing device settings,
113,114
Taskbar and toolbar settings,
110-111
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user logon

to computer, 126-127

to domain, 127-128
User State Migration Tool,

22,427
upgrade installation with,
21-22

username, for mailbox, 212
Users group, 124
Utility Manager, 113

\"/

value, 428
version of Internet Explorer,
determining, 255
VGA mode for display
troubleshooting, 84
video card Properties dialog box,
General tab, 326
View menu (Internet Explorer),
252-253,253
View menu (Outlook Express),
259,259-260
virtual DOS machine (NTVDM),
223-224,428
virtual memory, 129
virtual operating system
software, 24
Virtual PC (Microsoft), 24
virtual private network (VPN),
166-168, 172, 380, 428
connections configuration,
359-361
default gateway, 168
troubleshooting, 166
viruses, 386, 387-390, 411, 428
effects, 387-388
preventing, 390
recovery from attack,
388-389
spread, 389
VMWare, 24
volumes, 10, 428. See
also partitions

w

Watch Conversation
(Outlook Express Message
menu), 261
web browsers, 144. See also
Internet Explorer
web content zones, 170-171
Web e-mail (HTTP accounts),
mailbox configuration,
210-211
web pages, sending in e-mail, 251
web resources
making available offline, 254
Microsoft Developers
Network (MSDN)
library, 199
Office Update website,
196-198, 197
for Upgrade Advisor, 21
Windows Catalog, 7-9, 8
websites
Content Advisor ratings, 214
saving password in Internet
Explorer, 311
What's This?, 83
Winl6 on Win32 (WOW), 224
Windows 9x operating
system, 428
simulation, 225
Windows Catalog, 7-9, 8, 30
Windows Internet Name Service
(WINS), 343-346, 428
Windows Performance Tool,
131-132, 132,428
Windows Product Activation
(WPA), 14, 428
Windows Update, 411, 428
in attended installation, 14, 15
for drivers, 94, 95
security patches, 390
website, 390-396
Windows Update (IE Tools
menu), 254
Windows Welcome in Windows
Setup, 13
Windows XP

configuring, 263-271
desktop shortcuts,
268-271
Start menu, 264-265
Taskbar, 265-268
customization, 282, 318-328
exam essentials, 330
folder settings, 326-328
fonts, 324-326
regional settings, 322
Start menu, 318-320
Taskbar, 321
error messages, 271-272
localization, 115
minimum hardware
requirements, 6
Windows XP CD
for partitions, 12-13
User State Migration Tool, 22
winipcfg, 338, 350
Winlogon.exe file, 126
WINS (Windows Internet Name
Service), 157-158, 343-346
wireless devices, radio frequency
(RF), 92
Word (Microsoft)
standard toolbars, 283
toolbar, 111
Work Offline (Outlook Express
File menu), 258
Work Offline/Work Online (IE
File menu), 251
worms, 387
WOW (Winl6 on Win32), 224
Write NTFS file permission, 35
Write NTES folder permission, 36

X

X.509 certificate format, 215

Y4

zones for web content, 170-171
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